This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
# Table of Contents

1 vCloud Automation Center Overview ................................................. 1
   Virtual Machine Provisioning and Management .................................. 1
   Cloud Machine Provisioning and Management ................................. 2
   Physical Machine Provisioning and Management .............................. 2
   Elements of Machine Provisioning and Management ....................... 2
      Provisioning Groups and Users ....................................................... 3
      Virtualization Compute Resources, Enterprise Groups and Virtual Reservations 3
      Cloud Endpoints, Enterprise Groups and Cloud Reservations .......... 3
      Physical Machines and Physical Reservations ............................... 4
      Blueprints ..................................................................................... 4
      Build Profiles ................................................................................ 5
      Global Administrators ...................................................................... 5
   vCAC Licensing ................................................................................ 5
   The Machine Lifecycle ........................................................................ 5
   vCAC Terms and Definitions ............................................................... 8

2 Preparing for Provisioning ................................................................. 11
   Choosing a Provisioning Method ......................................................... 11
   Enabling Remote WMI Requests on Windows Reference Machines ...... 13
      Enable Remote WMI Requests on the Reference Machine .............. 13
      Allow WMI Requests Through the Windows Firewall ..................... 14
      Disable UAC .................................................................................. 14
      Test Remote WMI Access ............................................................... 14
   Active Directory and Windows Provisioning ...................................... 15
      Enabling Visual Basic Scripts in Machine Provisioning ................. 15
   Using the vCAC Guest Agent in Machine Provisioning ..................... 16
   Preparing for Virtual Provisioning by Cloning .................................. 17
      Creating the Template and Customization Object for Cloning .......... 18
      Assigning IP Addresses to Cloned Machines ................................... 20
   Preparing for vCNS Integration ......................................................... 21
   Preparing for WIM-Based Provisioning ............................................ 21
      How WIM-Based Provisioning Works ............................................. 21
      WIM-Based Provisioning Setup Tasks ............................................ 23
      Preparing the Staging Area ............................................................. 23
      Preparing the WIM Image .............................................................. 23
      Preparing the WinPE Image ............................................................ 29
      Making the WinPE Image Available for Provisioning .................... 32
   Preparing for Linux Kickstart/AutoYaST Provisioning ...................... 32
How Linux Kickstart/AutoYaST Provisioning Works ...........................................32
Linux Kickstart/AutoYaST Provisioning Setup Tasks .........................................33
Creating the Kickstart or AutoYaST Configuration File.......................................33
Creating the Boot Image and Making It Available for Provisioning.....................34
Assigning IP Addresses to Machines Provisioned Using Kickstart/AutoYaST ...35
Adding Customization Scripts.............................................................................35
Preparing for SCCM-Based Provisioning...................................................... 36
How SCCM-Based Provisioning Works..............................................................37
Preparing for Provisioning Within SCCM ...........................................................37
Preparing for PXE-Based Provisioning .............................................................38
How PXE-Based Provisioning Works .................................................................39
PXE-Based Provisioning Setup Tasks................................................................39
Preparing for Amazon EC2 Provisioning ...................................................... 40
Access and Credentials ......................................................................................40
Amazon Machine Images ...................................................................................40
Instance Types ...................................................................................................41
Security Groups ..................................................................................................41
Virtual Private Cloud .........................................................................................41
Elastic Load Balancers .......................................................................................42
Elastic IP Addresses ..........................................................................................42
Elastic Block Storage ..........................................................................................43
Preparing for Integration with vCAC ............................................................. 43
Preparing to Integrate XenDesktop ....................................................................43
Preparing to Integrate Citrix Provisioning Server ..............................................44
3 Setting Up vCAC and Organizing Infrastructure ....................... 45
Setting Up vCAC Roles and Elements.......................................................... 45
Assigning vCAC Administrators ......................................................................45
Adding a Virtualization Compute Resource to vCAC..........................................46
Adding a Cloud Service Account to vCAC..........................................................49
Adding Cloud Endpoint Credentials ..................................................................50
Creating an Amazon EC2 Endpoint .....................................................................50
Generating and Entering an EC2 Key Pair .........................................................51
Amazon EC2 Instance Types ...............................................................................52
Amazon EC2 Security Groups ............................................................................53
Creating an Enterprise Group with Enterprise Administrators .........................53
Adding a Physical Machine to vCAC .................................................................54
Creating a Provisioning Group with Reservations ............................................55
Creating Blueprints ....................................................................................... 62
Blueprint Type.....................................................................................................62
Local and Global Blueprints ..............................................................................62
Creating Build Profiles .....................................................................................62
Overview of Blueprint Settings ..........................................................................63
## Table of Contents

Creating a Blueprint................................................................. 68
Creating a Blueprint for Virtual Provisioning by Cloning............... 68
Virtual Provisioning by Cloning with Static IP Address Assignment ... 70
Enabling Snapshot Manager .......................................................... 71
Creating a Blueprint for Linked Clone .......................................... 72
Creating a Blueprint for WIM-Based Provisioning .......................... 73
Creating a Blueprint for Linux Kickstart/AutoYaST Provisioning ..... 76
Creating a Blueprint for SCCM-Based Provisioning ....................... 78
Creating a Blueprint for PXE-Based Provisioning ......................... 79
Creating a Blueprint for Amazon EC2 Provisioning ....................... 80
Adding XenDesktop Integration to a Virtual Blueprint .................... 83
Adding Citrix Provisioning Server Integration to a Virtual Blueprint ... 85
Calling Visual Basic Scripts from a Blueprint ................................. 87
Creating a Virtual Blueprint for the Basic Workflow ...................... 88
Including the FQDN in Automatic Email ....................................... 88

Requesting Machines Using a Blueprint ..................................... 89

Organizing Your Infrastructure ................................................... 89
Understanding Virtual Machine Management ............................... 90
Preparing to Use the Organizer .................................................. 90
Using the Infrastructure Organizer .............................................. 91

### 4 Using the vCAC Console ....................................................... 95

Overview of the vCAC Console .................................................. 95
Console Security and Access ..................................................... 95
Starting the Console ................................................................. 95
Elements of the vCAC Console .................................................. 96
Entering Information Using the vCAC Console .............................. 98
Console Synchronization .......................................................... 98
Roles and Activities ................................................................. 98

Dashboard: Tracking Virtual, Physical and Cloud Machines .......... 105
Self-Service: Requesting and Managing Your Own Machines ........ 106
Requesting a Machine ............................................................. 106
Managing Your Machines ........................................................ 109
Managing Cloud Machines ....................................................... 119
Support User: Working on Behalf of Another User ....................... 122
PGM: Managing a Provisioning Group ........................................ 123
Managing Provisioning Group Machines ...................................... 123
Monitoring Provisioning Group Resource Usage .......................... 129
Managing Provisioning Group Blueprints .................................... 132
Access Control: Managing Group Membership ............................ 144
Approver: Approving Machine Requests ..................................... 144
Enterprise Administrator: Managing vCAC Resources .................... 146
Managing Enterprise Machines ................................................................. 146
Reclaiming Enterprise Virtual and Cloud Machines ................................. 150
Managing Build Profiles ......................................................................... 153
Managing Global Blueprints .................................................................. 156
Managing Provisioning Groups ............................................................... 156
Managing Approval Groups and Policies .................................................... 160
Managing Virtualization Compute Resources ........................................... 164
Managing Reservations .......................................................................... 170
Managing Reservation Policies ................................................................. 189
Managing Network Profiles ..................................................................... 190
Managing Machine Prefixes .................................................................... 192
Managing Cost Profiles ........................................................................... 193
Managing EBS Volumes (Amazon EC2) .................................................... 195
Discovery: Organizing Virtual Infrastructure ........................................... 195
vCAC Administrator: Configuration, Security, and Customization .......... 196
  Setting Up Virtual, Cloud and Physical Provisioning .............................. 196
  Managing Credentials and Endpoints ..................................................... 198
  Managing Enterprise Groups ................................................................. 203
  Designating Administrators .................................................................. 204
  Viewing User Rights ............................................................................. 205
  Customizing the vCAC Console .............................................................. 205
  Using the Log Viewer and the Audit Log Viewer .................................... 208
  Viewing Distributed Execution Status .................................................... 209
  Workflow Execution History ................................................................. 209
  Viewing Distributed Execution Status and Workflow History ............... 209
  Managing Licenses ................................................................................ 211
  About the License Portal ..................................................................... 213
  Managing Instance Types ..................................................................... 214
Using vCAC Reports ................................................................................ 214
  Executive Summary ............................................................................. 215
  Capacity Usage Reports ....................................................................... 216
  Audit Log Reports ............................................................................... 218
  Chargeback Reports ........................................................................... 218
  Reclamation Reports ........................................................................... 220
Using the vCAC Self-Service Portal Website ............................................ 221
  Accessing the vCAC Self-Service Portal ............................................... 221
  Connecting by Using SSH for Linux Machines ..................................... 221
  Preferences ......................................................................................... 222
  Selecting Multiple Machines ................................................................. 222
  Blueprint Icons ................................................................................... 222
  Multi-Machine Services Support ........................................................... 223
  vCloud Director .................................................................................... 223
  Security ............................................................................................... 223
Retrying a Reconfiguration ...............................................................296
Rescheduling a Reconfiguration ......................................................297
Canceling a Reconfiguration ...........................................................297
Troubleshooting Reconfigure Machine ..............................................298
Data Collection ................................................................................298
Destroying Machines .........................................................................298

B Using Multiple Datastores for Machine Volumes .........................299
Creating a Storage Reservation Policy ..................................................299
Assigning Storage Reservation Policies to a Compute Resource ........300
Using Disk Properties with Volumes ......................................................300
Using Disk Properties on the Volumes Grid ........................................301
Using Disk Properties on the Properties Tab ........................................301
Allowing Alternative Datastores at Provisioning Time .......................301
Assigning Datastores to Volumes .........................................................302
Assigning Storage Reservation Policies to Volumes (Linked Clone Only) 302
Using Storage Reservation Policies in a Blueprint ...............................303
Using Create, Clone, or Flexclone Blueprints ......................................303
Using Linked Clone Blueprints ............................................................304
Requesting a Machine with Storage Reservation Policies ....................305
Editing a Machine with Storage Reservation Policies ........................305
Viewing the Machine’s Storage ..........................................................306

C Implementation Examples...............................................................307
BMC BladeLogic ..................................................................................307
EPI Agent for BladeLogic Requirements ..............................................307
Installing an EPI Agent for BladeLogic ..............................................308
Integrating BMC BladeLogic .................................................................309
Adding BMC BladeLogic Integration to a Blueprint ............................311
HP Software Automation (Opsware SAS) .............................................313
EPI Agent for HP SA Requirements ....................................................314
Installing an EPI Agent for HP SA ......................................................315
Integrating HP SA .............................................................................316
Creating Blueprints for HP SA Integration ........................................318

D Machine Lifecycle States.................................................................322
Chapter 1 vCloud Automation Center Overview

VMware vCloud® Automation Center™ (also known as vCAC) is comprised of three modules: Virtual Resource Manager (VRM), External Cloud Manager (ECM) and Physical Resource Manager (PRM). Together, these modules provide an enterprise-wide system for provisioning virtual, cloud and physical machines and for comprehensively managing the machine lifecycle from user request and administrative approval through decommissioning and resource reclamation, while dramatically improving resource cost control and management. Built-in customization and extensibility features also make vCloud Automation Center a highly flexible means for customizing machine configurations as needed and integrating machine provisioning and management with other enterprise-critical systems.

This guide describes the use of vCAC and its constituent products by machine owners and by the administrators who create and maintain its management policies and elements.

Virtual Machine Provisioning and Management

A virtual machine is a server, workstation, desktop or other computer system implemented entirely in software, using resources provided by one or more hardware systems. Virtualization allows an enterprise to provide users with the systems they need without having to individually procure, transport, build, install and configure hardware systems and the software deployed on them. The benefits of virtual machine provisioning include:

- Users get exactly the machines they need faster and with less overhead, and can roll back to start fresh whenever they need to.
- Provisioning capacity is as scalable as underlying hardware resources.
- Fewer person-hours are devoted to installing and configuring physical systems.
- Hardware resources are used more efficiently, with faster provisioning and dynamic workload rebalancing making data centers more agile.
- Hardware remains under the direct control of data centers personnel for more manageable security, maintenance, update, repair, and backup/restore.
- Remote users access data sources using local hardware, improving performance.
- Compliance with regulatory, corporate, and other enterprise computing requirements is easier.
- User workspaces are improved by the removal of unnecessary hardware.

Virtualization also brings challenges, however. Among these are costly and time-consuming manual processes for specifying and deploying machines and managing their ever-growing numbers and the ever-increasing resources they consume.

By handling all interaction with the virtualization platforms that provision virtual machines, vCAC and the console provide a self-service interface that simplifies and automates the tasks of specifying, requesting, provisioning, tracking, managing and disposing of virtual machines.
Cloud Machine Provisioning and Management

A cloud service provides an enterprise with the ability to provision and use virtual machines hosted at the service's data centers rather than its own, relieving the enterprise of the need to maintain and manage the hosting hardware and network. With a cloud service you simply request and pay for the virtual machines you need as you need them.

All of the advantages of virtual machine provisioning apply to cloud machine provisioning, with the additional advantage of much simpler cost tracking. The disadvantages of virtual provisioning also apply, however—cloud machines can easily proliferate and become unmanageable, creating a major financial burden.

As with virtual provisioning, by handling all interaction with the cloud services that provision cloud machines, ECM and the vCloud Automation Center web console provide a self-service interface that simplifies and automates the tasks of specifying, requesting, provisioning, managing and disposing of cloud machines. This helps to ensure that the ease of cloud provisioning will not lead to unacceptable costs.

Physical Machine Provisioning and Management

The comprehensive lifecycle management and flexible processes provided by PRM through the vCloud Automation Center web console bring some of the advantages of virtual and cloud machines to physical systems as well. By directly provisioning an operating system on a physical system using the hardware's management interface, PRM allows machine requestors and administrators to standardize, customize, use, track, manage and decommission physical machines in the same manner as virtual and cloud machines. Many virtual machines can be provisioned on a single virtualization compute resource and many cloud machines within a single cloud service account, whereas one physical machine represents one hardware system. But otherwise virtual, cloud and physical machines are provisioned, used and managed in much the same manner using the vCloud Automation Center web console.

Elements of Machine Provisioning and Management

vCloud Automation Center does not itself virtualize resources, but works with a virtualization platform—virtualization manager, hypervisor or OS-level virtualizer—to provision and manage the virtual machines created by that platform and the virtualization compute resources they are created on. To do this, vCAC uses proxy agents that communicate with the platform involved.

Likewise, vCAC does not directly provision cloud machines, but interacts directly with the cloud service to provision and manage the cloud machines created by that platform.

To provision and manage physical machines, vCAC communicates directly with each system's management interface to executes actions such as OS installation, rebooting, reprovisioning and so on.

Within vCAC, the basic elements include:

- policies controlling machine specifications, provisioning, approval, management and disposal
- administrators who manage resources, policies and user requests
- consumers who request and use machines

These elements are represented in the following diagram and described in the text.
Provisioning Groups and Users

A *provisioning group* is a collection of machine consumers, often corresponding to a line of business, department or other organizational unit. To request machines, a vCAC user must belong to at least one provisioning group. Each group has access to a set of *local blueprints* used to request machines.

A group must have at least one *provisioning group manager*, who maintains blueprints for the group and approves some machine requests. Groups can also contain *support users*, who can request and manage machines on behalf of other group members. A vCAC user can be a member of more than one provisioning group, and can have different roles in different groups.

Virtualization Compute Resources, Enterprise Groups and Virtual Reservations

A *virtualization compute resource* is a vCAC object representing a host, host cluster or pool within a virtualization platform. The virtual machines requested by provisioning group members are provisioned on compute resources.

vCAC regularly collects information about known compute resources and the virtual machines provisioned on them through the *proxy agents* that manage and communicate with them for vCAC. The compute resources an agent manages may be defined in an *endpoint* for which the agent is configured at installation, or the agent may have been configured for the compute resources on an individual basis.

Compute resources are organized into *enterprise groups* and managed by *Enterprise Administrators*. Enterprise groups are independent of provisioning groups.

A *virtual reservation* is a share of one compute resource’s resources—memory, CPU and storage—reserved for use by a particular provisioning group in provisioning machines.

Each virtual reservation is for one provisioning group only but the relationship is many-to-many—a group may have multiple reservations on one compute resource or reservations on multiple compute resources or both.

Each virtual reservation can be added to one *reservation policy*. The reservation from which a particular virtual machine is provisioned is determined by vCAC based on the reservation policy specified in the blueprint, if any, the priorities and current usage of the provisioning group’s various virtual reservations, and other factors.

Cloud Endpoints, Enterprise Groups and Cloud Reservations

A *cloud endpoint* is a vCAC object representing a cloud service account. The cloud machines requested by provisioning group members are provisioned in these cloud service accounts.

As with virtualization compute resources, vCAC regularly collects information about known cloud endpoints and the cloud machines provisioned on them. As with compute resources, cloud endpoints are organized into enterprise groups, the Enterprise Administrator of which can create reservations on them for provisioning groups. Because the cloud service manages its own resources, cloud reservations do not specify a share of these resources, but can limit the number of machines provisioned within an account.

Like virtual reservations, cloud reservations are for one provisioning group only but the relationship is many-to-many—a group may have multiple reservations on one endpoint or reservations on multiple endpoints or both. Cloud reservations can also be added to reservation policies. The reservation from which a particular cloud machine is provisioned is determined by vCAC based on the reservation policy
specified in the blueprint, if any, the priorities and current usage of the provisioning group’s various virtual reservations, and other factors.

**Physical Machines and Physical Reservations**

A *physical machine* is a hardware system known to vCAC because a *physical endpoint* representing it has been added to vCAC. vCAC regularly collects information about each known physical machine through its management interface. Depending on the type of management interface, an endpoint may represent one machine or a pool of multiple machines.

Physical machines do not belong to enterprise groups; any enterprise administrator can manage any known physical machine and reserve it for any provisioning group.

Until vCAC provisions it, a physical machine is *unprovisioned*, even if it already has an operating system. Once provisioned with an OS in vCAC, or imported with its existing OS intact, a physical machine is under the same vCAC management and control as a virtual or cloud machine.

A *physical reservation* is set of physical machines reserved for a provisioning group’s use. Unprovisioned physical machines must be added to a physical reservation before being provisioned or imported, and cannot be removed until they are decommissioned and become unprovisioned.

Each physical reservation is for one provisioning group only but a provisioning group can have any number of physical reservations containing any number of physical machines.

Physical reservations can be added to reservation policies. The physical machine to be provisioned and the physical reservation from which it is selected are determined by vCAC based on the reservation policy specified in the blueprint, if any, and the priorities and current usage of the provisioning group’s various physical reservations.

**Blueprints**

A *blueprint* is the complete specification for a virtual, cloud or physical machine, determining the machine’s attributes, the manner in which it is provisioned, and its policy and management settings. When a user requests a machine, she must select the blueprint from which it will be created.

For example, a virtual blueprint might specify a Windows XP Professional developer workstation with one CPU, 2 GB of memory and a 30 GB hard disk. A cloud blueprint might specify a Red Hat Linux web server image in a small instance type with 1 CPU, 2 GB of memory and 160 GB of storage. A physical blueprint might specify Windows Server 2008 R2 installed on a server with exactly two CPUs and at least 4 GB of memory. Blueprints specify the workflow used to provision a machine and additional provisioning information as needed, such as the locations of required disk images or virtualization platform objects. Finally, blueprints set the policies that apply to a machine, such as the approvals required to provision it, when it expires, which operations its owner can perform on it, and so on.

When a blueprint is created, some information is specified using controls in the console and some using *custom properties*.

A *local* virtual or physical blueprint is created by a provisioning group manager for a single provisioning group and is available only to that group’s members. A *global* virtual or physical blueprint is created by an Enterprise Administrator and/or Provisioning Group Manager can be selected for inclusion among a provisioning group’s local blueprints by the Provisioning Group Manager.
Build Profiles

A build profile is a set of properties to be applied to a machine when it is provisioned. These properties may determine the specification of the machine, the manner in which it is provisioned, operations to be performed after it is provisioned, or management information about it maintained within vCAC.

All build profiles are available to all provisioning groups. This makes it possible for a profile to serve as the basis for a set of similar blueprints within a provisioning group or across provisioning groups. An incorporated build profile is always read at machine build time, so the current version is always used no matter when the build profile was first incorporated in a blueprint.

Global Administrators

Global administrators are responsible for setting up and maintaining the vCAC site so provisioning groups members can request and use machines. A global administrator role does not enable a user to request machines. Global administrators include:

- **vCAC administrators**, who make global administrator assignments and review user rights; configure vCAC agents; manage credentials associated with endpoints; manage the endpoints representing virtualization platforms, cloud service accounts, physical machines and storage devices; manage enterprise groups; and review logs, Distributed Execution Manager status and license information.

- **Enterprise Administrators**, who manage compute resource and physical machines, virtual and physical reservations, provisioning groups, global blueprints, build profiles, reservation policies, approval policies and other global elements; track resource usage; and reclaim virtual machines as needed.

- **Access Administrators**, who can modify provisioning group memberships only.

- **Approvers**, whose approval can be required to build machines by including the appropriate approval policy in a blueprint.

A vCAC user can have more than one global administrator role, and can be both a global administrator and a provisioning group member in any role.

vCAC Licensing

vCAC must be installed with a license provided by VMware. This may be a perpetual license or an evaluation license of limited length. If the latter, a banner in the console continually reminds all global Administrators and Provisioning Group Managers of how many days are left on the license.

A perpetual license has no expiration date. Evaluation licenses are of limited length. When an evaluation license is in place, the License Info page indicates the number of days left on the license, as does a banner displayed for administrators. The evaluation period begins with the day on which the evaluation license is generated, not when you install vCAC.

The Machine Lifecycle

When the components described in the previous section have been set up and related to each other provisioning group members can request and use machines. The creation and operation of a machine proceeds through the following steps; please refer to the figure that follows for illustration.
1. A machine consumer opens the vCAC Console and reviews the local virtual, cloud and physical blueprints her provisioning group memberships give her access to. She selects a blueprint, enters a reason for her request, indicates the number of machines desired, makes other choices that may be available depending on the blueprint such as machine specifications or provisioning location, and completes her machine request.

2. If the blueprint requires approval, the request is sent to the provisioning group manager, one or more outside approvers, or both.

3. When the request is approved, or if it does not require approval, the machine is provisioned from one of the provisioning group’s virtual, cloud or physical reservations using the workflow, specifications and properties detailed in the blueprint, and turned on.

4. By selecting **Self-Service > My Machines**, which displays all of a user’s machines, the user can connect to the machine and perform operations on it such as shutting it down or rebooting it, reprovisioning it to its initial state, expiring it and destroying it. The user can also check the lease status of the machine and ask the group’s managers to extend the lease if necessary. You have the option to use the vCAC Console or the new Self-Service Portal (if installed) to request and manage your own machines. The See “Using the vCAC Self-Service Portal Website” on page 221 for more detail.

   **Note:** A machine lease time starts from the moment of request, and not from moment of approval.

5. When the machine’s lease (as specified by the blueprint) expires, or it is manually expired, the machine is destroyed (virtual or cloud) or decommissioned (physical). If a virtual blueprint specifies an *archive period*, however, the virtual machine’s owner can request *reactivation* by a provisioning group manager at any time before that archive period ends. This allows the owner to retrieve data left on the machine or to extend its use as changing circumstances require.

   Enterprise Administrators can also search for and identify unused or underused virtual machines and reclaim them (with the consent of the user) through early expiration.

6. When the end of the archive period is reached, or if there is no archive period, a virtual machine is destroyed. The resources that provisioned it are now available to provision new machines. When a cloud machine expires, it is destroyed, terminating any charges related to it. When a physical machine expires, it is decommissioned and becomes available for future provisioning requests from provisioning group members.
Figure 1 The vCAC Machine Lifecycle

1. **User requests machine** by selecting from among group’s local blueprints.

2. Group manager and/or others **approve request** as required.

3. Machine is provisioned from group’s virtual or physical reservations.

4. **Owner uses machine for life of lease, reprovisioning or requesting extension** as needed.

5. **Machine is reclaimed** by enterprise admin or expires, and is either archived or immediately destroyed (virtual) or decommissioned (physical).

6. On reclamation, expiration or end of archive period, virtual machine is **destroyed** and resources are recycled; physical machine is **decommissioned** and becomes available for future provisioning.

enterprise administrator maintains **build profiles** and global blueprints

provisioning group A

build profiles

local blueprints

provisioning group B

global blueprints

group managers create local blueprints and select global blueprints for local use

approvers

enterprise admin reserves host resources, cloud resources and physical machines for provisioning groups

memory

CPU

disk

memory

CPU

disk

machine owner

cloud service account

improvisioned physical machines

improvisioned physical machines

owner machine
vCAC Terms and Definitions

The following table provides a concise reference to the terms used in this guide to describe vCAC and the technologies with which it interacts.

Table 1  vCAC Terms and Definitions

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>blueprint</td>
<td>A specification for provisioning virtual or physical machines, determining the machines characteristics and the policies applied to it. A local blueprint belongs to a single provisioning group and can be used only by its members. A global blueprint is available to all provisioning group managers.</td>
</tr>
<tr>
<td>build profile</td>
<td>A set of custom properties that can be incorporated into blueprints.</td>
</tr>
<tr>
<td>cloud machine</td>
<td>A virtual machine provisioned by a cloud service on its own hardware and network.</td>
</tr>
<tr>
<td>cloud reservation</td>
<td>Access to the provisioning services of a cloud service account for a particular provisioning group.</td>
</tr>
<tr>
<td>vCAC database</td>
<td>vCAC uses a Microsoft SQL Server database to maintain information about the machines it manages and its own elements and policies. This database can be local or remote.</td>
</tr>
<tr>
<td>vCAC Manager Service</td>
<td>The vCloud Automation Center service (commonly called the Manager Service) coordinates vCAC communication between vCAC agents (including proxy agents), the vCAC database and SMTP.</td>
</tr>
<tr>
<td>vCAC role</td>
<td>A global administrator assignment or provisioning group membership within vCAC that determines which vCAC activities are available to a user; a single user can be in multiple roles.</td>
</tr>
<tr>
<td>vCAC web console</td>
<td>The browser-based interface to vCAC for machine owners and administrators.</td>
</tr>
<tr>
<td>vCAC workflow</td>
<td>A description of the activities (logical units of work) that make up a complex task, including order of execution and dependent relationships between them and the people or systems that perform them. vCAC uses workflows to define its machine provisioning and management processes. The master workflow defines all the states and stages within the machine lifecycle and is optimized to support long running, dynamic tasks; provisioning workflows define the process of building or cloning a machine and are specified in blueprints.</td>
</tr>
<tr>
<td>Distributed Execution Manager (DEM)</td>
<td>A Distributed Execution Manager (DEM) executes the business logic of custom models, interacting with the vCAC database and with external databases and systems as required. Each DEM instance performs one of two roles, Worker or Orchestrator. The Worker role is responsible for executing workflows and the Orchestrator role is responsible for monitoring DEM Worker instances, pre-processing workflows for execution, and scheduling workflows.</td>
</tr>
<tr>
<td>endpoint</td>
<td>Information required for access to a group of virtualization compute resources to be managed by a vCAC proxy agent; to a cloud service account to be managed by vCAC; or to one or more physical management interfaces, including those of physical machines to be provisioned in vCAC and those of devices.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enterprise Administrator</td>
<td>A global administrator who manages virtualization compute resources and physical machines, virtual, cloud and physical reservations, provisioning groups, global blueprints, build profiles, reservation policies, approval policies and other global elements, and tracks resource usage and reclaims machines as needed</td>
</tr>
<tr>
<td>enterprise group</td>
<td>A group of virtualization compute resources and cloud endpoints managed by one or more Enterprise Administrators.</td>
</tr>
<tr>
<td>global administrator</td>
<td>One of several vCAC roles responsible for setting up and maintaining the vCAC site so provisioning groups members can request and use machines.</td>
</tr>
<tr>
<td>Model Manager</td>
<td>The Model Manager is used to create and manage custom models, which facilitate integration of vCAC with external entities and implement custom business processes. The Model Manager communicates with the vCAC database, vCAC Console and Distributed Execution Managers (DEMs).</td>
</tr>
<tr>
<td>physical machine</td>
<td>A hardware system managed by vCAC that can be or has been provisioned with an operating system by vCAC.</td>
</tr>
<tr>
<td>physical reservation</td>
<td>A set of physical machines reserved for provisioning by a particular provisioning group.</td>
</tr>
<tr>
<td>provisioning group</td>
<td>A collection of machine consumers, typically corresponding to a line of business, department or other organizational group.</td>
</tr>
<tr>
<td>Provisioning Group Manager (PGM)</td>
<td>A member of a provisioning group who maintains blueprints for the group and approves some machine requests</td>
</tr>
<tr>
<td>proxy agent</td>
<td>The means by which vCAC communicates with a virtualization platform and the compute resources on which it provisions virtual machines, including regular collection of data about compute resources and machines.</td>
</tr>
<tr>
<td>reservation policy</td>
<td>A collection of reservations that can be selected in a blueprint to restrict machine provisioning to the reservations in the policy; often used to group like resources to create defined service levels, or to make a specific type of resource easily available for a particular purpose.</td>
</tr>
<tr>
<td>virtual machine</td>
<td>A computer system implemented entirely in software, using resources provided by one or more hardware systems.</td>
</tr>
<tr>
<td>virtual reservation</td>
<td>A share of one virtualization compute resource’s resources dedicated to a particular provisioning group for use in provisioning virtual machines.</td>
</tr>
<tr>
<td>virtualization compute resource</td>
<td>A vCAC object representing a host, host cluster or pool within a virtualization platform on which virtual machines requested by vCAC users are provisioned.</td>
</tr>
<tr>
<td>virtualization platform</td>
<td>A catch-all term for a virtualization technology with which vCAC directly interacts, whether it is a virtualization manager (such as vCenter Server) or a hypervisor of one type or another (such as XenServer and Hyper-V).</td>
</tr>
</tbody>
</table>
Chapter 2 Preparing for Provisioning

This chapter describes the preparation required outside of vCAC for the available provisioning methods. vCAC components and all required agents and associated software as described in the vCloud Automation Center Installation Guide, must be successfully installed.

After vCAC is installed and initially configured, site administrators must enable machine owners to request and provision new virtual, cloud and physical machines by using vCAC.

This goal requires both preparation outside of vCAC and setup within vCAC by using the vCAC Console. For example, you want to be able to provision virtual machines by cloning on an ESX Server host within a vCenter Server instance managed by a vCAC vSphere agent. To enable this you must do the following, at a minimum:

- Outside of vCAC, create a cloning template and an optional customization specification within the vCenter Server instance
- Inside of vCAC, create:
  - An enterprise group and add compute resources to it
  - A machine prefix for generating virtual machine names
  - A provisioning group and add users to it
  - A reservation on the compute resources for the provisioning group
  - A cloning blueprint for the provisioning group and in it select the template and customization specification you created in vCenter Server

After these steps are complete, any user belonging to the provisioning group can provision a virtual machine from the vCAC Console and selecting Self-Service > Request Machine, and then selecting the blueprint you created and confirming the request. You have the option to use the vCAC Console or the new Self-Service Portal (if installed) to request and manage your own machines. See “Using the vCAC Self-Service Portal Website” on page 221 more detail.

Choosing a Provisioning Method

You can choose one or more provisioning methods, described in Table 1, to provision machines. Each of these methods requires some preparation outside of vCAC.
## Table 1  vCAC Provisioning Methods

<table>
<thead>
<tr>
<th>Provisioning Method</th>
<th>Machines Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon EC2</td>
<td>cloud only</td>
<td>The specified Amazon Machine Image (AMI) and instance type are used to create an Amazon Elastic Cloud Computing (EC2) machine instance within an Amazon Web Services (AWS) account available to vCAC. All desired provisioning elements including AMIs and security groups must exist within the AWS account. Account access credentials must be provided to vCAC, as well as key pairs for each region within the account.</td>
</tr>
<tr>
<td>cloning</td>
<td>virtual only</td>
<td>A template object created from an existing Windows or Linux reference machine (called the reference machine) and a customization specification are used to create Windows or Linux clones of the reference machine. The template and customization specification must exist in the virtualization platform.</td>
</tr>
<tr>
<td>kickstart/ autoYaST</td>
<td>virtual, physical Linux only</td>
<td>A newly created virtual machine or a physical machine is booted from a virtual CD image, then a kickstart or autoYaST configuration file and a Linux distribution image are used to install the desired operating system on the machine. The boot image must exist in the virtualization platform and the configuration file and Linux distribution image must be available to the newly created machine and vCAC.</td>
</tr>
<tr>
<td>PXE-based</td>
<td>physical only (required for Cisco UCS)</td>
<td>A physical machine queries a PXE boot server for a network bootstrap program (NBP), then downloads and executes the program, which can use any boot image-based provisioning method (WIM-based, kickstart/autoYaST, SCCM-based) to deploy the desired operating system. The NBP must exist on the boot server and the boot server must be properly configured and on a VLAN accessible to the machine being provisioned.</td>
</tr>
<tr>
<td>SCCM/ SCVMM-based</td>
<td>virtual, physical Windows only</td>
<td>A newly created virtual machine or a physical machine is booted from a virtual CD image corresponding to a Microsoft System Center Configuration Manager (SCCM) operating system deployment task sequence. The task sequence must exist on the specified SCCM server and the SCCM server must be available to the new machine and vCAC.</td>
</tr>
<tr>
<td>WIM-based</td>
<td>virtual, physical Windows only</td>
<td>A newly created virtual machine or a physical machine is booted from a virtual CD image, then a Windows Imaging File Format (WIM) image of an existing Windows reference machine is used to install the desired operating system on the machine. The boot image must exist in the virtualization platform and the WIM image must be available to vCAC and on a location that can be accessed by the new machine.</td>
</tr>
</tbody>
</table>

PXE is the only supported provisioning method for Cisco UCS physical machines, but once booted using PXE, Cisco UCS machines can be provisioned using other methods, as described in Preparing for PXE-Based Provisioning.
Enabling Remote WMI Requests on Windows Reference Machines

A Windows Management Instrumentation (WMI) agent is required to collect certain data from a Windows machine managed by vCAC, for example the Active Directory status of a machine’s vCAC owner. To ensure successful management of Windows machines, you must install a WMI agent (typically on the Manager Service host) and enable the agent to collect data from Windows machines.

For information on installing the WMI agent, see the vCloud Automation Center Installation Guide.

To enable the WMI agent to collect this data from Windows machines,

- Each domain to which Windows machines provisioned and managed by vCAC may be joined must include an Active Directory group containing the service credentials of the WMI agents that may execute remote WMI requests on the machine. (See the vCloud Automation Center Installation Guide for information about agent service credentials.)

- Remote WMI requests must be enabled on each Windows machine for the Active Directory group(s) containing the agent credentials.

To enable remote WMI requests on Windows machines provisioned using cloning or WIM-based provisioning, prepare the reference machine from which you will create the required template or WIM image using the following procedures. These procedures also apply generally to any reference machine used to create an operating system deployment image used in SCCM-based or PXE-based provisioning.

To enable remote WMI requests on cloud machines provisioned in AWS accounts, create an Amazon Machine Instance (AMI) to which the following procedures have been applied, and select this AMI in the cloud blueprint.

Enable Remote WMI Requests on the Reference Machine

To enable remote WMI requests on Windows XP, Windows Server 2003, Windows Vista and Windows Server 2008 reference machines:

1. Determine which domain(s) machines provisioned from the template or WIM-image will be joined to. This depends on the SysPrep to be applied to the machine, which is determined by the customization object (cloning) or answer file (WIM-based provisioning) you apply; see the following sections for more information.

2. For each domain, ensure that the Remote WMI Request group you created, containing the appropriate WMI agent service credentials, is available in the domain. Join the reference machine to the domain.

3. Click Start > Administrative Tools > Computer Management, expand Local Users and Groups, select Groups, then right-click Administrators and select Add to Group ....

4. Click Add to add the Remote WMI Request group to Administrators, then save the group.

5. In Computer Management, expand Services and Applications, select WMI Control, then right-click and select Properties.

6. Select the Security tab and press the Security button

7. Ensure that Enable Account and Remote Enable in the Allow column are selected for the Administrators group. Click OK twice to save the WMI permissions.
When you remove the reference machine from the domain, as you must before converting it to a template or creating a WIM image, the entry for each Remote WMI Request group(s) in the local Administrators group will be replaced by an SID. When provisioned machines are joined to the domain, however, this entry will be restored, and the domain Remote WMI Request group will thereby have the needed permissions.

**Allow WMI Requests Through the Windows Firewall**

If the reference machine is a Windows XP system with Windows Internet Connection Firewall enabled, you must configure the firewall to allow incoming WMI requests. To do so, execute the following in a command window:

```
netsh firewall set service RemoteAdmin enable
```

On machines with Windows7 and Windows Server 2008, you must run this command:

```
netsh firewall set rule group="remote administration" new enable=yes
```

**Disable UAC**

On Windows Vista and Windows 7 reference machines, you may need to disable User Access Control (UAC) to enable remote WMI requests.

**Test Remote WMI Access**

Before proceeding with template or WIM creation, test remote WMI access from the system on which the WMI agent or proxy agent is installed.

1. Log into the system on which the WMI agent is installed, using the credentials under which the WMI agent service is running.
2. Type the following command in the Start Menu to launch WMI Management Console:

```
wmi/mgmt.msc
```
3. Right-click WMI Control and select Connect to another computer, then enter the name of the reference machine.
4. In the Change Managed Computer window, select the radio button for Another Computer, enter the name of your provisioned reference machine and click OK.
5. Right-click WMI Control and select Properties. The client will attempt a remote WMI connection to the reference machine to retrieve information.

If the test is not successful, it is recommended that you install WMI Administrative Tools from Microsoft. This package includes a WMI browser that allows you to connect to a remote machine and browse through its WMI information, which will help to isolate any connectivity or permissions issues. Once the WMI browser can access a remote machine, WMI agents should be able to as well. See [http://www.microsoft.com/downloads/details.aspx?familyid=6430F853-1120-48DB-8CC5-F2ABDC3ED314&displaylang=en](http://www.microsoft.com/downloads/details.aspx?familyid=6430F853-1120-48DB-8CC5-F2ABDC3ED314&displaylang=en).
Active Directory and Windows Provisioning

When provisioning Windows virtual or physical machines, you can always join the provisioned machine to an Active Directory domain, as follows:

- When provisioning by cloning, use the customization specification to join provisioned machines to the desired domain.
- When using WIM-based provisioning, or when using a WIM image in SCCM-based or PXE-based provisioning, you can
  - include joining the machine to the desired domain in the SysPrep of the reference machine before creating the WIM image
  - include the SysPrep.Identification.JoinDomain property in the blueprint, with the desired domain as its value
- When using Amazon EC2 provisioning, create an Amazon Machine Image (AMI) that is joined to the desired domain and select this AMI in the blueprint.

In any form of provisioning other than cloning or Amazon EC2 provisioning, each machine is placed in the Active Directory container specified by the **Active directory container** setting of the provisioning group within which the machine is provisioned. Virtual machines provisioned by cloning and cloud machines must be placed in containers manually, after provisioning.

Enabling Visual Basic Scripts in Machine Provisioning

vCAC allows you to specify Visual Basic (VB) scripts to be run outside vCAC as additional steps in the provisioning process, before or after provisioning a machine. You can also run a script when unprovisioning (destroying) a machine. The desired script(s) can be specified in the blueprint from which machines will be provisioned. Such scripts have access to all the custom properties associated with the machine and can even update their values; the next step in the workflow then has access to these new values. For example, you could use a script to generate certificates or security tokens before provisioning and then use them in provisioning the machine.

To enable VB scripts in provisioning, you must install a specific type of EPI agent (see the **vCloud Automation Center Installation Guide** for more information) and place the scripts you want to use on the system on which the agent is installed. When executing a VB script, the EPI agent passes all machine custom properties as arguments to the script. To return updated property values to vCAC, you must place these properties in a dictionary and call a function provided by vCAC.

To enable and prepare for the use of VB scripts in provisioning, therefore, you must take the following actions:

- Install an EPI agent for VB scripting, as described in the **vCloud Automation Center Installation Guide**
- Create your scripts and place them on the system on which the agent is installed. You may find it most convenient to put them in the **scripts** subdirectory of the EPI agent installation directory, where the template is located
- Add the needed custom properties to the blueprint.
Using the vCAC Guest Agent in Machine Provisioning

In vCAC, the guest agent sets up and provisions Windows and Linux virtual and physical machines. The vCAC Manager Service sends a workitem to the guest agent, telling it in which folder to find the scripts needed to process each workitem. The guest agent executes files in the folder whose names begin with 2 digits and an underscore, following the order indicated by the file names (for example, 10_filename, 20_filename, etc.). On a Windows machine, the guest agent considers only .bat files. On a Linux machine, the guest agent checks that the file is executable.

A guest agent can be installed on a reference machine that is used as a template to provision a cloned machine. The guest agent runs as a service in Windows or as a daemon in Linux on the cloned machine and can run scripts that accept custom properties and thereby customize the machine.

In Linux:

- The guest agent is used for kickstart/autoYaST provisioning.
- The guest agent is optionally installed on cloning templates to run as a service on Linux machines provisioned by cloning, enabling the use of external customization scripts on these machines.

In Windows:

- The guest agent is used in WIM-based provisioning.
- The guest agent is optionally installed on cloning templates to run as a service on Windows machines provisioned by cloning, enabling further customization of these machines.

In previous releases, the same guest agent installer was used for both kickstart/autoYaST provisioning and Linux cloning. In recent releases, several different guest agent installers are used in Linux as follows:

- In kickstart/autoYast provisioning, a gugent-5.2.3-<version>.rpm or gugent-5.2.3-<version>.tar.gz file provided with vCAC is used to install the correct Linux agent for the guest operating system being deployed. For example, vCAC provides a gugent-5.2.3-348.x86_64.rpm for Red Hat Enterprise Linux 64-bit. Sample kickstart/autoYaST configuration files for each operating system are also provided in the Release/LinuxGuestAgentPkgs folder. The necessary procedures are described in Preparing for Linux Kickstart/AutoYaST Provisioning.
- In provisioning by cloning in Linux, the guest agent installer is used to install the Linux guest agent on Linux cloning templates, enabling the use of scripts to customize provisioned machines. The procedure for doing this is described in Preparing for Virtual Provisioning by Cloning.
Preparing for Virtual Provisioning by Cloning

You can use vCAC to clone both Windows and Linux virtual machines. Cloning can involve the following on some platforms:

- A template to clone from, created from a reference machine. When cloning in vCenter Server, a reference machine can be used directly for this purpose as well, and can be powered off or powered on when used.
- (Optional for some platforms) A customization object to customize the cloned machines by applying System Preparation Utility for Windows (SysPrep) information or Linux customization.
- (Optional) When cloning in vCenter Server, you provide a customization specification as the customization object.

Cloned machines can also be customized if you install the guest agent on the cloning template, as described in the following procedure. To customize cloned machines, you must use either a customization specification or a guest agent, and you can use both methods together.

If you want to customize cloned machines using the guest agent, you must set the custom property `VirtualMachine.Admin.UseGuestAgent` to TRUE in those machines' build profiles or blueprints. You may also use the other custom properties described in Table 2.

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>VirtualMachine.Admin.UseGuestAgent</code></td>
<td>If the guest agent has been installed as a service on a template, setting this property to &quot;true&quot; or &quot;false&quot; will enable or disable the guest agent service on machines cloned from that template.</td>
</tr>
<tr>
<td><code>VirtualMachine.DiskN.Letter</code></td>
<td>Letter of machine’s disk N (e.g., C:, E:, F:, etc.) or mount point for a Linux machine. Default is C:</td>
</tr>
<tr>
<td><code>VirtualMachine.DiskN.Size</code></td>
<td>Size of machine’s disk N.</td>
</tr>
<tr>
<td><code>VirtualMachine.DiskN.Label</code></td>
<td>Label of machine’s disk N. Windows limits the size of a disk label to 32 characters.</td>
</tr>
<tr>
<td><code>VirtualMachine.Admin.CustomizeGuestOSDelay</code></td>
<td>Time to wait after VMware customization is complete before starting the guest OS customizations. The specified value must be in the format HH:MM:SS, where H is an hours digit, M is a minutes digit, and S is a seconds digit. VMware recommends setting this value to one minute (00:01:00).</td>
</tr>
<tr>
<td><code>VirtualMachine.Customize.WaitComplete</code></td>
<td>Boolean field which, when set to “true”, indicates that the workflow should wait for the VMware customizations before continuing.</td>
</tr>
</tbody>
</table>
Create the Template and Customization Object for Cloning

Follow this procedure to create the objects needed to provision by cloning within vCenter Server:

1. Identify or create the reference machine. Provisioning by cloning produces copies of this machine. The reference machine can be any Windows or Linux machine provisioned in vCenter Server (including one provisioned by cloning). If you have not yet set up provisioning within vCAC, you can create a machine in vCenter Server or use an existing one.

   Note: If you want to enable XenDesktop integration for machines provisioned by cloning from this reference machine, the reference machine from which the template is prepared must include an installed and fully configured Citrix Virtual Desktop Agent.

2. Enable remote WMI requests by proxy and WMI agents, if desired, as detailed in Enabling Remote WMI Requests on Windows Reference Machines.

3. Remove the reference machine from all domains to which it is joined.

4. Note all the specifications of the reference machine, including the number of its CPUs and the amount of memory and storage it contains.

5. (Optional) Install VMware Tools on the machine within vCenter Server as specified by VMware in the article here: http://kb.vmware.com/selfservice/microsites/search.do?cmd=displayKC&docType=kc&docTypeID=DT_KB_1_1&externallId=1014294 (or in an article superseding it, if any).

6. For all Linux reference machines:
   - If you create the Linux reference machine directly in vCenter Server, be sure it meets the requirements for guest customization of a Linux guest OS as stated by VMware in the article referenced here: http://pubs.vmware.com/vi3i_i35/admin/wwhelp/wwhimpl/common/html/wwhelp.htm?context=admin&file=c2custlinuxreqs.html or in a later article superseding it, if any.
7. For all Linux reference machines, if you intend to specify an external Linux customization script or other post-provisioning steps in the cloning blueprint, perform the following additional steps on the Linux reference machine:

- Install the vCAC guest agent using the RPM package from the vCAC installation files in the LinuxGuestAgentPkgs folder and appropriate sub-folder by running the command
  
  `rpm -i gugent-version.rpm`

- Configure the guest agent service using the following commands:
  
  ```
  cd /usr/share/gugent
  ./installgugent.sh -servername:port ssl
  ```

  where: `-servername:port` is the name of the Manager Service host and the port number (default is 443)

8. For all Windows reference machines:

a. Download and extract `setup\GugentZip.zip` from the vCAC installation package into `C:\` on the reference machine. This will produce the folder `C:\VRMGuestAgent`.

   **Note:** Do not change the name of the `C:\VRMGuestAgent` folder.

b. In an elevated command prompt, run one of the following commands:

   `(HTTP) winservice -i -h vcac_fqdn[[:portnumber]]`

   `(HTTPS) winservice -i -h vcac_fqdn[[:portnumber] -p ssl]`

   Where `vcac_fqdn` is the fully qualified domain name of the vCAC server host, and the optional `portnumber` is the port number for the ProxyAgentService endpoint on that host. If you don’t specify a port number, vCAC assigns the default port number 80 (HTTP) or 443 (HTTPS) for the ProxyAgentService endpoint.

   The name of the Windows service is `VCACGuestAgentService`. The installation log `VCAC-GuestAgentService.log` can be found in `C:\VRMGuestAgent`.

9. (Optional) Within vCenter Server, shut down the reference machine, then convert it into a template by right-clicking the machine in the Inventory pane and choosing Convert to Template ....

10. (Optional) Within vCenter Server, choose or create a customization specification for the appropriate OS by selected **View > Management > Customization Specifications Manager** ....

Follow this procedure to create the objects needed to provision by cloning within SCVMM:

1. Create a virtual machine on SCVMM, with the desired Linux OS, or Windows OS, either directly in SCVMM or through vCAC.

2. For all Linux reference machines, if you intend to specify an external Linux customization script or other post-provisioning steps in the cloning blueprint, perform the following additional steps on the Linux reference machine:

   **Note:** Using the guest agent allows users to clone virtual machines in SCVMM that can be given custom host names. This also allows them to be given static IP addresses.
• Install the vCAC guest agent using the RPM package from the vCAC installation files LinuxGuestAgentPkgs folder and appropriate sub-folder by running the command
  
  `rpm -i gugent-version.rpm`

• Configure the gugent service using the following commands:
  
  `cd /usr/share/gugent`  
  `./installgugent.sh -servername:port ssl`

  where: `-servername:port` is the name of the Manager Service host and the port number (default is 443)

3. For all Windows reference machines:
   a. Download and extract setup\GugentZip.zip from the vCAC installation package into C:\ on the reference machine. This will produce the folder c:\VRMGuestAgent.

   **Note:** Do not change the name of the c:\VRMGuestAgent folder.

   b. In an elevated command prompt, run one of the following commands:

   (HTTP) `winservice -i -h vcac_fqdn[:portnumber]`

   (HTTPS) `winservice -i -h vcac_fqdn[:portnumber -p ssl]`

   Where `vcac_fqdn` is the fully qualified domain name of the vCAC server host, and the optional `portnumber` is the port number for the ProxyAgentService endpoint on that host. If you don’t specify a port number, vCAC assigns the default port number 80 (HTTP) or 443 (HTTPS) for the ProxyAgentService endpoint.

   The name of the Windows service is VCACGuestAgentService. The installation log VCAC-GuestAgentService.log can be found in c:\VRMGuestAgent.

4. Turn the newly created machine into an SCVMM template.

5. Run endpoint data collection on your SCVMM endpoint to collect the new template.

   **Note:** Contact your IT Administrator to make the necessary network changes to the virtual machine are performed, so that it may be cloned properly. Contact VMware Support if you have any further questions.

**Assigning IP Addresses to Cloned Machines**

Provisioning by cloning requires an available DHCP server on the network unless you use the static IP assignment option available with some platforms. If you want to assign static IPs to cloned virtual machines, you may want to prepare one or more network profiles, which define the IP addresses available for static assignment.

   **Note:** Static IP service must be enabled by a vCAC administrator using the vCAC Administrator > Customization activity pane entry before static IP addresses can be assigned.
Preparing for vCNS Integration

The integration of vCloud Networking and Security (vCNS) with vCAC allows you to assign vCNS security groups and load balancing pools to vSphere (vCenter Server) virtual machines during provisioning. You use the vCNS custom properties described in Assigning vCNS Security Groups and Load Balancing Pools Using Custom Properties to make the assignments, and you can specify the custom properties in reservations, blueprints, build profiles, and anywhere else custom properties can be used.

Before you can use the vCNS custom properties in this way, you must establish credentials and an endpoint for a vCNS Manager instance as described in Managing Credentials and Endpoints. You will need the following information for use within vCAC:

- The URL of the vCNS Manager instance
- The vCNS enterprise administrator-level credentials for the vCNS Manager instance
- The vCAC endpoint for the associated vSphere vCenter Server instance

The endpoint for a vCNS Manager instance is also the endpoint for its associated vSphere vCenter Server instance. You must therefore have vCAC administrator access to the vSphere vCenter Server endpoint to save the vCNS endpoint data.

Preparing for WIM-Based Provisioning

WIM-based provisioning involves the use of an existing Windows system, called the reference machine, as the original or source for the machines to be provisioned by vCAC. Each newly created virtual machine or selected physical machine is first booted into the Windows Preinstallation Environment (WinPE), a small, bootable operating system that allows the user to execute a number of tasks related to installation. In WinPE, a Windows Imaging File Format (WIM) image of the reference machine is copied to the disk of the machine being provisioned. When the machine is rebooted, Windows installs itself based on the WIM image, producing a copy of the reference machine’s operating system, environment and applications on the provisioned machine.

Once you have prepared the images needed for WIM-based provisioning, as detailed in the next section, you must set up vCAC and create an appropriate blueprint. Once this work is done, WIM-based provisioning is available to users of your vCAC site.

How WIM-Based Provisioning Works

The steps in WIM-based provisioning of virtual machines are as follows:

1. **User request:** A machine consumer requests a machine by selecting a blueprint. The blueprint specifies a WinPE image containing the vCAC guest agent as well as a WIM file with associated index, both of which are accessible to the virtualization platform involved (vCenter Server, vCloud Director, KVM RHEV, XenServer, or Hyper-V). The blueprint also specifies the WIMImageWorkflow vCAC workflow.

2. **Workflow initiation:** When the request is approved (or if it does not require approval), vCAC initiates the WIMImageWorkflow workflow.

3. **CreateMachine workflow activity (proxy agent):** The vCAC proxy agent for the virtualization host involved instructs the virtualization platform to create a machine with the specified WinPE image attached as its boot disk. When the machine is created, the proxy agent updates the vCAC database with the machine’s UUID.
4. **PowerON workflow activity (proxy agent):** The proxy agent instructs the virtualization platform to power on the machine, which boots from the WinPE image into WinPE. The vCAC guest agent starts up and queries vCAC for work items associated with the machine’s UUID. As the agent reports success with each work item as detailed below, vCAC moves on to the next workflow activity which generates a new work item.

   a. **Partition workflow activity (guest agent):** The guest agent partitions the machine’s disk. (The SetupDisks activity can be used instead to format and partition in one step.)

   b. **Format workflow activity (guest agent):** The guest agent formats the machine’s disk.

   c. **ExtractImage workflow activity (guest agent):** Using the specified WIM file and associated index, the guest agent extracts a WIM image onto the machine’s disk.

   d. **Customize workflow activity (guest agent):** The guest agent checks for an existing SysPrep answer file within the extracted image. If the blueprint specifies any SysPrep information this is added to the answer file, overwriting existing entries. The SetupOS workflow activity can also be used to execute the four guest agent tasks.

   e. **CopyVRMAgent workflow activity (guest agent):** The guest agent copies guest agent executables to the machine for post-installation execution.

   f. **ExportProperties workflow activity (guest agent):** The guest agent writes all of the machine’s custom properties and their values to the file %SystemDrive%\VRM\Build\Properties.ini on the machine.

5. **EjectCD workflow activity (proxy agent):** The proxy agent instructs the virtualization platform to unmount the WinPE image from the machine. The machine’s disk with its extracted WIM image becomes the boot disk.

6. **Reboot workflow activity (guest agent):** The guest agent instructs the virtualization platform to reboot the machine. On startup, Windows installs itself based on the WIM image including SysPrep information, resulting in a powered-on copy of the original reference machine with its own unique identifiers. The guest agent is activated upon first successful login, and

   a. Queries vCAC for post-installation work items, which include adding domain users to local groups and assigning letters to disk drives according to the machine’s properties as recorded in %SystemDrive%\VRM\Build\Properties.ini.

   b. Instructs vCAC to terminate the workflow.

The WIM-based provisioning process for physical machines is similar to that for virtual machines, with the following differences:

- Communication with the machine is through the machine’s management interface, not through a proxy agent.

- Because the machine to be provisioned already exists, the **CreateMachine** activity is not required.

- Before booting the machine from the WinPE image, vCAC obtains the machine’s endpoint information from the database entry and uses the management interface to

  - Check the machine’s power state and if it is on, power it down

  - Specify the WinPE image as the media for the machine’s next boot

  - Power the machine on so that it boots from the WinPE image

  - Specify the WinPE image as the media for the machine’s next boot

  - Power the machine on so that it boots from the WinPE image
From this point on the provisioning process is very similar to that described for virtual machines, except that vCAC uses the machine’s management interface, rather than a proxy agent, to eject the WinPE boot image and reboot from the hard disk to complete the OS installation.

**WIM-Based Provisioning Setup Tasks**

Preparing for WIM-based provisioning involves the following tasks:

1. Creating a staging area for the WIM and WinPE images you will create.
2. Preparing a WIM image of the reference machine you want to replicate—for example, a Windows 7 workstation with financial and statistical software installed—and placing it in the staging area.
3. Preparing a WinPE image from which the newly created virtual machine or selected physical machine will be booted into WinPE and placing it in the staging area. This can be done using the PEBuilder utility provided with vCAC, or by inserting the vCAC guest agent package into your own WinPE image.
4. Making the WinPE image accessible to the appropriate virtualization host or physical endpoint so it can be attached as boot disk to the newly created virtual machine or selected physical machine.

**Preparing the Staging Area**

Before preparing the WIM and WinPE images needed for WIM-based provisioning, you must identify or create a staging area. This should be a network directory that can be specified as a UNC path on or mounted as a network drive by:

- The reference machine
- The system on which you will build the WinPE image
- The virtualization host on which virtual machines will be provisioned
- The physical endpoints of the physical machines that will be provisioned

You must also ensure that a DHCP server is available on the network. vCAC cannot provision machines using a WIM image unless DHCP is available.

**Preparing the WIM Image**

The procedure for creating a WIM image includes three tasks:

- Preparing a reference machine with the Microsoft Windows operating system, environment and applications you want to replicate on the provisioned virtual or physical machine
- Using the System Preparation Utility for Windows (SysPrep) to prepare the reference machine’s operating system for deployment.
- Creating a WIM image of the SysPrepped reference machine

**Preparing the Reference Machine**

1. Use your virtualization platform to create a reference machine, or identify an existing virtual or physical machine to use as the reference machine. The following requirements apply:
• When you use a virtual reference machine for WIM-based virtual provisioning, you must create the reference machine within the virtualization platform that will provision the machine. That is, if you are implementing WIM-based provisioning of virtual machines using vCenter Server, you must create the virtual reference machine in vCenter Server.

• The reference machine must have the following installed:
  • .NET 4.5 (see http://msdn.microsoft.com/en-us/netframework/aa569263.aspx)

  \begin{note}
  After installing Windows AIK you must reboot the machine before proceeding, although the installer does not prompt you to do so.
  \end{note}

• By default, Windows Server 2008, Windows Vista, and Windows 7 installation creates a small 100 MB partition on a system’s hard disk, in addition to the main partition. vCAC does not support the use of WIM images created on such multi-partitioned reference machines. To avoid this problem, create a virtual reference machine, boot it into WinPE, and use the diskpart utility to format and partition the hard disk before installing the operating system.

  \begin{note}
  If you want to enable XenDesktop integration for virtual machines provisioned using the WIM image, the reference machine must include an installed and fully configured Citrix Virtual Desktop Agent.
  \end{note}

2. Prepare the reference machine so that the operating system and application environment are exactly what you want to replicate in the machines provisioned using the WIM image.

3. Enable remote WMI requests by proxy and WMI agents, if desired.

4. Remove the system from any Windows domains to which it is joined (it must remain in at least one Windows workgroup)

5. If the reference machine OS is a Windows Server 2003 or Windows XP system, reset the Administrator password to be blank (that is, so there is no Administrator password).

\section*{SysPrepping the Reference Machine}

When installing a Windows operating system using a WIM image created from a reference machine, as is done in WIM-based provisioning, the System Preparation Utility for Windows (SysPrep) is used to:

• Generalize system settings and information such as computer name and SID while retaining the reference machine’s installed applications and the default profile, deleting temporary files and (optionally) user accounts, and enabling entry of new license keys

• Place the reference system in a state in which it will reinstall itself into a fresh deployment when booted

• Specify individual attributes for the provisioned machine, for instance a particular language/locale/time zone combination or a specific domain account to be added to the local Administrators group,

Applying SysPrep settings to a machine involves two steps:
• Creating a SysPrep answer file on the machine (the format of this file differs depending on the operating system of the machine)

• Running the **sysprep** command with the appropriate options

When a SysPrepped machine is next booted, the settings specified in the answer file are applied.

There are two ways to SysPrep machines provisioned by vCAC using WIM-based provisioning:

• SysPrep the reference machine before creating the WIM image. This step is required.

• Use custom properties in the blueprint from which the machine is provisioned to specify certain individual SysPrep settings, causing the vCAC guest agent to SysPrep each newly provisioned machine with those settings during the WinPE phase. The specified settings are added to or overwrite settings in the existing SysPrep answer file.

Combining these two methods allows for two levels of SysPrep—one applied to the reference machine and included in the WIM image, the other applied to machines provisioned during the WinPE phase with the various blueprints you create. For example, you might want to apply the same SysPrep.UserData.OrgName setting to all your WIM images, but use blueprints to apply SysPrep.UserData.FullName during postprovisioning customization,

Table 3 lists the custom properties that you can use in a blueprint to apply SysPrep information during the WinPE phase. Not all of the custom properties apply to all Windows platforms.

**Table 3  Postprovisioning SysPrep for Windows Platforms**

<table>
<thead>
<tr>
<th>Section</th>
<th>Custom Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>GuiUnattended</td>
<td>Sysprep.GuiUnattended.AdminPassword</td>
</tr>
<tr>
<td></td>
<td>Sysprep.GuiUnattended.TimeZone</td>
</tr>
<tr>
<td></td>
<td>Sysprep.GuiUnattended.OemSkipWelcome</td>
</tr>
<tr>
<td></td>
<td>Sysprep.GuiUnattended.OemSkipRegional</td>
</tr>
<tr>
<td></td>
<td>Sysprep.Identification.JoinWorkgroup</td>
</tr>
<tr>
<td>Unattended</td>
<td>Sysprep.Unattended.OemSkipEula</td>
</tr>
<tr>
<td>UserData</td>
<td>Sysprep.UserData.ProductKey</td>
</tr>
<tr>
<td></td>
<td>Sysprep.UserData.FullName</td>
</tr>
<tr>
<td></td>
<td>Sysprep.UserData.ComputerName</td>
</tr>
<tr>
<td></td>
<td>Sysprep.UserData.OrgName</td>
</tr>
</tbody>
</table>

These settings are applied using the **Sysprep.Section.Key** custom property, for example **Sysprep.Unattended.OemSkipEula**.

Some required SysPrep settings for WIM-based provisioning are not included in this set. You must therefore ensure that all needed settings are included in the answer file on the reference machine from which the WIM file is created.
The procedure for SysPrepping the reference machine differs depending on whether it is a Windows Server 2003/Windows XP system or any other Windows system.

Use the following procedure to SysPrep a Windows Server 2003 or Windows XP reference machine.

1. Create the directory `%SystemDrive%\SysPrep`.
2. Copy the contents of `\support\tools\deploy.cab` from the reference machine’s original installation medium or an image of the reference machine’s operating system into `%SystemDrive%\SysPrep`. Unpack the contents of `deploy.cab`.
3. Copy the `i386`, `amd64` or `ia64` folder from the reference machine’s original installation medium or an image of the reference machine’s operating system into `%SystemDrive%\SysPrep`.
4. Use Windows Setup Manager (`setupmgr.exe`) to create a `SysPrep.inf` answer file. Ensure that connections by Remote Desktop Protocol are enabled, and that the machine will be joined to the domain in which you enabled remote WMI requests as described earlier in this chapter. (You can also copy a prepared `SysPrep.inf` answer file from another location into the `%SystemDrive%\SysPrep` directory.)

The following settings in the `GuiUnattended` section must be included in the SysPrep of machines provisioned using WIM-based provisioning:

```plaintext
AutoLogon=Yes
AutoLogonCount=1
AutoLogonUsername=username
AutoLogonPassword=password
```

where `username/password` are the credentials used for autologon when the newly provisioned-machine boots into the guest operating system. Administrator is typically used.

5. Execute the following command:

```
%SystemDrive%\sysprep\sysprep.exe -mini -reseal
```

When processing is complete, the system shuts down.

Use the following procedure to add a SysPrep answer file to a Windows reference machine that is not a Windows Server 2003/Windows XP system and run SysPrep.

To provide maximum precision in the process of creating an answer file for these operating systems, a specially prepared master system is typically used for this purpose. (It is also possible to perform the procedure on the reference machine itself.) Like the reference machine itself, the master system must have the following installed:


**Note:** After installing Windows AIK you must reboot the machine before proceeding, although the installer does not prompt you to do so.

The following procedure assumes a master system is used to create the answer file.

1. Mount the Windows CD or ISO image so that it is available to the master system.
2. On the master system, open Windows System Image Manager (SIM) using Start > All Programs > Microsoft Windows AIK > Windows System Image Manager.

3. Use File > Select Windows Image to browse to the sources folder on the CD or ISO and select install.wim, then open it. A dialog appears listing operating system versions you can use as the master image. Select the version you want and click OK. The selected image is loaded into SIM and displayed. (If the catalog file is not present, SIM may need to create it first.)

4. Select File > New Answer File. The master image and a new answer file are now both loaded into SIM and associated. Select File > Save Answer File and save the answer file as Unattend.xml, then begin specifying customization settings as described in the following steps.

5. Expand the Components folder in the Windows Image pane.

6. Drag the appropriate Microsoft-Windows-Security component from the Windows Image pane to generalize in the Components folder in the Answer File pane. Then drag the same component to specialize.

7. Specify product key, registered owner name, and time zone settings by dragging the appropriate Microsoft Windows Shelf-Setup component to specialize, and providing the desired values.

8. Ensure that the machine will be joined to the domain in which you enabled remote WMI requests earlier in this chapter by dragging the appropriate Microsoft-Windows-UnattendedJoin component to specialize, expanding it and selecting Identification, then providing the desired information.

9. You must enable autologon when the newly provisioned machine is booted into WinPE. Do this by dragging the appropriate Microsoft Windows Shelf-Setup component to oobeSystem, expanding it, selecting AutoLogon, and setting the following

   - Enabled=Yes
   - LogonCount=1
   - Username=username
   - Password=password

   where username/password are placeholders for the actual credentials used for autologon when the newly provisioned machine boots into the guest operating system. SysPrep provides the actual credentials which are user name Administrator and the password set by the custom property 

   Note: You must set the autologon password with the custom property Sysprep.GuiUnattended.AdminPassword for reference machines that use a Windows platform newer than Windows Server 2003/Windows XP.

   You can also use this component to disable display of the EULA, configure the screen resolution and color depth (for example, 1280x960 is best for VMware full screen mode) and specify a default local administrator account password.

10. Configure Remote Desktop Connections as follows:

   a. Open OS_Version > Components in the Windows Image pane, right-clicking Microsoft-Windows-TerminalServices-LocalSessionManager, and selecting Add Setting to Pass specialize to add it to the Answer File pane under specialize. Select the component and set fDenyTSCConnections to false.
b. As above, select **Microsoft-Windows-TerminalServices-RDP-WinStationExtensions** in the **Windows Image** pane, add it to **4 specialize**, and set **UserAuthentication** to 0 (zero).

c. As above, select the **FirewallGroup** subcomponent of the main **Networking-MPSSVC-Svc** component in the **Windows Image** pane to **4 specialize** and specify the following:

- **Active=true**
- **Group=Remote Desktop**
- **Key=rd1**
- **Profile=all**

Other common customizations you may want to add include the following:

- Assigning an auto-generated computer name
- Setting organization and owner Information
- Setting language and locale
- Setting the initial tasks screen not to show at logon
- Creating a second administrative account and setting the password
- Running a post-image configuration script under the administrator account at logon
- Disable the initial configuration dialog and auto-start of the server manager application
- Setting automatic updates to not configured (to be configured post-image)
- Configuring the network location

11. Once you are satisfied with your answer file, select **File > Save Answer File** and save the final answer file.

12. Copy the answer file to `%WinDir%\Panther\unattend.xml` on the reference machine.

13. On the reference machine, open a command window, change to `%WinDir%\System32\Sysprep`, and enter this command

   ```
   sysprep /generalize /oobe /shutdown /unattend:%WinDir%\panther\unattend.xml
   ```

   A popup windows displays SysPrep is processing the answer file. When processing is complete, the system shuts down.

### Creating the WIM Image


   **Note:** You can use the provided PEBuilder utility to create the needed WinPE image, as described in the next section, but be sure it does **not** include the vCAC guest agent plugin.
2. Attach the WinPE image to the reference machine as a virtual CD-ROM and configure the reference machine to boot from this image.

**Caution:** *Ensure that the reference machine will boot from the WinPE image. If the reference machine boots from its hard disk instead of the WinPE image it will begin to self-install after booting, erasing all the preparation work you have done on it.*

3. When the machine boots into WinPE, map the staging area you created as a network drive using the command

    net use k: \server\share /user:domain\username

4. Use the following command to create a WIM file in the staging area. (Provide a descriptive name for the file, which is specified by name in the blueprint. Be sure to indicate the virtualization platform that created the reference machine in the image name or description so it will be used appropriately.)

    imagex.exe /capture c: k:\filename.wim name description

You can also use the /scroll option to display the operation’s progress as it is ongoing, and the /compress maximum option to make the smallest possible WIM image if disk space is a consideration.

**Note:** Do not include any spaces in the name of the WIM image file or provisioning will fail.

If you already created a WIM file from a previous reference machine, you can use ImageX to add the new image to that file, or you can create a new file. If you place multiple images in a file, record the index for each image. (Remember not to mix WIM images from reference machines created by different virtualization platforms.)

For information about SysPrep and ImageX, see [http://technet2.microsoft.com](http://technet2.microsoft.com).

**Preparing the WinPE Image**

As described above, WIM-based provisioning relies on booting the new virtual machine or selected physical machine into WinPE, within which a vCAC guest agent executes the required work items. You have two options for creating the required WinPE image:

- Use the PEBuilder utility provided with vCAC to create a WinPE image.
- Create a WinPE image by another method. If you do so, you must include the provided vCAC guest agent executables.

Once the image is prepared you must make it available in a location accessible to the virtualization platform that will be used to create machines.

Third-party drivers can also be copied to the PEBuilder folder to be added to an image. After installing PEBuilder, copy the driver files to the PEBuilder installed directory:

Plugins\ESX Net Driver\x86

The utility adds the drivers to the image automatically from this folder.
Using PEBuilder to Create a WinPE Image

To create a WinPE ISO file containing the guest agent using PEBuilder, follow these steps:


   **Note:** After installing Windows AIK you must reboot the machine before proceeding, although the installer does not prompt you to do so.

2. Extract the vCAC-WinPEBuilder-Setup.exe installation file from the Setups folder in the vCAC installation package.

3. Execute the file to install PE Builder on the build system. All plugins are selected along with PE Builder itself; click **Next** to install the utility.

4. Run PEBuilder by using the shortcut or by executing the application file.

5. In the dialog that appears specify:
   - The host name of the vCAC server and the port number.
   - The path to the PEBuilder plugins directory (the default is as installed, a Plugins subdirectory of the install directory).
   - The output path for the created ISO file, which should be the staging area you prepared previously. (You can give the file any name you wish, as the file is specified by name in the blueprint.)
   - By selecting **Advanced** from the **File** menu, you can open another dialog where you include the vCAC guest agent plugin in the WinPE ISO, as required.

   In release 5.2, vCAC and its components are installed to use HTTPS as the transport protocol, which ensures secure communication between vCAC components. As a result, you must configure the guest agent to use HTTPS. To do so, select the HTTPS radio button under Protocol.

   **Note:** Do not change the architecture selection on the Advanced tab—it must be set to x86 for successful provisioning.

6. Once you have provided the above information, click **Build** to begin the process. PEBuilder updates you with its status until the ISO image has been created.

Inserting the vCAC Guest Agent into a WinPE Image

You can create a WinPE image by a method of your own choosing, but you must include the guest agent. To do so, follow these steps:

1. Select a Windows system from which the staging area you prepared is accessible and on which .NET 4.5 (see http://msdn.microsoft.com/en-us/netframework/aa569263.aspx) and Windows

2. Extract the `vCAC-WinPEBuilder-Setup.exe` installation file from the Setups folder in the vCAC installation package.

3. Execute the file, clear both Plugins and PE Builder, then expand Plugins and select only VRMAgent.

4. When installation is complete, copy the contents of `%SystemDrive%\Program Files (x86)\VMware\PE Builder\Plugins\VRM Agent\VRMGuestAgent` to a new directory within your WinPE image.

5. Copy the file `doagent-template.bat` and rename the copy to `doagent.bat`.

6. Open the file `doagent.bat` in a text editor.

7. Replace all occurrences of the string `#Dcac Hostname#` with the fully qualified domain name and port number for the vCAC server host (for example, `my_machine_name.vmware.com:443`).

8. Replace all occurrences of the string `#Protocol#` with the string `ssl`.

9. Replace all occurrences of the string `#Comment#` with `REM` (the REM statement, followed by a space).

10. Save the file.

11. Copy the file `doagentsvc-template.bat` and rename the copy to `doagentc.bat`.

12. Open the file `doagentc.bat` in a text editor.

13. Repeat Step 7.

14. Replace all occurrences of the string `#errorlevel#` with the character `1`.

15. Repeat Step 8.

16. Replace all occurrences of the string `#Comment#` with `REM` (the REM statement, followed by a space).

17. Save the file.

18. Copy the file `gugent.properties` and rename the copy to `gugent.properties.template`.

19. Open `gugent.properties` in a text editor.

20. Replace all occurrences of the string `GuestAgent.log` with the string `X:/VRMGuestAgent/GuestAgent.log`.

21. Save the file.

22. Copy the file `gugent.properties.template` and rename the copy to `gugentc.properties`.

23. Open the file `gugentc.properties` in a text editor.

24. Replace all occurrences of the string `GuestAgent.log` with the string `C:/VRMGuestAgent/GuestAgent.log`.

25. Save the file.
Making the WinPE Image Available for Provisioning

For virtual provisioning, copy the WinPE image from the staging area to the required location within the virtualization platform that will be using the image while provisioning machines. For example:

- For vCenter Server instances, copy the WinPE ISO file onto a datastore that will be accessible to the provisioning host.
- For XenServers, copy the WinPE ISO file onto a Windows File Sharing (CIFS) share or network drive.
- For Hyper-V servers, copy the WinPE ISO file onto the server itself, so that its location can be specified as a local path on that server.

For physical provisioning, place the image in a web-accessible location (HP iLO) or a location available through NFS or CIFS (Dell IDRAC) and record the address.

The required WinPE and WIM images are now in place, and you are ready to work with vCAC.

Preparing for Linux Kickstart/AutoYaST Provisioning

Linux kickstart/autoYaST provisioning is similar to WIM-based provisioning in that the newly provisioned virtual machine or selected physical machine is booted from a prepared image. The OS is then installed from a Linux distribution source and the Linux agent performs post-installation work.

How Linux Kickstart/AutoYaST Provisioning Works

Linux kickstart/autoYaST provisioning uses a configuration file (kickstart for Red Hat Enterprise Linux or VMware ESXi and ESX, autoYaST for SUSE Linux Enterprise Server) to automate Linux installation on a newly provisioned virtual machine or a selected physical machine. The configuration file contains answers to all the questions that would normally be asked during a typical installation and installs the vCAC Linux agent, which completes the provisioning process. You can install multiple systems using the same configuration file.

1. A vCAC user requests a machine by selecting a blueprint for kickstart/autoYaST provisioning, which specifies the location of a bootable ISO image containing both the location of the Linux distribution source and the location of the configuration file.

2. When the request is approved (or if it does not require approval), vCAC creates a virtual machine, or selects an unprovisioned physical machine matching the blueprint specifications for memory and CPU count. If the latter, vCAC creates an entry in its database that contains all of the selected physical machine’s hardware details and custom properties as well as its UUID (this entry represents the machine as long as it is managed by vCAC).

3. In virtual provisioning, the vCAC proxy agent instructs the virtualization platform to attach the specified boot image to the virtual machine’s CD drive and boot the machine.

   In physical provisioning, vCAC obtains the machine’s endpoint information from the database entry and uses the management interface to:
   - Check the machine’s power state and if it is on, power it down
   - Specify the boot image as the media for the machine’s next boot
   - Power the machine on so that it boots from the boot image
4. When the machine is booted, the following events occur:
   • The machine’s guest OS is installed from the specified Linux source.
   • The vCAC Linux agent is installed on the machine and configured.
   • The Linux agent is started. The agent queries vCAC for work items and on receiving each item it:
     • Records the machine’s properties as received in the work item in a file on the machine
     • Runs vCAC scripts installed with the Linux agent
     • Optionally runs customization scripts added by the user
     • Returns a response to vCAC

5. When the last work item is complete, provisioning terminates and the machine is available to its owner.

**Note:** Some Linux distributions may perform an extra reboot of the machine during the process described above.

The Linux agent runs during the postinstallation stage of the kickstart/autoYaST process; if you run additional postinstallation activities outside of the kickstart/autoYaST process, you will have to wait until they are finished before logging in.

### Linux Kickstart/AutoYaST Provisioning Setup Tasks

Preparing for Linux kickstart/autoYaST provisioning involves the following tasks:

1. Preparing the configuration file and placing it in a location that will be accessible to the virtual or physical machine when it is booted from the ISO image.
2. Creating the boot ISO image and placing it in a location accessible to the virtualization platform you will use to provision the virtual machine or to the selected physical machine.

You must also ensure that a DHCP server is available on the network. vCAC cannot provision machines using kickstart or autoYaST unless DHCP is available or you are using the static IP option.

The Linux agent installation packages and associated sample configuration files that are provided with vCAC are in the directory `LinuxGuestAgentPkgs` in the vCAC installation package.

Each installation package is available as both `gugent-5.2.3-<version>.rpm` and `gugent-5.2.3-<version>.tar.gz` (only `tar` is provided for ESXi). Each sample configuration file comes in two versions, `sample-http.cfg` for vCAC instances installed to use HTTP as the transport protocol and `sample-https.cfg` for instances installed to use HTTPS (see the vCloud Automation Center Installation Guide for more information). Select and copy the installation package and configuration file appropriate for your Linux distribution and vCAC instance.

### Creating the Kickstart or AutoYaST Configuration File

The kickstart configuration file is a simple text file, containing a list of items, each identified by a keyword. The autoYaST configuration file is an XML file containing the properties required to configure a single system. The content of these files varies depending on the Linux distribution involved.
Table 4 Sample Configuration Files for Kickstart and AutoYaST

<table>
<thead>
<tr>
<th>These Folders</th>
<th>Contain These Sample Configuration Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>esx4</td>
<td>gugent-5.2-282.tar</td>
</tr>
<tr>
<td>rhel5-amd64</td>
<td>gugent-5.2-282.x86_64.rpm</td>
</tr>
<tr>
<td>rhel6-amd64</td>
<td>sample-http</td>
</tr>
<tr>
<td>sles10-amd64</td>
<td>sample-https</td>
</tr>
<tr>
<td>sles11-amd64</td>
<td></td>
</tr>
<tr>
<td>esxi4</td>
<td>gugent-5.2-282.tar</td>
</tr>
<tr>
<td>esxi5</td>
<td>sample-http</td>
</tr>
<tr>
<td></td>
<td>sample-https</td>
</tr>
<tr>
<td>rhel5-x86</td>
<td>gugent-5.2-282.i386.rpm</td>
</tr>
<tr>
<td>rhel6-x86</td>
<td>gugent-5.2-282.tar</td>
</tr>
<tr>
<td>sles10-x86</td>
<td>sample-http</td>
</tr>
<tr>
<td>sles11-x86</td>
<td>sample-https</td>
</tr>
</tbody>
</table>

vCAC 5.2 provides a number of sample configuration files, as listed in the preceding table. If you begin with one of these sample files, there are certain changes you must make, but you can also modify and extend the configuration file as appropriate to your needs.

In the configuration file, you must specify the locations of the Linux agent installation package and the vCAC server. To create and correctly locate the configuration file, follow this procedure:

1. Open the appropriate sample configuration file and make the following changes.
   - Locate the string `host=dcac.example.net` and replace each instance with the host name of the vCAC server (the manager service host; see the vCloud Automation Center Installation Guide for more information). Because the vCAC instance is installed to use HTTPS as the transport protocol, you must provide the fully qualified host name and a port.
   - Locate references to `gugent.rpm` or `gugent.tar.gz` and replace the URL including `rpm.example.net` with the appropriate location. For example, `--host=172.20.9.59`; do not use the host name.

2. Save the file in a location that will be accessible to the virtual or physical machine when it is booted from the ISO image. You can use whatever base name you wish.

Creating the Boot Image and Making It Available for Provisioning

The procedure for creating the boot ISO image varies slightly depending on which Linux distribution is involved.

Before creating the boot image, you must edit the `isolinux/isolinux.cfg` or `loader/isolinux.cfg` file to specify the location and name of the configuration file you just created and the appropriate Linux distribution source.
For virtual provisioning, place the boot ISO image in the required location within the virtualization platform. Specifically,

- For vCenter Server instances, copy the boot ISO image onto a datastore that will be accessible to the provisioning host.
- For XenServers, copy the boot ISO onto a Windows File Sharing (CIFS) share or network drive.
- For Hyper-V servers, copy the boot ISO onto the server itself, so that its location can be specified as a local path on that server.

For physical provisioning, place the image in a web-accessible location (HP iLO) or a location available through NFS or CIFS (Dell IDRAC) and record the address.

The required files are now in place and you are ready to work within vCAC.

**Assigning IP Addresses to Machines Provisioned Using Kickstart/AutoYaST**

Kickstart/autoYaST provisioning requires an available DHCP server on the network. If you want to assign static IPs to machines provisioned using this method, you may want to prepare one or more network profiles, which define the IP addresses available for static assignment.

**Adding Customization Scripts**

You can provide your own post-installation customization scripts to be executed during Linux kickstart/autoYaST provisioning. There are two ways to do this.

- **Using the blueprint:** You can execute customization scripts on a machine provisioned using kickstart/autoYaST provisioning by including the necessary custom properties in the blueprint from which the machines are provisioned.

- **Using the configuration file:** You can specify the scripts in the post-installation section of the kickstart (indicated by `%post`) or autoYaST (indicated by `post-scripts`) configuration file.

Note that each method allows you to run customization scripts on a per-blueprint or per-build profile basis because the boot ISO image (which determines the configuration file), is also specified using custom properties. Scripts you execute using either method have access to all of the custom properties of the machine, as these properties are stored in files on the machine.

To specify your own scripts to the configuration file, you must add one or more commands to the file to place the scripts in the required directories. For example, you can use `rpm` to install the scripts, or copy them using `cp`. This command should come immediately after the command installing the Linux agent.

When the Linux agent receives a work item from vCAC during provisioning, it does the following:

1. Records the machine’s custom properties as received in the workitem as name/value pairs in a file called `properties.xml` in the directory `/usr/share/gugent/site/workitem` on the machine, where `workitem` is the name of the work item. In virtual kickstart/autoYaST provisioning, the standard work items are `SetupOS` and `CustomizeOS`; in physical kickstart/autoYaST provisioning, they are `SetupOS` and `InstallOS`.

2. Reads the directory `/usr/share/gugent/site/workitem` and executes any files with the basename `NN_scriptname`, where `NN` is a two digit number. The files must be executable with the executable mask set. Files are executed starting with the lowest `NN` and progressing to the highest; if two files have the same number, they are executed in alphabetical order based on `scriptname`. 
3. After executing the last file, returns a response to vCAC indicating that the work item is complete.

The Linux agent installer places scripts required for provisioning in the `/usr/share/gugent/site/workitem` directories. To execute your own script, you must add it to one of the directories, using a name that will cause it to be executed with the scripts installed with the agent. For example, if the agent installer creates `/usr/share/gugent/site/SetupOS/10_scriptname.sh` and `20_scriptname.sh`, you can modify the configuration file to install `30_addusers.sh`, as in the following command:

```
cp nfs:172.20.9.59/linuxscripts/30_addusers.sh /usr/share/gugent/site/SetupOS
```

Any script you add can refer to `./properties.xml` to obtain custom property values for the machine. (Note that the two properties files in the two `workitem` directories may differ, depending on the provisioning sequence.) VMware recommends using shell scripts to execute the types of scripts desired (for example python). Remember that your files must be executable (`chmod+x`).

**Note:** Your scripts should return a non-zero value to indicate failure. When a script executed by the Linux agent during a work item fails, provisioning fails. To avoid this, write your scripts to always return zero or use some other method to avoid returning error codes to the Linux agent.

### Preparing for SCCM-Based Provisioning

SCCM-based provisioning is similar to WIM-based and Linux kickstart provisioning in that the virtual or physical machine is booted from a virtual CD image, in this case created in Microsoft System Center Configuration Manager (SCCM), to begin the provisioning process. Control is then passed to an SCCM server, which executes a task sequence to complete machine provisioning.

**Note:** vCAC supports only operating system deployment using SCCM; software distribution and updates are not supported.

SCCM-based provisioning can be used to provision only Windows virtual and physical machines; Linux provisioning is not supported.

To use SCCM-based provisioning in vCAC, you must:

- Provision using System Center Configuration Manager 2007 SP3
- Use operating system deployment via boot media
- Consult with your network administrator to ensure that the following network requirements are met:
  - Communication with SCCM requires the NetBios name of the SCCM server, so at least one installed Distributed Execution Manager must be able to resolve the fully qualified name of the SCCM server to its NetBios name.
  - The SCCM server and the vCAC server or physical machine to be provisioned must be on the same network and available to each other.

How SCCM-Based Provisioning Works

SCCM-based provisioning relies on three elements created within SCCM:

- An operating system deployment task sequence, ending with the installation of a software package containing the vCAC guest agent
- A collection to be advertised with the task sequence
- A bootable ISO image corresponding to the task sequence

The following describes the SCCM-based provisioning process:

1. A vCAC user requests a machine by selecting a blueprint for SCCM provisioning, which specifies:
   - An SCCM server and a collection on that server, as well as other information needed to interact with the server
   - The location of a bootable ISO image

2. When the request is approved (or if it does not require approval), vCAC creates a virtual machine, or selects an unprovisioned physical machine matching the blueprint specifications for memory and CPU count. If the latter, vCAC creates an entry in its database that contains all of the selected physical machine’s hardware details and custom properties as well as its UUID (this entry represents the machine as long as it is managed by vCAC).

3. vCAC registers the machine in the specified SCCM collection on the specified SCCM server.

4. If a physical machine is being provisioned, vCAC checks the machine’s power state and if it is on, powers it down.

5. vCAC attaches the ISO image to the virtual machine’s CD-ROM drive or specifies it as the physical machine’s next boot location, then powers the machine on.

6. When the machine boots from the ISO image, control is passed to the SCCM task sequence corresponding to the ISO image, and the machine is provisioned according to the task sequence. The required final task in the sequence is to install the vCAC guest agent software package, which runs a script to install and start the guest agent.

7. When the guest agent reports the success of its final work item, vCAC terminates the provisioning workflow. The machine is now provisioned and under vCAC management.

**Note:** When the virtual machine is eventually destroyed or the physical machine decommissioned, it is unregistered from the SCCM collection.

Preparing for Provisioning Within SCCM

Preparing for SCCM-based provisioning in SCCM involves the following tasks:

1. Extract the file `setup\GugentZip.zip` from the vCAC installation package, to a folder available to SCCM.

2. Create a software package from the definition file `SCCMPackageDefinitionFile.sms` in this folder and make it available to your distribution point.

3. Select the contents of the extracted `GugentZip.zip` file as your source files.
4. Create the desired task sequence for provisioning the machine. The final step in the sequence must be to install the software package you created; with SCCM 2012, you can instead run `cscript.exe “GuestAgent.vbs”` in a Command Prompt window and then select the resulting software package.

**Note:** You can make a custom variable available to the task sequence when the machine is registered in the SCCM collection by adding it to the blueprint used for provisioning.

5. Create a bootable CD media (.ISO image) for the task sequence.

6. Copy the ISO image to the appropriate location. For virtual provisioning, copy the image to the required location within the virtualization platform to be used for provisioning. For example
   - For vCenter Server instances, copy the ISO file onto a data store that will be accessible to the provisioning host.
   - For XenServers, copy the ISO file onto a Windows File Sharing (CIFS) share or network drive.
   - For Hyper-V servers, copy the ISO file onto the server itself, so that its location can be specified as a local path on that server.

   For physical provisioning, place the image in a web-accessible location (HP iLO) or a location available through NFS or CIFS (Dell IDRAC) and record the address.

7. Gather the following information for use within vCAC:
   - The name of the collection containing the task sequence
   - The fully qualified domain name of the SCCM server on which the collection containing the task sequence resides
   - The site code of the SCCM server
   - Administrator-level credentials for the SCCM server

You are now ready to create a physical blueprint for SCCM-based provisioning.

**Preparing for PXE-Based Provisioning**

The Preboot eXecution Environment (PXE) allows computers to be booted using a network interface. A PXE-enabled system can be booted from a network bootstrap program (NBP) independently of its data storage devices or any installed operating system. The NBP can then boot the machine from any desired image, allowing the use of any boot image-based provisioning method (WIM-based, kickstart/autoYaST, SCCM-based) for physical machines booted using PXE.

Using PXE-based provisioning allows you to implement uniform application of a particular provisioning method across hardware platforms (Cisco UCS, HP iLO, Dell iDRAC); blueprints appropriate to each hardware type can all be directed to the same NBP, which can be easily updated at any time. Loading and booting from an image using PXE is also faster and more reliable than using virtual media.

PXE-based provisioning is used for physical machines only. PXE is the only supported provisioning method for Cisco UCS physical machines, but once booted using PXE, Cisco UCS machines can be provisioned using other methods, as described in PXE-Based Provisioning Setup Tasks, below.
How PXE-Based Provisioning Works

PXE-based provisioning relies on the presence of a properly configured PXE server on a VLAN accessible to the physical machine being provisioned. When a user request to provision a physical machine using a PXE-based blueprint is approved, or if it does not need approval, provisioning proceeds through the following steps:

1. vCAC configures the physical machine to boot from PXE and optionally runs a PowerShell script installed in the Model Manager.

   Note: Users need to run `SetExecutionPolicy unrestricted`.

2. The machine is powered on and queries the PXE boot server for an NBP, which it then downloads and executes.

3. The NBP boots the machine from a specified image. This can be a WinPE image, a Linux boot image or an SCCM task sequence boot image. Provisioning proceeds depending on the boot image used.

4. When the vCAC guest agent or Linux agent informs vCAC that the final work item is complete, vCAC optionally runs a PowerShell script installed in the model manager.

5. If a Cisco UCS machine is being provisioned, the boot policy specified by the blueprint (if any) is applied to the newly provisioned service profile.

   Note: To load scripts into vCAC, vCloud Automation Center Designer needs to be installed and CloudUtil.exe needs to be run to import the scripts. See the vCloud Automation Center Development Kit Advanced Operations Guide for details on extensibility in vCAC.

PXE-Based Provisioning Setup Tasks

Once the physical machine boots from the specified image, the remainder of the provisioning process proceeds exactly as described in previous sections. The only difference is that the blueprint does not need to specify the location of the boot image. For example:

- To boot from a WinPE image for WIM-based provisioning, you must prepare for WIM-based provisioning by creating the WinPE image and the WIM image as instructed, and specify the location of the WIM image in the blueprint

- To boot from a Linux boot image for kickstart/autoYaST provisioning, you must prepare for kickstart/autoYaST provisioning by creating the boot image and the configuration file as instructed

- To boot from a SCCM boot image for SCCM-based provisioning, you must prepare for SCCM-based provisioning by creating an operating system deployment task sequence, a collection to be advertised with the task sequence, and a boot image corresponding to the task sequence as instructed

The additional required tasks are:

- Preparing an NBP that will boot the physical machine being provisioned from the correct image
• Configuring your PXE server to deliver the correct NBP in response to the physical machine's query
• To run PowerShell scripts before or after provisioning, install the scripts in the Model Manager

**Note:** There are a number of ways to set up and configure PXE, and you should implement the configuration best meeting your provisioning needs. PXE configuration requires appropriate expertise and should not be attempted by other than qualified personnel.

### Preparing for Amazon EC2 Provisioning

With Amazon Elastic Cloud Computing (EC2) cloud provisioning, you provision, manage, and dispose of EC2 machine instances associated with an AWS account using the vCAC Console.

#### Access and Credentials

Communication with an AWS account is established by the creation of a vCAC endpoint, through which data is collected from and commands are passed to Amazon Web Services. To create the needed endpoint you will need the access credentials for the account, consisting of the Access Key ID and Secret Access Key. Once data has been collected from the account through the endpoint, vCAC has information about the regions.

To create a cloud reservation on the endpoint, you will need at least one key pair. Key pairs can be created and managed using the vCAC Console.

#### Amazon Machine Images

To provision a machine in an AWS account, an instance type is applied to an Amazon Machine Image (AMI). Both the AMI and the instance type need to be available within an Amazon region. Not all instance types are available in all regions. AMIs are managed within AWS accounts; instance types available for provisioning are managed within vCAC. When preparing AMIs in the AWS accounts within which you intend to provision cloud machines, bear in mind the following considerations:

• Each cloud blueprint must specify an AMI. A private AMI is specific to a particular account and to a region within that account; a public AMI is typically available to all accounts, but is specific to a region within each account. Moreover, it is possible for AMIs to be enabled for some availability zones (called locations within vCAC) but not all that exist within the region. Either the reservation must only have valid availability zones selected or the user requesting a cloud machine from the blueprint is required to choose a valid availability zone in order to use AMIs enabled for a subset of availability zones in a region.

• When a cloud blueprint is created, the AMI to be used is selected from those for regions that have been data collected. If multiple AWS accounts are configured on your vCAC server, care must be taken to ensure that when selecting private AMIs the PGM has rights to that private AMI. This combination of AMI region and user location selection restricts a successful cloud provisioning request to reservations with the corresponding region and location.

• It is important to plan the distribution of AMIs in your AWS accounts and the regions within them, in conjunction with cloud reservations and reservation policies. These policies can be used to restrict provisioning from a blueprint to a particular set of reservations.
• vCAC cannot create user accounts on a cloud machine. For this reason, the first time a machine owner connects to a cloud machine, she must log in as Administrator and then add the credentials under which she uses vCAC as a user on the machine. She can then log in under her vCAC credentials from that point on.

To log in as Administrator, however, she must discover the Administrator password. If the AMI is configured to generate the Administrator password on every boot, in Windows she can display the password on the Edit Machine Record page. If not, this information must be obtained by examining the AMI within the AWS account. To avoid this problem, either configure all available AMIs to generate the Administrator password on every boot, or provide information about AMI Administrator passwords to users (or perhaps to the support users provisioning machines for users) so that they are able to log in as Administrator and add their own credentials to the machine.

• As described in Enabling Remote WMI Requests on Windows Reference Machines, the vCAC WMI agent must be enabled to collect data from Windows machines managed by vCAC. To enable remote WMI requests on cloud machines provisioned in AWS accounts, create AMIs to which the procedures in that section have been applied.

**Instance Types**

To create a blueprint, you must choose one or more instance types to be available for selection by the user using the blueprint to provision a machine. You can modify and add to these instance types using the vCAC Console but they will only work if the instance type is supported in the region.

**Security Groups**

A security group acts as a firewall to control access to a cloud machine.

When creating a cloud reservation on a cloud endpoint, you must specify at least one security group. Information about security groups, which are specific to the regions available within an AWS account, is obtained by inventory data collection per region. Since every region includes at least the default security group, you are not required to create any additional security groups in order to make a reservation.

In the Amazon EC2 Management Console, you must create security groups, configure ports for RDP or SSH and set up a VPN for VPCs.


**Virtual Private Cloud**

Amazon Virtual Private Cloud (VPC) allows users to provision a private, isolated section of the Amazon Web Services (AWS) Cloud where instances can be launched in a virtual network you design. AWS users can create a VPC to design a virtual network topology according to your specifications.

You can assign a VPC in vCAC. However, vCAC does not track the cost of using it.

You must use the AWS management console to create:

- An Amazon VPC, which includes Internet gateways, routing table, security groups and subnets. The Classless Inter-Domain Routing (CIDR) block determines the available IP addresses.

- A VPN if you want to login to machines outside of the AWS console.

vCAC users can perform the following tasks when working with a VPC:
• An enterprise administrator can assign a VPC and subnets within it to a cloud reservation.
• A machine owner can assign an instance to a VPC and subnets within it.

Elastic Load Balancers

Elastic Load Balancers automatically distribute incoming application traffic across multiple Amazon EC2 instances. They enable you to achieve greater fault tolerance and performance in EC2 applications by providing the amount of load balancing capacity needed in response to incoming application traffic.

vCAC automatically discovers Elastic Load Balancers during routine inventory data collections or when an Enterprise Administrator runs a manual inventory data collection on selected compute resources. vCAC does not create, delete, manage or track the cost of using Elastic Load Balancers.

You must create Elastic Load Balancers in the AWS Management Console.

The Elastic Load Balancer must be available in the EC2, VPC and provisioning location. For example, if a load balancer is available in us-east1c and a machine location is us-east1b, the machine cannot use the available load balancer.

For more information, refer to AWS documentation on Elastic Load Balancing: http://aws.amazon.com/elasticloadbalancing/.

Elastic IP Addresses

Elastic IP Addresses are static IP addresses designed for dynamic cloud computing. An Elastic IP Address:

• Is associated with an AWS account
• Is controlled by the account owner until the owner chooses to release it or a custom property takes it
• Is available to all provisioning groups that have rights to the region
• Can be assigned to an instance

There are two groups of Elastic IP Addresses within a region, one group for non-VPC instances and another group for VPCs. If you allocate addresses in a non-VPC region only, the addresses will not be available in a VPC. The reverse is also true. If you allocate addresses in a VPC only, the addresses will not be available in a non-VPC region.

You must allocate Elastic IP Addresses to your account in the Amazon AWS Management Console. Also, you must allocate one range of addresses in a non-VPC region and another range in a VPC.

You can use vCAC to assign an Elastic IP Address. However, vCAC does not track the cost of using the address. A Provisioning Group Manager can assign an Elastic IP Address to a machine after it is provisioned or specify a custom property to automate the process of assigning an Elastic IP Address to an instance during provisioning.

A machine owner can view the Elastic IP Address assigned to an instance.

Keep in mind the following caveats:

• In Amazon, only one instance at a time can use the same Elastic IP Address.
• When you use a custom property to assign an Elastic IP Address, one of the following occurs to an instance that was previously assigned to the address.
• Non-VPC – Amazon takes the Elastic IP Address from an existing instance and assigns it to a new instance.
• VPC – Amazon fails to assign the Elastic IP Address.

**Elastic Block Storage**

Amazon Elastic Block Store (EBS) provides block level storage volumes to use with an Amazon EC2 instance and VPC. Amazon EBS volumes are off-instance storage that can persist independently from the life of an instance.

When you use an EBS volume in vCAC, the following caveats apply:

• You can never attach an *existing* elastic block storage volume when you provision an instance. However, if you create a new volume and request more than one machine at a time, the volume will be created and attached to each instance.

  For example, if you create one volume named Volume 1 and request three machines, a volume will be created for each machine. Three volumes named Volume 1 will be created and attached to each machine. Each volume will be the same size and in the same location.

• The volume must be the same OS and in the same location as the machine to which you attach it.

• vCAC does not track the cost of using an EBS volume.

• vCAC does not manage the primary EBS volume of an EBS-backed instance.

**Preparing for Integration with vCAC**

vCAC supports integration of virtual machine provisioning with two types of external infrastructure

• Virtual desktop infrastructure, including XenDesktop

• External provisioning infrastructure, including Citrix Provisioning Server

**Preparing to Integrate XenDesktop**

If one or more Citrix Desktop Delivery Controllers (DDCs) are available on the network and you installed one or more VDI integration agents to interact with them (see the vCloud Automation Center Installation Guide), virtual machines provisioned from a blueprint can be registered with XenDesktop. With the necessary preparation outside vCAC, you can make it possible to register machines provisioned by vCAC either:

• On a specific DDC

• On any DDC within a specified Farm through a specified XenDesktop web console

Preparing for XenDesktop integration requires:

1. Installing the necessary agents and configuring XenDesktop DDC servers.

  As described in the vCloud Automation Center Installation Guide, a VDI agent can be installed to interact only with a specific DDC server or with multiple DDC servers. If you install only agents dedicated to specific DDC servers, it will not be possible to register machines within a specified farm, but rather only on the servers with which the dedicated agents interact. Registering
machines on any DDC within a farm requires that a general XenDesktop VDI agent is installed. See the vCloud Automation Center Installation Guide for full agent installation and XenDesktop DDC server configuration instructions.

2. Preparing the reference machine to be converted to a template for cloning or to be used to create the WIM image for virtual WIM-based provisioning.

In addition to other requirements described earlier in this chapter, when preparing the reference machine for these purposes you must

- Join the reference machine to the OU of the Farm containing the DDC(s) the provisioned machines will be registered with
- Install and fully configure a Citrix Virtual Desktop Agent, selecting the correct Farm from the Farm Selection page during installation
- Open port 8080 for communication with the XenDesktop Delivery Controller on the intended XenDesktop DDC server

Note: If it is not possible to join the reference machine to the correct OU before installing the Virtual Desktop Agent, you can use an alternate method following agent installation. Use Active Directory Explorer to trace the OU of the Farm container down to a GUID and in the registry key HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\VirtualDesktopAgent on the reference machine create a new string value Named: FarmGUID with this GUID as its value.

Preparing to Integrate Citrix Provisioning Server

If a Citrix Provisioning Server (CPS) is available on the network and you have installed an EPI agent to interact with it, machines created from a blueprint can be registered on it and provisioned by it through on-demand disk streaming.

A CPS EPI agent can be installed to interact only with a specific Citrix Provisioning Server or with multiple servers. See the vCloud Automation Center Installation Guide for full agent installation and CPS server configuration requirements and instructions.
Chapter 3 Setting Up vCAC and Organizing Infrastructure

This chapter describes tasks performed within vCAC to set up the vCAC roles and elements needed for machine provisioning. This includes bringing the virtualization compute resources on which virtual machines will be provisioned, the cloud service accounts in which cloud machines will be provisioned, and the physical machines that will be available for provisioning under vCAC management.

Additional information includes

- Creating blueprints for virtual, cloud and physical provisioning using various methods, as well as build profiles to be shared among blueprints.
- Using the blueprints to request machines.
- Using the Infrastructure Organizer to bring both existing virtualization compute resources and the existing virtual machines provisioned on them under vCAC management in a single operation.

Setting Up vCAC Roles and Elements

This section provides instructions for the minimum setup needed to enable provisioning in vCAC. These procedures represent only some of what is needed to fully set up a vCAC site.

Setting up a vCAC site for virtual, cloud and physical provisioning requires completion of the following tasks:

- Assigning administrators
- Bringing virtualization compute resources and cloud service accounts under vCAC management and placing them in enterprise groups
- Bringing physical machines under vCAC management
- Creating provisioning groups
- Creating reservations for provisioning groups, including
  - virtual reservations on virtualization compute resources
  - cloud reservations on cloud service accounts
  - physical reservations containing available physical machines

Further setup involves creation of other global elements including approval groups and policies, reservation policies, machine prefixes and cost profiles.

Assigning vCAC Administrators

The vCAC installation procedure initially assigns the vCAC administrator role to the local Administrators group on the vCAC server. The following procedure must be performed by a member of this group. The remaining procedures in this section can be performed by any user assigned as a vCAC administrator in the first procedure.
1. As an administrator on the vCAC server, display vCAC in your browser using the URL: https://vCAC_server_hostname/vCAC

   The vCAC Console is divided into the activity pane on the left and the working area on the right. The working area displays welcome messages and the Recent Events list, which provides messages about the success or failure of the activities you execute. The activity pane, which you use to select the vCAC operation you want to perform, contains only the Reports and vCAC Administrator entry groups.

   **Note:** Scripting and cookies must be enabled in your browser in order to use the vCAC Console.

   Active scripting must be enabled in Internet Explorer, which can be done by enabling this feature alone or by disabling Enhanced Security Configuration. If vCAC is installed on a Windows Server system and Internet Explorer with Enhanced Security Configuration enabled is used to open the console on that system, frequent security warnings will occur. If Internet Explorer is used on another system, the warnings will not occur, even if Enhanced Security Configuration is enabled.

   To use the console’s context-sensitive help, you may need to enable popup windows in your browser.

   If your credentials when you open the console are the same as the ones the manager service is running under, you may see additional activity groups in the activity pane. This does not affect the procedures detailed below.

   If a “Server Error” page displays when you try to load the vCAC Console, it may because the vCloud Automation Center service is not running. Restart it by logging into the vCAC server, selecting Start > Administrative Tools > Services and starting the service.

2. Select vCAC Administrator > Administrators to load the Administrators page.

3. Click vCAC Administrator at the bottom of the page.

4. In the Members box on the vCAC Administrators page, remove BUILTIN\Administrators (unless you want to continue giving vCAC administrator access to the local Administrators group). Enter the user names you want to assign as vCAC administrators, including your own, directly into the box. If the users are not local users of the vCAC server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

   **Caution:** Never remove all vCAC administrator assignments; you will lose administrative access to the vCAC Console.

---

**Adding a Virtualization Compute Resource to vCAC**

The instructions in this section tell you how to bring virtualization compute resources under vCAC management so that it can be used in virtual machine provisioning. This is accomplished in two steps:

- Installing a proxy agent and configuring it with the information needed to collect data from the compute resource and pass work items to its hypervisor.
- Adding the compute resource to an enterprise group
There are two methods for configuring the required proxy agent, depending on the type of compute resource involved:

- **ESX Server hosts in vCenter Server instances**—Adding the compute resource’s vCenter Server URL to a vSphere endpoint, then installing a vSphere proxy agent configured for that endpoint. The agent then discovers the names of the compute resources within the vCenter Server instance.

- **XenServer and Hyper-V hosts**—Adding the compute resource’s name to the configuration of an installed Xen or Hyper-V proxy agent.

The two methods are described in the following sections.

Once an agent has been configured for the compute resource and it is known to vCAC, it can be added to an enterprise group. Once the compute resource is in an enterprise group, the agent begins collecting data from it.

**Creating an Endpoint for a vSphere Agent**

As described in the *vCloud Automation Center Installation Guide*, a vSphere proxy agent is configured for a specific endpoint when installed. This endpoint contains the information needed for the proxy agent to discover the compute resources within a vSphere vCenter Server instance.

As noted in the *vCloud Automation Center Installation Guide*, you must create the endpoint first and then install the agent. To complete this process you need the following information:

- The URL of the vSphere vCenter Server instance the agent is to manage, for example `https://vsphereA/sdk`
- The agent name
- The endpoint name with which the vSphere agent was installed, which should be related to the agent and instance names
- The administrator-level credentials the agent will use to interact with the vCenter Server instance

You can add the needed credentials to vCAC before creating the endpoint or while you are doing so. Once you have created the endpoint you must install the agent itself.

**Adding vSphere Endpoint Credentials**

vCAC access to virtualization compute resources, as well as to cloud services, physical machines and certain storage devices, requires use of the appropriate user name/password pairs. Credentials for Hyper-V and XenServer proxy agents are configured in the agent at installation, but those for vSphere agents, Microsoft SCVMM service accounts, cloud service accounts, physical machines and storage devices are stored in vCAC. Because the same credentials may be used for multiple endpoints, credentials are managed separately from endpoints and associated with endpoints as the latter are created and edited. Once credentials have been entered they can be used for multiple endpoints as appropriate.

The credentials used by the vSphere agent to manage the vCenter Server instance *must have permission to modify custom attributes*. In some cases, the use of an administrator-level account for this purpose may conflict with established policy or practice. The *vCloud Automation Center Installation Guide* contains a table showing the detailed permissions the vSphere agent account must have to enable the agent to manage a vCenter Server instance for vCAC.

To add the credentials for a vSphere endpoint to vCAC:
1. Select **vCAC Administrator > Credentials** (or select **vCAC Administrator > Endpoints** and use the . . . button next to the **Credentials** drop-down list, as described in the next procedure). The credentials list is displayed.

2. Click the **New Credentials** link at the right-hand end of the title bar.

3. Enter a useful name for the credentials—the user name itself can be used, or some indication of the vCenter Server instance the credentials are for—as well as a more detailed description, then the user name and password (the latter twice for verification) for the vCenter Server instance.

4. Click the **Save** button. If the two password entries do not match, you cannot save.

**Creating a vSphere Endpoint**

> **Note:** When creating the endpoint representing the vCenter Server instance to be managed by a vSphere agent, you can choose to have the agent use the credentials the service is running under to interact with vCenter Server. See the following procedure for more information.

To create an endpoint for a vSphere agent:

1. Select **vCAC Administrator > Endpoints**. The endpoints list is displayed.

2. Point to the **New Endpoint** link at the right-hand end of the title bar and select **vSphere** (**vCenter**) from the drop-down list of endpoint types.

3. Enter the endpoint name for which the vSphere agent will be configured—typically this indicates the vCenter Server instance the endpoint is for—as well as a more detailed description. Then enter the URL of the vCenter Server instance (for example **https://vsphereA/sdk**). Finally, click the . . . (elipses) button to display all credentials and select the credentials you previously created, select **Integrated** to specify the credentials the agent service is running under, or create a set of credentials as described in the previous procedure.

4. Click the **Save** button.

**Installing the Agent**

Follow the instructions in the **vCloud Automation Center Installation Guide** to install a vSphere agent and enter the name of the endpoint you just created when prompted. Once the agent starts, it immediately discovers the compute resources within the vCenter Server instance. Once those compute resources are added to enterprise groups, full data collection begins. Repeat the above procedures to configure endpoints for multiple vSphere agents.

**Configuring a Proxy Agent for a Hyper-V or XenServer Virtualization Compute Resource**

As described in the **vCloud Automation Center Installation Guide**, a Hyper-V or XenServer proxy agent is installed only with the credentials needed for access to the virtualization compute resources it will manage. In order for vCAC to begin collecting data from and managing these compute resources, you must first configure the appropriate proxy agent for each resource.
The following procedure assumes that information about which proxy agents will manage which Hyper-V and XenServer hosts is available following agent installation. Remember that the credentials you provide during agent installation must be valid for administrator-level access to any Hyper-V or XenServer compute resource you configure for that agent.

To configure a proxy agent for a Hyper-V or XenServer compute resource or a Xen pool:

1. Select **vCAC Administrator > Agent Configuration**.
2. Select the appropriate proxy agent, enter the fully qualified DNS name of the Hyper-V server or XenServer, and optionally enter a description for the compute resource. Click **OK** to configure the agent to manage the compute resource.

**Caution:** Do not enter the name of a Xen pool on this page. The pool will be incorrectly identified to vCAC and therefore unusable, and it will be impossible to disassociate the agent from the pool name so the pool can be correctly associated.

A Xen proxy agent can manage both individual XenServers and Xen pools. To associate a Xen pool with the appropriate proxy agent, enter the name of pool master. Data collection recognizes the specified compute resource as the master of a pool and associates the pool with the compute resource object. You must add it to your enterprise group once the pool has been collected.

**Note:** Within the Xen pool, all nodes must be identified by their fully qualified DNS names. vCAC cannot communicate with or manage any node not identified by its fully qualified DNS name within the Xen pool.

Once an agent is configured for a Hyper-V compute resource or XenServer compute resource and it is added to an enterprise group, data collection begins automatically. When the first data collection is complete, the compute resource is listed on the Compute Resources page in the vCAC Console. If the credentials with which the agent you selected was installed do not provide sufficient access to the compute resource, however, data collection fails and the compute resource is not discovered.

Repeat this procedure to configure multiple XenServer or Hyper-V agents for multiple compute resources, as needed.

**Adding a Cloud Service Account to vCAC**

The instructions in this section tell you how to give vCAC access to a cloud service account so that it can be used in cloud machine provisioning. This is accomplished by creating an endpoint of the appropriate type with the credentials needed to gain access to the account.

With Release 4.5, vCAC supports Amazon Elastic Cloud Computing (EC2) provisioning in Amazon Web Services (AWS) accounts. To create an endpoint that can be reserved for an AWS account, use the procedures provided in the following sections.
Adding Cloud Endpoint Credentials

vCAC access to cloud services requires the use of the appropriate username/password pairs. Because the same credentials may be used for multiple endpoints, credentials are managed separately from endpoints and associated with endpoints as the latter are created and edited. To add the credentials for an Amazon EC2 endpoint to vCAC:

1. Select vCAC Administrator > Credentials (or select vCAC Administrator > Endpoints and use the ellipsis (….) button next to the Credentials drop-down list, as described in the next procedure). The credentials list is displayed.

2. Click New Credentials.

3. Enter a useful name for the credentials—the user name itself can be used, or some indication of the account the credentials are for—as well as a more detailed description. Then enter the Access Key ID and Secret Access Key for the AWS account as the user name and password (the latter twice for verification).

To obtain the Access key ID and Secret Access Key:

1. Log into the AWS account on aws.amazon.com,
2. Click the Account link at the top to display the Your Account page, then click the Security Credentials link to display the Security Credentials page.
3. Scroll down to the Access Credentials section. The Access Keys tab displays the access keys for the account. Copy and paste the Access Key ID into the Username field in vCAC, then click the Show link in the Secret Access Key column to display the Secret Access Key and copy and paste the contents into the Password field.

   **Note:** Do not enter the account sign-in credentials, an X.509 certificate or a key pair.

4. Click the Save button.

Creating an Amazon EC2 Endpoint

To create an Amazon EC2 endpoint for an AWS account:

1. Select vCAC Administrator > Endpoints. The endpoints list is displayed.
2. Select New Endpoint > Cloud > Amazon EC2.
3. Specify a Name for the endpoint. Typically this indicates the AWS account that corresponds to this endpoint.
4. (Optional) Specify a more detailed Description.
5. Click the ellipsis (...) button to display all credentials and either select the credentials you previously created or create a set of credentials as described in the previous procedure.

   **Note:** Only one EC2 endpoint can be associated with an Access Key ID.

6. For additional security, you can make all connections to Amazon Web Services go through a proxy server.
   a. Select Use proxy server.
   b. Specify the Hostname of your proxy server.
c. Specify the **Port** number on proxy server to use for the connection
d. (Optional) Click the ellipsis (…) button to select or create **Credentials** that represent the user name and password for the proxy server, if required by proxy configuration.

7. Click the **Save** button.

After the endpoint is created, vCAC immediately begins collecting data from the AWS regions.

### Generating and Entering an EC2 Key Pair

Key pairs are required to provision a cloud instance and to connect to machine instances associated with an AWS account. It is used to decrypt Windows passwords and to log in to a Linux machine. You can create and manage key pairs using the vCAC Console.

There are two components to a key pair. One component is public and the other is private and unique.

- **Name** — This is the public component. vCAC discovers the name during data collection.
- **Secret key** — This is the private component.

For information on key pairs in AWS, refer to Amazon documentation:


As an enterprise administrator, you can:

- Manage key pairs:
  - Create a new Amazon key pair
  - Upload .PEM file contents to an existing Amazon key pair
  - Export .PEM file contents for an existing key pair
  - Delete a key pair
- Specify a method to auto-generate key pairs for machines provisioned on a reservation:
  - Per machine — Each machine has a unique key pair. This is the more secure method because no key pairs are shared among machines.
  - Per provisioning group (Default) — Every machine provisioned on a reservation has the same key pair. This setting applies to machines provisioned on other reservations when the machine has the same compute resource and provisioning group.

As a provisioning group manager, you can:

- Specify a method to auto-generate key pairs for machines provisioned on a blueprint:
  - Per machine
  - Per provisioning group

As a machine owner, you can export .PEM file contents to a certificate.

To create a new key pair:

1. Log in as an enterprise administrator.
2. Click **Enterprise Administrator > Key Pairs**.
3. Click **New Key Pair**.
4. Provide the following required information:
   - **Key pair** — Type a name.
   - **Compute resource** — Select a compute resource assigned to your enterprise group.
5. Click the **Save** button.
6. Press **F5** to refresh the page. The key pair is ready to use when **Being Created** changes to ************.

To upload .PEM file contents for a key pair:
1. Log in as an enterprise administrator.
2. Click **Enterprise Administrator > Key Pairs**.
3. Locate the key pair name that will use the .PEM file and click the **Edit** button.
4. Use one of the following methods to upload .PEM file contents:
   - In the **Secret key** field, type or copy and paste the private key, including both of the following lines and all text between them: -----BEGIN RSA PRIVATE KEY----- and -----END RSA PRIVATE KEY-----.
   - Click **Browse**, select a .PEM file and click **Open**. Then click **Upload** for the .PEM file contents to appear in the **Secret key** field.
5. Click the **Save** button.

To export .PEM file contents for a new key pair:
1. Follow the steps to create a new key pair or to upload the secret key for an existing key pair.
2. On the **Key Pairs** page, in the **Secret Key** column, the new key pair appears as a string of asterisks followed by an **Export** icon.
3. Click the **Export** button ( ).
4. Click the **Save** button.

To delete an unused key pair:

**Caution:** This procedure permanently deletes the key pair from the local database and AWS.

1. Log in as an enterprise administrator.
2. Click **Enterprise Administrator > Key Pairs**.
3. Click the **Delete** button.
4. Click **OK** to confirm.

**Amazon EC2 Instance Types**

A set of predefined Amazon instance types is provided with vCAC. These instance types are available for blueprint creators to select in a blueprint, making them available in turn to users requesting
machines. The instance type selected by the requesting user is applied to the AMI specified in the blue-
print to provision a cloud machine.

You do not need to modify or add to the available instance types to enable Amazon EC2 provisioning;
you can do so, however, using the vCAC Administrator > Manage Instance Types option.

There are limits to the number of instances Amazon allows. The limit varies with instance type. For example, 20 is the limit for private AMI instances. For more information see Amazon documentation:
http://aws.amazon.com/ec2/faqs/#How_many_instances_can_I_run_in_Amazon_EC2

The Micro Instance is the smallest instance type. It uses Elastic Block Storage only. Because it does not
use instance storage, Storage (GB) is 0 on the blueprint and machine request.

**Note:** For provisioning to succeed, the AMI and instance type specified in the provi-
sioning request must be a valid combination within EC2. vCAC does not vali-
date the combination.

---

**Amazon EC2 Security Groups**

When creating a cloud reservation on a cloud endpoint, you must specify at least one security group per
region within an AWS account. Information about security groups are obtained by data collection.

For information on security groups in AWS, refer to Amazon documentation:

**Creating an Enterprise Group with Enterprise Administrators**

Enterprise Administrators are responsible for managing the reservations and machines on virtualization
compute resources and cloud endpoints. To add compute resources and cloud endpoints to an enter-
prise group and assign at least one Enterprise Administrator to that group, use the following procedure.

1. As vCAC administrator, select vCAC Administrator > Enterprise Groups to load the Enter-
prise Groups page.
2. Click the New Enterprise Group link at the right-hand end of the title bar.
3. Enter a name and description for the new enterprise group.
4. Select the compute resource(s) and endpoint(s) you want to add to the group.
5. Enter the user names you want to assign as Enterprise Administrators, including your own if you
will be completing the procedures in this chapter. If the users are not local users of the vCAC
server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

The users you assign will have vCAC management access to any compute resources and end-
points you add to the group; for instance, they will be able to create virtual and cloud reserva-
tions on them, disable data collection from them, and so on. They will also be able to

- Create and manage global vCAC elements including provisioning groups, physical reserva-
tions, build profiles and global blueprints
- Manage virtual and cloud machines provisioned on the compute resources and endpoints in
the group and all physical machines, provisioned and unprovisioned

**Note:** You can add an Active Directory security group as an Enterprise Administrator
to give this role to all members of the security group. Do not, however, add
Active Directory distribution groups, as distribution groups cannot be authenti-
cated against and thus cannot convey vCAC roles.

6. Click OK to save the group. If you added yourself as Enterprise Administrator, note that the Enterprise Administrator activity group now appears in the activity pane.

Repeat this procedure to create multiple enterprise groups containing compute resources and end-
points, as needed.

Compute resources can also be added to existing enterprise groups using the vCAC Infrastructure Organizer.

Adding a Physical Machine to vCAC

To make a physical machine available for provisioning, you must create an endpoint to represent it. Once you have done so, vCAC collects data about the machine(s) represented by the endpoint, such as its installed memory and CPU count, making it available for reservation by any Enterprise Administrator and (once reserved) for provisioning by members of the provisioning group it is reserved for. Physical machines do not belong to enterprise groups; all Enterprise Administrators have access to all physical machines.

There are three types of physical endpoints, representing the three management interfaces through which vCAC communicates with physical machines:

- Cisco UCS Manager
- Dell iDRAC
- HP iLO

iDRAC and iLO endpoints represent single standalone machines, while Cisco UCS Manager endpoints represent pools of multiple machines.

To create a physical endpoint, you must specify at a minimum its address and the credentials to use to access its management interface. As with a vSphere or cloud endpoint, you can add the needed credentials before creating the endpoint, or use the New control on the Create Endpoint page to add credentials.

To add a physical machine to vCAC:

1. Identify the physical machine you want to add and obtain the necessary information about its management interface type, address and credentials as described in the following steps.

2. As described earlier in Creating an Endpoint for a vSphere Agent or Creating an Amazon EC2 Endpoint select vCAC Administrator > Credentials and add the credentials required for access to the machine’s management interface. You can also display this page from the Create Endpoint page.

3. Select vCAC Administrator > Endpoints to load the Endpoints page.

4. Point to the New Endpoint link at the right-hand end of the title bar. and select Dell iDRAC, HP iLO, or Cisco UCS Manager from the list of endpoint types. The Create Endpoint page appears. There are two tabs on this page.

5. On the Endpoint tab, enter this information:
   - Name—A descriptive name for the endpoint.
   - Interface Type—Type of interface.
• **Description**—A longer description of the endpoint and the machines it represents.

• **Address**—The address used to interact with the hardware’s management interface. This can be a host name with optional port, web URL, or IP address.

**Note:** The address of a Cisco UCS Manager instance must be specified as an IP address in URL format, for example `http://111.222.333.444`

• **Credentials**—Click the button to display existing credentials and select those you just added or use the [New Credentials](#) link to create and then select new credentials.

• **Custom properties**—Leave this grid empty.

6. Settings on the Details tab are all optional and include

• **Data center**—The hardware’s location.

• **Row and Rack**—Use this information to describe the hardware’s physical location within the specified data center.

7. Click **OK** to save the endpoint and begin data collection from the physical machine(s) it represents. Once data collection is complete, the **Physical Machines** grid at the bottom of the Details tab will contain information about the machine(s) represented by the endpoint, including vendor and CPU count. To view this information, click the endpoint name on the Endpoints page after data collection is complete to edit the endpoint.

Repeat the above procedure to create multiple endpoints as needed.

## Creating a Provisioning Group with Reservations

Now that virtualization compute resources, cloud endpoints and physical machines are available for provisioning, you can create a provisioning group and provide it with

• a virtual reservation so that its members can provision virtual machines

• a cloud reservation on a cloud endpoint so that its members can provision cloud machines on that endpoint

• a physical reservation containing at least one physical machine so that its members can provision that machine

Because machine prefixes are required to generate names for newly-provisioned machines, you must create at least one machine prefix before creating a provisioning group.

The procedures in this section must be performed by an Enterprise Administrator of the enterprise group or groups containing the virtualization compute resources and cloud endpoints on which reservations will be created. If you do not yet have this role, assign it to yourself now. If you are not a vCAC administrator, ask one to place you in this role.

### Creating a Machine Prefix

Each machine provisioned by vCAC is assigned a host name including a prefix and a number, for example `ServerOps0147`. Every provisioning group must have a default machine prefix for use in generating machine names; if a blueprint does not specify a prefix for machines provisioned from it, the default is used. Therefore you cannot create a group until you have created at least one prefix.
1. As Enterprise Administrator, select Enterprise Administrator > Machine Prefixes in the activity pane.
2. Click the New Machine Prefix link at the right-hand end of the title bar.
3. On the Machine Prefixes page, enter a prefix, the length of the number (the number of digits in it), and the number of the first machine to be created with this prefix. For example, the entry QA 4 10
   would result in this sequence of machine names:
     QA0010
     QA0011
     QA0012
     ...
   **Note:** To conform to standard host-name limitations, machine prefixes must contain only the ASCII letters a through z (case-insensitive), the digits 0 through 9 and the hyphen (-). They must not begin with a hyphen. No other symbols, punctuation characters, or blank spaces can be used.
   To conform to the Windows limit of 15 characters in host names, machine prefixes should not be longer than 15 characters, including the digits. Longer host names are truncated when a machine is provisioned.
4. Click the Save button to add the prefix. (You must use the go icon to save the prefix before leaving the page.)

Repeat this procedure to create multiple prefixes as needed.

**Note:** Successful creation of a machine prefix verifies that MSDTC was correctly configured for a remote vCAC database prior to vCAC installation, as described in the vCloud Automation Center Installation Guide.

**Creating a Provisioning Group**

Before actually creating a provisioning group, list the users you want to make members of the group. There are three provisioning group roles:

- **All members including basic users** can request and manage their own virtual, cloud and physical machines.
- **Support Users** can also request and manage machines on behalf of other group members.
- **Provisioning Group Managers (PGMs)** can request and manage their own machines like other users, request machines on behalf of other users, and manage all machines owned by group members. They also create and manage the virtual, cloud and physical blueprints used by group members to request machines, and approve members’ machine and lease extension requests when required.

Each provisioning group must have at least one PGM. To review the machine request procedure for a basic user, you must add at least one user.

To create a provisioning group, follow these steps:
1. As Enterprise Administrator, select **Enterprise Administrator > Provisioning Groups** in the activity pane to display the Provisioning Groups page.

2. Click the **New Provisioning Group** link at the right-hand end of the title bar.

3. On the Create Provisioning Group page, specify the following information:
   - A name and description for the group
   - One or more email addresses (including group aliases) or Active Directory accounts for the user(s) specified as group manager. Multiple entries must be separated by commas, for example
     
     JoeAdmin@VMware.com,VMware\TinaVP,WeiMgr@VMware.com
     
     These addresses are shown in the My Pending Requests lists of group members.
   - The machine prefix you just created, as the default.
   - The Active Directory container for machines created by provisioning group members (such as ou=test,ou=servers,dc=VMware,dc=local).
   - The users you want to add as manager, support user, and user members, in **DOMAIN\user-name** format, for example Engineering\Joe.Admin. (If you will be completing the procedure in the next section, don’t forget to add yourself as PGM.)

   **Note:** You can add an Active Directory security group as a provisioning group member to give provisioning group membership to all members of the security group. Do not, however, add Active Directory distribution groups, as distribution groups cannot be authenticated against and thus cannot convey vCAC roles.

4. Click **OK** to save the group. If you added yourself as manager, note that the **Self-Service** and **PGM** groups now appear in the activity pane. (A manager is a user and support user member of a group as well as being its manager.)

Repeat this procedure to create multiple provisioning groups as needed.

### Creating a Virtual Reservation

A virtual reservation is a share of resources available from one virtualization compute resource which are dedicated to one provisioning group for use in provisioning virtual machines. A provisioning group can have multiple reservations on each of multiple compute resources; a single compute resource can have multiple reservations for each of multiple provisioning groups. An Enterprise Administrator can create a reservation for any provisioning group on any compute resource in his enterprise group(s). There are many issues to be considered when planning virtual reservations for a vCAC site.

To create a virtual reservation:

1. As Enterprise Administrator, select **Enterprise Administrator > Reservations** in the activity pane to display the Reservations page. Reservations of all types are listed.

2. Point to the **New Reservation** link at the right-hand end of the title bar, select **Virtual** and the platform type.

3. Enter the following information in the **Reservation Information** tab:
   - Select the compute resource on which to create the reservation. The drop-down list includes only compute resources in the enterprise group(s) of which you are Enterprise Administrator.
Once you have selected a compute resource, information about its memory and available storage and network paths is displayed. The list of resources will not be available until inventory data collection has completed.

- When you select a compute resource, a name for the reservation is automatically generated. You can enter a different descriptive name if you wish, perhaps incorporating the name of the provisioning group it is for.

- Select the provisioning group for which you are creating the reservation.

- (Optional) Specify the maximum number of virtual machines that can be provisioned from the reservation using the **Machine quota** counter. (If you leave this counter blank there is no limit.)

- Set the priority of the reservation to **0** (highest priority) or another number.

4. Click the **Resources** tab.

- Specify the amount of memory to be reserved on the compute resource for the group’s use in provisioning machines.

- Select at least one of the available storage paths and specify the amount of storage and priority on each that will be reserved for the group’s use.

**Note:** Note that it is possible to overallocate a compute resource by specifying more memory or storage than the physical capacity of the compute resource, but you should not do so unless you are certain this is appropriate.

For reservations on Hyper-V compute resources, you must select **default** as the storage path. This is the only currently supported storage path.

- Select at least one network to which virtual machines provisioned on the reservation will be attached from among those available.

- Leave the following optional settings blank for now: **Reservation policy**, **Resource pool** and **Custom properties**.

5. (Optional) To enable reservation alerts, click the **Alerts** tab. For more information, see “Reservation Alert Settings” on page 186.

6. Click **OK** to save the reservation.

**Note:** Once you have created a reservation, neither the compute resource nor the provisioning group can be changed.

Repeat this procedure to create multiple virtual reservations as needed. Note that you can begin by copying the settings of an existing reservation using the **Copy from existing reservation** drop-down list.

### Creating a Cloud Reservation

A cloud reservation makes the capacity of the cloud service account represented by the endpoint it is on available to one provisioning group for use in provisioning cloud machines. A provisioning group can have multiple reservations on each of multiple regions; a single region can have multiple reservations for each of multiple provisioning groups. An Enterprise Administrator can create a reservation for any provisioning group on any region in his enterprise groups.
To create a cloud reservation:

1. As Enterprise Administrator, select **Enterprise Administrator > Reservations**.
2. Click **New Reservation > Cloud > Amazon EC2**.
3. Enter the following information in the **Reservation Information** tab:
   - **Compute resource** — Select the region which to create the reservation. The drop-down list includes only regions in the enterprise group(s) of which you are enterprise administrator.
   - **Name** — When you select an endpoint, a name for the reservation is automatically generated. You can enter a different descriptive name if you wish.
   - **Provisioning group** — Select the provisioning group for which you are creating the reservation.
   - **Reservation policy** — (Optional) Restricts provisioning to the appropriate reservation.
   - **Machine quota** — (Optional) Specify the maximum number of cloud machines that can be provisioned from the reservation.
   - **Priority** — Set the priority of the reservation to 0 (highest priority) or another number.
   - **Custom properties** — Add custom properties according to your reservation needs.
4. Click the **Resources** tab.
5. In the **Key pair** field, select one of the following options to specify whether to autogenerate key pairs for this reservation or use a specific key pair.
   - **Not specified** — Select this to control key pair behavior at the blueprint level rather than the reservation level.
   - **Auto-Generated per Provisioning Group** — If you select this option, every machine provisioned within the same provisioning group has the same key pair, including machines provisioned on other reservations when the machine has the same compute resource and provisioning group. Because key pairs generated this way are associated with a provisioning group, the key pairs are deleted when the provisioning group is deleted.
   - **Auto-Generated per Machine** — If you select this option, each machine has a unique key pair.
   - **Specific Key Pair** — If you select this option, every machine provisioned on this reservation has the same key pair. Click the ellipsis (...) button to select a key pair that has a secret key.
6. To enable Virtual Private Cloud for this reservation, select **Assign to a subnet in a VPC**. Steps 7-9 do not apply for Virtual Private Cloud. For details about configuring Virtual Private Cloud, see “Creating an Amazon Reservation for Virtual Private Cloud” on page 60.
7. In **Locations**, select one or more availability zones.

   **Note:** Because Amazon Machine Images (AMIs) are region-specific, the AMI specified in a blueprint automatically requires the requesting user to select a location available within the corresponding region. This allows vCAC to select an appropriate reservation from which to provision the cloud machine.
8. In **Security Groups**, select one or more security groups that can be assigned to a machine during provisioning.
9. (Optional) If you are using the Elastic Load Balancer feature, you can select from a list of **Load Balancers** that apply to the selected locations.

10. (Optional) To enable reservation alerts, click the **Alerts** tab. For more information, see “Reservation Alert Settings” on page 186.

11. Click **OK** to save the reservation.

**Note:** Once you have created a reservation, neither the compute resource nor the provisioning group can be changed.

Repeat this procedure to create multiple cloud reservations as needed. Note that you can begin by copying the settings of an existing reservation using the **Copy from existing reservation** drop-down list.

**Creating an Amazon Reservation for Virtual Private Cloud**

Amazon Virtual Private Cloud (VPC) allows users to provision a private, isolated section of the Amazon Web Services (AWS) Cloud where instances can be launched in a virtual network you design. AWS users can create a VPC to design a virtual network topology according to your specifications.

You can assign a VPC to a reservation in vCAC. However, vCAC does not track the cost of using it.

When the basic user provisions a machine, assignments for VPC and non-VPC locations are random when both of the following conditions exist:

- The cloud blueprint has access to reservations with VPC and non-VPC locations.
- The cloud blueprint does not display the **Network** tab, which is the default.

To prevent this random assignment, the Provisioning Group Manager has two options:

- Display the **Network** tab by selecting **Enable Amazon network options on the machine** in the **Build Information** tab of the cloud blueprint.
- Tie the blueprint to the desired reservation by using a reservation policy.

To assign a VPC and subnets within it to a cloud reservation:

1. Log in as **Enterprise Administrator > Reservations**.
2. Click **New Reservation > Cloud > Amazon EC2** or point to an existing cloud reservation and click **Edit**.
3. Go to the **Resources** tab.
4. Select the **Assign to a subnet in a VPC** check box.
5. In the **VPC** list, locate the VPC you want to assign and click the **Edit** button.
6. In the **Edit VPC** window:
   - In the **Subnets** list, select each subnet in the VPC that will be available for provisioning.
   - In the **Security Groups** list, select each group that can be assigned to a machine during provisioning.
(Optional) If you are using the Elastic Load Balancer feature, you can select from a list of Load Balancers that apply to the selected subnets to use in the VPC.

7. Click the Save button.

8. If you want to assign additional VPCs, repeat steps 5-7.

9. Click OK to save the reservation.

Creating a Physical Reservation

A physical reservation is a set of available unprovisioned physical machines reserved for one provisioning group. A given machine can belong to only one reservation. Once a machine is provisioned or imported, it cannot be removed from its reservation until it is decommissioned. Any Enterprise Administrator can reserve any unreserved physical machine for any provisioning group.

To create a physical reservation:

1. As Enterprise Administrator, select Enterprise Administrator > Reservations in the activity pane to display the Reservations page. Reservations of all types are listed.

2. Point to the New Reservation link at the right-hand end of the title bar and select Physical.

3. Enter the following information in the Reservation Information tab:
   - **Name** — Enter a descriptive name for the reservation.
   - **Provisioning group** — Select the provisioning group for which you are creating the reservation.
   - **Reservation policy** — (Optional) Select the reservation policy.
   - **Machine quota** — (Optional) Specify the maximum number of physical machines that can be provisioned from the reservation using the Machine quota counter. (If you leave this counter blank there is no limit.)
   - **Priority** — Set the priority of the reservation to 0 (highest priority) or another number.
   - **Custom properties** — (Optional) Select custom properties to add to the reservation.

4. Click the Resources tab.
   - Click Add Machine to display the Physical Machines popup listing unreserved physical machines and select one or more.

5. (Optional) To enable reservation alerts, click the Alerts tab. For more information, see “Reservation Alert Settings” on page 186.

6. Click OK to save the reservation.

Repeat this procedure to create multiple physical reservations as needed. Note that you can begin by copying the settings of an existing reservation using the Copy from existing reservation drop-down list.

You are now ready for the final step—creating a blueprint provisioning group members can use to provision machines.
Creating Blueprints

A blueprint is the complete specification for a virtual, cloud or physical machine, determining the 
machine’s attributes, the manner in which it is provisioned, and its policy and management settings. To 
request a machine, a group member must select the blueprint from which it will be provisioned.

When you create a blueprint, you specify some information using controls in the console and some 
using custom properties. Custom properties can also be specified in build profiles; multiple build profiles 
can be incorporated into any blueprint of any type. User can click the drop-down list to display a list of 
build profiles to choose from.

**Note:** Custom properties can be specified in a number of places including endpoints, 
compute resources, in reservation, in approval groups, in provisioning groups, 
and when editing, provisioning, or reprovisioning machines.

Blueprint Type

Each blueprint can be used to provision a single type of machine—virtual, cloud or physical. As with res-
ervations, the three types of blueprint share many settings in common but have some significant differ-
ences, which are noted in the following procedures. Further, each physical blueprint is created for just 
one of the three hardware types—Cisco UCS, HP iLO or Dell iDRAC.

When a user requests a machine, all types of blueprints are displayed together.

Local and Global Blueprints

Enterprise Administrators create and manage *global* blueprints, which can be selected for any provision-
ing group, and PGMs create *local* blueprints for their groups only. You can create each blueprint in one 
of two ways:

- As Enterprise Administrator, select **Enterprise Administrator > Global Blueprints** to create a 
global blueprint.
- As PGM of the provisioning group, choose **Provisioning Group Manager > Blueprints**, edit 
the global blueprint, and select it for the provisioning group.
- As PGM of the provisioning group you created, select **Provisioning Group Manager > Blue-
prints** to create a local blueprint.

A global blueprint is available across all provisioning groups. If you make it copyable, it will be available 
for copying within those groups as well. A local blueprint can be used in a single provision group.

Creating Build Profiles

The sections that follow provide details about the custom properties that must be included in different 
types of blueprints. You can make these required custom properties available to multiple blueprints and 
all provisioning groups by placing them in build profiles.

For example, you may want to use WIM-based provisioning to provision similar machines with varying 
specifications (amount of memory or storage, number of disks to divide the storage between) from the 
same WIM image and WinPE ISO. In this case, properties that are shared between these blueprints— 
such as the names and locations of the WIM image and WinPE ISO—can be placed into a build profile, 
that can then be incorporated into multiple WIM-based provisioning blueprints (global or local).
Follow these steps to place the properties you need into a build profile:

1. As Enterprise Administrator, select **Enterprise Administrator > Build Profiles** in the activity pane and click the **New Build Profile** link at the right-hand end of the Build Profiles title bar.

2. On the Create Build Profile page, enter a name and description for the profile and the minimum set of custom properties required for the provisioning method. You can create more than one build profile for a blueprint. Users can select from a list of build profiles when they click the drop-down arrow.

3. For any property, you can select **Prompt User** to require the user to provide a value for the property or accept the value you supply as the default. If you leave the value empty, the user must supply a value to use this property and continue with the machine request.

   **Note:** When **Prompt User** is selected for a property, the requesting user is prompted only once for the value, even when requesting more than one machine: the value supplied is applied to all machines provisioned from the request. Selecting **Prompt User** for the Hostname property, however, restricts all requests from the blueprint to a single machine because the value of this property must be unique for each machine.

4. The **Encrypt** check box ensures that a secure property (such as a password) is never visible in plain text.

5. Click the **Save** button to save the property or the **Cancel** button to cancel it without saving changes. The properties you enter or modify are not saved until you save the blueprint by clicking **OK**.

   **Note:** When entering custom properties, always ensure that property values do not contain trailing spaces, as these may cause provisioning to fail.

Remember that an incorporated build profile is always read at machine build time, so the current version is always used no matter when the build profile was first incorporated in a blueprint.

**Overview of Blueprint Settings**

The settings for each blueprint are divided into four tabs: Blueprint Information, Build Information, Properties and Security. Many of blueprint settings have default values or selections, but some must be specified by the blueprint creator, including blueprint name, lease and archive period lengths, and memory, CPU count and storage specifications. Differences between virtual, cloud and physical blueprints are noted.

**Specifying Custom Properties**

Custom properties can be specified in the following for the machine to be provisioned:

- Build profile
- Blueprint
- Provisioning group
- Compute resource
- Reservation
• Endpoint

**Note:** Because properties from these sources may be applied to machines to be provisioned, they should be applied carefully.

Specifying the characteristics of the machine to be provisioned is generally done by adding properties to blueprints and build profiles. Any property specified in a blueprint overrides the same property specified in the incorporated build profile; this enables a blueprint to use most of the properties in a profile while differing from the profile in some limited number. For example, a blueprint that incorporates a standard developer workstation profile might override the US English settings in the profile with UK English settings. On the other hand, if no appropriate profile is available all the needed properties can be specified in the blueprint itself. This arrangement ensures that the number and complexity of blueprints remain manageable.

Custom Properties can also be specified in approval groups, if the advanced approval is enabled and machine provisioning is to be approved. Any similar custom property specified in approval group will take over the existing property of the machine while requesting the machine.

**Note:** At new machine request time, vCAC has not yet allocated Reservation and as such Compute Resource and Endpoint are unknown as well, as a result only custom properties from Build Profile, Blueprint and Provisioning Group are reconciled and presented to administrator who is requesting machine.

The Blueprint Information tab contains information and settings, which include:

• The name and description of the blueprint. Provide an informative name for and a detailed description of the blueprint you are creating. Blueprint names must be unique across a vCAC site.

• Whether the blueprint is global or local and whether it is Master that can be copied. Remember that if you create a global blueprint, Provisioning Group Managers (PGMs) will be able to select it; if you make it a Master, they will be able to copy it in creating local blueprints. The **Global** check box is locked unless you are both Enterprise Administrator and PGM, in which case you can decide whether the blueprint is global or local.

• The provisioning group a local blueprint belongs to, or the provisioning groups a global blueprint is selected for. In either case choose one or more of the provisioning groups you created earlier in this chapter. If you are an Enterprise Administrator only, the **Groups** check boxes are locked.

• The machine prefix used to generate names for machines created from the blueprint. Leave this set to **Use group default** to use the default prefix you assigned to the provisioning group.

• The reservation policy from which to select the reservation on which to provision machines from the blueprint. Reservation policies are not covered in this chapter; leave this setting blank.

• The approval policy determining whose approval is needed to provision a machine from the blueprint. You have not created any approval policies yet, but still have the choices **No Approval** and **Default Approval** (Group Manager). Choose the latter to require group manager approval for basic and support user requests.

• Whether the blueprint is enabled (available for machine requests).

• For **virtual** blueprints, whether requesting users have the option of selecting a provisioning location. For **cloud** blueprints, this option is always selected; it is not available in **physical** blue-
prints. The requesting user’s choice of location affects the selection of a virtual or cloud reservation for provisioning.

- The maximum number of machines provisioned from this blueprint that any single user can own at one time.

- The length of the archive period, in days, that expired virtual machines built from the blueprint will remain available for reactivation during that time. If you specify 0 machines will be destroyed immediately after they expire. This setting does not appear in cloud and physical blueprints.

- A daily cost for the blueprint. For virtual and physical machines, this is used together with the cost profiles associated with the compute resource and storage path on which the virtual machine is provisioned or with the physical machine being provisioned to calculate the machine’s daily total cost. For cloud machines this setting is the sole determinant of daily cost. A machine’s daily cost is used for chargeback and reporting purposes and to inform users and administrators of the cost of a requested or existing machine. Missing machines are not included in chargeback reports.

The Build Information tab contains settings that specify how the machine is to be provisioned. They are covered in detail in the instructions for creating a particular type of blueprint that follow. There are significant differences between the various types of blueprint; settings not shared by all three are indicated.

- Whether the machine provisioned is to be identified as a server or workstation for licensing, integration and record-keeping purposes.

- In physical blueprints a third selection, Hypervisor, lets you indicate that the machine is being provisioned with a hypervisor (VMware ESXi or ESX, Hyper-V in vCAC release 5.2) using kick-start provisioning. This requires an indefinite lease for the machine, enables the Join a Cluster option for the machine and requires extra confirmation of other operations on the machine that would disrupt virtual machine provisioning and management, such as powering it off, reprovisioning it and destroying it.

  **Note:** For licensing purposes, a hypervisor-provisioned physical machine is counted as a server.

- Whether a virtual blueprint is to create, clone, linked clone, or Flexclone virtual machines.

- The provisioning workflow to be used. This depends on the type of machine being provisioned and the provisioning method.

- The Amazon Machine Image (AMI) on which the cloud machine will be based, and the Amazon instance types which the user can apply to the AMI. A check box to "Enable Amazon network options on machine" and a list box for key pairs to be used to override what is set on the reservation are available.

- For SCVMM, Create Blueprints, virtual hard disk, hardware profile and ISO are all optional selections on the Build tab.

- The service profile template and boot policy to be used in provisioning the Cisco UCS physical machine.

- The minimum and optionally maximum memory, CPU count, and storage specifications for the machine, as well as optional approval thresholds for these settings.
In **virtual** blueprints, the memory, CPU count and storage specifications determine the resources allocated to the virtual machine. If you supply a maximum, the machine requestor can optionally increase the specification up to that limit. (An exception is the Reserved storage specification for cloning blueprints, which has a Minimum counter only.)

In **cloud** blueprints, the minimums and maximums are determined by the specifications of the instance types you selected and cannot be changed. The machine's specifications are determined by the requesting user's choice of instance type.

In **physical** blueprints, the memory and CPU count specifications are used to select an appropriate physical machine for provisioning. For this reason they include resource matching specifications, which can be set to select a machine with **At least** as much memory and as many CPUs as specified, or one with **Exactly** those specifications. (Physical blueprints do not specify an amount of storage for the machine, as vCAC does not collect data about the storage associated with available physical machines, which in any case can be changed at any time after provisioning.) If you supply a maximum, the machine requestor can optionally increase the specification up to that limit.

For all types of blueprint, if you select an approval policy on the Blueprint Information tab and use one or more maximum specifications, you can also set approval thresholds; only machines for which the requester sets one or more of the specifications at or above the approval threshold will require approval.

At this stage you may want to use minimums only.

**Note:** Maximum values for the counters are 256 CPUs, 2 TB (2 million MB) of memory and 2 PB (2 million GB) of storage.

- The length of the machine's lease (time until it expires) in days. A blank **Lease (days)** setting means no expiration date. As with the machine specifications, you can set a maximum to allow the requesting user to increase lease length up to that figure and an approval threshold above which the machine will require approval (if an approval policy is set on the Blueprint Information tab).

**Note:** Selecting **Hypervisor** in the **Platform type** drop-down list makes the lease length setting unavailable, locking it to an indefinite lease (no expiration date).

The calendar control used to set the lease length does not actually set the selected date as expiration date. Rather, it calculates the number of days between the current date and the date you select, and sets this number of days as the length of the lease. The lease begins when the machine request is completed, even if required approvals delay provisioning of the machine until a later date.

The maximum possible lease is for 274 years (one hundred thousand days).

- In **virtual cloning** blueprints, the identifier for the template from which the machine is to be cloned and the customization specification.

The Properties tab contains Build profiles and Custom properties that can be specified and are described below.

- The build profile or build profiles to be incorporated, if any. If you have created one or more profiles, select a profile and click the **View more information** button ( ) to review its contents.
• Any custom properties to be included. Custom properties required for different types of blue-prints are described in the following sections. Remember that these can be added directly to the blueprint or instead added to an incorporated build profile.

• When the same property exists in more than one source, a specific order is followed when applying to the machine. This order is as follows, with the latter overriding earlier:
  • Build profile
  • Blueprint
  • Provisioning group
  • Compute resource
  • Reservations
  • Endpoint
  • Runtime

• Any runtime property takes higher precedence and overrides a property coming from any source in vCAC.

**Note:** A custom property is marked as runtime if:

• The property is marked as **Prompt User**, which means that the user must supply a value for it when requesting a machine. This requires machine requestors to customize individual characteristics of each machine, or gives them the option of doing so when a default value is provided for the required property.

• A Provisioning Group Manager is requesting a machine and the property is displayed in the **Custom properties** grid on the **Properties** tab of the **Confirm Machine Request** page.

• The **Encrypt** check box ensures that a secure property (such as a password) is never visible in plain text.

• Click the **Save** button to save the property or the **Cancel** button to cancel it without saving changes, but remember that the properties you enter or modify are not saved until you save the blueprint by clicking **OK**.

The Security tab contains access settings. These include:

• The user names of the group members who can request machines from the blueprint, or on whose behalf machines can be requested by support users; if no user names are specified, the entire group can own machines provisioned from the blueprint.

**Note:** The setting available on blueprint tabs depend on your role. Enterprise Administrators and Provisioning Group Managers can perform different activities.

• The machine operations that will be available to owners of machines created from the blueprint, including various power cycle options, reprovisioning the machine, connecting to the machine using RDP (for Windows machines), SSH (for Linux machines), and VDI (machines registered
through a XenDesktop server), expiring and destroying the machine, and joining a physical
machine provisioned with a hypervisor to a virtualization host cluster (these can be selected and
unselected individually). The power cycle options available depend on the type of blueprint (vir-
tual, cloud, or physical). These selections for available machine menu operations also apply to
machines previously provisioned from the blueprint.

Note: Customized operations you have added to the machine menu using vCAC
Designer automatically appear on the Security tab, and must be selected like
other operations to be made available to the user.

Support users always have access to all operations, including those not
selected on the Security tab, both for their own machines and while working on
behalf of other users. PGMs have access to all operations.

Creating a Blueprint

The following sections describe the specific settings and custom properties required to create blueprints
for various purposes. These procedures apply to both local and global blueprints.

To create a blueprint, select Provisioning Group > Blueprints or Enterprise Administrator > Global
Blueprints in the activity pane, move the pointer over the New Blueprint link at the right-hand end of
the title bar, and choose Virtual, Physical, or Cloud. Enterprise Administrators and PGMs (or a user
who is both) can create blueprints. Users who are both Enterprise Administrator and PGM can choose
whether to create a global or a local blueprint.

If you are creating more than one blueprint for similar purposes, remember that you can always copy a
Master blueprint to begin a new one. An Enterprise Administrator can copy a global blueprint to create
another global blueprint; a group manager who is not an Enterprise Administrator can create only a local
blueprint, even if the blueprint being copied is global.

Creating a Blueprint for Virtual Provisioning by Cloning

You can use vCAC to clone both Windows and Linux virtual machines. Cloning involves two objects:

- A template to clone from, created from a reference machine. A reference machine can be used
directly for this purpose as well.

- A customization object to customize the cloned machines by applying System Preparation Util-
ity for Windows (SysPrep) information or Linux customization. When cloning in vCenter Server,
you specify a customization specification as the customization object. When Cloning in SCVMM
Console, Windows SysPrep is performed using Guest OS Profiles that are included in the tem-
plate.

When cloning Windows machines, you must use a customization object to customize the
machines. To customize Linux clones, however, you can specify an external customization
script when cloning from a template on which the Linux agent was installed. In vCenter Server,
you can even use a customization object and a script together.

Note: When provisioning Windows machines by cloning, you must use the custom-
ization specification to set the Active Directory OU of provisioned machines; the
default provisioning group OU and the Infrastructure.Admin.MachineObjectOU
property are ignored.
With vCenter Server, you can take advantage of NetApp FlexClone space-efficient storage technology when provisioning by cloning on FlexClone-enabled devices.

To provision by cloning within vCenter Server or SCVMM, create a virtual blueprint with the following settings on the Build Information tab:

- Select **Clone** to specify that the machine will be cloned. The **Provisioning workflow** drop-down list is set to **CloneWorkflow**.
- Set the **# CPUs** and **Memory** specifications as desired. vCAC can create a clone with CPU and memory specifications that differ from those of the template in use.
- Set the **Minimum** counter for **Reserved storage** exactly as the total storage specification of the template in use.
- Enter the name of the template to clone from in the **Clone from** box. Type a template name or click the ellipsis (...) button to select it from the list of available templates.

**Note:** The list of templates you can select from includes all templates on all available reservations. vCAC does not validate that the selected template exists on the reservation that is used when provisioning a machine from the blueprint.

To avoid errors during provisioning, ensure that the template is available on all reservations that could be used to provision machines from this blueprint, either by adding the template to all possible reservations, or by using reservation policies to restrict the blueprint to reservations where the template is available.

- For vCenter Server clone blueprints, enter the name of the customization specification in the **Customization spec** box. A customization specification is not required unless you are cloning with static IP addresses but you cannot perform any customization of Windows cloned machines without it, or of Linux cloned machines without either a customization specification or an external script or both.
- Specify the following set of custom properties (or add some or all of them to the incorporated build profile).

The four Linux.ExternalScript properties are used to specify your own customization script to be executed by the Linux agent during the **CustomizeOS** activity. You can execute customization scripts specified using the Linux.ExternalScript properties during provisioning by cloning only if the legacy Linux agent was installed on the reference machine from which the cloning template was created.

You can include other vCAC properties.

### Table 5  Custom Properties Required for Cloning Blueprint

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Admin.Thin Provision</td>
<td>Determines whether thin provisioning is used on ESX Server hosts using local or iSCSI storage. If <strong>True</strong>, thin provisioning is used; if <strong>False</strong>, standard provisioning is used; if not specified, virtualization platform default is used.</td>
</tr>
</tbody>
</table>
When provisioning by cloning, the only way to join provisioned Windows machines to an Active Directory domain is by using the customization specification from vCenter Server or including a GuestOS Profile with your SCVMM template. Machines provisioned by cloning cannot be placed in an Active Directory container; this must be done manually after the machine is provisioned, if desired.

The VirtualMachine.Admin.AddOwnerToAdmins custom property, which is used to add the machine's owner (VirtualMachine.Admin.Owner) to the local Administrators group on the machine, is not used for provisioning by cloning.

### Virtual Provisioning by Cloning with Static IP Address Assignment

In general, vCAC uses DHCP to assign IP addresses to the machines it provisions, regardless of which provisioning method is used. When provisioning virtual machines by cloning, however, you have the option of assigning static IP addresses from a predetermined range.

For this option to be available, a vCAC administrator must have enabled static IP use for your site using the **vCAC Administrator > Customization** activity pane entry and Enterprise Administrators must have created at least one network profile, a global element that specifies one or more IP ranges to be used.

If a network profile exists, you can use it to assign static IP addresses to cloned machines by adding the following custom property to your provisioning by cloning blueprint or in an incorporated build profile.

When cloning with static IP addresses in vCenter Server, you must specify a valid customization specification on the Build Information tab of the blueprint. For SCVMM, static IP addresses are only supported when cloning with Linux machines.

### Table 6  Custom Properties Required for Adding Static IP Address Assignment to Blueprint

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.NetworkN.ProfileName</td>
<td>The name of the network profile from which to obtain the range(s) of static IP addresses that can be assigned to network device N of a cloned machine, where N=0 for the first device, 1 for the second, and so on (provisioning by cloning and kickstart/autoYaST provisioning only)</td>
</tr>
</tbody>
</table>
You can also specify a network profile for each network path selected in a virtual reservation. Any machine provisioned by cloning and attached to a network path with a network profile selected is provisioned using static IP address assignment. The network profile specified in a machine’s source blueprint using the VirtualMachine.NetworkN.ProfileName property, however, overrides the network profile specified for the network to which it is attached.

An IP address within the specified ranges that has been allocated to a machine is made available again using a scheduled static IP workflow that runs automatically every 30 minutes when the machine is destroyed. For this reason, addresses specified in the network profile may not be available immediately. When this is the case, machines cannot be provisioned using a blueprint that specifies static IP assignment from that network profile. Also, Static IP address assignment can be used with Linux kickstart/autoYaST provisioning.

**Enabling Snapshot Manager**

A snapshot is an image of a virtual machine at a certain point in time. It is a space-efficient, pointer-based copy of the original VM image. Snapshots can be an easy way to recover a system from damage, data loss and security threats.

Beginning in release 4.5, you can use Snapshot Manager to create a snapshot of the virtual machine state with or without the state of the memory. If you create snapshots in VirtualCenter, vCAC discovers them during inventory data collection. Snapshot Manager is supported for VMware vSphere only, excluding version 2.5.

To ensure that snapshots are used properly, you can specify:

- Who is allowed to create, apply and delete snapshots by enabling or disabling the feature for machine owners
- How many snapshots of a machine are allowed, which controls storage capacity
- When a snapshot becomes too old to apply, which prevents a machine owner from rolling back to obsolete or non-compliant system states

Snapshot Manager is enabled in vCAC by default on the Customization page in the Console Settings tab. The vCAC Administrator can disable Snapshot Manager by deselecting the **Enable vSphere vCenter Snapshot Management** check box. This removes all references to Snapshot Manager from the vCAC website, but does not destroy existing snapshots or change the database in any way.

The setting that allows users to take snapshots is on the Blueprint page in the Security tab. In the list of features that machine owners can use, **Snapshot Manager** is selected by default. If the Enterprise Administrator or Provisioning Group Manager deselects the check box, the machine owner does not see Snapshot Manager on the right-click menu for the machine.

By default, vCAC allows one snapshot per machine and provides no age limit for snapshots. Both settings can be changed with custom properties. Any administrative user, such as the Enterprise Administrator or Provisioning Group manager, can add these snapshot policy properties to a blueprint or modify their values on Machine Edit page.

To customize the limit or age of snapshots allowed:

1. Based on your privileges, navigate to a blueprint or virtual machine:
   - Enterprise Administrator – Open a new or existing global virtual blueprint.
   - Provisioning Group Manager – Open a new or existing virtual blueprint.
• Either EA or PGM – In Self-Service, point to a virtual machine and click **Edit**.

2. Click the **Properties** tab.

3. In the **Custom properties** list, click **New Property**.

4. Add a property named **Snapshot.Policy.Limit** to increase the number of snapshots per machine from the default depth of 1. Snapshots are shown in a hierarchical tree. There is no limit the width of the tree. The depth is limited to a maximum of 31 by vSphere.

5. Add a property named **Snapshot.Policy.AgeLimit** to specify the number of days a snapshot can exist before it becomes too old to apply. When the age of the snapshot exceeds the limit, the **Apply** option is no longer available for it. The default is no limit.

6. Click the **Save** button.

7. Click **OK**.

**Creating a Blueprint for Linked Clone**

A linked clone is a space-efficient copy of a virtual machine. It is based on a snapshot of a VM and uses a chain of delta disks to track differences from the parent machine.

By pointing to a snapshot, the linked clone uses less disk space than a full clone. This reduces storage costs. Linked clones can be provisioned quickly and are ideal to use when performance is not a high priority.

The following principles apply:

- Linked clones must have access to the parent disk. If the parent disk is deleted or moved to a different datastore, the linked clone is disabled.
- A linked clone of a machine with multiple disks has a delta file for each disk.
- If the machine or snapshot on which the linked clone is based is deleted, the linked clone still works because shared disks remain on the server. Only unshared disks get deleted with a machine.
- To ensure that linked clones are used properly, you can specify:
  - Who is allowed to provision a linked clone
  - How many linked clones of one machine are allowed
  - What pool of reservation resources to use

To create a linked clone blueprint:

**Note:** As a prerequisite, at least one virtual machine must be provisioned and be in the ON or OFF state.

1. Navigate to a blueprint:
   a. **Enterprise Administrator > Global Blueprints.**
b. Provisioning Group Manager > Blueprints.

2. Click New Blueprint > Virtual > vSphere (vCenter) or point to an existing virtual blueprint with a Platform type of vSphere (vCenter) and click Edit.

3. Click the Build Information tab.

4. In the Action field, select Linked Clone which is available for the vSphere (vCenter) platform only. This changes the Provisioning workflow to CloneWorkflow.

5. In the Clone from field, click the ellipsis ( . . . ) button.

6. In the wizard:
   a. Select a Machine to Clone and click Next.
   b. Select a Snapshot and click Finish.

7. Click OK to confirm.

By default, vCAC allows you to make 20 linked clones of one machine snapshot. You can change this setting with a custom property.

To set the maximum number of linked clones:

1. Navigate to a blueprint:
   a. Enterprise Administrator > Global Blueprints.
   b. Provisioning Group Manager > Blueprints.

2. Click New Blueprint > Virtual > vSphere (vCenter) or point to an existing virtual blueprint with a Platform type of vSphere (vCenter) and click Edit.

3. Click the Properties tab.

4. In the Custom properties list, click New Property.

5. In the Name field, type MaximumProvisionedMachines.

6. In the Value field, type the maximum number of machines you want to provision on the linked clone blueprint.

7. Click the Save button.

8. Click OK.

Creating a Blueprint for WIM-Based Provisioning

WIM-based provisioning involves the use of

- a Windows Preinstallation Environment (WinPE) image from which the newly-created virtual machine or the selected physical machine boots and WAIK
- a Windows Imaging File Format (WIM) image of an existing machine from which the machine’s guest OS is installed

To execute WIM-based provisioning of machines, you must have created both of these files and placed them in locations accessible to the virtualization platform involved.

To create a WIM-based provisioning blueprint, create a virtual, HP iLO physical, or Dell iDRAC physical blueprint with the following settings on the Build Information tab:
- In a virtual blueprint, select **Create** rather than **Clone**, and select the **WIMImageWorkflow** workflow.

- In a physical blueprint, select the **PhysicalProvisioningWorkflow** workflow.

- Specify the following set of required custom properties (or add some or all of them to the incorporated build profile). The first nine are required; **SysPrep.Section.Key** is optional. You can include other vCAC reserved properties.

---

**Note:** When provisioning machines with Windows 7 32-bit guest operating systems on ESX Server hosts, be sure to use the VMware.Network.Type property as specified below.

These properties are included in property sets provided with vCAC.

---

### Table 7 Custom Properties Required for WIM-Based Provisioning Blueprint

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>For virtual provisioning only, the vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version of the reference machine; see VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values.</em> (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the WinPE ISO image. In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. This custom property is not needed for Hyper-V provisioning. Instead, the ISO location and name are both specified in the Image.ISO.Name custom property for Hyper-V. In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed.</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the WinPE ISO image.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on vCenter Server, the path to the WinPE ISO file, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOs/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on XenServer, the name of the WinPE ISO file within the storage repository specified by Image.ISO.Location.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on Hyper-V, the full local path to the WinPE ISO file, including filename.</td>
</tr>
<tr>
<td></td>
<td>In physical provisioning, the name of the WinPE ISO image.</td>
</tr>
<tr>
<td>Image.WIM.Path</td>
<td>The UNC path to the WIM file.</td>
</tr>
<tr>
<td>Image.WIM.Name</td>
<td>The name of the WIM file.</td>
</tr>
<tr>
<td>Image.WIM.Index</td>
<td>The index to be used to extract the desired image from the WIM file.</td>
</tr>
<tr>
<td>Image.Network.User</td>
<td>The user name under which to map the WIM image path (Image.WIM.Path) to a network drive on the machine, typically a domain account with access to the network share.</td>
</tr>
<tr>
<td>Image.Network.Letter</td>
<td>The drive letter to which WIM image path is mapped on the machine (default is K).</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Thin Provision</td>
<td>In virtual provisioning only, determines whether thin provisioning is used on Hyper-V server hosts and on ESX Server hosts using local or iSCSI storage. If True, thin provisioning is used; if False, standard provisioning is used; if not specified, virtualization platform default is used. Not used in physical provisioning.</td>
</tr>
</tbody>
</table>
Creating a Blueprint for Linux Kickstart/AutoYaST Provisioning

To create a blueprint for Linux kickstart/autoYaST provisioning of machines, you must have created or obtained and appropriately located the following items:

- a boot ISO image
- a kickstart or autoYaST configuration file
- a Linux distribution ISO
- the appropriate Linux agent installation package from the vCAC installation files

To create a Linux kickstart/autoYaST provisioning blueprint, create a virtual, HP iLO physical, or Dell iDRAC physical blueprint with the following settings on the Build Information tab:

- In a physical blueprint, if the machine is to be provisioned with a hypervisor select Hypervisor in the Blueprint type drop-down list.
- In a virtual blueprint, select Create rather than Clone, and select the LinuxKickstartWorkflow workflow.
- In a physical blueprint, select the PhysicalProvisioningWorkflow workflow.
- Specify the following custom properties or add some or all of them to the incorporated build profile. The first three are required:
  - VMware.VirtualCenter.OperatingSystem
  - Image.ISO.Location
  - Image.ISO.Name

You can include other vCAC properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SysPrep.Section.Key</td>
<td>Optionally used to specify information to be added to the SysPrep answer file on the machine during WinPE stage of provisioning. Section represents the name of a section in the file; Key represents a key name within the section. Information that already exists in the answer file is overwritten. Only the Section.Key combinations below can be specified:</td>
</tr>
<tr>
<td></td>
<td>GuiUnattended AdminPassword EncryptedAdminPassword TimeZone</td>
</tr>
<tr>
<td></td>
<td>UserData ProductKey FullName ComputerName OrgName</td>
</tr>
<tr>
<td></td>
<td>Identification DomainAdmin DomainAdminPassword JoinDomain JoinWorkgroup</td>
</tr>
</tbody>
</table>
### Table 8  Custom Properties Required for Linux Kickstart/AutoYaST Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
</table>
When this property has a non-Windows value, the **Connect Using RDP** option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint. |
| Image.ISO.Location                            | The location of the boot ISO image.  
In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. This custom property is not needed for Hyper-V provisioning. Instead, the ISO location and name are both specified in the Image.ISO.Name custom property for Hyper-V.  
In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed. |
| Image.ISO.Name                                | The name of the boot ISO image.  
In virtual provisioning on vCenter Server, the path to the WinPE ISO file, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOS/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash.  
In virtual provisioning on XenServer, the name of the WinPE ISO file within the storage repository specified by Image.ISO.Location.  
In virtual provisioning on Hyper-V, the full local path to the WinPE ISO file, including filename.  
In physical provisioning, the filename of the WinPE ISO image. |
| VirtualMachine.Admin.ThinProvision            | In virtual provisioning only, determines whether thin provisioning is used on Hyper-V server compute resources and on ESX Server compute resources using local or iSCSI storage. If **True**, thin provisioning is used; if **False**, standard provisioning is used; if not specified, virtualization platform default is used. Not used in physical provisioning. |
Creating a Blueprint for SCCM-Based Provisioning

SCCM-based provisioning involves the use of a task sequence and bootable ISO image created within Microsoft System Center Configuration Manager (SCCM). If you have prepared these elements and obtained the needed information about the SCCM server and collection involved, you can provision virtual or HP iLO or Dell iDRAC physical machines with vCAC using this method.

To create a virtual, HP iLO physical, or Dell iDRAC physical blueprint for SCCM-based provisioning, specify the following settings on the Build Information tab:

- Select the `VirtualSccmProvisioningWorkflow` workflow in a virtual blueprint or the `PhysicalSccmProvisioningWorkflow` workflow in a physical blueprint.
- Specify the following custom properties (or add some or all of them to the incorporated build profile).

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the SCCM operating system deployment task sequence bootable ISO image.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning, the value depends on the virtualization platform.</td>
</tr>
<tr>
<td></td>
<td>For vCenter Server this is the name of a datastore within the instance</td>
</tr>
<tr>
<td></td>
<td>that will be accessible to the provisioning compute resource, for XenServer</td>
</tr>
<tr>
<td></td>
<td>the name of a storage repository. In physical provisioning, the HTTP URL of</td>
</tr>
<tr>
<td></td>
<td>the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC)</td>
</tr>
<tr>
<td></td>
<td>in which the image has been placed.</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the SCCM operating system deployment task sequence bootable ISO image.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on vCenter Server, the path to the WinPE ISO file,</td>
</tr>
<tr>
<td></td>
<td>including the name, within the datastore specified by Image.ISO.Location,</td>
</tr>
<tr>
<td></td>
<td>for example /MyISOs/Microsoft/MSDN/win2003.iso. The value must use forward</td>
</tr>
<tr>
<td></td>
<td>slashes and begin with a forward slash.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on XenServer, the name of the WinPE ISO file within</td>
</tr>
<tr>
<td></td>
<td>the storage repository specified by Image.ISO.Location.</td>
</tr>
<tr>
<td></td>
<td>In virtual provisioning on Hyper-V, the full local path to the WinPE ISO file,</td>
</tr>
<tr>
<td></td>
<td>including filename.</td>
</tr>
<tr>
<td></td>
<td>In physical provisioning, the filename of the WinPE ISO image.</td>
</tr>
<tr>
<td>SCCM.Collection.Name</td>
<td>The name of the SCCM collection containing the operating system deployment task sequence.</td>
</tr>
<tr>
<td>SCCM.Server.Name</td>
<td>The fully qualified domain name of the SCCM server on which the collection resides.</td>
</tr>
<tr>
<td>SCCM.Server.SiteCode</td>
<td>The site code of the SCCM server.</td>
</tr>
<tr>
<td>SCCM.Server.UserName</td>
<td>A user name with administrator-level access to the SCCM server.</td>
</tr>
</tbody>
</table>

Note: These properties are included in property sets provided with vCAC.
Creating a Blueprint for PXE-Based Provisioning

To create a blueprint for PXE-based provisioning of physical machines, you must

2. Install vCloud Automation Center Designer.
3. Run CloudUtil.exe to import PXE scripts into vCAC.

You must also have

- made a PXE server available on a VLAN accessible to the physical machine being provisioned
- created a network boot program (NBP) that boots the physical machine from the desired boot image
- configured the PXE server to deliver the correct NBP in response to the physical machine’s query
- completed any preparation required for the provisioning method to be initiated by booting the machine from the specified image—WIM-based, kickstart/autoYaST, or SCCM-based

If you want to run PowerShell scripts on a machine while it is provisioning, the following must be installed in the Model Manager.

For PXE-based provisioning, create a physical blueprint with the following settings on the Build Information tab:

- If the machine is ultimately to be provisioned as a hypervisor (VMware ESXi or ESX in vCAC release 5.2), select Hypervisor in the Blueprint type drop-down list.
- If you are using PXE-based provisioning to provision using an SCCM task sequence, choose the PhysicalSccmPxeProvisioningWorkflow; if provisioning using a WIM image or kickstart/autoYaST configuration file, choose the PhysicalPXEPresionningWorkflow workflow.
- If Cisco UCS is selected in the Hardware type drop-down list, select a service profile template (required). The available choices represent all of the service profile templates discovered on all existing Cisco UCS Manager endpoints. The selected template must be properly configured to boot over the network.
- If Cisco UCS is selected in the Hardware type drop-down list, select a boot policy which is optional but recommended.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCCM.CustomVariable.Name</td>
<td>The value of a custom variable named SCCM.CustomVariable.Name to be made available to the SCCM task sequence when the newly created virtual machine or selected physical machine is registered with the SCCM collection.</td>
</tr>
</tbody>
</table>

Note: If the specified service profile template is not found in the Cisco UCS Manager instance managing the machine selected for provisioning, provisioning fails. For this reason, VMware recommends using reservation policies to restrict provisioning of Cisco UCS physical machines from a particular blueprint to reserva-
tions on endpoints on which the selected service profile and boot policy are available. The endpoint on which each template is available is shown in the **Service profile template** drop-down list (a template may exist on more than one endpoint); this allows you to identify appropriate reservations for the blueprint.

- Specify the following custom properties or add some or all of them to the incorporated build profile.
- If booting from a prepared WinPE image to install a Windows operating system from a WIM image, from a prepared Linux boot image to use kickstart/autoYaST provisioning, or from an SCCM boot image to use SCCM-based provisioning, specify the properties listed in earlier sections on WIM image, kickstart/autoYaST, and SCCM-based provisioning.
- If you have prepared PowerShell scripts to be run on the machine and installed them in the model manager, as described in the *vCloud Automation Center Designer User’s Guide*, you can specify the following properties:

**Table 10  Custom Properties for Using PowerShell Scripts in PXE-Based Provisioning**

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pxe.Setup.ScriptName</td>
<td>The name of a PowerShell script installed in the vCAC model manager, to be run on the selected physical machine before it is booted using the PXE network boot program.</td>
</tr>
<tr>
<td>Pxe.Clean.ScriptName</td>
<td>The name of a PowerShell script installed in the vCAC model manager, to be run on the selected physical machine while it is provisioning.</td>
</tr>
</tbody>
</table>

**Note:** By default, the organization in Cisco UCS Manager in which a provisioned Cisco UCS machine is placed is created for each provisioning group by vCAC. It is possible to override this setting for a particular provisioning group using the Cisco.Organization.DN custom property.

**Creating a Blueprint for Amazon EC2 Provisioning**

Amazon EC2 provisioning does not require any external preparation beyond what is needed to provision using EC2 directly. Communication with an AWS account is established by the creation of a vCAC endpoint, through which data is collected from and commands are passed to EC2. Creation of an Amazon EC2 blueprint involves selecting from among various elements discovered on the endpoint or installed with vCAC.

To create a blueprint for Amazon EC2 provisioning:

1. Log in to the vCAC Console as an enterprise administrator or provisioning group manager.
2. Select **Enterprise Administrator > Global Blueprints** or **Provisioning Group Manager > Blueprints**.
3. Click **New Blueprint > Cloud > Amazon EC2**.
4. On the **Blueprint Information** tab, specify the blueprint details as you would for any blueprint.
5. Click the **Build Information** tab.
6. Select the **Blueprint type** for licensing purposes.

7. Click the ellipsis (...) button to select an **Amazon machine image (AMI)**. The list of available AMIs is collected by inventory state data collection which is run for each region that is added as a compute resource to an Enterprise Group.

8. (Optional) Specify a method for autogenerating key pairs for machines provisioned with this blueprint:
   - **Not specified** — Select this to control key pair behavior at the reservation level rather than the blueprint level.
   - **Auto-Generated per Provisioning Group** — If you select this option, every machine provisioned using any blueprint within the same provisioning group has the same key pair. Because key pairs generated this way are associated with a provisioning group, the key pairs are deleted when the provisioning group is deleted.
   - **Auto-Generated per Machine** — If you select this option, each machine has a unique key pair.

   **Note:** If key pair behavior is specified on the reservation, it overrides the setting on the blueprint.

9. Select one or more instance types that can be selected as part of the machine request. When you complete your selection, the range of values for CPUs, memory and storage are loaded in the Minimum and Maximum columns.

10. (Optional) If you have specified an approval policy on the Blueprint Information tab and more than once instance type, you can specify an approval threshold in the **Approval At** column.

   **Note:** For provisioning to succeed, the AMI and instance type specified in the provisioning request must be a valid combination within EC2. vCAC does not validate the combination.

   A set of predefined instance types is installed with vCAC, but a vCAC Administrator can add and modify the available instance types in **vCAC Administrator > Instance Types**.

11. Configure **EBS Storage** for this blueprint.
   - To set a maximum threshold for the size of EBS volumes, specify a number in the **Maximum** column. For unlimited capacity, leave the field blank.
   - To disable EBS storage, set the **Maximum** to 0.

12. On the **Properties** tab, specify custom properties.

13. On the **Security** tab, specify the blueprint access and enable machine operations.

### Assigning Elastic Load Balancers on an Amazon EC2 Blueprint

You can assign Elastic Load Balancers to machines that you provision from a blueprint using the custom property **Amazon.ElasticLoadBalancer.Names**.

When you use this custom property, we recommend using a reservation policy to restrict provisioning to the appropriate reservation. Without a policy, provisioning cannot be guaranteed.
For example, there are two reservations:

- Reservation 1 – Region is US-East, with Subnet 1 of VPC 1 selected.
- Reservation 2 – Region is US-East, with Subnet 1 of VPC 2 selected.

On the blueprint, this custom property specifies a load balancer that is created for VPC1. Because you cannot share a load balancer between VPCs, you should use a reservation policy to ensure that machines requested from the blueprint are provisioned on Reservation 1.

To specify a custom property that assigns a load balancer to a machine provisioned on a blueprint:

1. Log in to the vCAC Console as an enterprise administrator or provisioning group manager.
2. Select Enterprise Administrator > Global Blueprints or Provisioning Group Manager > Blueprints.
3. Click New Blueprint > Cloud > Amazon EC2 or point to an existing cloud blueprint and click Edit.
4. Click the Properties tab.
5. In the Custom properties list, click New Property.
6. In the Name field, type Amazon.ElasticLoadBalancer.Names.
7. In the Value field, type the elastic load balancer name. You can specify multiple load balancers by typing a comma-separated list of names.
8. Click the Save button.
9. Click OK to save the blueprint.

Assigning Elastic IP Addresses on an Amazon EC2 Blueprint

You can assign an Elastic IP Address to machines that you provision from a blueprint using the custom property Amazon.ElasticIpAddress.IpAddress.

Machines provisioned via this blueprint will be assigned the corresponding Elastic IP Address. If the Elastic IP Address is in use, the workflow will try to transfer it to the newly created Amazon instance. If multiple instances are created in the machine request, the specified Elastic IP Address will be assigned to the last machine created.

Before you specify this custom property, you should use a reservation policy to link the blueprint to the correct reservation. Without a reservation policy, successful provisioning cannot be guaranteed. Provisioning could fail because the blueprint could use a reservation that does not have the desired resources.

For example, you have two reservations:

- Reservation 1 is for region US-East with location us-east-1b.
- Reservation 2 is also for region US-East, with subnet 1 created on location us-east-1b.

In the blueprint, you specify the custom property Amazon.ElasticIpAddress.IpAddress with a non-VPC elastic IP address.

You need to make sure that when a user requests a machine from this blueprint, the machine ends up on Reservation 1. Because it is not possible to assign a non-VPC Elastic IP Addresses to a machine
provisioned on a subnet in a VPC, Reservation 2 would not work. To ensure this, you create a reservation policy and apply it to Reservation 1 and the blueprint.

To automatically assign an Elastic IP Address to an instance during provisioning:

1. Log in to the vCAC Console as an enterprise administrator or provisioning group manager.
2. Select **Enterprise Administrator > Global Blueprints** or **Provisioning Group Manager > Blueprints**.
3. Click **New Blueprint > Cloud > Amazon EC2** or point to an existing cloud blueprint and click **Edit**.
4. Click the **Properties** tab.
5. In the **Custom properties** list, select **New Property**.
6. In the **Name** field, type **Amazon.ElasticIpAddress.IpAddress**.
7. In the **Value** field, type an IPv4 elastic IP address.
8. Click the **Save** button.
9. Click **OK** to save the blueprint.

**Adding XenDesktop Integration to a Virtual Blueprint**

You can create a blueprint for provisioning virtual machines with XenDesktop integration if

- one or more Citrix Desktop Delivery Controllers (DDCs) are available on the network
- you have installed one or more VDI integration agents to interact with the DDCs as described in the *vCloud Automation Center Installation Guide*
- you have prepared an appropriate cloning template or WIM image

**Creating a Virtual Blueprint for XenDesktop Integration**

Create a blueprint for either provisioning by cloning or WIM-based provisioning as described earlier in this chapter, then add the custom properties below (or add some or all of them to the incorporated build profile). The first three properties are required and the last four are optional.

**Table 11   Custom Properties Required for XenDesktop Integration**

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.VDI.Type</td>
<td>Type of Virtual Desktop Infrastructure; set to <strong>XenDesktop</strong>.</td>
</tr>
</tbody>
</table>
If you encounter the following error is preventing vCAC’s attempts to register provisioned machines with XenDesktop, you need to register Citrix MFCOM for the DDC server involved on the host on which the VDI agent is running.

```
Error: This operation failed because the QueryInterface call on the COM component for the interface
```

See VDI Integration Agent Installation Requirements in the *vCloud Automation Center Installation Guide* for the required procedure. Details about the error are available at [http://support.citrix.com/article/CTX120649](http://support.citrix.com/article/CTX120649).

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDI.Server.Name</td>
<td>Name of server hosting the DDC to register with and connect to or name of a XenDesktop farm containing DDCs to register with.</td>
</tr>
<tr>
<td></td>
<td>If the value is a farm name, VDI.Server.Website must be the URL of an appropriate Citrix web interface site to use in connecting to the machine.</td>
</tr>
<tr>
<td></td>
<td>If the value is a server name:</td>
</tr>
<tr>
<td></td>
<td>• If at least one general XenDesktop VDI agent was installed without specifying a DDC server, this value directs the request to the desired server.</td>
</tr>
<tr>
<td></td>
<td>• If only dedicated XenDesktop VDI agents for specific DDC servers were installed, this value <em>must match exactly</em> the server name configured for a dedicated agent.</td>
</tr>
<tr>
<td>VDI.Server.Group</td>
<td>For XenDesktop 5, name of XenDesktop group to add machines to and name of the catalog to which the group belongs, in the format *group_name;catalog_name*.</td>
</tr>
<tr>
<td></td>
<td>For XenDesktop 4, name of XenDesktop group to add machines to.</td>
</tr>
<tr>
<td>VDI.Server.Website</td>
<td>Server name of Citrix web interface site to use in connecting to the machine. If the value of VDI.Server.Name below is a XenDesktop farm, this property must have an appropriate value or the machine owner will not be able to connect to the machine using XenDesktop from within vCAC. If this property is not specified, VDI.Server.Name determines the DDC to connect to, and therefore must be the name of a server hosting a DDC.</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Interval</td>
<td>Optional interval value in TimeSpan format for VDI Machine Active Directory registration check, default 00:00:15 (15 sec).</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Timeout</td>
<td>Optional timeout value in TimeSpan format for VDI Machine Active Directory registration check, default 00:30:00 (30 min).</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Delay</td>
<td>Optional value in TimeSpan format determining delay between successfully adding machine to Active Directory and initiation of XenDesktop registration, default 00:00:05 (5 sec).</td>
</tr>
</tbody>
</table>
XenDesktop Integration of Individual Machines as Determined by Custom Properties

To determine whether a machine can be registered with XenDesktop, vCAC always reads its properties from the following locations, in the following order:

- The blueprint from which it was provisioned
- The build profile (if any) incorporated in the blueprint from which it was provisioned
- The machine itself

As soon as the appropriate VDI properties are found, the search terminates. This has several important implications:

- If you update the values of the VDI properties in a blueprint—for instance, to change the XenDesktop web console/farm combination used for registration—the update affects not only machines to be provisioned the blueprints, but also all existing machines provisioned from the blueprint.
- If you update the VDI properties in a build profile, the update affects all existing and future machines from blueprints incorporating that profile as long as the blueprints themselves do not have the same properties. If VDI properties are later added to a blueprint incorporating the profile, machines from the blueprint will be updated with the values in the blueprint itself.
- The VDI property values of a specific machine may be overwritten at any time when VDI properties are updated in or added to its blueprint or the build profile incorporated in its blueprint.
- To enable XenDesktop registration for a machine provisioned without VDI, VDI properties can be added to the machine by a group manager using the Edit option. This adds the Virtual Desktop options to the machine’s menu and it can be registered with XenDesktop by a support user, group manager or Enterprise Administrator using the Register Virtual Desktop option. This is also the case when a machine was provisioned without VDI but VDI properties are added to its blueprint or the incorporated build profile.

Note: Due to a limitation in Citrix Web Interface version 5.3 or earlier, when this software is in use users can access only one machine in each Private or AssignOn-FirstUse XenDesktop group using Connect to Virtual Desktop. This limitation does not apply when Citrix Web Interface version 5.4, which is automatically installed with XenDesktop 5, is in use. Under this limitation, users do not benefit from owning more than one machine in such a group. If machines built from the blueprint are to be registered with a XenDesktop group of these types, Connect to Virtual Desktop users should be limited to one machine from the blueprint at a time to avoid wasting resources. This can be done using the Max # of machines setting described above.

Adding Citrix Provisioning Server Integration to a Virtual Blueprint

If a Citrix Provisioning Server is available on the network and you installed at least one EPI agent to interact with it, virtual machines created from a blueprint can be provisioned by it through on-demand disk streaming. To add Citrix Provisioning Server integration to a virtual blueprint, do the following on the Build Information tab:
• Select **Create** to indicate that the machine will be created by the virtualization platform rather than cloned.

• Use the Provisioning workflow drop-down list to select the **ExternalProvisioningWorkflow** workflow.

• When selecting the machine prefix, ensure that the names of machines provisioned from the blueprint will never exceed 15 characters. Machine names longer than 15 characters will cause provisioning to fail.

• Add the custom properties listed in the following table (or add some or all of them to the incorporated build profile).

### Table 12 Custom Properties Required for Citrix Provisioning Server Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VMware.VirtualCenter.OperatingSystem</strong></td>
<td>For virtual provisioning only, the vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version of the reference machine; see VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.api.ref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.api.ref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values.</em> (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td><strong>Infrastructure.Admin.MachineObjectOU</strong></td>
<td>Specifies the OU of the machine, which must be the same as that of the Citrix Provisioning Server. Use Citrix’s format; for example, for <strong>OU=Xen-Farm,OU=QA</strong> use the value <strong>Xen-Farm, QA</strong> with no extra commas or spaces. When machines are placed in the required OU by the provisioning group OU setting, this property is not required.</td>
</tr>
<tr>
<td><strong>VirtualMachine.EPI.Type</strong></td>
<td>Type of external provisioning infrastructure; set to <strong>CitrixProvisioning</strong> for Citrix Provisioning Server integration.</td>
</tr>
<tr>
<td><strong>VirtualMachine.CDROM.Attach</strong></td>
<td>Set to <strong>False</strong> to provision the machine without a CD-ROM device.</td>
</tr>
<tr>
<td><strong>EPI.Server.Name</strong></td>
<td>Name of Citrix Provisioning Server to provision from. As described in the <strong>vCloud Automation Center Installation Guide</strong>, each Citrix Provisioning Server instance to be used in provisioning requires a dedicated EPI agent. The value of this property must therefore match the server name provided when an EPI agent of type <strong>CitrixProvisioning</strong> was installed.</td>
</tr>
<tr>
<td><strong>EPI.Server.Port</strong></td>
<td>Port on which to contact Citrix Provisioning Server; omit to use default of <strong>54321</strong>.</td>
</tr>
</tbody>
</table>
Calling Visual Basic Scripts from a Blueprint

vCAC allows you to specify Visual Basic (VB) scripts to be run outside vCAC as additional steps in the provisioning process, before or after provisioning a machine. You can also run a script when unprovisioning (destroying) a machine. The desired script(s) can be specified in a blueprint from which machines will be provisioned. Such scripts have access to all the custom properties associated with the machine and can even update their values; the next step in the workflow then has access to these new values. For example, you could use a script to generate certificates or security tokens before provisioning and then use them in provisioning the machine.

To enable VB scripts in provisioning, you must install a specific type of EPI agent and place the scripts you want to use on the system on which the agent is installed. When executing a VB script, the EPI agent passes all machine custom properties as arguments to the script. To return updated property values to vCAC, you must place these properties in a dictionary and call a function provided by vCAC.

A sample VB script that you can use as a template, PrePostProvisioningExample.vbs, is included in the Scripts folder of the EPI agent installation directory. This script contains a header to load all arguments into a dictionary, a body in which you can include your function(s) and a footer to return updated custom properties values to vCAC.

Once you have installed the EPI agent and placed the scripts you want to run on the system on which the agent is installed (you may find it most convenient to use the Scripts subdirectory) you can call the scripts from any blueprint by including the following properties either in an incorporated build profile or directly on the blueprint’s Build Information tab.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPI.Server.VDiskName</td>
<td>Name of Citrix Provisioning vDisk to provision from.</td>
</tr>
<tr>
<td>EPI.Server.Store</td>
<td>Name of Citrix Provisioning store containing the vDisk specified in EPI.Server.VDiskName.</td>
</tr>
<tr>
<td>EPI.Server.Collection</td>
<td>Name of Citrix Provisioning collection to register machine under.</td>
</tr>
</tbody>
</table>

Table 13  Custom Properties Required for Calling Visual Basic Scripts

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VbScript.PreProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run before a machine is provisioned, including the filename and extension, for example %SystemDrive%\Program Files (x86)\DynamicOps\DCAC Agents\EPI_Agent\Scripts\SendEmail.vbs.</td>
</tr>
<tr>
<td>VbScript.PostProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run after a machine is provisioned, including the filename and extension, for example %SystemDrive%\Program Files (x86)\DynamicOps\DCAC Agents\EPI_Agent\Scripts\SendEmail.vbs.</td>
</tr>
</tbody>
</table>
Creating a Virtual Blueprint for the Basic Workflow

vCAC’s basic workflow allows you to provision a virtual machine with no guest operating system, so that the guest OS can be installed after provisioning.

Provisioning machines using the basic workflow requires a virtual blueprint in which

- the Provisioning workflow drop-down list on the Build Information tab is set to BasicVmWorkflow
- the following custom properties are included, either in an incorporated build profile or directly on the blueprint’s Build Information tab:

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VbScript.UnProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run when a machine provisioned from the blueprint is destroyed, including the filename and extension, for example %SystemDrive%\DynamicOps\DCAC Agents\EPI_Agent\Scripts\SendEmail.vbs.</td>
</tr>
</tbody>
</table>

Including the FQDN in Automatic Email

For various reasons, machine requestors may want to know the fully qualified domain name of the newly-provisioned machine as well as its vCAC name. To include the FQDN in the email automatically
sent to the owner when a machine is provisioned and activated, include the following property in the blueprint or incorporated build profile:

**Table 15 Custom Properties Required for Including the FQDN in Automatic Email**

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Admin.NameCompletion</td>
<td>If set to domain name, the fully qualified domain name of the machine is included in “machine activated” automatic email to owner.</td>
</tr>
</tbody>
</table>

### Requesting Machines Using a Blueprint

Once one or more blueprints are in place, provisioning group members can request machines by:

1. Loading the vCAC Console using `https://vCAC_server_hostname/vCAC`
2. Selecting **Self-Service > Request Machine** in the activity pane, or by using the new Self-Service Portal (if installed).
3. Expanding a provisioning group to see all available blueprints for a group or groups if the machine requester is a member of several groups. However, if a blueprint is disabled, it will not appear in the list.
4. Selecting one of the blueprints.
5. Specifying optional information on the Confirm Machine Request page including the number of machines requested, a description of the machine and a reason for the request to be sent to approvers if approval is required. The only information that might be required rather than optional is the **Location** selection for a cloud machine and the value of any **Prompt User** custom property that does not have a default value. If you request a machine as PGM or Support User, you can assign ownership of the machine to another user. PGMs can also add custom properties.
6. Clicking **OK**.

If you did not specify an approval policy in the blueprint, the machine immediately appears in the requestor’s machines list, which she can display by selecting **Self-Service > My Machines**. The entry will indicate a series of transient statuses, shown in blue, such as CreatingMachine and TurningOn until it reaches the **On** status, shown in green. You may have to refresh the browser window to display each of these states. (You can do this by clicking **Self-Service > My Machines** in the activity pane.)

If the selected blueprint requires approval, the machine request appears in the requestor’s list of pending requests on the same page, and in the machines list with a status of **AwaitingApproval**. Once a machine is built and turned on, the owner can connect to it and manage it on the **My Machines** page.

### Organizing Your Infrastructure

The Infrastructure Organizer is designed for two purposes:

- Reviewing and configuring known virtualization compute resources, including adding them to enterprise groups and assigning cost profiles.
- Importing into vCAC existing (“unmanaged”) machines on those compute resources, thereby bringing them under vCAC management. The Organizer allows you to add existing or create
new virtual reservations as needed to accommodate the machines you selected before importing them.

The Organizer is particularly useful when incorporating existing infrastructure into a newly installed vCAC site, but can be used at any time.

Understanding Virtual Machine Management

When a virtual machine created on a virtualization platform outside of vCAC is imported into vCAC, an entry for the machine is created in the vCAC database, reflecting both data collected by vCAC and the information you provide during import. For example, the machine is discovered on a particular compute resource, and you specify a blueprint to associate it with when you import it; both compute resource (collected data) and blueprint (user-supplied data) become part of the database entry.

In general, mismatches between the actual machine and information in its database entry are not corrected. There are some exceptions to this general rule, however, as follows

- If the storage path or compute resource on which an imported machine resides, the network, the size of its storage, the size of its memory or the number of CPU equivalents allocated to it are changed outside of vCAC (for instance in vCenter Server) or do not match the vCAC database, the database is updated with these differences during the next data collection. The **CPUs**, **Memory (MB)** and **Storage (GB)** settings on the Build Information tab of the blueprint you choose for a machine go into its database entry, but if this information does not match the machine’s actual specifications, the database will be corrected following the next data collection.

- Some blueprint settings are read from the blueprint when needed, such as **Max # of machines per user** on the Blueprint Information tab and the Machine owners can change operations on the Security tab (when **Apply changes** is checked). These settings in the blueprint under which you import the machine therefore affect the machine when the owner tries to create another machine from the blueprint and when the owner attempts to perform one of the operations on the Security tab.

*Note:* vCAC supports distribution of a virtual machine over multiple storage paths (for example as when a virtual machine is provisioned with multiple disks and the disks are located on multiple storage paths). If such a machine is imported using the Organizer, all storages consumed by the virtual machine are attributed to the coordinated storage paths its disks are on by the vCAC Console and in reports. The correct allocated space appears on chosen Reservation after machine import.

Preparing to Use the Organizer

Some preparation within vCAC is required before using the Organizer.

vCAC Roles Required to Use the Organizer

Although the Organizer is an **Enterprise Administrator** activity, the uses to which you can put it depend on your additional vCAC roles, as follows:

- A vCAC user who is both vCAC administrator and Enterprise Administrator can use the Organizer to organize compute resources into enterprise groups. This is because only a vCAC administrator can assign enterprise group membership to compute resources.
• A vCAC user who is both Enterprise Administrator and group manager can use the Organizer to import unmanaged machines into provisioning groups of which she is manager. This is because importing a virtual machine requires access to the provisioning groups into which it will be imported and the blueprints it will be associated with.

• A user who is vCAC administrator, Enterprise Administrator and PGM can use the Organizer to both organize compute resources and import virtual machines.

You may need to give yourself additional roles, or arrange to be given them, to fully organize and import the existing virtualization infrastructure at your site.

**vCAC Elements Required to Use the Organizer**

The instructions here assume you have done the following, using the procedures in Setting Up vCAC Roles and Elements:

• Added the virtualization compute resources that you want to organize into enterprise groups and search for unmanaged virtual machines.

• Created the enterprise groups into which you will organize the virtualization compute resources.

• Created the provisioning groups into which you want to import the unmanaged machines and the blueprints with which you intend to associate them.

Although the Organizer lets you create virtual reservations for the unmanaged machines you import, you may also want to create virtual reservations before using the Organizer.

**Creating Blueprints for Imported Machines**

The creation of the blueprints used to provision machines within vCAC is a fairly complex matter. When using the Organizer to import external machines, however, all you need to do is create global import blueprints with basic settings that match the machines you are importing. You can ignore settings that do not apply to imported machines, later adding them if you decide to use the blueprint for provisioning new machines as well.

Global blueprints are created and managed by Enterprise Administrators and are available to all provisioning groups. For this reason it is simplest and fastest to create global blueprints for use in importing external machines and (as PGM) select them for all provisioning groups into which you will import. You can, however, use the Organizer to import external machines with any local blueprint as long as you are manager of the group to which it belongs.

**Using the Infrastructure Organizer**

To organize your compute resources and import existing machines, follow these steps:

1. Load the vCAC Console (using https://vCAC_server_hostname/vCAC). You must be a vCAC administrator and Enterprise Administrator to use the Organizer, and you must also be a group manager to use it to import external machines.

2. Open the Organizer by selecting Discovery > Infrastructure Organizer in the activity pane.

**Note:** If no enterprise groups are defined, or you do not have access to any blueprints with which to associate imported machines, the Organizer warns you. Leave the Organizer and make sure all the necessary elements exist within vCAC and you
are using the vCAC Console as vCAC administrator, Enterprise Administrator and PGM.

3. When all of the needed elements are prepared, click **Next** to proceed to the Choose Compute Resources panel, which lists all known compute resources, including information such as whether the compute resource is registered (in at least one enterprise group), the number of unmanaged machines, managed machines and reservations on it, its memory and storage capacity, and its OS, vendor and model.

   On this panel and any Organizer panel with column headings, you can organize the display to your liking by:
   - Clicking a column heading to sort the list by that column
   - Dragging a column heading to the left or right to change the column order

4. Select the compute resources you want to configure and search for unmanaged machines, including both those that are not yet in enterprise groups and those that are, and proceed to the Configure Compute Resources panel.

5. Use the Configure Compute Resources panel to configure or reconfigure each compute resource in vCAC as needed by assigning or modifying its enterprise group membership and description and assigning the desired cost profile (if any exist). You cannot create reservations on a compute resource or search it for unmanaged machines unless it is in an enterprise group. Click the **Edit** button to the left of the compute resource’s name, enter the configuration information, and click the **Save** button to save your changes (or the **Cancel** button to cancel).

   **Note:** You can add compute resources to and remove compute resources from any enterprise group, including those of which you are not an administrator. You should not, however, remove a compute resource from another Enterprise Administrator’s enterprise group without prior agreement, as doing so will deprive her of management access to the compute resource, the reservations on it, and the machines on those reservations. Remember also that if a compute resource is not in one of your own enterprise groups, you will not have management access to it.

   To provide the same information for multiple compute resources at once, edit a compute resource, then use the pin icon or **Pin all** to pin all the compute resources you want to apply the information to. When you save that compute resource, all the configuration information you are saving is applied to all of the pinned compute resources.

   When you have provided all the information necessary to add the compute resources you selected, click **Next** to search for unmanaged machines on the selected compute resources and go on to the Choose Machines panel. (The search operation may take a significant amount of time, depending on the number of compute resources and machines involved.)

   **Note:** If you are vCAC administrator and Enterprise Administrator but not a PGM, you can use only the Choose Compute Resources and Configure Compute Resources panels to configure and/or reconfigure compute resources in vCAC. You cannot go on to the Choose Machines panel; the Organizer will skip to the Confirm Import panel.

6. The Choose Machines panel lists the unmanaged machines discovered on the compute resources you selected along with information about them. (vCAC machines are never
To select the machines you want to import, you must assign each of them to a provisioning group of which you are group manager. Use the edit and pin icons as described for the Configure Compute Resources panel in the previous step.

**Note:** vCAC cannot import virtual machines without disks. If any of the discovered machines do not have disks, ensure that none of them are selected, or import will fail.

7. When you have selected a provisioning group for each machine, continue to the Configure Machines panel. There the machines are grouped under the provisioning groups you assigned them to. Select a blueprint, reservation and owner from the applicable provisioning group for each machine.

**Note:** Using the pin icon copies a blueprint setting only to virtual machines with the appropriate provisioning group setting, and copies a reservation setting only to machines with the appropriate provisioning group and compute resource settings.

Remember that the provisioning group, blueprint and owner you select for a machine you import using the Organizer do not affect the machine itself, but are associated with it in the vCAC database. The blueprint may later affect the machine when it expires.

Importing more than approximately 100 machines at once may require an unacceptable amount of time.

Unmanaged machines with no storage path cannot be imported.

If you assign a machine to be imported to an existing virtual reservation, select **Increase Quota** to increase the reservation’s quota by one and **Grow Allocations** to increase the amount of memory and storage reserved in the reservation by exactly the amount that will be allocated to the imported machine. If you select both, a reservation that was available for provisioning (because it had sufficient unallocated quota, memory and storage) before you import machines to it will remain so afterwards (assuming there is enough free capacity available on at least one of its storage paths).

If you choose not to increase the reservation, it may become unavailable for provisioning as a result of imported virtual machines, or it may become overallocated—that is, the number of machines associated with it may exceed its machine quota, or total allocated memory or storage may exceed reserved memory or storage. The import process still completes successfully, however. When you are done using the organizer you can adjust reservation specifications and move imported machines to other existing reservations or to new reservation.

**Note:** Only virtual machines that are powered on count against a reservation’s quota and reserved memory. For this reason, when you exceed a reservation’s reserved memory or quota using the Organizer, some number of the machines you import may be powered off before being imported.

Machines imported from Hyper-V compute resources or XenServer compute resources may initially be shown as powered off even if they are powered on, but this is corrected by the next data collection.
If there are no existing virtual reservations for the provisioning group (as there will not be if you followed the procedures earlier in this section at a newly-installed vCAC site), or if you want to place an imported VM on its own reservation for any reason, you can create one by entering a name in the Reservation column. Because machines on different compute resources cannot be on the same reservation, you cannot provide the same new reservation name for machines on different compute resources. New reservations are created with the specifications needed for allocation to the imported machines regardless of whether you select Increase Quota or Increase Resource Reservation.

When you have made the needed selections for each machine, proceed to the Confirm Import panel.

8. The Confirm Import panel lists the numbers of compute resources to be configured or reconfigured, machines to be imported, and reservations to be added or updated to accommodate the machines.

9. Click Finish to proceed with the operation, or return to a previous panel to make changes. The import operation itself may take a significant amount of time, depending on the numbers involved. When it is complete, a message about the success or failure of each individual import is displayed.

10. Following use of the Organizer to import external machines, review all virtual reservations affected by the operation, whether previously existing or added by the Organizer. If you did not select Grow for a reservation, you will probably want to adjust it to eliminate its overallocation.

Note: Data collection does not begin until a virtualization host is added to an enterprise group. Because the Infrastructure Organizer does not actually place hosts into enterprise groups until the user clicks Finish on the final panel, this means that the Organizer cannot be used to add a host to an enterprise group for the first time and discover and import unmanaged virtual machines from that host in the same operation.

Either use the Infrastructure Organizer to organize hosts into enterprise groups for the first time, wait for initial data collection to complete, and then use the Organizer again to import unmanaged machines, or place the hosts in an enterprise group using vCAC Administrator > Enterprise Groups, wait for initial data collection to complete, and then use the Organizer to organize hosts and import unmanaged machines.
Chapter 4 Using the vCAC Console

The vCAC Console is an easy-to-use browser-based interface for specifying, requesting, provisioning, and managing virtual, cloud and physical machines.

Overview of the vCAC Console

This section describes the elements of the vCAC Console and the vCAC roles that provide access to it.

Console Security and Access

Access to the vCAC Console is based on each user’s Windows credentials. vCAC recognizes valid users of the Active Directory domains it is installed on as well as valid local users on the vCAC server. vCAC authorizes users for various activities based on their roles within vCAC.

The vCAC installation procedure initially assigns the vCAC administrator role to the local Administrators group on the vCAC server. Any member of this group, or any user added as a vCAC administrator by a member of this group, can follow the procedures provided below to assign global administrator roles, including vCAC, Enterprise and Access administrators.

Enterprise Administrators use the procedures to create provisioning groups and approval groups and add users to groups.

Once these activities have been completed, any user in a global administrator role or an approver role, or user added to a provisioning group can use the vCAC Console.

Note: A best security practice in your environment may be to remove the local Administrators group from the vCAC administrator role once individual users have been assigned as vCAC administrators. Consult your organization’s security policies for more information.

Starting the Console

To access the vCAC Console:

1. Launch a Web browser and navigate to: https://vCAC_server_hostname/vCAC.
2. When prompted, provide Windows credentials for a user with local administrator privileges on the Manager Service host.

Note: vCAC does not support the use of multiple Web browser instances with the same user account. Using the vCAC Console in more than one Web browser, window, or tab can produce unanticipated results when you are logged on as the same user for all of the Web browser instances.

vCAC administrators at your site can customize the start page that displays when basic users first access the console. For example, you may see announcements or the Dashboard, Request Machine, or My Machines pages. The My Machines page can also be customized and therefore may be different from what is described here.
Note: Scripting and cookies must be enabled in your browser in order to use the vCAC Console. Active scripting must be enabled in Internet Explorer, which can be done by enabling this feature alone or by disabling Enhanced Security Configuration.

If vCAC is installed on a Windows Server system and Internet Explorer with Enhanced Security Configuration enabled is used to open the console on that system, frequent security warnings will occur. If Internet Explorer is used on another system, the warnings will not occur, even if Enhanced Security Configuration is enabled.

To use the console’s context-sensitive help, you may need to enable popup windows in your browser.

You are logged into vCAC based on your current Windows domain and account. Each console page indicates your vCAC identity near the right-hand end of the title bar. If vCAC displays your site’s No Access Available announcement, indicating that you have no role in vCAC, or logs you in under an unexpected user name, contact your vCAC administrator.

Caution: To prevent unauthorized use of vCAC or other applications, you should never leave your workstation without locking it.

Elements of the vCAC Console

The vCAC Console contains two main areas: the activity pane on the left and the work area on the right.

The Activity Pane

The activity pane contains entries that let you use vCAC options. The entries it contains depend on your provisioning group membership, global administrator and approver roles within vCAC, and are organized by role.

The activity pane is divided into activity groups. Point to an activity group name (for example Self-Service) and select an activity (such as Request Machine) from menu, or click the group name to expand it and select an activity from the drop-down list.

The Work Area

The work area contains information about vCAC elements such as machines, blueprints, reservations and provisioning groups, along with the controls needed to perform operations on them.

Lists of items—such as lists of machines owned by individual users or managed by administrators, or lists of elements managed by Enterprise Administrators such as compute resources, virtual, cloud and physical reservations, and provisioning groups—include some or all of the following features:

- Each entry in a list of elements provides a menu of options; point to entry to display the menu, then select an option.

  The most frequently used option for that type of element, usually Edit, is also available by clicking the entry name. For example, the menu for each blueprint in a list contains the Edit, Delete, Request Machine and View Machines options, but you can simply click the blueprint name to edit the blueprint.
• Lists can be sorted and filtered by column heading. To sort by a column, click the column heading. To filter for a column value, type a search string matching the beginning of the value in the text box provided. You can also click the drop-down arrow to the right of the column heading to choose from common values. For example, to filter a list of machines, blueprints or reservations for virtual only, click the **Type** drop-down list and select **Virtual**.

• Lists can include a **Columns** drop-down list near the right-hand end of the title bar that lets you select which columns are included in the list. Every list has a set of columns that are displayed by default.

• Machine lists include a drop-down list that lets you apply complex filters to the list. Some lists come with built-in filters, and you can always create and save your own.

You can create **And**, **Or**, **Not And** or **Not Or** filters including conditions based on as many of the list’s columns as you want. Conditions can contain a wide variety of operators to filter a column based on the value you provide, and can be grouped.

• When a list is filtered, using either column filters or the **Filters** control, the filter is represented in the filter bar at the bottom of the list.

• Many lists let you export the information in the list to PDF, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file.

In almost all cases, changes you make in a list display—whether changing the columns, sorting or filtering by column, or applying complex filters—persist from one view of the list to the next.

Table 1 describes icons that are commonly used as list controls in the vCAC Console.

**Table 1** Common vCAC Console Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>Edit</td>
</tr>
<tr>
<td>⚠️</td>
<td>Delete</td>
</tr>
<tr>
<td>✅</td>
<td>Save</td>
</tr>
<tr>
<td>✗</td>
<td>Cancel</td>
</tr>
<tr>
<td>🔍</td>
<td>View more information</td>
</tr>
</tbody>
</table>

### Banner Messages

System and user status information can be displayed in banners running along the top of the work area. Click the banner to go to the appropriate page to perform a task.

### The Start Page

By default, the first page that appears when you load the vCAC Console is the Announcements page, which contains welcome and support announcements posted by vCAC administrators and includes the Recent Events frame.
vCAC administrators at your site can customize the start page to be the Dashboard, Request Machine, or My Machines page.

**Note:** If the activity pane on the start page is empty and a message that you do not have access is displayed, you have not been added to a provisioning group or you do not have an administrator or approver role.

Your vCAC identity is displayed in the upper right corner of every page. Next to it is an **Announcements** link that lets you display the announcements page at any time.

**Context-Sensitive Help**

The **Help** link in the upper right-hand corner displays a help topic in a new window. The behavior of this window depends on your browser settings. You may need to enable popup windows for the help topic to display.

**The Recent Events Frame**

The Recent Events frame displays all vCAC informational, warning, and error messages, including those resulting from operations you perform. For example, when an operation fails, an error message is added to Recent Events. The Recent Events list can be filtered to display errors and warnings only, or all three. You can also specify the number of messages to display on each page of the list.

**Entering Information Using the vCAC Console**

The following features help you provide valid entries on console pages using controls and text boxes:

- Required fields are indicated by red asterisks (*).
- Any invalid entries and missing required entries are indicated by red exclamation points (!). A message explains why the first flagged field is invalid. This feature applies even when a page has multiple tabs and the invalid field is on a hidden tab.
- Limits on text length are enforced by the entry boxes. Machine names must be unique.

**Console Synchronization**

vCAC collects data from virtualization compute resources, cloud service accounts and physical machines on a regular basis. This allows vCAC to discover new machines and elements and to synchronize its database with the current state of each managed machine—powered on, powered off, or missing (vCAC is unable to reach the machine)—as well as information such as installed memory and CPU count.

Between data collections, however, the console might provide information that does not match information on the compute resource, in the cloud service account or about the physical machine.

Use the **Data Collection** option to see the latest information for the compute resource or endpoint.

**Roles and Activities**

Every user has one or more roles within the application. The entries that appear in the activity pane of your console are determined by your role or roles.

There are a number of roles including:
You must be a member of a provisioning group to request and use machines:

- All members (users) can request and manage their own virtual, cloud and physical machines.
- Support Users can also request and manage machines on behalf of other group members.
- PGMs can request and manage their own machines like other users, request machines on behalf of other users, and manage all machines owned by group members. They also:
  - Create and manage the blueprints used by group members to request machines
  - Approve members’ machine and lease extension requests when required

Global administrators are responsible for setting up and maintaining the vCAC site so provisioning groups members can request and use machines. A global administrator role does not enable a user to request machines. Global Administrators include

- vCAC administrators, who:
  - Set up virtual, cloud and physical provisioning by:
    - Configuring the proxy agents through which the application manages XenServer and Hyper-V virtualization compute resources
    - Adding endpoints with appropriate credentials, allowing the application to manage virtual machines on ESX Server virtualization compute resources, SCVMM managed Hyper-V virtualization compute resources, cloud machines and physical machines
    - Organizing discovered virtualization compute resources into enterprise groups
    - Managing Amazon EC2 instance types
  - Make global administrator assignments
  - Customize the console
  - Monitor user rights, logs, Distributed Execution Manager (DEM) status and license information

- Enterprise Administrators, who
  - Manage virtual and cloud machines provisioned on compute resources and endpoints in enterprise group and all available physical machines
  - Manage virtualization compute resources and virtual, cloud and physical reservations, as well as reservation policies
• Manage provisioning groups, global blueprints, build profiles, network profiles, cost profiles and other global elements including key pairs, a property dictionary, and EBS volume management

• Designate approvers by creating approval groups and policies

• Track resource usage and reclaim machines as needed

• Access Administrators, who can modify provisioning group memberships only

Approvers approve or reject requests to provision virtual, cloud and physical machines. Each approver receives requests based on the approval groups he belongs to, the approval policies that contain those groups, and the blueprints in which those policies are selected. An approver can also designate delegates who then receive and can act on the same requests he receives.

The following tables show the general definitions of each role and which roles have access to each entry in the activity pane. A user can be in more than one administrator role and can have different roles in different provisioning groups. (In fact it is possible for a single user to simultaneously have all the roles shown.)

Table 2  vCAC Provisioning Group Member Role Definitions

<table>
<thead>
<tr>
<th>Role</th>
<th>Definition</th>
<th>Assigned By</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Requests and manages their own machines.</td>
<td></td>
</tr>
<tr>
<td>Support</td>
<td>Requests and manages own machines.</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Requests and manages machines on behalf of other users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Views site-wide reports.</td>
<td></td>
</tr>
<tr>
<td>PGM</td>
<td>Requests and manages own machines.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Requests machines on behalf of other users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manages all machines created by group members.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Approves some machine requests and all lease extension requests by group members.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creates, selects and manages group’s blueprints.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monitors group resource usage.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If also an Enterprise Administrator and vCAC administrator, imports unmanaged (external) virtual machines on compute resources in enterprise group.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Views site-wide reports.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PGM can also add, remove, and modify Elastic IP Addresses, Elastic Load Balancers, Security Groups and EBS volumes for Cloud machines.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When combined with the EA role. PGM can assign EBS volume ownership for machines inside the enterprise group.</td>
<td></td>
</tr>
</tbody>
</table>

| Enterprise Administrator or Access Administrator |

Table 3  vCAC Global Administrator Role Definitions

<table>
<thead>
<tr>
<th>Role</th>
<th>Definition</th>
<th>Assigned By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver</td>
<td>Approves machine requests when required by approval policy in blueprint; designates delegates to receive the same requests.</td>
<td>Enterprise Administrator</td>
</tr>
<tr>
<td>Role</td>
<td>Definition</td>
<td>Assigned By</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Access Administra-</td>
<td>Manages provisioning groups membership only.</td>
<td></td>
</tr>
<tr>
<td>tor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Administra-</td>
<td>Creates and manages provisioning groups, including membership and settings. Manages virtualization compute resources. Creates and manages reservations on virtualization compute resources and cloud endpoints, and physical reservations containing machines to be provisioned. Assigns reservations to reservation policies. Manages virtual and cloud machines provisioned on compute resources and endpoints in enterprise groups and all provisioned physical machines, including identifying and reclaiming those not in use. Designates approvers and manages approval groups and policies. Manages build profiles, property sets, and global blueprints available to all provisioning groups and global elements including key pairs, a property dictionary, and EBS volume management. If also a PGM, assigns EBS volume ownership. Run state and inventory data collections for EC2 compute resources. Run state, inventory data and performance collections on vSphere compute resources. Manages machine prefixes, cost profiles and network profiles. If also a PGM and vCAC administrator, imports unmanaged (external) virtual machines on compute resources in enterprise group. Views site-wide reports.</td>
<td>vCAC Administra-</td>
</tr>
<tr>
<td>vCAC Administra-</td>
<td>Adds credentials and endpoints and configures proxy agents to bring virtualization compute resources, cloud service accounts and physical machines under vCAC management to enable provisioning. Creates enterprise groups and assigns Enterprise Administrators to them; organizes virtualization compute resources and cloud compute resources into enterprise groups. Customizes the vCAC Console. Assigns other vCAC administrators and access administrators. Monitors individual users’ rights, vCAC logs including Distributed Execution Manager status. audit logs providing details about machine activities, workflow history and licensing information. Views site-wide reports.</td>
<td></td>
</tr>
<tr>
<td>tor</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 4  Access to vCAC Activities by Role

<table>
<thead>
<tr>
<th>Entry Group</th>
<th>Entry</th>
<th>Activity</th>
<th>Available To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Virtual Dashboard</td>
<td>View charts for own machines (all provisioning group members), provisioning group machines (PGMs) and enterprise group machines (Enterprise Administrators).</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Physical Dashboard</td>
<td></td>
<td>Support User</td>
</tr>
<tr>
<td></td>
<td>Cloud Dashboard</td>
<td></td>
<td>PGM</td>
</tr>
<tr>
<td></td>
<td>Cloud Dashboard</td>
<td></td>
<td>Enterprise Administrator</td>
</tr>
<tr>
<td>Self-Service</td>
<td>My Machines</td>
<td>Manage own machines.</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td>Request Machine</td>
<td>Request machines for oneself and (if Support User or PGM) for other users.</td>
<td>Support User</td>
</tr>
<tr>
<td></td>
<td>Support User</td>
<td>Manage the machines of individual provisioning group members.</td>
<td>Support User</td>
</tr>
<tr>
<td></td>
<td>Support Group</td>
<td>Manage the machines of all provisioning group members.</td>
<td>Support User</td>
</tr>
<tr>
<td>Reports</td>
<td>Group Machines</td>
<td>Display and manage all virtual, cloud and physical machines provisioned by group members.</td>
<td>Support User</td>
</tr>
<tr>
<td>PGM</td>
<td>Machine Requests</td>
<td>Approve or deny machine requests from group members.</td>
<td>PGM</td>
</tr>
<tr>
<td></td>
<td>Lease Extension Requests</td>
<td>Approve or deny lease extension requests from group members.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Build Profiles</td>
<td>View (but not modify or manage) global build profiles.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blueprints</td>
<td>Create and manage local blueprints for group.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Provisioning Groups</td>
<td>Monitor group’s use of reserved virtual, cloud resources and physical machines.</td>
<td></td>
</tr>
<tr>
<td>Access Control</td>
<td></td>
<td>Display and manage provisioning group memberships.</td>
<td>Access Administrator</td>
</tr>
<tr>
<td>Approvals</td>
<td></td>
<td>Approve machine requests as required. Delegate others to approve requests.</td>
<td>Approver</td>
</tr>
</tbody>
</table>
## Enterprise Machines
Manage virtual and cloud machines provisioned on compute resources and endpoints in enterprise group and all available managed and unprovisioned physical machines, including reserved and unreserved. Identify and reclaim machines not in use or underused.

## Build Profiles
Create and manage global build profiles; manage property sets.

## Global Blueprints
Create and manage global blueprints available to PGMs for local selection.

## Provisioning Groups
Create and manage provisioning groups, including both membership and group settings.

## Approval Groups & Policies
Create and manage approval groups assigning approvers; create and manage approval policies containing approval groups.

## Compute Resources
Manage virtualization compute resources in enterprise group.

## Reservations
Create and manage provisioning group virtual and cloud reservations on virtualization compute resources and cloud endpoints in enterprise group and physical reservations containing machines available for provisioning.

## Reservations Policies
Create and manage reservation policies to group reservations.

## Network Profiles
Create and manage network profiles for static IP address assignment.

## Machine Prefixes
Create and manage machine prefixes for use in blueprints.

## Cost Profiles
Create and manage cost profiles for virtualization compute resources and physical machines.

## Reclamation Requests
Manage reclamation requests on enterprise machines.

## EBS Volume Management
When combined with PGM role, can change ownership of or destroy level storage volumes to use with an Amazon EC2 instance.

## Property Dictionary
Create and manage user controls for custom properties.
The following sections describes each of the features and options available in the vCAC Console:

<table>
<thead>
<tr>
<th>Entry Group</th>
<th>Entry</th>
<th>Activity</th>
<th>Available To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Pairs</td>
<td></td>
<td>Upload or enter a key pair required to provision a cloud instances; include a name and a secret key.</td>
<td></td>
</tr>
<tr>
<td>Discovery</td>
<td>Infrastructure Organizer</td>
<td>Review known virtualization compute resources and add them to or remove them from enterprise groups.</td>
<td>Must be Enterprise and vCAC Administrator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import unmanaged virtual machines from virtualization compute resources into vCAC.</td>
<td>Must be Enterprise Administrator and PGM</td>
</tr>
<tr>
<td></td>
<td>Enterprise Groups</td>
<td>Create and manage enterprise groups including their Enterprise Administrators and virtualization compute resources belonging to them.</td>
<td>vCAC Administrator</td>
</tr>
<tr>
<td></td>
<td>Agent Configuration</td>
<td>Associate XenServer and Hyper-V virtualization compute resources with the appropriate proxy agents.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Credentials</td>
<td>Manage credentials to be associated with endpoints.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Endpoints</td>
<td>Manage endpoints representing vCenter Server and SCVMM instances, cloud service accounts, physical machines and storage devices.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Administrators</td>
<td>Assign vCAC administrators and access administrators.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>User Rights</td>
<td>Monitor role assignments and rights of individual users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Customization</td>
<td>Customize the vCAC Console.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Log Viewer</td>
<td>View and search vCAC logs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distributed Execution Status</td>
<td>Monitor Distributed Execution Manager status.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>License Info</td>
<td>Review information about the licenses for the vCAC site.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instance Types</td>
<td>Available to PGMs and EAs who will attach one or more specific instance types when they create a blueprint.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audit Log Viewer</td>
<td>View a log of all virtual machine activities.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Workflow History</td>
<td>View a list of all workflow events.</td>
<td></td>
</tr>
</tbody>
</table>
Dashboard: Tracking Virtual, Physical and Cloud Machines

The dashboard displays charts tracking virtual, physical and cloud machines by state, source blueprint, provisioning group and reservation (Enterprise Administrators only). Although the three dashboards are separate, the same charts are shown (with some differences in content as noted).

The dashboard is available to all provisioning group members (regardless of role) and to Enterprise Administrators. The charts you see when you select Dashboard in the activity pane depend on your role, as described below.

My Machines: All provisioning group members see charts in this section for the provisioned machines they own, as follows:

- **Machines by State**
  - **Permanent** — Active/provisioned with no expiration date
  - **Leased** — Active/provisioned with expiration date
  - **Archived** (virtual machines only) — Expired, can be reactivated by requesting a lease extension or using Change Lease if you are a PGM

- **Machines by Blueprint** — Number of machines provisioned from each listed blueprint

**Note:** An Enterprise Administrator who is not also a provisioning group member does not see the My Machines charts.

[Group/Enterprise] Machines: A PGM sees the Group Machines section on the virtual, cloud, and physical dashboards. On the virtual dashboard, the section shows charts tracking virtual machines provisioned on virtual reservations belonging to provisioning groups of which s/he is manager. On the cloud dashboard, the section shows charts tracking cloud machines provisioned on the group’s cloud reservations. On the physical dashboard, the section shows charts tracking all managed and unprovisioned physical machines reserved for those provisioning groups.

An Enterprise Administrator sees the Enterprise Machines section on the virtual, cloud, and physical dashboards. On the virtual dashboard, the section shows charts tracking virtual machines provisioned on virtualization compute resources in enterprise groups s/he is administrator of. On the cloud dashboard, the section shows charts tracking virtual machines provisioned on cloud endpoints in enterprise groups s/he is administrator of. On the physical dashboard, the section shows charts tracking all managed and unprovisioned physical machines known to vCAC.

A user who is both Enterprise Administrator and PGM sees both the Group and Enterprise Machines sections.

- **Machines by State**
  - **Permanent** — Active/provisioned with no expiration date
  - **Leased** — Active/provisioned with expiration date
  - **Archived** (virtual machines only) — Expired, can be reactivated
  - **Missing** (virtual and cloud only) — Provisioned by vCAC by cannot be detected on the virtualization compute resource or cloud endpoint
• **Unmanaged** (enterprise virtual and physical machines only) — For virtual, provisioned outside vCAC on virtualization compute resources in enterprise group(s), not managed by vCAC. For physical, not yet reserved for provisioning group, available for provisioning or import (if an operating system exists) once reserved

• **Reserved** (physical machines only) — Reserved for a provisioning group, but not yet provisioned; available for provisioning or import (if an operating system exists)

• **Machines by Provisioning Group** — Number of machines provisioned by each listed provisioning group. For group machines, includes only provisioning groups user is manager of; for enterprise machines, includes all provisioning groups

• **Machines by Blueprint** — Number of machines provisioned from each listed blueprint

• **Machines by Reservation** (enterprise machines only) — Number of machines provisioned on each listed reservation

---

**Note:** vCAC administrators at your site may have customized the vCAC Console to remove the Dashboard page for basic users.

---

**Self-Service: Requesting and Managing Your Own Machines**

The activities in the **Self-Service** section of the activity pane are intended for virtual, cloud and physical machine consumers—those who use vCAC to request and manage machines for their own use. These activities are available to all provisioning group members whether in the User, Support, or PGM role.

You have the option to use the vCAC Console or the new Self-Service Portal (if installed) to request and manage your own machines. See "Using the vCAC Self-Service Portal Website" on page 221.

**Requesting a Machine**

To request a machine, select **Self-Service > Request Machine** in the activity pane (or select **Self-Service > My Machines** and click the **Request Machine** link at the right-hand end of the title bar). The Request Machine page lists the blueprints available to you, organized by the provisioning group they belong to. These groups are collapsed when the page first appears (unless there is only one, in which case it is expanded); expand each group to select among its blueprints.

The information provided for each blueprint includes its type (virtual, cloud or physical), the length of the lease and archive periods, its specifications, its estimated daily cost, and description. To see only virtual, cloud or physical blueprints, enter **v, c** or **p** in the search box for the **Type** column.

---

**Note:** Blueprints from which a machine cannot currently be provisioned due to insufficient resources are not available, and have no entry under **Daily Cost** (that is, the column is blank, rather than showing **$0.00** as when there are no costs associated with a blueprint).

vCAC administrators at your site may have customized the columns included in the list of blueprints.
The locked icon ( ) on a blueprint indicates that requests to create machines from that blueprint require approval by a PGM or others, either always or when you increase one or more specifications above the approval threshold.

Select a blueprint by clicking its name. The request confirmation page appears. Three optional fields are always available for all types of blueprints, for you to make entries as desired:

- You can request more than one machine; to do so, change the counter to the number you need. Some blueprints impose a limit on the number of machines built from that blueprint that a single user can own at one time. When this is the case, a message informs you of how many machines you can build from the blueprint. If you are already at the maximum, you will not be able to complete the request. EBS volume limits can also be added to a blueprint.

- You can enter an identifying description of the machine, a useful practice if you own and use a number of machines. These will be visible to you and to the group’s managers and can be changed at any time during the life of the machine.

- You can enter a reason for the request, which is provided to the PGM or other specified approvers when approval is required.

In addition to these, a number of other controls may appear, depending on your role and on the type and settings of the blueprint involved.

- Some blueprints allow you to optionally increase the length of the machine’s lease from the minimum up to a maximum figure, which is displayed for your information. Note that the calendar control used to set the lease length does not actually set the selected date as expiration date. Rather, it calculates the number of days between the current date and the date you select, and sets this number of days as the lease length. The lease begins when the machine request is completed, even if required approvals delay provisioning of the machine until a later date.

- Some virtual and physical blueprints allow you to optionally increase the CPU count, memory or storage (virtual only) specifications from the minimum up to a maximum figure, which is displayed for your information.

- Some virtual blueprints allow you to optionally select a particular location at which to provision the machine. If you select a location, a virtual machine can be provisioned only from a reservation on a virtualization compute resource with that location specified in the Location field. Blueprints can also hide or show the location for EC2 requests as well.

- If you are a Support User or PGM you can assign the requested machine to any user in the provisioning group(s) in which you have this role. Once you complete the request, the rest of the approval and provisioning process continues as if the selected user had made the request himself.

- If external provisioning systems such as HP Server Automation (Opsware) are integrated with your vCAC site, blueprints may offer a list of software that you can select for installation on the machine(s) you are requesting. See Appendix A for more details. The list is added using custom properties and when the list is not displayed, the user does not have the option to select the software.

- If the blueprint prompts you for values for any required custom properties, you must provide these before confirming the request. If a required property has a lock icon to its right, the value you enter will be encrypted. You can accept or replace default values, if any; if there is no
default, you must make an entry. If you are requesting more than one machine, remember that the value you supply will be applied to all machines provisioned from the request.

- For Amazon EC2, instance type is not a custom property but is always required. Also, EBS volumes and network options can be added at machine request time.

When you have entered the information you want, click OK to proceed with the request. A banner informs you that the request has been submitted.

To check the status of your request, select Self-Service > My Machines in the activity pane to display your machine status page. This page contains the My Machines list of all of your machines of all types, as well as several other expandable frames.

- If the blueprint from which you requested the machine is not locked, press Refresh to view the status of the machine in the appropriate machine list after a few seconds. The entry will indicate a series of transient statuses, shown in blue, such as CreatingMachine, SettingUpOS and TurningOn (depending on machine type) until it reaches the On status, shown in green. Refresh your browser window to see each of these states. (You can do this by clicking Self-Service > My Machines in the activity pane.)

Wait at least ten minutes after the status displays On before connecting to the machine. Full customization could take up to 20 minutes.

Over time you will learn how long it takes to fully provision and build each type of machine available to you, and how much time you should allow for customization after the machine is powered on before connecting to it and logging in.

**Note:** The full menu of machine options described in the next section is not available until the new machine reaches On status.

- If the selected blueprint is locked, the machine appears in the appropriate machines list with the status AwaitingApproval and the request appears in the list of your pending requests.

- If the request fails, no new machine appears in your machines lists. Expand the Recent Events frame at the bottom of the page to see an error message describing the problem.

Once a machine you have requested is built and turned on, you can connect to it and manage it on your machine status page.

### Requesting a Cloud Machine (Amazon EC2)

Some additional options are available when requesting machines from Amazon EC2.

If **Enable Amazon network options on machine** is enabled in the blueprint, you can select whether to provision the machine into a VPC or non-VPC location.

To assign an new instance to a VPC and subnets within it:

1. Select **Self-Service > Request Machine**.
2. Click a cloud blueprint.
3. On the **Request Information** tab, click the **Provision into** list box and select **Subnet in a VPC**.
4. On the **Network** tab, click the **Subnet** list box to select a subnet within the VPC.

The VPC and Location of the selected subnet display in boxes below.
5. In the **Security groups** list, select each group the machine should belong to when it is provisioned.

   **Note:** If you do not select security groups, all security groups from the reservation will be applied to the machine.

6. Click **OK**.

If Elastic Block Storage is enabled, you can request and attach additional storage capacity when provisioning an instance.

To request additional storage capacity for a new instance:

1. Select **Self-Service > Request Machine**.
2. Click a cloud blueprint.
3. Click the **Storage** tab. The number of GB attached and available is shown at the bottom.
4. Click **Add volume** and enter the following information for the EBS volume to add:
   - **Name**
   - **Storage (GB)** — Select the amount of storage without exceeding the amount available
   - **Device** — Select the platform. Devices in the xvdk format are for Windows instances and devices in the /dev/sdk format are for Linux instances.
   - **Description** — You can enter a description.
5. Click the **Save** button.
6. Click **OK** to submit the request.

You can also modify EBS storage capacity for an existing instance.

### Managing Your Machines

Display your machine status page by selecting **Self-Service > My Machines** in the activity pane. The machine status page contains the following lists your:

- Virtual, cloud, and physical machines
- Pending machine approval and lease extension requests
- Open machine reclamation requests you have received from Enterprise Administrators
- Machines that will expire soon

This page also includes Recent Events. The title bar of each of these frames includes a control for collapsing and expanding the frame. Whenever you display the page, each frame is as you left it—collapsed or expanded according to your last use of the controls.

**Note:** vCAC administrators at your site can customize the My Machines page for basic users so some frames and controls described below may not appear.
Using Your Machines Lists

The My Machines lists provide you with information about your machines and let you perform operations on them. Default columns include the name and status of each machine, its type and description, and the dates on which it expires (virtual only) and will be destroyed or decommissioned. (Your vCAC administrators may have changed the available columns in the My Machines lists.) If your vCAC administrator has enabled it, the Columns control lets you select many more columns for display, some of which do not apply to all types of machines. When a column does not apply, there is no entry.

You can sort and filter each column individually, as described in "Elements of the vCAC Console"; if your vCAC administrator has enabled it, the Filters control lets you create and save complex filters. Filters applied to the list are always shown in the filter bar at the bottom. Changes you make in a list display persist from one view of the list to the next.

When a list of machines is filtered by any column or columns, the total number of machines displayed in the title bar changes to indicate how many machines are in the filtered display.

If your vCAC administrator has enabled it, the Export drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file. You can also request a machine from the My Machines page by clicking the Request Machine link at the right-hand end of the title bar.

Note: MachineProvisioned is a transient status that may appear in the status column for a prolonged period for various reasons. Do not attempt to connect to and use a machine with this status, as any machine is subject to disposal or decommissioning without notice until its status becomes On or Off.

Yes in the Is Missing column indicates that the last data collection from the virtualization compute resource or endpoint was unable to detect the machine.

Machine Expiration, Archive Period, and Deletion

If a machine’s blueprint specifies a lease length, that machine will have an expiration date once provisioned. If the blueprint does not specify a lease length, the value in the Expires column is Never and the machine can be used indefinitely.

For all cloud and physical machines, and some virtual machines, when a machine with an expiration date reaches that date it is powered off and destroyed. You may receive an email warning before the machine expires and another email message when it actually expires. These messages also appear in the Recent Events frame. Before a machine expires, you can ask your PGM to extend its lease (give it a later expiration date) using the Extend Lease option described below.

On expiration, all cloud machines are destroyed, and all physical machines are decommissioned (unprovisioned) and become available for future provisioning requests. A virtual machine, however, can be archived—temporarily saved for potential restoration. If a virtual machine’s source blueprint specifies an archive period, the machine is not permanently destroyed until the archive period ends. (If a virtual machine’s source blueprint does not specify an archive period, the machine is destroyed immediately upon expiration.) When you request a machine and list blueprints on the Request Machine page, virtual blueprints with an archive period show a number greater than 0 in the Archive column.

Any virtual machine in your My Machines list with the status Expired is archived. If you want to turn on a virtual machine that is archived, you can ask your PGM to reactivate it (give it an expiration date in the future and power it back On) by selecting the Reactivate option described below.
The scheduled deletion date of a virtual machine, whether active or archived, is always shown in the **Destroyed** column in your My Machines list. The difference between **Expires** and **Destroyed** is the archive period. If the expiration date of an active machine is **Never**, the destroy date is also **Never**. If a virtual machine’s expiration date and destroy date are the same, or a cloud or physical machine has an expiration date, you will permanently lose access to it when it expires, so plan accordingly.

**Working with Snapshots**

A snapshot is an image of a virtual machine at a certain point in time. It is a space-efficient, pointer-based copy of the original VM image. Snapshots can be an easy way to recover a system from damage, data loss and security threats.

Use Snapshot Manager to create, apply, delete and view snapshots. Snapshot Manager is supported for VMware vSphere versions later than 2.5 only.

Snapshot Manager displays a list of snapshots of the selected machine. For each snapshot, the following information displays:

- **Name** – Snapshot name. Duplicate names are not allowed.
- **Created** – Date and time when the snapshot was created
- **Is Memory Snapshot?** – Yes if the snapshot includes memory state, No if it does not. This column has data for only snapshots that were created from vCAC.
- **Description** – You can enter optional information.

As you work with snapshots, you can see a history of snapshot actions in the Recent Events log.

When creating snapshots, keep the following prerequisites in mind:

- The maximum depth of snapshots allowed on a machine cannot be exceeded. The default is 1.
- The datastore on the reservation on which the machine is provisioned must have sufficient space to store the snapshot. For vCAC, sufficient space is enough to store another copy of the virtual machine’s hard drive.
- The machine must be in the **On** or **Off** state.

To create a snapshot:

1. Navigate to your machines:
   - **Enterprise Administrator** – Choose Enterprise Machines.
   - **Provisioning Group Manager** – Choose Group Machines.
   - Support – Choose **Support Group > Group Machines** or **Support User > Machines for User**
   - **Machine Owner** – Choose My Machines.
2. Point to a virtual machine and click **Snapshot Manager**.
3. Click **New Snapshot** in the upper-right corner.
4. (Optional) The **Name** field displays the machine name and present data and time, which you can change.
5. (Optional) Add a description.
6. (Optional) Click **Snapshot the machine’s memory** to create a disk and memory snapshot.

7. Click **OK** to create the snapshot and add it to the list in Snapshot Manager.

To apply a snapshot:

1. Navigate to Snapshot Manager, as described in steps to create a snapshot.
2. Point to a snapshot and click **Apply**.
3. Confirm your request on the **Confirm Snapshot Action** dialog. While the snapshot is being applied, the **Apply** option is not available and you cannot create or delete other snapshots. When you refresh or reload the page after the snapshot is applied, all options are available again.

Caution: When you apply a snapshot, all changes made or data added to the machine since the last snapshot was created are permanently lost.

To delete a snapshot:

1. Navigate to Snapshot Manager, as described in steps to create a snapshot.
2. Point to a snapshot and click **Delete**.
3. Confirm your request on the **Confirm Snapshot Action** dialog.

Caution: When you delete a snapshot, the machine state preserved in the snapshot is permanently lost. If you delete the current snapshot, indicated by You are here, the parent snapshot is applied.

**Owner Machine Options**

Use the buttons in the **Status** column ( ) to power a machine on (all types) or to shut down the guest operating system down and power the machine off (virtual and physical machines only).

Note: Only a virtual or cloud machine that is turned on is counted in the allocated machine quota of the reservation it is provisioned from; only a virtual machine that is turned on is counted against allocated memory. Turning off a virtual or cloud machine that is not in use therefore makes more quota and memory available. However, a virtual or cloud machine that is turned off cannot be turned on if the reservation provisioning it no longer has sufficient available quota or memory to support it.

To perform operations on a machine, move the pointer over the machine name and select an option from the menu, or just click the machine’s name to use the **Edit** option.

There are a few differences between the options available for virtual, cloud, and physical machines; these are noted in this section. In addition, a blueprint can remove some user operations from the menu for machines created from that blueprint. The menu for each of your machines thus contains some combination of the following options, depending on whether it is virtual or physical, its state, whether it has an expiration date, and any restrictions in the blueprint from which it was created.

Note: All machine operations available to machine owners can also be performed by PGMs, including those that can deny owners access or delete the data on a machine. Managers also have access to several operations unavailable to
owners. Some machine operations described here may not be available for machines provisioned from a particular blueprint at the discretion of the PGM.

**Edit:** Add to or change your description of the machine. You can also review other information about the machine, but cannot modify it. For a cloud machine, the Edit Machine Record page allows you to use the Show button to show the Administrator password and display the DNS name of the cloud machine.

**Properties:** View (not change) the machine’s description when the Edit option is not available, for example when the machine is in a transient state.

**Connect Using RDP:** Download an .rdp file that you can open to create a Remote Desktop Protocol link and open a Microsoft Terminal Services connection to a Windows machine. You can configure your browser to automatically open the connection, or to ask you first. The owner of a machine is added to the local Remote Desktop Users group by default on virtual and physical machines, so you can log in using the Windows credentials that provide your role in vCAC. Cloud machines require you to add these credentials first. You cannot connect to a machine unless its status is **On**.

**Note:** The Connect Using RDP option can be disabled for non-Windows machines (including Linux and ESX/ESXi) and RDP connections to machines can be customized on a blueprint-by-blueprint basis.

If you are using Internet Explorer with Enhanced Security Configuration enabled, .rdp files cannot be downloaded.

**Connect Using SSH:** To enable use of the Connect Using SSH option for a Linux machine, use the procedure below.

1. On the vCAC manager service host, edit the file C:\Program Files (x86)\DynamicOps\DCAC Server\Website\Web.config. At the end of the <appSettings> section, before </appSettings>, insert the following line:

   ```xml
   <add key="ShowConnectUsingSsh" value="true" />
   ```

2. Reset IIS and restart the manager service.

3. Add the custom property Machine.SSH=true to a blueprint or the blueprint’s incorporated build profile.

For any powered on machine provisioned from the blueprint, the Connect Using SSH right-click option will now appear. However, when you select it the browser attempts to load the URL ssh://machine_name which requires an ssh URL handler to be installed on the system you clicked the link on to use.

**Connect to Virtual Desktop** (virtual only): If a virtual machine is registered with a XenDesktop DDC server, opens a connection to the XenDesktop DDC server in a new window. This option does not appear for machines that are not provisioned with XenDesktop integration. The option has no effect if the machine was provisioned but not yet registered, in which case a Support User, PGM or Enterprise Administrator can register it.

**Note:** If the machine was provisioned without XenDesktop integration, but XenDesktop integration has since been added to the blueprint from which the machine was provisioned, the Connect to Virtual Desktop option appears even though the machine is not registered with XenDesktop. The machine can be registered by adding XenDesktop integration directly to its custom properties.
The **Connect Using RDP** option does not appear when a virtual machine is registered with a XenDesktop Desktop Delivery Controller (DDC) server and the **Connect to Virtual Desktop** option is available.

**Power cycle options:** In addition to the Power on and Shut Down buttons in the status column, up to four power cycle options are available. The options available depend on the machine type, as shown in the following table:

### Table 5  Machine Power Cycle Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Available for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power On button</td>
<td>Power the machine on</td>
<td>All types</td>
</tr>
<tr>
<td>Shut Down button</td>
<td>Attempt to shut down the guest OS and, if the shutdown is successful, power off the machine. If the shutdown is not successful the machine remains on.</td>
<td>All types</td>
</tr>
<tr>
<td>Suspend</td>
<td>“Pause” the machine so that it cannot be used and does not consume any system resources (other than the storage it is currently using). The Power On button is used to resume normal operation from the point at which the machine was suspended.</td>
<td>Virtual only</td>
</tr>
<tr>
<td>Reboot</td>
<td>Shut down the guest OS and, if the shutdown is successful, restart it. If the guest OS does not shut down successfully, no further action is taken.</td>
<td>All types</td>
</tr>
<tr>
<td>Power Off</td>
<td>Power off the machine without shutting down the guest OS.</td>
<td>All types</td>
</tr>
<tr>
<td>Power Cycle</td>
<td>Turn the machine off and then on again; equivalent to using the power button on a physical computer. The guest OS is not shut down before the machine is powered off.</td>
<td>All types</td>
</tr>
</tbody>
</table>

**Expiration Reminder:** Download an iCalendar file to set an reminder of the machine’s expiration date and time, if it has one, in your calendar program. This reminder is in addition to the reminders you receive in the console and by email.) You may need to configure your browser to open the file using the calendar program.

**Change Lease:** Ask PGMs to change (delay) the expiration date of an active machine.

You can propose a new expiration date and time, and enter text explaining the request. You will receive an email message when a manager approves or rejects the request. You can also select the check box, **Never.**

You cannot request a new expiration date that is before the current expiration date, even if it is after the current date; the only way to expire a machine before the current expiration date is to use the **Expire** option. You cannot change the archive period of an existing machine.

**Reactivate** (virtual only): Ask PGMs to return to active use a virtual machine that has already expired and is archived by giving it a new expiration date and powering it back **On.** Use this option either to continue using an expired machine or to briefly reactivate it so you can retrieve data stored on it.

You must propose a new extension date and enter text explaining the request. You cannot propose an indefinite lease, but you can request this in the text you enter. You will receive an email message when a PGM approves or rejects the request.

You cannot change the archive period of an existing machine.
**Export Certificate** (cloud only): Export an X.509 certificate from the machine. The certificate is downloaded.

**Reprovision**: Recreate a virtual machine, or reprovision the guest OS of a physical machine. (Not available for cloud machines.) No approval is required to reprovision even if the blueprint is locked. Please note the following characteristics of the reprovisioning operation:

- In general, the machine is reprovisioned according to the specifications in the blueprint, and therefore may be affected by changes in the blueprint since the machine was provisioned. However, any custom properties of the machine that are not present in the current blueprint are retained; a machine provisioned to be registered with XenDesktop, for example, will be registered following reprovision, even if XenDesktop integration has been removed from the blueprint in the interim.
- The expiration date of the machine does not change; if it was provisioned with a 60-day lease, and 20 days have passed, it will still have only 40 days remaining following reprovisioning.
- The CPU, memory and storage specifications of the machine are not changed by reprovisioning, regardless of changes in the blueprint.
- If you were prompted for a custom property value when you requested the machine, and the blueprint still includes that property with **Prompt User** selected, you are prompted again when reprovisioning, but the value you entered when requesting the machine is provided as the default. (Does not apply to network-related properties.)
- If a physical blueprint has been changed and the physical machine no longer matches it—for example, if the blueprint has been changed from a CPU count of exactly 2 to a CPU count of at least 4, and the machine has 2 CPUs—the blueprint is ignored and the machine is reprovisioned despite the discrepancy.

**Note**: If a Hyper-V machine is missing and the machine is reprovisioned, it’s existing virtual disk will be used if the disk still exists. If the disk no longer exists, a new virtual disk will be created.

**Caution**: Reprovisioning a machine destroys all data stored on the machine.

**Expire** (virtual and vApp only): Change the machine’s status to **Expired**. You may decide you are finished with a machine before its scheduled expiration date; using the **Expire** option begins the disposal process, which eventually releases its allocated resources for use by new machines, without waiting for the scheduled date. If the blueprint from which a machine was created specifies an archive period, the archive period begins immediately; until it ends, you can regain access to the machine by requesting a lease extension, or you can use the **Destroy** option to destroy the machine earlier.

**Caution**: If there is no archive period specified, the **Expire** option means the machine is immediately destroyed along with all the data stored on it.

**Destroy** (virtual and cloud only): Immediately destroys the machine regardless of its current status. Use this option if you are certain you have no further use for a machine or any of the data stored on it.

**Note**: After a cloud machine is destroyed in vCAC it may remain visible in the Amazon Web Services console for up to an hour.
Decommission (physical only): Immediately removes the guest OS from a physical machine, making it available to be used for future physical machine provisioning requests.

**Caution:** When you use the Destroy or Decommission options, all data stored on the machine is immediately lost. Furthermore, all information about the machine is removed from the vCAC database.

### Performing Operations on Multiple Machines

You can select more than one machine when performing some operations. Machine operations that can be performed on more than one machine include:

- Change Lease
- Send Reclamation Request
- Destroy
- Expire
- Install Tools
- Power Cycle
- Power Off
- Reboot
- Shut Down
- Suspend

**Note:** All workflow tasks except Reprovision can be performed on multiple machines. Reprovision requires user input for each machine so the operation cannot be performed on more than one machine at a time.

To select multiple machines, do one of the following:

- In the machine list, click the check box to the left of a machine name.
- Click **Select All on Page**.

To deselect multiple machines:

- Click **Deselect All on Page**.

To perform operations on multiple machines:

1. Point to the selected machines to display the menu and select an operation.
   - If more than one machine is selected, only tasks that can be performed on all selected machines are enabled.
   - If a user is hovering over a machine that is on, the operations available for a machine that is on are displayed with some operations grayed out.
   - If machines that are turn off are selected in the batch, machines that were selected and are not turned on already, will be unchecked and grayed out at the confirmation screen.
• Only machines that support the operation are enabled when you confirm the action. Other machines are displayed but disabled.

2. Confirm the operation.

If one of the machines in the list of selected machines is a hypervisor, a warning message is displayed with an additional check box to confirm the action. Machines that are hypervisors display an icon that distinguishes them as hypervisors.

When selecting Change Lease, if only one machine is selected, the existing lease status is displayed. If more than one machine is selected and available, the current expiration date is not displayed.

Machines that are not accessible are disabled and cannot be selected. For example, physical and cloud machines do not support all of the operations that are available for virtual machines. You cannot use the multiple machine selection across all machine types.

Note: Custom machine operations can be performed on more than one machine if the operation includes the confirmVMTasks page.

**Reviewing Your Pending Requests**

If you have requested one or more machines from locked blueprints or used the Extend Lease or Reactivate options to request lease extension or reactivation, you can review your pending requests in the My Pending Requests frame on your My Machines page. The email address of the responsible PGM or other approver is included in the display; you can click the address to send a message about the request.

Depending on the approval policy selected in the blueprint you choose, approval for a request from a locked blueprint may be required from the PGM, a sequence of approval groups, or both. An approval group can have any number of members, any one of whom can approve the request for the group; an approval policy may contain any number of approval groups, each of which must approve the request in a specified sequence.

The email address of the current required approver—PGM or approval group—is included in the display. This email address changes as each approval is received. You can click the address to send a message about the request. Each group has only one email address, which in most cases will be an alias for the entire group.

When a request is approved, the machine is provisioned, extended or reactivated. Whether approved or denied, a message appears in the Recent Events frame, the request is removed from the My Pending Requests list, and you may receive an email informing you of the decision.

If advanced approval support is enabled, the approval workflow may return to you for a decision about whether to continue with or cancel the request using the Approve or Reject buttons. Because advanced approval support lets you examine the custom properties of the machine at that point in the workflow by clicking the View more information button (.), this feature is useful when one or more prior approvers have supplied property values for the machine. When one or more requests return to you for a decision, the My Pending Requests frame is automatically expanded when you display the My Machines page, even if you left it closed.

**Reviewing Your Reclamation Requests**

When reviewing your physical, cloud (Amazon EC2), or virtual machine reclamation requests, you can use the Columns drop-down list to select the columns you want to see in the requests.
When an Enterprise Administrator identifies one or more of your physical, cloud (Amazon EC2), or virtual machines as candidates for resource reclamation and sends you a reclamation request, you receive an email message and a reclamation request in the My Reclamation Requests section of your My Machines page. In the reclamation request, the Enterprise Administrator specifies the length of a new lease, the amount of time given for a user’s response, and which machine(s) to target for reclamation.

In both your My Reclamation Requests list and the email message, you are asked to verify that the physical, cloud (Amazon EC2), or virtual machine is still in use. You can then select either of two options, both of which are available in the My Reclamation Requests menu and as links in the email:

- **Machine in Use**: terminates the reclamation request without action
- **Machine Released for Reclamation**: immediately expires the virtual machine

If you do not use one of these options by the deadline stipulated in the email message and

- The machine’s existing lease expires *before* the deadline, then the machine expires when the lease expires.
- The machine’s existing lease expires *after* the deadline and
  - The existing lease is *shorter* than the new lease, then the existing lease remains in effect.
  - The existing lease is *longer* than the new lease, then vCAC automatically converts the machine to the new lease.

If you select the **Machine Released for Reclamation** option from the menu in My Reclamation Requests or as a link in the email, your machine expires immediately. You can also use the **Extend Lease** option (available in the My Machines list) to request that the lease be extended, or do nothing and allow the machine to expire.

**Caution:** If you select **Machine Released for Reclamation**, the machine is immediately expired; if an archive period of 0 is specified in its blueprint it is immediately destroyed.

The email also displays the cost of maintaining the machine.

If you select the **Machine in Use** option from the menu in My Reclamation Requests or as a link in the email, the vCAC Console opens and displays the Respond to Reclamation Request page. Use this page to select a predefined reason from among the following:

- machine is still needed, average utilization will likely be low
- machine is still needed, users typically don’t log into this machine
- machine is still needed, even though it has been turned off lately
- machine is still needed in the short term, but will be a reclamation candidate at a later date
- Other

**Note:** The selection of reasons may be different at your site.

You can also enter text in the **Explanation** box, to support the choice of **Other** or for any other purpose.
**Reviewing Your Expiring Machines**

The **My Expiring Machines** list reminds you of all machines you own that will expire within the selected period—7, 14, 30, 60, or 90 days. As discussed in the previous section, you can use the **Extend Lease** option to request a later expiration date for an individual machine from the PGM, and the **Expiration Reminder** option to set a reminder in your calendar for an individual machine.

**The Recent Events Frame**

The Recent Events frame, which also appears on the announcements page, displays all vCAC informational, warning, and error messages, including those resulting from operations you perform. For example, when an operation fails, an explanatory error message is always added to Recent Events. The Recent Events list can be filtered to display just one of the message types, errors and warnings only, or all three. You can also specify the number of messages to display on each page of the list.

**Managing Cloud Machines**

Additional options are available for machines provisioned with Amazon EC2.

**Connecting to a Cloud Machine**

When using the **Connect Using RDP** option to connect to a cloud machine, as described in the next section, two additional considerations apply.

**Connecting to a Cloud Machine for the First Time**

Every virtual and physical machine is automatically provisioned with a user account for the machine’s vCAC owner. Because cloud machines are provisioned within a cloud service, however, vCAC cannot create user accounts on a cloud machine. For this reason, the first time you connect to a cloud machine you must log in as Administrator. You can then add the credentials under which you use vCAC as a user on the machine, and log in under your vCAC credentials from that point on.

**Note:** To log in as Administrator, you must discover the Administrator password. However, the Amazon Machine Images (AMI) from which the machine was provisioned may not be configured to generate the Administrator password on every boot. If the **Show** button does not display the password as described below, contact your vCAC administrator.

The first time you connect to a Windows cloud machine you have provisioned:

1. Click **Edit**, as described below, for the cloud machine.
2. On the Edit Machine Record page, click **Show for Administrator password**.
3. Copy the password and paste it into an ASCII text editor such as Windows Notepad.

**Note:** It is a good practice to paste the password into an ASCII editor, rather than simply copying it, because copying it directly from the vCAC Console sometimes includes extra characters, which are removed when you paste into an ASCII editor.

4. Click **Connect Using RDP** for the machine.

The Remote Desktop Protocol connection opens a login dialog for your vCAC credentials.
5. Click **Use another account**, and type **LOCAL\Administrator** as user name. (You can also enter **LOCAL\compute resource** or the machine name as the domain, instead of **LOCAL**; note that the machine name is case-sensitive, so do not use **W2K8\-37** if the machine name is **W2K8\-37**.)

6. Copy and paste the Administrator password from the ASCII editor to the password field, then click **OK** to log in. (You can also type the password in if you prefer.)

7. Once logged in as administrator, add your vCAC credentials as appropriate. For example, on a Windows Server 2008 machine, open Server Manager, select **Configuration > Local Users and Groups**, and add your credentials (in **DOMAIN\username** format) to the Remote Desktop Users group.

8. Log out, then select **Connect Using RDP** again and log in using your vCAC credentials.

**Connecting to a Cloud Machine After an IP Address Change**

The IP address of an Amazon EC2 instance can change at any time. When this happens, the RDP link in the automatic email you received becomes invalid, and **Connect Using RDP** will not work.

When this happens, wait until after the next data collection from the Amazon EC2 endpoint (typically every 15 minutes) to use the **Connect Using RDP** option. (You can contact your vCAC administrator to request an immediate data collection if you wish.)

**Viewing Security Groups**

To view security groups for a machine:

1. As a machine owner, click **Self-Service > My Machines**.
2. Point to a cloud machine and click **Edit**.
3. Click the **Network** tab.

**Exporting the Secret Key of a Machine’s Key Pair to a Certificate**

You can export the contents of the .PEM file for a cloud machine to a certificate.

To export a machine’s secret key:

1. As a machine owner, click **Self-Service > My Machines**.
2. Point to a machine and click **Export Certificate**.
3. Click **Save**.

**Managing Elastic Load Balancers**

If **Enable Amazon network options on this machine** is enabled on a blueprint, you can associate or disassociate an Amazon instance from an elastic load balancer.

You can associate a vCAC-managed instance to a load balancer in two places:

- **AWS Management Console** — The association you make in AWS will show in vCAC after data collection.
- **vCAC** — You make the association on the reservation. If the load balancer is removed from the reservation, the association is lost.

To associate and disassociate an instance from a load balancer:
1. As a machine owner, click **Self-Service > My Machines**.
2. Point to an existing cloud machine and click **Edit**.
3. Click the **Network** tab.
4. In the **Load balancers** list:
   a. Select each load balancer to assign to the machine.
   b. Deselect a load balancer to disassociate it from the machine.
5. Click **OK**.

You can always view information about an elastic load balancer, including:

- Status
- Port configuration
- Locations
- Ping target, timeout and interval
- Health
- Health thresholds
- Total number of instances assigned to a load balancer and how many of them are healthy

To view detailed information about a load balancer:

1. As a machine owner, click **Self-Service > My Machines**.
2. Point to an existing cloud machine and click **Edit**.
3. To view information about a load balancer, click the **View more information** button (🔍).

### Viewing Elastic IP Addresses

If **Enable Amazon network options on this machine** is enabled on a blueprint, you can view the Elastic IP address used by a provisioned instance.

To view the Elastic IP Address assigned to an instance:

1. As a machine owner, click **Self-Service > My Machines**.
2. Point to a cloud machine and click **Edit**.
3. Click the **Network** tab.

### Managing Elastic Block Storage

To modify existing storage capacity for a provisioned instance:

1. As a machine owner, click **Self-Service > My Machines**.
2. Point to a cloud machine and click **Edit**.
3. Click the **Storage** tab. The number of GB attached and available is shown at the bottom.
4. Locate the volume you want to modify and click the **Edit** button.
5. For volumes you own that are not attached to other machines, you can change the following fields:
   - **Attached** — Check the box to attach the volume or clear the check box to detach it.
   - **Name**
   - **Description**

6. Click the **Save** button.
7. Click **OK** to submit the request.

To delete an EBS volume:
1. As a best practice, log in to the instance and unmount the volume before you delete it. This prevents the system from crashing and the data from being corrupted.
2. As a machine owner, click **Self-Service > My Machines**.
3. Point to a cloud machine and click **Edit**.
4. Go to the **Storage** tab.
5. Locate the volume you want to delete and click the **Delete** button.
6. Click **OK** to confirm.

To delete all EBS volumes when destroying a machine:
1. As a machine owner, click **Self-Service > My Machines**.
2. Point to a cloud machine and click **Destroy**.
3. Check the **Delete all attached EBS Volumes?** check box.
4. Click **OK** to confirm.

**Support User: Working on Behalf of Another User**

If you are a Support User or PGM, you can manage the machines of other users in your group, in addition to requesting machines for others.

Two activities are available for this purpose. The first is available to both Support Users and PGMs, the second to Support Users only.

- To list all machines owned by an individual member of the provisioning group(s) in which you are Support User or PGM so you can manage them, select **Self-Service > Support User** in the activity pane. Then select a user name from the **User** drop-down list (which includes all machine owners whose machines you can manage), or enter a user name, and press **Load**. Virtual Machines, Physical Machines, Expiring Machines, and Recent Events lists for the selected user are displayed.

- To list the machines owned by all members of the provisioning group(s) in which you are Support User so you can manage them, select **Self-Service > Support Group**.

**Note:** If you are both Support User and PGM, **Self-Service Support Group** does not appear in the activity pane; use **Provisioning Group Manager > Group Machines** to manage all provisioning group machines.
The available options for each machine are the same as those described in the preceding section for machine owners on the My Machines lists, except for **Expiration Reminder** which does not appear. The **Edit** option, however, allows a Support User to change the owner of a virtual or physical machine. This makes it possible to reassign the machine within the group. (While ownership of a machine can be passed to a user who is not a member of the provisioning group within which it was created, that user will have no access to the machine and will not be able to perform any operations on it unless she is also added to the provisioning group.) If the owner you specify is not a local user of the vCAC server, you must enter the user name in domain format, for example `VMware\JoeAdmin`.

The following two additional options may also be included, appearing only for virtual machines provisioned with XenDesktop integration.

**Register Virtual Desktop**: Register the virtual machine with the XenDesktop DDC server specified in its custom properties. (If the machine is already registered, this option has no effect.)

**Unregister Virtual Desktop and User**: Unregister the virtual machine from the XenDesktop DDC server specified in its custom properties.

**Note**: If a virtual machine was provisioned without XenDesktop integration but XenDesktop integration has since been added to the blueprint from which the machine was provisioned, the **Register/Unregister** options appear even though the machine is not registered and has never been registered with XenDesktop. The machine can be registered by adding XenDesktop integration directly to its custom properties.

You can perform some operations on more than one machine at the same time. For more information, see "Performing Operations on Multiple Machines," on page 116.

**PGM: Managing a Provisioning Group**

The managers in a provisioning group are responsible for:

- Working with Enterprise Administrators to plan and manage the reservations available to the group for machine provisioning
- Creating, selecting and managing the group’s blueprints, which are used by group members to request machines
- Approving or rejecting machine and lease extension requests from group members

PGMs can also manage all machines created by group members from group blueprints, including several options not available to machine owners who are not managers.

**Note**: More than one user can have the manager role in a provisioning group. There is no mechanism for directing particular decisions to particular managers. Each decision is made by whichever PGM first acts on the opportunity to make it, and actions taken by one manager cannot be rescinded by others.

**Managing Provisioning Group Machines**

To manage group machines, select **Provisioning Group Manager > Group Machines** in the activity pane. The Group Machines page that appears gives you access to all virtual, cloud and physical...
machines created from blueprints in the provisioning groups of which you are manager. (Note that this list do not include machines created by you from blueprints in groups of which you are not manager.)

**Using the Group Machines Lists**

Columns included in the Group Machines list includes the name of each machine and its status, type, owner and source blueprint, as well as the group it was provisioned in and the reservation it was provisioned on by default. The **Columns** control lets you select more fields to display, some of which do not apply to all types of machines.

You can sort and filter each column individually, and the **Filters** control lets you create and save complex filters. Filters applied to the list are always shown in the filter bar at the bottom. Changes you make in how a list is displayed persist from one view of the list to the next.

When a list of machines is filtered, the total number of machines displayed in the title bar changes to indicate the number of machines in the filtered display.

The **Export** drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx,.xls or CSV) or Microsoft Office Word (RTF) file. You can also request a machine from the My Machines page by clicking the **Request Machine** link at the right-hand end of the title bar.

**Group Physical Machine Categories**

Each physical machine reserved for a provisioning group is either **unprovisioned**, meaning there is no vCAC database entry for an operating system on it, or **managed**, meaning vCAC has a database entry for its operating system and can interact with it.

There are two types of unprovisioned machines in the Group Physical Machines list, indicated by a status of **Reserved** and a machine name of **Unknown**.

- **No operating system installed**
  
  An unprovisioned machine with no operating system installed can be selected for a group member’s provisioning request, or a PGM can provision it by using the **Provision** option. Once provisioned its status becomes **On** (or **Off** when powered off) and it is assigned a vCAC-generated machine name.

- **Operating system installed before being discovered by vCAC**
  
  An unprovisioned machine with an operating system can be selected for a group member’s provisioning request, or a PGM can provision it by using the **Provision** option. When such a machine is provisioned in vCAC in this way, *its existing operating system is lost along with all associated data*; its status becomes **On** or **Off** and it is assigned a vCAC-generated machine name.

  An unprovisioned machine with an operating system can also be imported with its operating system intact by a PGM by using the **Import** option. This brings the machine under vCAC management without provisioning it by naming it and assigning it to a blueprint and an owner. From that point on it can be managed like any other provisioned machine.

Managed machines are indicated by a status of **On** or **Off** and a machine name. The name of a managed machine typically indicates whether it was imported into or provisioned within vCAC.

**Note:** Except for Cisco UCS physical machines, it is not possible to distinguish between unprovisioned machines with and without operating systems within vCAC. Cisco UCS machines with an associated service profile can be imported
but not provisioned; Cisco UCS machines with no associated service profile can be provisioned but not imported.

**PGM Machine Options**

To perform operations on a machine, point to the machine name and select an option from the menu, or click the name to use the **Edit** option.

All owner machine options except **Expiration Reminder**, as discussed in "Managing Your Machines," on page 109, are available to PGMs, except the **Machine in Use** and **Machine Released for Reclamation** options and the **Extend Lease/Reactivate** options, which are replaced by **Change Lease**. The **Register Virtual Desktop** and **Unregister Virtual Desktop and User** (for virtual machines provisioned with XenDesktop integration) discussed in "Support User: Working on Behalf of Another User", earlier in this chapter, are also available.

**Edit (PGM)**: A PGM can use this option to change the owner of a machine. This makes it possible reassign the machine within the group. If the owner you specify is not a local user of the vCAC server, you must enter the user name in domain format, for example `VMware\JoeAdmin`.

A manager can also use the Edit Machine Record page to modify the machine’s description and to change, delete, or add to the machine’s custom properties.

The **Edit** option can also be used to display a cloud machine’s administrator password, which is needed to add the owner’s credentials to the machine.

In the case of an unprovisioned physical machine, a manager can modify all the settings inherited from its endpoint, including hardware details (**Data Center**, **Row** and **Rack**, as well as hardware custom properties), but cannot modify the cost profile. However, an unprovisioned machine does not have an owner, description, or machine custom properties to modify.

For a provisioned physical machine, a manager can modify the machine details (as with a virtual machine), but the hardware details and cost profile cannot be modified.

None of these changes affect the machine itself, however, but change only vCAC’s record of the machine (and in some cases the virtualization platform’s record of a virtual machine). The correct property value will be restored and the record corrected by the next data collection.

Click the **Save** button to save the property or the **Cancel** button to cancel it without saving changes. Properties you enter or modify are not saved until you save the machine record by clicking **OK**.

---

**Note:** Cost profiles are used together with the daily cost specified in a virtual or physical machine’s blueprint to calculate a machine’s total daily cost. This cost is used for reporting and chargeback purposes, and is also displayed to requesting users, to request approvers, and to Enterprise Administrators reclaiming unused virtual machines.

**Change Lease**: Change the expiration date of the machine, or change its lease from limited to indefinite or from indefinite to limited. When a user asks to extend a machine’s lease or reactivate a virtual machine, the PGM acts on the request using the Lease Extension Requests page. This option is used for manual changes initiated by the PGM.

You can use **Change Lease** to extend the lease of an active virtual or physical machine or to reactivate an archived virtual machine, either briefly to allow the owner to connect and retrieve data, or to restore it to use for a specified lease or indefinitely. The expiration date box for an expired machine will always be empty. Unlike approving a lease extension request, using **Change Lease** does not power an archived machine back on; it is no longer **Expired** but it remains **Off**.
To give a machine an indefinite lease (no expiration date), clear the **Expiration date** box. To specify the new expiration date (which cannot be in the past), enter the date or select it from the popup calendar.

You cannot change the archive period of an existing virtual machine. You can, however, change the archive period setting in a virtual blueprint to immediately change the archive period for all virtual machines created from that blueprint.

**Install Tools** (virtual only): Install virtualization platform tools on the virtual machine or update them if they are already installed. When a virtual machine is created, the virtualization platform that creates it may install management software on it. This software must be in place and up to date to maintain full control of the machine by the virtualization platform, and thus by vCAC through its proxy agents. If tools are not installed on a machine they should be installed by this method, and machines that exist when a new version of these tools becomes available may need to be updated by this method.

Using **Install Tools** is generally easier and faster than upgrading the tools on existing machines using the equivalent function within the virtualization platform. The tools installed by this option depend on the virtualization platform in use. It may be necessary to mount a tools CD from the appropriate vendor on the virtual machine.

**Reprovision** (PGM): This option is used to recreate a virtual machine or reprovision the guest OS of a physical machine according to the specifications in the blueprint. (The option is not available for cloud machines.) When you use it as PGM, you have the option of altering the specifications to which the machine is reprovisioned by changing the values of the machine’s custom properties or adding properties to the machine.

---

**Note:** Changes you make to a machine’s network-related properties during reprovisioning have no effect.

Please note the following characteristics of the reprovisioning operation:

- In general, the machine is reprovisioned according to the specifications in the blueprint, and therefore may be affected by changes in the blueprint since the machine was provisioned.
- Any custom properties of the machine that are not present in the current blueprint are retained. For example, if the blueprint contained properties for registration with XenDesktop but no longer does, the machine retains these properties on reprovision and is registered with XenDesktop.
- The expiration date of the machine does not change; if it was provisioned with a 60-day lease, and 20 days have passed, it will still have 40 days remaining following reprovisioning.
- The CPU, memory and storage specifications of the machine are not changed, regardless of changes in the blueprint.
- Changes to the machine made outside of vCAC and subsequently adjusted by data collection are **not** preserved. For example, if a virtual machine is provisioned with 2 CPUs and the number of CPUs is changed to 4 in the virtualization platform and subsequently updated in vCAC through data collection, the machine will be reprovisioned with 2 CPUs, not 4.
- Any properties added to the machine after provisioning by a PGM or Enterprise Administrator are applied to reprovisioning. If the PGM has added a property to the blueprint since provisioning, however, the blueprint value is used.
- Property values supplied by an approver are not preserved during reprovisioning.
- If a physical blueprint has been changed and the physical machine no longer matches it—for example, if the blueprint has been changed from a CPU count of exactly 2 to a CPU count of at
least 4, and the machine has 2 CPUs—the blueprint is ignored and the machine is reprovisioned despite the discrepancy.

**Caution:** Reprovisioning a machine destroys all data stored on the machine.

**Connect to Endpoint** (physical only): Opens a connection to the management interface of the physical machine.

**Provision** (unprovisioned physical only): Provision the selected **Reserved** physical machine. When you select this option, the Provision Physical Machine page is displayed, allowing you to select a physical blueprint for provisioning (as described in "Requesting a Machine", earlier in this chapter). The provisioning group it will be associated with is determined by the reservation it is in, so only blueprints from that group are displayed. When you confirm the operation, entering any needed information as described in "Requesting a Machine", the machine is provisioned and its status becomes **On**.

**Caution:** When a physical machine with an existing operating system is provisioned using the **Provision** option, the operating system is lost along with all associated data.

**Note:** The **Provision** option does not appear for an unprovisioned Cisco UCS physical machine with an associated service profile, indicating it has an existing operating system. To provision such a machine within vCAC, first use the **Import** option (below) and then use the **Reprovision** option to provision it according to the blueprint you associated it with on import.

When using the **Provision** option, provisioning proceeds even if the CPU count or memory of the selected machine do not match the specifications in the blueprint you chose.

**Import** (unprovisioned physical only): Use this option to bring a **Reserved** machine under vCAC management while retaining its current operating system. This function operates in the same way as the **Provision** option: the Import Physical Machine page is displayed, allowing you to select a physical blueprint to associate with the machine. The provisioning group it will be imported into is determined by the reservation it is in, so only blueprints from that group are displayed. When you provide a machine name and confirm the operation, the machine is imported with you as owner and its status becomes **Provisioned**.

**Note:** When a machine is imported, it is turned off.

The **Import** option does not appear for an unprovisioned Cisco UCS physical machine with no associated service profile.

If there is a mismatch between the imported machine and the blueprint you select, for example a different amount of memory or number of CPUs, the mismatch remains in effect (that is, the vCAC record of the machine differs from its actual specifications) until the machine is decommissioned.

**Join a Cluster** (hypervisor-provisioned physical machines only): Lets you join a physical machine provisioned with a hypervisor to an existing virtualization compute resource cluster known to vCAC. When you select this option, a dialog appears on which you can enter the information required for this operation, as described below. You may need to obtain this information from your Enterprise Administrator or vCAC administrator.
- **Endpoint**—Select the vSphere endpoint through which vCAC manages the virtualization compute resource (cluster) you want to add the machine to.

- **Cluster**—Once you have selected an endpoint, this drop-down list contains all clusters discovered in the vCenter Server instance by the most recent data collection from the selected endpoint. Select the one you want to add the machine to.

- **Compute resource user name/password**—Enter credentials for access to the ESXi or ESX instance on the machine (of sufficient privilege to allow vCAC to add the machine to the vCenter Server instance).

- **Compute resource IP address**—Enter the IP address of the hypervisor-provisioned machine.

- **Apply cluster compute resource profile**—If your site uses compute resource profiles in ESX Server clusters, you must select this option. If you do not, the machine could be added to the cluster without the same storage and network configurations as other cluster members, causing provisioning of virtual machines on the cluster to fail. If you select this option and there is no compute resource profile available on the cluster, the compute resource will be added in maintenance mode, without activation.

- **Leave compute resource in maintenance mode**—Add the compute resource to the cluster in maintenance mode, do not activate.

You can perform some operations on more than one machine at the same time. For more information, see "Performing Operations on Multiple Machines," on page 116.

### Assigning Elastic IP Addresses to a Cloud Machine

To assign an Elastic IP Address to an existing instance:

1. Click **Provisioning Group Manager > Group Machines**.
2. Point to a cloud machine and click **Edit**.
3. Go to the **Network** tab.
4. In the **Elastic IP address** list, select an address.
5. Click **OK**.

### Reviewing User Requests

PGMs are responsible for approving or rejecting two types of requests from provisioning group members:

- Requests for new machines created from locked blueprints
- Requests to modify the leases of existing machines—either to extend the lease of a virtual, cloud or physical machine or to reactivate an archived (expired) virtual machine

Managers are informed of requests from provisioning group members by email messages and are reminded by banners whenever they are logged into the vCAC Console. It is important that these requests be dealt with in a timely manner. Any manager in the group can act on any request.

To review machine requests, click **View Requests** in the reminder banner or select **Provisioning Group Manager > Machine Requests** in the activity pane; to review lease extension requests, click the banner or select **Provisioning Group Manager > Lease Extension Requests**. Each requests page
shows you all outstanding requests from all provisioning groups in which you are manager. You can act on some, all, or none of the requests; any you do not act on will remain on the page for the next time it is displayed by you or another manager.

When you reject a request, be sure to record the reason(s) in the Rejection Details box; the text you enter is provided to the requestor as an explanation of your decision.

Note: If there is more than one page of requests, you must press OK on each page to record the decisions you have made on that page before moving to another page.

The Machine Requests page shows you the locked blueprint the user wants to provision a machine from as well as the provisioning group within which the user made the request, the date of the request, and the user’s reason for making it (if she entered one). You can click the listed blueprint name to review and optionally modify the locked blueprint from which the user wants to create a machine. You can also click the View more information button (.) to review information about the specifications (CPU count, memory, storage, lease) of the requested machine as well as the values the user supplied for any custom properties for which he was prompted.

Note: If you are both a PGM and an approver, all machine requests awaiting your approval appear on both this page and the approver Machine Requests page regardless of whether you received the request as a member of an approval group or as a PGM.

The Lease Extension Requests page shows you the name of the machine to be extended or reactivated and the new expiration date proposed by the owner, as well as the user’s reason for the request. Point to the machine name and select Edit from the menu to review and optionally modify information about the machine.

Note: To avoid excessive email, you receive email about a lease extension request only if there are no such requests outstanding. Once there is at least one request in your list, you will not receive any more email about lease extension requests until you have dealt with all requests in the list.

You can select an approval policy for a blueprint that requires multiple approvals before the machine can be provisioned. If an Enterprise Administrator has included you in an approval group, your activity pane includes the Approvals entry, which displays a page very similar to the PGM’s Machines Request page. If you are an approver as well as PGM, and you choose an approval policy that includes your approval group and specifies PGM approval, you may receive the same machine request on both Machine Requests pages.

Note: As PGM, you do not need your own approval to build from a locked blueprint, but if the approval policy specifies other approvals you do need those.

Monitoring Provisioning Group Resource Usage

For a provisioning group’s members to provision a type of machine, the group must have at least one reservation of that type. Each virtual reservation represents provisioning resources—memory, storage, and specific maximum number of provisioned machine—on a specific virtualization compute resource. Each cloud reservation represents a region representing an Amazon Web Services (AWS) account,
optionally with a limit on the number of machines that can be provisioned from that reservation. Each physical reservation contains one or more physical machines to be provisioned by the group.

Enterprise Administrators manage reservations, but PGMs can help avoid provisioning failures by tracking overall resource usage by the provisioning group and alerting Enterprise Administrators when resources are running low.

**Understanding Reservation Selection and Capacity**

The selection of a reservation from which to provision a virtual, cloud or physical machine depends on a number of factors, including:

- The reservation policy specified in the blueprint, if any
- For virtual machines, whether the reservation’s location matches the location selected by the requesting user
- For cloud machines, whether the reservation’s region match the region of the Amazon Machine Image (AMI) specified in the blueprint and the location selected by the user
- The priorities of the available reservations
- Whether the reservation has provisioning capacity available and, if so, for virtual and physical machines the allocated percentage of each reservation’s machine quota (limit on the number of machines that can be provisioned from it)
- Whether the user requested provisioning in a non-VPC location or a subnet in a VPC
- Whether the security groups match
- For virtual machines, whether at least one storage path in the reservation has sufficient unused capacity to provision the machine

When a virtual reservation’s machine quota, memory or storage is fully allocated, no further virtual machines can be provisioned from it. In some situations, resources may be reserved beyond the physical capacity of a virtualization compute resource (overestimation) but when the physical capacity of a compute resource is 100% allocated, virtual machine provisioning from reservations on it cannot continue. When a cloud reservation has reached its machine quota, no further cloud machines can be provisioned on it. When a physical reservation’s machines are all provisioned, no further physical machines can be provisioned from it.

**Note:** In some circumstances, the reservation selected for provisioning may not meet requirements, and provisioning fails. Examples include cases in which no unprovisioned machine within the selected physical reservation matches the CPU and memory specifications in the blueprint, or when the selected cloud reservation is on an endpoint representing an account that does not contain the AMI specified in the blueprint.

**Monitoring Resource Usage**

Enterprise Administrators are responsible for managing virtualization compute resources, cloud endpoints, physical machines and reservations, and for identifying and reclaiming unused and underused machines, so that provisioning groups do not reach allocated or physical limits on provisioning.
As a PGM, however, you can help by monitoring your group’s resource usage. You can do this by selecting **Provisioning Group Manager > Provisioning Groups** from the activity pane to display the Provisioning Groups page.

This page is similar to one available to Enterprise Administrators for managing provisioning groups, but includes only provisioning groups of which you are manager and does not allow you to perform any operations on them. The page shows the following information for each group by default:

- The name of the group
- A description of the group
- The number of existing virtual machines provisioned on the group’s reservations by group members
- The percentage of the group’s total reserved virtual capacity that is currently allocated to virtual machines for machine quota (maximum number of machines that can be provisioned), memory and storage. (Total reserved virtual capacity is the sum of all of the group’s existing reservations on all virtualization compute resources.)

The final (**Total**) row aggregates the usage statistics for all provisioning groups, showing the total virtual machine quota, memory and storage allocated out of reserved capacity for all of your provisioning groups.

**Note:** Memory and machine quota statistics for virtual machines reflect only machines that are currently turned on, but storage statistics reflect all existing virtual machines, regardless of their state.

You can sort and filter individual columns and change the included columns using the **Columns** control and create complex filters using the **Filters** control.

Additional **virtual** columns available include:

- The total storage used by the group
- The storage used by the group as a percentage of reserved storage.

**Physical** columns available include

- The total of all physical machines reserved for the group
- The percentage of total machines that are provisioned and under vCAC management
- The percentage of total reserved quota that is provisioned and under vCAC management

**Cloud** columns available include

- The number of existing cloud machines provisioned on the group’s reservations by group members
- The percentage of the group’s total reserved cloud machine quota that is currently allocated to cloud machines. (Total reserved machine quota is the sum of all of the group’s existing reservations on all cloud endpoints.)

These additional columns are also totaled for all provisioning groups in the final row.

Changes you make in the list display persist from one view of the list to the next.
The **Export** drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx,.xls or CSV) or Microsoft Office Word (RTF) file.

The menu for each listed group provides the **View Machines** option, which displays the Group Machines page, filtered for the selected provisioning group. The list of machines displayed can be further filtered, for instance for machines with very low average disk, memory or CPU utilization, which might indicate that they are inactive.

**Note:** You can also monitor group resource usage by reviewing such reports as **Capacity Usage > Capacity by Group** and **Provisioning Group Capacity Exception**.

### Managing Provisioning Group Blueprints

To provision a virtual, cloud or physical machine, the machine requestor must select a blueprint. A blueprint is the detailed specification for

- A particular type of virtual machine (for example, a Windows XP Professional developer workstation with one CPU, 2 GB of memory and a 30 GB hard disk), cloud machine (a RedHat Linux web server AMI in a Small instance type with 1 CPU, 2 GB of memory and 160 GB of storage), or physical machine with installed OS (for example, Windows Server 2008 R2 installed on a server with exactly two CPUs and at least 4 GB of memory).

- The policies that apply to the machine such as which approvals are required to provision it, the length of its lease, and which operations its owner can perform on it.

- The workflow used to provision the machine, as well as the names and locations of any disk images or other non vCAC objects required to provision using that workflow.

Creating and managing provisioning group blueprints is a critical PGM responsibility. Without appropriate blueprints, users cannot request the machines they need. At the same time, effective blueprint management is needed to successfully operate within the constraints of the group’s reservations. Advance planning, full cooperation with the Enterprise Administrator who is responsible for creating and maintaining reservations, and careful consideration before making changes to existing blueprints or adding new ones are very important to support the machine needs of provisioning group members.

This section discusses blueprints generally.

- Provisioning by cloning, including static IP address assignment
- WIM-based provisioning
- Linux kickstart/autoYaST provisioning
- SCCM-based provisioning
- PXE-based provisioning
- Amazon EC2 provisioning
- Virtual desktop infrastructure integration, for example with XenDesktop
- External provisioning infrastructure integration, for example with Citrix Provisioning Server
- Calling Visual Basic scripts from a blueprint
• Provisioning using the basic workflow

**Blueprint Types**

A single blueprint can be used to provision one and only one of the following types of machines:

- virtual
- Amazon EC2 cloud
- physical, with one of the following hardware management interfaces:
  - HP iLO
  - Dell iDRAC physical
  - Cisco UCS Manager physical

The various types of blueprint are similar but there are some significant differences:

- Virtual blueprints can specify an archive period, during which an expired machine remains available for reactivation (instead of immediately being destroyed). Cloud and physical machines cannot be archived but rather are always destroyed or decommissioned immediately upon expiration, so cloud and physical blueprints do not have this setting.

- Virtual blueprints provide a choice of provisioning by creating and provisioning by cloning. Cloud and physical blueprints cannot provision by cloning.

- Virtual and cloud blueprints specify an amount of storage to be allocated to the virtual machine. Physical blueprints do not, as vCAC does not collect data about the storage associated with available physical machines, which in any case can be changed at any time after provisioning.

- Virtual and physical blueprints can optionally give the requesting user a range of values to choose from for machine specifications—CPUs, memory, and storage (virtual only). In cloud blueprints, these specifications are determined by the instance type to be used; the requesting user can optionally be given a choice of instance types.

- Physical blueprints add a resource matching field to the CPU and memory specifications to aid in selecting an appropriate machine for provisioning. Virtual and cloud machines are provisioned with exactly the specifications provided; a physical machine is selected for provisioning based on whether its CPU count and memory exactly match or are at least as much as the blueprint specifications, depending on the resource matching selection for each specification.

When a user requests a machine, all blueprints in each provisioning group to which a user belongs are displayed together.

**Local and Global Blueprints**

PGMs determine which blueprints are available to the group’s members for provisioning machines. They can make a blueprint available in one of two ways: by creating a *local* blueprint, or by selecting a *global* blueprint created by an Enterprise Administrator.

All global blueprints can be listed by any PGM. To select a global blueprint for a provisioning group, the PGM edits the blueprint and selects the desired group in the Groups box (this is the only setting a PGM can change). If the Enterprise Administrator set the global blueprint as copyable, the PGM can also copy it to create a new local blueprint.
PGMs cannot modify or delete global blueprints. Users who are both Enterprise Administrator and PGMs can create and modify both global and local blueprints.

**Custom Properties in Machine Provisioning, Blueprints and Build Profiles**

*Custom properties* are name-value pairs used to specify attributes of a machine or to override default specifications; these attributes are also entered in the machine’s record in the vCAC database. Different custom properties are used for different provisioning methods, types of machines, and machine options. For example, custom properties can be used to:

- Specify a particular type of guest OS, for instance Windows 7 64-bit
- Enable WIM-based provisioning, in which a Windows Imaging File Format (WIM) image of a reference machine is used to provision new machines
- Customize the behavior of Remote Desktop Protocol when connecting to a machine
- Register a virtual machine with a XenDesktop Desktop Delivery Controller (DDC) server
- Customize a virtual machine’s system specifications, such as adding multiple hard disk drives
- Customize a machine’s guest OS, for instance by including specified users in selected local groups
- Enable cleanup of a machine’s Active Directory account after it is destroyed

**Sources of a Machine’s Custom Properties**

Custom properties can be added to the following elements to be applied to provisioned machines:

- A reservation, to apply them to all machines provisioned from that reservation
- A provisioning group, to apply them to all machines provisioned by provisioning group members
- A global or local blueprint, to apply them to all machines provisioned from the blueprint
- Build profiles, which can be incorporated into any global or local blueprint, to apply them to all machines provisioned from the blueprint
- A machine request, if you are an Enterprise Administrator or PGM, to apply them to that machine
- The applicable approval policy, if any (and if advanced approval support is enabled), to require approvers to provide the values to be applied to the machine being approved

When the same property exists in more than one source, a specific order is followed to override property when applying to the machine in the following order with the latter taking precedence:

- Build Profile
- Blueprint
- Provisioning Group
- Compute Resource
- Reservations
• Endpoint

• Runtime

**Build Profile/Blueprint Hierarchy**

Custom properties in reservations and provisioning groups may be applied to many machines so they should be used carefully. Their use is typically limited to purposes related to their sources, such as resource management, line of business accounting, and so on. Specifying the characteristics of the machine to be provisioned is generally done by adding properties to blueprints and build profiles.

Each blueprint of any type can optionally incorporate one build profile and thereby inherit the custom properties in that profile. Build profiles are especially useful for applying common sets of properties for specific purposes to a wide range of blueprints. For example, your site might want to add a second disk to, customize RDP behavior for, and enable AD cleanup for a wide variety of machines. If a build profile with the necessary properties is created, it can be incorporated into all of your blueprints, local or global.

---

**Note:** When creating and managing build profiles, Enterprise Administrators can load a number of predefined property sets provided by vCAC to add several related properties all at once, instead of one by one.

---

**Viewing Build Profiles**

PGMs cannot modify or create profiles, but they can examine existing profiles in two ways.

- Select **Provisioning Group Manager > Build Profiles** in the activity pane to display a list of build profiles, then click an individual profile to view its contents.

- When editing or creating a blueprint, click the **View more information** button (🔍) next to the **Build profile** drop-down list on the Build Information tab to examine the currently selected profile (as described in the next section).

**Viewing, Deleting and Editing Blueprints**

For a list of existing local and global blueprints, select **Provisioning Group Manager > Blueprints** in the activity pane.

Global and local blueprints are distinguished by their icons and by **Yes** in the **Global** column. All global blueprints are displayed regardless of whether they are selected for local groups. Blueprints that require approval before a machine can be provisioned (that is, that specify an approval policy) are marked with a locked icon (🔒). Blueprints that can be copied when you are creating a new blueprint are indicated by **Yes** in the **Copyable** column.

You can sort and filter individual columns and change the included columns using the **Columns** control as described in "Elements of the vCAC Console", earlier in this chapter. Changes you make in the list display persist from one view of the list to the next.

The **Export** drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file.

The menu for each listed blueprint provides several options. (You can also click the blueprint to use the **Edit** option).

**Edit:** Edit the selected blueprint.
**Delete**: Delete the selected blueprint. You cannot delete a global blueprint unless you are an Enterprise Administrator. You cannot delete a global or local blueprint if machines provisioned from it exist.

To prevent further machine requests from a blueprint so that you can delete it when all machines built from it have been disposed of:

- In a local blueprint, clear the **Enabled** check box on the Blueprint Information tab as described below to prevent further requests within the provisioning group.

- In a global blueprint,
  - Clear the blueprint from a provisioning group in the **Groups** box on the Blueprint Information tab as described below to prevent further requests within that provisioning group.
  - Clear the **Enabled** check box to prevent further requests from any provisioning group.

**Request Machine**: Request a new machine from the selected blueprint. (As PGM, you do not need your own approval to build from a locked blueprint, but if the approval policy specifies other approvals you do need those.)

**View Machines**: Display the Group Machines page.

### Selecting a Global Blueprint

When you list virtual or physical blueprints, all existing global blueprints (indicated by the global icon, ![global icon]) are included in the displayed list. To select one for your provisioning group(s), edit the blueprint and check the groups you want to select it for in the **Groups** box on the Blueprint Information tab. When you return to the blueprints list you will note that the groups you selected appear in the **Groups** column for the blueprint. Members of the selected groups now have access to the global blueprint.

You can unselect a global blueprint from a provisioning group, even if machines provisioned from it within the group still exist, to prevent further machine requests within that provisioning group. Existing machines can still be managed and reprovisioned even when the blueprint they were provisioned from is unselected.

### Blueprint Settings

This section describes the general use of blueprint settings. Differences between settings for different types of blueprints are noted.

When you edit an existing local blueprint, you can change all of its settings. Only settings on the Security tab can be optionally applied to machines previously provisioned from the blueprint; others apply only to machines built after the blueprint was modified.

When you edit a global blueprint, the only change you can make (unless you are also an Enterprise Administrator) is to select or clear the blueprint for any of the provisioning groups of which you are manager.

**Note**: When a machine’s owner chooses the **Reprovision** option, the machine is recreated according to the specifications in the blueprint (with some exceptions), and therefore may be affected by changes in the blueprint since the machine was provisioned.

The virtualization platforms supported by vCAC—VMware ESX servers within vCenter Server instances, XenServers, Hyper-V servers, and Hyper-V servers with SCVMM instances—place varying limits on machine specifications (such
The settings for each blueprint are divided into four tabs.

The Blueprint Information tab contains management information and settings, which except for Archive are the same for all types of blueprints. They include:

- The name and description of the blueprint. Blueprint names must be unique across a vCAC site.
- Optional display icons are available on the Blueprint Information tab in the vCAC console for use by the vCAC Administrator. The display icons are intended to identify what the machine is, for example, Windows Server 2008 R2, Red Hat Linux web server, Database machine, or load balancer. You can use the icons provided or upload your own. The icon must be either a .png (preferred) or .gif and it must be 32x32 pixels. You can use the combination of the icons and the name of the blueprint to differentiate machine types and functions.
- Whether the blueprint is a global or local blueprint. If you are a PGM you can select but not create a global blueprint; if you are Enterprise Administrator only, you can create and edit only global blueprints. Users who are both PGM and Enterprise Administrator can choose whether to create a global or local blueprint, and can toggle a given blueprint between global and local.
- The provisioning group a local blueprint belongs to, or the provisioning groups a global blueprint is selected for. You can assign a local blueprint only to a provisioning group of which you are PGM, and to just one group. You can select a global blueprint for any combination of the groups of which you are manager.
- The machine prefix used to generate names for machines created from the blueprint. Prefixes are base names to which numbers are appended in sequence, and are created and managed by Enterprise Administrators. Use default prefix, to use the provisioning group’s default prefix, is always selected by default when a blueprint is created, but a different prefix can be selected using the drop-down list at any time.

**Note:** For a global blueprint, Use default prefix results in use of the default prefix of the provisioning group the blueprint was selected from. For example, suppose a global blueprint has been selected by the managers of pgroup1, pgroup2 and pgroup3. If a user who is a member of all three groups selects the blueprint on the Request Machine page by expanding pgroup1, it uses pgroup1’s default prefix for the resulting request; if by expanding pgroup2, it uses pgroup2’s default prefix; and so on.

- The reservation policy from which the reservation on which to provision machines from the blueprint must be selected. Reservation policies are collections of virtual, cloud or physical reservations maintained by Enterprise Administrators; they are often used to group like resources to create defined service levels or make a specific type of resource (for example, NetApp Flex-Clone-enabled storage devices) easily available for a particular purpose. When a user requests a machine from a blueprint with a reservation policy selected, provisioning must be on a reservation associated with that reservation policy. Provisioning will fail if:
• The reservation policy does not include a reservation belonging to the provisioning group from which the user selected the blueprint

• None of the provisioning group’s reservations included in the reservation policy matches other criteria and has sufficient unallocated resources to provision the machine

Note: A reservation policy can include reservations of different types, but only reservations matching the blueprint type are considered for provisioning.

Ask an Enterprise Administrator for information about reservation policies available within your vCAC site.

Note: You can see which blueprints have a particular reservation policy selected by adding the optional Reservation Policy column to the Blueprints page, then sorting or filtering that column.

If the specified service profile template is not found in the Cisco UCS Manager instance managing the machine selected for provisioning, provisioning fails. For this reason, VMware recommends using reservation policies to restrict provisioning of Cisco UCS physical machines from a particular blueprint to reservations on endpoints on which the selected service profile and boot policy are available. The endpoint on which each template is available is shown in the Service profile template drop-down list (a template may exist on more than one endpoint); this allows you to identify appropriate reservations for the blueprint.

• The approval policy determining whose approval is needed to provision a machine from the blueprint. Approval policies are created and maintained by Enterprise Administrators, but as PGM you always have at least two choices: No Approval and Default Approval. When you select the latter, only PGM approval is required for basic and Support Users, and PGMs do not need approval.

For basic information about the approval policy you have selected, click the View more information button ( ) to the right of the drop-down list. If you need more detailed information about approval policies, consult an Enterprise Administrator.

• The Enabled check box, which makes the blueprint available for machine requests. This box can be unchecked to prevent further machine requests in preparation for deleting a blueprint.

• The Master check box, which indicates that the blueprint can be copied when creating new blueprints.

• The Display location on request check box, which is used to allow the requesting user to select a particular location at which to provision the machine. Note that a provisioning group manager can select a particular location even when the check box is not selected.

• For virtual blueprints, this feature is optional, and requires that
  • at least one location has been added to the vCAC location file
  • at least one virtualization compute resource is associated with a location in the file; all reservations on a compute resource are associated with its location
Location selections available to the user are determined by the location file. If the user selects a location and there is no virtual reservation with sufficient available capacity to provision the virtual machine on a compute resource associated with the selected location, provisioning fails.

- For cloud provisioning, this feature is required. The Amazon Machine Image (AMI) specified in the blueprint is contained in a particular region of an AWS account, and the location selections available to the user represent the availability zones within that region. If there is no cloud reservation with available machine quota with the corresponding region and location, provisioning fails.

- The maximum number of machines built from the blueprint that any single user can own at one time. (This is a limit on the number of simultaneous machines from the blueprint per user, not on total lifetime machines from the blueprint.)

- The length of the archive period (in days) during which an expired virtual machine provisioned from the blueprint will remain available for reactivation before it is destroyed. If you specify 0, virtual machines will be destroyed immediately after they expire. This setting is not included in cloud or physical blueprints.

The Build Information tab contains settings that specify how the machine is to be provisioned. There are significant differences between the various types of blueprint; settings not shared by all three are indicated. They include

- Whether the machine is to be identified as a server or workstation for licensing, integration and record-keeping purposes.

- In physical blueprints a third selection, Hypervisor, lets you indicate that the machine is to be provisioned with a hypervisor. This requires an indefinite lease for the machine, enables the Join a Cluster option for the machine and requires extra confirmation of other operations on the machine that would disrupt virtual machine provisioning and management, such as powering it on and off, reprovisioning it, destroying it and so on.

- Whether the virtual machine is to be created using only the information in the blueprint and incorporated build profiles (if any), or cloned from a template object outside vCAC. Cloud and physical machines cannot be cloned and are always created.

- The provisioning workflow to be used.
  - When Create is selected in a virtual blueprint, choose
    - WIMImageWorkflow for WIM-based provisioning
    - LinuxKickstartWorkflow for kickstart/autoYaST provisioning
    - VirtualSccmProvisioningWorkflow for SCCM-based provisioning
    - ExternalProvisioningWorkflow for external provisioning services
    - BasicVmWorkflow to provision machines with no guest operating system
  - When Clone is selected in a virtual blueprint, the CloneWorkflow workflow is selected.
  - In a cloud blueprint, CloudProvisioningWorkflow is selected.
  - When the hardware type is HP iLO or Dell iDRAC for a physical blueprint, choose
    - PhysicalProvisioningWorkflow for WIM-based or kickstart/autoYaST provisioning
• **PhysicalSccmProvisioningWorkflow** for SCCM-based provisioning

• **PhysicalSccmPxeProvisioningWorkflow** for PXE-based provisioning using an SCCM task sequence.

• **PhysicalPxeProvisioningWorkflow** for PXE-based provisioning using another method.

• When the hardware type is **Cisco UCS Manager** for a physical blueprint, select either **PhysicalSccmPxeProvisioningWorkflow** or **PhysicalPxeProvisioningWorkflow** as described above.

• The AMI on which the cloud machine will be based. Use the button next to the Amazon AMI field to review and select from among all AMIs discovered within the region. This may include numerous AMIs; you can use the column filter boxes, Columns control, and Filter control, as described in Elements of the vCAC Console, to narrow the list down before selecting an AMI.

• The AMI specified in the blueprint is contained in a particular region of an AWS account, and the location selections available to the user represent the availability zones within that region. If there is no cloud reservation with available machine quota matching the AMI’s region and the user’s location selection, provisioning fails.

**Note:** Due to a limitation in Amazon EC2, the platform name column in the AMI list does not provide platform information for non-Windows AMIs.

• The Amazon instance types that can be applied to the specified AMI to create a cloud machine. Available instance types are managed by your vCAC administrator. If you select only one, that instance type will be used; if you select more than one, the user can choose from among them.

**Note:** For provisioning to succeed, the AMI and instance type specified in the provisioning request must be a valid combination within EC2. vCAC does not validate the combination. Use a reservation policy to increase the probability of success.

• If the hardware type is **Cisco UCS Manager** for a physical blueprint, the service profile template and boot policy to be used. The available choices represent all of the service profiles discovered on all existing Cisco UCS Manager endpoints.

**Note:** If the specified service profile template is not found in the Cisco UCS Manager instance managing the machine selected for provisioning, provisioning fails. For this reason, it is recommended to restrict provisioning of Cisco UCS physical machines from a particular blueprint to reservations on endpoints on which the selected service profile and boot policy are available. The endpoint on which each template is available is shown in the Service profile template drop-down list (a template may exist on more than one endpoint); this allows you to identify appropriate reservations for the blueprint.

• If SCVMM is selected with the Create action, it is possible to select the virtual hard disk, hardware profile and ISO that can be attached to a machine at creation time.

• The minimum and optionally maximum memory, CPU count, and storage specifications for the machine.
• In **virtual** blueprints, the memory, CPU count and storage specifications determine the resources allocated to the virtual machine. If you supply a maximum, the machine requestor can optionally increase the specification up to that limit. (An exception is the Reserved storage specification for cloning blueprints, which has a Minimum counter only.)

• In **cloud** blueprints, the minimums and maximums are determined by the specifications of the instance types you selected and cannot be changed. The machine’s specifications are determined by the requesting user’s choice of instance type.

• In **physical** blueprints, the **# CPUs** and **Memory** specifications have an additional **Resource matching** drop-down list. Choose **Exactly** to require that the machine selected for provisioning exactly matches the specification you provide, or the requestor provides if you set a range. Choose **At least** to require that the selected machine have at least as many CPUs or as much memory as specified by you or the requesting user. (Physical blueprints do not specify an amount of storage for the machine, as vCAC does not collect data about the storage associated with available physical machines, which in any case can be changed at any time after provisioning.)

For example, suppose the CPU specification in a physical blueprint has a minimum of 1 and a maximum of 4 and a resource matching setting of **At least**. If the user accepts the minimum of 1 CPU, any physical machine is eligible to be provisioned; if she selects 4, only machines with 4 or more CPUs can be provisioned. On the other hand, if the setting is **Exactly**, eligibility is limited to machines with exactly the number of CPUs the user chooses.

**Note:** Maximum values for the counters are 256 CPUs, 2 TB (2 million MB) of memory and 2 PB (2 million GB) of storage.

• The length of the machine’s lease (time until it expires) in days. A blank **Lease (days)** setting means no expiration date. As with the machine specifications, you can set a maximum to allow the requesting user to increase lease length up to that figure and an approval threshold above which the machine will require approval (if an approval policy is set on the Blueprint Information tab).

**Note:** Selecting **Hypervisor** in the **Blueprint type** drop-down list makes the lease length setting unavailable, locking it to an indefinite lease (no expiration date).

The calendar control used to set the lease length does not actually set the selected date as expiration date. Rather, it calculates the number of days between the current date and the date you select, and sets this number of days as the length of the lease. The lease begins when the machine request is completed, even if required approvals delay provisioning of the machine until a later date.

The maximum possible lease is for 274 years (one hundred thousand days).

• For all types of blueprint, if you selected an approval policy on the Blueprint Information tab and specified one or more maximum specifications, you can set approval thresholds using the **Approval at** counters. When a user requests a machine from this blueprint with one or more specifications set at or above the corresponding approval threshold, the request requires approval. If a blueprint has an approval policy and any resource has both a minimum and maximum value and no approval threshold, approval is always required. The instructions that appear on the Confirm Machine Request Page when a user requests a machine from the blueprint reflect the combination of minimums, maximums, and approval thresholds you choose.
• If the virtual machine is to be cloned, identifiers for the object from which it is to be cloned (for example, a template in vCenter Server) and the customization object providing SysPrep information (a customization specification in vCenter Server).

When cloning Windows machines in vCenter Server, a customization specification is not required unless you are cloning with static IP addresses, but you cannot perform any customization of cloned machines without it. SCVMM uses Guest OS Profiles for Windows, but vCAC does not support static IP addresses with Windows and SCVMM. If you are cloning Linux machines, you can customize the clones using a customization specification or scripts, or even both methods together.

• A daily cost for the blueprint. For virtual and physical machines, this is used together with the cost profiles associated with the compute resource and storage path on which the virtual machine is provisioned or with the physical machine being provisioned to calculate the machine’s daily total cost. For cloud machines this setting is the sole determinant of daily cost. This cost is used for reporting and charge-back purposes and is also displayed to requesting users, approvers, and Enterprise Administrators reclaiming unused resources.

**Note:** Each cost profile contains a compute resource cost, charged per GB of memory, a cost per GB of storage, and a cost per CPU. Only the compute resource and CPU costs are applied to physical machines, however, as vCAC does not collect data about the storage associated with physical machines, and only the blueprint cost is applied to cloud machines. For this reason physical and cloud machine costs can appear considerably lower than virtual machine costs. You may want to use the daily cost in physical blueprints to more accurately reflect the cost of cloud and physical machines, as well as maintaining separate cost profiles for virtualization compute resources and physical machines.

The Properties tab contains

• The build profiles to be incorporated, if any. Select a profile and click the View more information button (🔍) to review its contents.

• Any optional custom properties to be used;

**Note:** Custom properties can be used to activate custom state change workflows you have added to machine provisioning using vCAC Designer.

When entering custom properties, always ensure that property values do not contain trailing spaces, as these may cause provisioning to fail.

The Security tab contains access settings, including:

• The user names of the group members who can request machines from the blueprint, or on whose behalf machines can be requested by Support Users; if no user names are specified, the entire group can own machines provisioned from the blueprint.

**Note:** This setting is not available in global blueprints; once selected for a provisioning group, a global blueprint is always available to any member of the group.

A support request cannot assign ownership of a machine to a user who is not among the specified users on the Security tab, either when requesting a machine or using the Edit option.
If a PGM is not among the specified users, he can still request a machine from the blueprint by selecting the Request Machine option for the blueprint on the Blueprints page.

- The machine operations that will be available to owners of machines created from the blueprint, including various power cycle options, reprovisioning the machine, expiring and destroying the machine, and joining a physical machine provisioned with a hypervisor (VMware ESXi or ESX) to a virtualization compute resource cluster (these can be selected and unselected individually). The power cycle options available depend on the type of blueprint. These selections for available machine menu operations also apply to machines previously provisioned from the blueprint.

**Note:** Customized operations you have added to the machine menu using vCAC Designer automatically appear on the Security tab, and must be selected like other operations to be made available to the user.

Support users always have access to all operations, including those not selected on the Security tab, both for their own machines and while working on behalf of other users. PGMs always have access to all operations.

### Creating a Blueprint

To create a blueprint, select Provisioning Group > Blueprints in the activity pane, move the pointer over the New Blueprint link at the right-hand end of the title bar, and choose Virtual, Physical, or Cloud, followed by the platform type or hardware type. If you are creating more than one blueprint for similar purposes, remember that you can always copy a Master blueprint to begin a new one.

**Note:** Users who are both Enterprise Administrator and PGM can choose whether to create a global or a local blueprint, and can select a global blueprint for one or more provisioning groups while creating it.

Settings marked with a red asterisk are mandatory, and some of these do not have defaults and therefore must be specified by the blueprint creator, including name, archive and lease length, hardware type, machine specifications, and AMI and instance types.

To begin by copying the settings of an existing blueprint, use the Copy from existing machine blueprint drop-down list to select from among all available master blueprints of the correct type, both local and global. If you are an Enterprise Administrator as well as PGM, you can copy a global blueprint to create another global blueprint; if you are not, you can create only a local blueprint, even if the blueprint you are copying is global.

Copying from an existing master copies all the settings you need to create the blueprint except the name, but it is a good idea to review all three tabs before saving. If you are a manager of more than one provisioning group, you can create a blueprint in one group by copying a master in another—just remember to change the Group setting.

Remember that a useful name and description are very important to machine requestors. Your site may have required naming conventions.

Although the selected provisioning group’s default machine prefix is selected in the Machine prefix drop-down list by default, you can always select a different prefix using the drop-down list when creating or editing a blueprint.
Access Control: Managing Group Membership

An Access Administrator can modify the membership of any provisioning group, but only the membership; other group settings can be changed only by an Enterprise Administrator. Access Administrators must be designated by a vCAC administrator.

To view and modify provisioning group membership as an Access Administrator, select Access Control in the activity pane. The page that appears lists all groups within your vCAC site. Select a group to display its settings; those other than membership are locked.

Current PGM, Support User, and basic user memberships are shown; you can remove and add users as desired. A group can have more than one manager, and a user can be manager of more than one group. Any changes you make are reflected immediately; for example, if you change a member’s role from manager to user, she immediately loses access to the PGM activities (such as managing blueprints and approving requests) for that group, and this change is immediately reflected in her console if she is currently using vCAC.

Note: When specifying users for any authorization purpose within vCAC, you can always specify groups as well as individual users.

Approver: Approving Machine Requests

If an Enterprise Administrator has included you in an approval group, your activity pane includes the Approvals entry. Select this to see a list of machine requests awaiting your approval.

You are always informed of a new request by email (assuming the needed email aliases have been arranged) but it is important to check this list regularly in any case, as approval requests should be dealt with in a timely manner.

The Machine Requests page shows you the locked blueprint the user wants to provision a machine from as well as the provisioning group it belongs to, the date of the request, and the user’s reason for making the request (if she entered one). You can also click the View more information button (.) to review information about the specifications (CPU count, memory, storage, lease length) of the requested machine as well as custom property values supplied by the requesting user or by prior approvers (if advanced approval support is enabled).

You can act on some, all, or none of the requests in your list; any you do not act on will remain in the list until approved or rejected by another approver in the group.

When you reject a request, be sure to explain your decision to the requestor in the Rejection Details box; the text you enter is provided to the requestor as an explanation of your decision.

Note: If there is more than one page of requests, you must press OK on each page to record the decisions you have made on that page before moving to another page.

If advanced approval support is enabled, you may be required to provide a value for one or more of the machine’s custom properties. Typically, the property you are prompted for already has a value provided by the blueprint or the requesting user, which appears as the default in the prompt.

Advanced approval support also allows approvals to be scheduled after the requested machine is provisioned. If you have the needed authorization within vCAC, this allows you to directly examine the provisioned machine before giving your approval.
Approval groups can contain more than one user, but just one approval is needed from each approval group. A request may appear in your list and then be removed before you have acted on it because another member of your approval group approved it.

If advanced approval support is enabled, you can at any time temporarily or indefinitely designate one or more delegates for each approval group you belong to. To do so, click the edit icon next to the approval group name and enter (or remove) one or more user names. (Be sure to use the domain format, for example VMware\Joe.Admin.) The users you designate become approvers and receive all requests that come to you, in effect becoming members of the approval group. A delegate may approve or reject a request before you review it, in which case you will never see it.

**Note:** Unless a delegate you designate is added to the email address or alias specified for the approval group, she will not receive automatic emails about approval requests.

Approval policies can contain more than one approval group, and when an approval policy is selected for a blueprint, approvals from all the groups in the policy are required, in the specified order. Therefore, if you belong to more than one approval group in the same policy, a request may reappear in your list after it was removed when you or another member of an earlier group approved it.

If you are both a PGM and an approver, all machine requests awaiting your approval appear on both this page and the Group Manager Machine Requests page, regardless of whether you received the request as a member of an approval group or as a PGM.
Enterprise Administrator: Managing vCAC Resources

Enterprise Administrators manage the resources provisioning groups rely on to provision and manage machines. Enterprise Administrators may also be administrators of the virtualization platforms, cloud service accounts, and physical machines with which vCAC interacts, and are responsible for setting up and managing the infrastructure that corresponds to the infrastructure of the vCAC site. Enterprise Administrators have a number of responsibilities, including

- Creating and manages provisioning groups, including both membership and settings.
- Managing enterprise group virtualization compute resources and cloud endpoints as well as available physical machines, assigning virtual, cloud and physical reservations to provisioning groups, and sorting those reservations into reservation policies.
- Managing cloud and virtual machines provisioned on enterprise group compute resources and endpoints, as well as physical machines, and identifying cloud and virtual machines that may be unused or underused for reclamation.
- Creating and managing global elements including build profiles and global blueprints, approval groups and policies, machine prefixes, network profiles and cost profiles.

Managing Enterprise Machines

An Enterprise Administrator can manage all virtual machines provisioned on virtualization compute resources in the enterprise group, all cloud machines provisioned on endpoints in the enterprise group, and all available physical machines, whether reserved, reserved and managed (provisioned within vCAC).

Understanding Enterprise Machine Management

It is important for Enterprise Administrators to understand which machines they can manage. The situation is different in regard to virtual and cloud machines on the one hand and physical machines on the other.

Enterprise Virtual and Cloud Machines

Within vCAC, virtualization compute resources and cloud endpoints are independent of provisioning groups. Each Enterprise Administrator can manage only those compute resources and endpoints in her own enterprise groups, including creating reservations on them. But any Enterprise Administrator can assign a reservation to any provisioning group.

A provisioning group can have one or more reservations on any compute resource or endpoint, and any compute resource or endpoint can have reservations for one or more provisioning groups. The relationship between enterprise groups and provisioning groups varies accordingly.

Enterprise Administrators and PGMs manage different sets of virtual and cloud machines, performing different operations on them. A PGM manages all virtual and cloud machines provisioned within her provisioning groups, but an Enterprise Administrator manages virtual machines provisioned on compute resources in her enterprise groups and cloud machines provisioned on endpoints in her enterprise groups. Therefore the intersection between the set of virtual and cloud machines that a PGM manages and those an Enterprise Administrator manages depends on the reservation relationship between the enterprise groups and provisioning groups involved.

vCAC collects data from compute resources and endpoints on a regular basis, so its information about virtual and cloud machines provisioned on the compute resources and endpoints in each enterprise
group is generally up to date. To make sure it is fully up to date, you can use the Data Collection option for an individual compute resource or endpoint.

**Note:** Data collection from virtualization compute resources detects unmanaged (provisioned outside vCAC) virtual machines on those compute resources, but data collection from cloud endpoints does not collect any information about cloud machines in the account that were not provisioned by vCAC.

**Enterprise Physical Machines**

The basis on which Enterprise Administrators manage physical machines is simpler—all Enterprise Administrators manage all physical machines available within the vCAC instance.

Each physical machine available for reservation and provisioning is associated with an endpoint. For physical machines, an endpoint consists of a specific address and credentials used to interact with a management interface. Once a vCAC administrator adds an endpoint, vCAC collects data about the machines it can discover using this information and updates that data at regular intervals.

Any Enterprise Administrator can create a physical reservation for any provisioning group, and at any time can add any unreserved machine to any reservation (a machine can be in only one reservation at a time) or move an unprovisioned machine between reservations or out of the reservation it is in. But all Enterprise Administrators can always manage all physical machines. This is shown in the following illustration.

All physical machines listed on the Enterprise Machines page are either unprovisioned, meaning the machine has been discovered but there is no vCAC database entry for an operating system on it, or managed, meaning vCAC has a database entry for its OS and associated information.

When a physical machine is discovered by data collection from the endpoint representing it, it may or may not have an existing operating system. Both types of machine have a status of Reserved (if reserved for a provisioning group) or Unmanaged (if not reserved) and a machine name of Unknown when added to vCAC.

An unmanaged machine becomes managed when it is reserved for a provisioning group and then

- selected for a group member’s provisioning request
- provisioned by a PGM using the Provision option
- imported into vCAC by an EA or PGM or both using the Import option (machines with existing operating systems only)

Machines provisioned by either method above receive vCAC-generated machine names (unless the Hostname property is used. Imported machines receive a name provided by the importing PGM. Therefore, each machine in the Enterprise Physical Machines list belongs to one of four categories, as shown in the following table.

**Note:** Except for Cisco UCS physical machines, it is not possible to distinguish between unprovisioned machines with and without operating systems within vCAC. Cisco UCS machines with an associated service profile can be imported but not provisioned; Cisco UCS machines with no associated service profile can be provisioned but not imported.
Table 6  Enterprise Physical Machine Categories

<table>
<thead>
<tr>
<th>Machine Name</th>
<th>Managed by vCAC?</th>
<th>Status</th>
<th>Reserved?</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>no</td>
<td>Unmanaged</td>
<td>unreserved</td>
<td>With or without existing operating system (no way to distinguish except for Cisco UCS)</td>
</tr>
<tr>
<td>Provided by importing the user granted EA and PGM roles</td>
<td>yes</td>
<td>On or Off</td>
<td>reserved</td>
<td>Imported into vCAC with existing operating system</td>
</tr>
<tr>
<td>Generated by vCAC</td>
<td></td>
<td></td>
<td></td>
<td>Provisioned by vCAC</td>
</tr>
</tbody>
</table>

Caution: When an un provisioned machine with an existing operating system is provisioned using the Provision option, the operating system is lost along with all associated data.

Because vCAC regularly collects data from endpoints, its information about physical machines associated with all known endpoints is generally up to date. To make sure it is fully up to date, you can use the Data Collection option for an individual endpoint.

Using the Enterprise Machines Lists

To manage enterprise machines, select Enterprise Administrator > Enterprise Machines in the activity pane.

Columns in the Enterprise Machines list by default include the name of each machine and its status, type, owner and source blueprint, as well as the group it was provisioned in and the reservation it was provisioned on. The Columns control lets you select many more fields for display, some of which do not apply to all types of machines. When a column does not apply, there is no entry.

You can sort and filter each column individually, as described in "Elements of the vCAC Console", and the Filters control lets you create and save complex filters. Filters applied to the list are always shown in the filter bar at the bottom. Changes you make in a list display persist from one view of the list to the next.

When a list of machines is filtered by any column or columns, the total number of machines displayed in the title bar changes to indicate how many machines are in the filtered display.

The Export drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file. You can also request a machine from the My Machines page by clicking the Request Machine link at the right-hand end of the title bar.

Enterprise Administrator Machine Options

To perform operations on a machine, move the pointer over the machine name and select an option from the menu, or just click the name to use the Edit option.

All owner machine options are available to Enterprise Administrators, who can also use the Edit option to modify the owner and custom properties of the machine. An Enterprise Administrator can also use the Register Virtual Desktop and Unregister Virtual Desktop and User (for virtual machines provisioned with XenDesktop integration) discussed in "Support User: Working on Behalf of Another User" and the Connect to Endpoint (for physical machines) discussed in "Managing Provisioning Group Machines".
There are two additional options for Enterprise Administrators only: **Change Reservation** and **Send Reclamation Request**. These are discussed below.

**Edit, Reprovision** (Enterprise Administrator): An Enterprise Administrator can use **Edit** to modify the same information as a PGM and can change machine properties before provisioning or reprovisioning. (The custom properties of an unprovisioned physical machine do not have the **Prompt User** check box because a machine is not selected for provisioning until after the user request is completed.) Enterprise Administrators can also modify the hardware details that an unprovisioned physical machine inherited from its endpoint and assign or change a provisioned or unprovisioned machine’s cost profile.

For details about reprovisioning machines, see the description of the feature in PGM Machine Options. As an enterprise administrator, you can change the blueprint for a machine using the **Change Reservation** feature prior to reconfiguring. In this case, custom properties that existed on the original blueprint and were applied to the machine during the initial provisioning are retained on the machine after reprovisioning with a new blueprint.

**Change Reservation** (virtual only): This option lets you change the virtual reservation of a virtual machine that has been moved to a new storage path that is not available in its current reservation. (When virtual machines move between storage paths within the same reservation, data collection automatically detects and records this change.) You cannot change the machine’s current compute resource, but you can move it to any reservation on that compute resource, including one belonging to a different provisioning group. You must be PGM of both the original and target provisioning group to use this function.

**Send Reclamation Request**: When you have identified a cloud or virtual machine that may be unused or underused, you can use this option to initiate a reclamation request. You can select multiple cloud and virtual machines for this purpose.

You can perform some operations on more than one machine at the same time. For more information, see "Performing Operations on Multiple Machines," on page 116.

### Managing Enterprise Virtual, Cloud, and Physical Machines in Bulk

The Bulk Operations Client for Windows is provided with vCAC. This client can be installed on any host with access to the vCAC server and allows Enterprise Administrators to use the following options on multiple enterprise virtual, cloud or physical machines simultaneously:

- **Turn On** (equivalent to Power On button)
- **Turn Off** (equivalent to **Power Off**)
- **Reboot**
- **Destroy**

The following options are available for virtual machines only

- **Reprovision**
- **Change Reservation**
- **Register/Unregister Virtual Desktop** (if BOC user is also provisioning group manager)

---

**Caution**: Misuse or erroneous use of the Bulk Operations Client can be extremely destructive. Access to this tool should be restricted to high-level administrators and it should be used with caution.
To install the Bulk Operations Client (BOC):

1. Copy the installation file DCACBulkOperationsClientInstaller.msi to the installation compute resource.
2. Execute the installer as a user with full administrative access to the host.
3. After accepting the EULA, indicate on the Bulk Operations Client Configuration panel whether you want the BOC to use HTTPS as the transport protocol and provide the name of the host on which the manager service is installed (the vCAC server).

**Note:** All vCAC components must be installed to use the same transport protocol; select Use HTTPS only if the vCAC instance for which you are installing the BOC was installed to use HTTPS. If you do select Use HTTPS you must enter the fully qualified domain name of the manager service host.

You must run the BOC under the credentials the manager service is running under (see the vCloud Automation Center Installation Guide); if uncertain of these, you can check the credentials of the vCloud Automation Center service on the manager service host. Furthermore, these credentials must be added to vCAC as an enterprise administrator (see "Designating Administrators", later in this chapter).

To start the BOC, select **Bulk Operations Client** from the **Start** menu. The BOC appears:

**Reclaiming Enterprise Virtual and Cloud Machines**

To maintain the most efficient use of enterprise group virtualization resources, an Enterprise Administrator must continually work to ensure that cloud and virtual resources are allocated only to machines for which there is a genuine ongoing need, and that where resources are in heavy use they are reclaimed in a timely manner. vCAC’s lifecycle management provides a context within which cloud and virtual machines that are not in active use can be identified and eliminated.

**Monitoring Resource Usage**

Be sure to read the section "vCAC Resource Hierarchy" in "Managing Virtualization Compute Resources", later in this chapter, for an explanation of the terms used within vCAC to identify virtual provisioning resources and their usage. Also review "Managing Virtual Reservation Capacity and Overreservation" in "Managing Reservations" for important information about managing virtualization resources.

vCAC provides several ways to monitor virtual resource usage—that is, how much of each compute resource’s physical memory and storage capacity is reserved by vCAC, and how much of each reservation’s machine quota, memory, and storage is allocated to and used by provisioned machines.

- The dashboard (as described near the beginning of this chapter) and the Provisioning Groups page (described in "Managing Provisioning Groups" later in this chapter) show you how much of each provisioning group’s total cloud and virtual reservation capacity is allocated to machines.
- The compute resources page shows you how much of each compute resource’s physical capacity is reserved, how much of that reserved capacity is allocated, and how much of that allocation is in use.
- The Reservations page, described in "Managing Reservations", lets you see how much of each cloud or virtual reservation’s capacity is allocated and how much of that allocation is in use.
- The Reports web site provides a number of reports on resource usage.
In resource usage, including locating compute resources and reservations on which allocation should be reduced, one of the most important tools you can use to address them within vCAC is the machine reclamation process. This process involves

- Sorting and filtering the Enterprise Machines page to isolate and identify physical, cloud, and virtual machines that have not been used recently or that are little used
- Initiating reclamation workflows for the machines you identify

### Identifying Unused and Underused Cloud and Virtual Machines

The Enterprise Machines page provides a number of columns that are useful in identifying reclaimable machines, as described earlier in the previous section. You can sort and filter these columns alone or in combination as described in "Elements of the vCAC Console", saving any complex filters you create.

- The **Last Power On**, **Last Power Off**, and **Last Logon Date** columns provide information about when a vSphere virtual machine was last actually used.
- The **Memory** and **Storage** columns let you identify machines to which large amounts of resources are allocated.
- The **Avg CPU**, **Memory**, **Disk**, and **Network Utilization** columns can be used, especially in combination, to identify vSphere virtual machines that are inactive or little used, or that may not be required if the purposes they are being used for can be transferred to other existing machines.

In addition, the Enterprise Machines page provides several useful built-in filters for reclamation purposes. When a filter is in use, either built-in or created by you, you can select the **Exclude From** `filter_name` option for one or more machines to exclude them from this particular filter view. This can be used, for example, to exclude web servers from filters that identify machines no one has logged into over a long period.

**Note:** When using a filter, whether built-in or created by you, do not replace the value entered in a search box by the filter; first clear the filter and then enter a value in the search box. For example, when using the **Off for 90+ days ago** built-in filter, do not simply replace the date entered by the filter in the **Last Power Off Date** column search box; first clear the filter by selecting **Clear** from the menu in the upper right or at the right-hand end of the filter bar at the bottom, then enter a new date in the **Last Power Off Date** search box.

### Sending Reclamation Requests

Once you have identified one or more reclaimable physical, cloud (Amazon EC2), or virtual machines, choose **Send Reclamation Request** from the menu. You can select multiple machines first, using the **Select All on Page** and **Deselect All on Page** controls and the individual check boxes, and apply this option to all of them at once; all subsequent actions described apply to all of the selected machines. Note that you can select multiple machines only within one list page; if you move to the next or previous page of the Enterprise Machines list, current machine selections are lost.

The Send Reclamation Request page has the following options:

- **New lease length (days):** Specifies the number of days the machine will be available for use under the new lease. The minimum is 1 day, the maximum is 100,000 days, and the default is 30 days.
Waiting before forcing lease (days): Specifies the number of days the owner has available to respond to the reclamation notice. At the end of that time, a new lease is created with the new lease length. The minimum waiting period is 0 days, the maximum is 999 days, and the default is 3 days. When you specify 0, the machine owner’s response is not required and the machine's lease is converted to the new lease length immediately, unless the new lease length exceeds the existing lease length.

Notify group manager (via email): If selected, an email is also sent to the owner’s PGM about the reclamation request.

Machines: Lists the machine(s) selected for reclamation. Unselecting a machine removes it from the request.

Reason for request: (Optional) Specifies the reason for requesting the reclamation. Appears in the emails, on the Self-Service > My Machines page (My Reclamation Requests frame), on the Enterprise Administrator > Reclamation Requests page, and on the vCAC Administrator > Audit Log Viewer page.

In an email message, the machine owner is asked to select either of two links in the email:

- Machine in Use: terminates the reclamation workflow without action
- Machine Released for Reclamation: immediately expires the machine

If the owner does not respond by using one of these options within the Waiting before forcing lease period, the machine is automatically converted to the New lease length period (unless the existing lease is shorter) and the owner is notified of this action in the My Reclamation Requests list and an email message.

The owner can then select the Machine Released for Reclamation option, available both in the menu in My Reclamation Requests and as a link in the email, which immediately expires the machine. The owner can also use the Extend Lease option (available in the My Machines list) to request that the lease be extended, or do nothing and allow the machine to expire.

Caution: When an owner selects Machine Released for Reclamation, the machine is immediately expired; if an archive period of 0 is specified in its blueprint, it is immediately destroyed.

Managing Reclamation Requests

You can see open reclamation workflows in your enterprise group by selecting Enterprise Administrator > Reclamation Requests. The list that appears includes the executed and active reclamation requests for existing machines and provides the status of each, among other information. The options available depend on the state of the request. They include:

Notify: Send a reminder email to the provisioning group manager and the owner of a machine who has not yet responded to a reclamation request.

Resubmit: Restart the previous reclamation workflow for the machine if the workflow timed out due to error, or if the owner selected Machine in Use at some earlier point but you want to start the reclamation workflow again.

View Request History: View all details about the reclamation workflow, including the Action (Assigned, Created, Release, etc.), User, Description, and Prior Status.
**Machine Released for Reclamation/Machine in Use:** If you have reason to believe the machine’s owner is absent or for some reason unable to respond and that the machine should or should not be reclaimed, you can choose these options to initiate or cancel reclamation.

**Close:** Close the reclamation workflow and remove it from the list.

| Note: | All other machine options that would be available for the machine if you were viewing it on the Enterprise Machines page appear along with the reclamation options. |

---

**Modifying ESX Server Virtual Machine Deletion Policy**

By default, when a virtual machine provisioned on an ESX Server compute resource is destroyed in vCAC, it is also deleted in the instance. However, the vSphere agent managing the vCenter Server instance can be configured to instead move destroyed machines to a **VRMDeleted** folder within the instance. The latter approach provides extra assurance against data loss but consumes more resources. If a vSphere agent is configured to move destroyed machines to **VRMDeleted** and you want to reclaim this space by changing to immediate deletion from vCenter Server, you can use the vCAC agent configuration utility, described in full in the *vCloud Automation Center Installation Guide*. (This option is available for vSphere agents only, virtual machines are immediately destroyed on their XenServer and SCVMM Hyper-V compute resources when destroyed in vCAC.)

To change deletion policy for a vSphere agent:

1. Log into the vCAC server as a user with administrator-level credentials and change to the directory `%SystemDrive%\Program Files (x86)\VMware\vCAC\Agents\agent_name`, where `agent_name` is the directory containing the vSphere agent.

2. Issue this command:
   ```
   DynamicOps.Vrm.VRMencrypt.exe VRMAgent.exe.config get
   ```
   For a vSphere agent, the output of the command looks like this:
   ```
   endpoint: http://dev-test-vmware-1/sdk
doDeletes: True
username: localdomain\hawkeye
   ```

3. To change the agent’s deletion policy, issue this command:
   ```
   DynamicOps.Vrm.VRMencrypt.exe VRMAgent.exe.config set doDeletes value
   ```
   where `value` is **true** to immediately delete destroyed machines or **false** to instead move them to the **VRMDeleted** folder.

---

**Managing Build Profiles**

A build profile is a set of custom properties that can be incorporated into a virtual or physical blueprint. The latest versions of the profile are always read and incorporated when a machine is provisioned from the blueprint.

**Property Sets, Build Profiles, and Blueprints**

Build profiles are very useful in applying a set of custom properties to multiple blueprints for a variety of purposes, such as setting up and customizing a particular type of guest OS, enabling WIM-based virtual or physical provisioning, or registering virtual machines with a XenDesktop DDC server.
A blueprint can also contain custom properties. Any property specified in a blueprint overrides the same properties specified in the incorporated build profiles; this enables a blueprint to use most of the properties in a profile while differing from the profile in some limited number.

When you are creating or editing a build profile, you can incorporate one or more predefined sets of properties for specific purposes, providing or adjusting their values as appropriate for the build profile you are working with. You can also add your own property sets to the predefined library by creating and importing XML documents. This provides three levels of standardization in machine specification: property sets; build profiles, which incorporate property sets; and blueprints, which incorporate build profiles.

**Note:** When a property set is modified, it must be loaded into the build profile again; property set changes are not automatically inherited by build profiles.

Build profiles are global elements maintained by Enterprise Administrators, who can easily extend the set available to the site by copying and modifying existing profiles. By establishing a useful library of property sets and a useful range of build profiles, Enterprise Administrators can support themselves and PGMs in meeting all the needs of machine consumers while ensuring that the number and complexity of blueprints remain manageable.

**Viewing, Editing and Deleting Build Profiles**

To view and edit existing profiles, select **Enterprise Administrator > Build Profiles** in the activity pane to display the Build Profiles page. The list includes profile names and descriptions. The **Export** drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file.

The menu for each listed profile provides two options. You can also select the **Edit** option by simply clicking the profile name.

**Edit Build Profile**: Edit the profile. Each profile includes a name and description, which should be informative and useful to PGMs selecting profiles to incorporate into blueprints.

The table at the bottom of the page shows the profile’s custom properties as attribute-value pairs. You can change, delete, or add to these properties individually. You must supply a value for each property you specify, except those for which you select **Prompt User**; if you do not supply a value, the property will not be saved with the build profile.

For any property, you can select **Prompt User** to require the user to provide a value for the property or to accept the value you supplied as the default. If you leave the value empty, the user must supply a value in order to continue with the machine request.

**Note:** When **Prompt User** is selected for a property, the requesting user is prompted only once for the value, even in a request for more than one machine; the value supplied is therefore applied to all machines provisioned from the request.

Selecting **Prompt User** for the compute resource property, however, restricts all requests from the blueprint to a single machine, as the value of this property must be unique for each machine.

The **Encrypt** check box is needed anytime a password is used and ensures that a secure property (such as a password) is never visible in plain text.

Click the **Save** button to save the property or the **Cancel** button to cancel it without saving changes, but remember that the properties you enter or modify are not saved until you save the blueprint by clicking **OK**.
To add a property set, use the **Add from property set** drop-down list to select a property set and press the **Load** button. The properties in the set are added. Repeat until you have incorporated all the property sets you want. If a set you add contains a property that is already included in the build profile, the current value is retained.

**Note:** When entering custom properties, always ensure that property values do not contain trailing spaces, as these may cause provisioning to fail.

**Delete:** Delete the selected profile. You cannot delete a profile if blueprints incorporate it. To make it possible to delete the profile, edit each blueprint that incorporates it (as described in "Managing Provisioning Group Blueprints") and select a different profile to incorporate. Make sure that you provide and select a suitable replacement, however, as simply removing the profile may cause the blueprint to build machines that do not match the intended specification or WIM image, or leave the blueprint without sufficient information to build machines.

### Creating a Build Profile

To create a build profile, click the **New Build Profile** link at the end of the Build Profiles title bar.

To begin by copying the custom properties from an existing build profile, use the **Copy from existing build profile** drop-down list to select from among all profiles. You can then add, remove or edit properties and save the profile under a new name.

### Managing and Adding Property Sets

To review and manage the property sets available at your site, including those included with vCAC and any you have added, edit or create a build profile and on the Edit/Create Build Profile page use the **Manage Property Sets** links in the upper right-hand corner. The Manage Property Sets page lists all current property sets, with two available options:

**Disable/Enable:** If you want to exclude an existing property set from the **Add from property set** drop-down list on the Edit/Create Build Profile page, select **Disable**. The green dot to the left of the set name disappears to indicate that the property set is disabled. Select **Enable** to restore the set.

**Delete:** You can delete only property sets you have added; predefined sets included with vCAC cannot be deleted.

To add a property set to your library:

1. Create an XML document in the format:

   ```xml
   <?xml version="1.0" encoding="UTF-16"?>
   <Doc>
   <CustomProperties>
     <Property Name="property_name" DefaultValue="property_value" Encrypted="true_or_false" PromptUser="true_or_false"/>
     . . .
   </CustomProperties>
   </Doc>
   ```

2. You can include as many properties as you like. Where the **DefaultValue**, **Encrypted**, or **PromptUser** parameters are not provided, their values are empty, false and false respectively. It is sometimes useful to provide a default value indicating what the actual value should be, for example
Use the **Browse** button at the bottom of the Manage Property Sets page to enter the file’s pathname in the **Property set XML file** box, enter a useful name and description, and press the **OK** button. The property set is added to the list.

Use the **Back to Build Profile** link in the upper right-hand corner to return to the Edit/Create Build Profile page.

**Managing Global Blueprints**

As described in "Managing Provisioning Group Blueprints", earlier in this chapter, a blueprint is the detailed specification for a particular type of machine, the policies that apply to it, and the workflow used to provision it, as well as the names and locations of any disk images or virtualization platform objects required to provision using that workflow.

A *local* blueprint is created by a PGM, belongs to a single provisioning group and is available only to that group’s members. A *global* blueprint is created by an Enterprise Administrator and can be selected for local use by any PGM.

If you are an Enterprise Administrator but not a PGM, you can create and manage only global blueprints by selecting **Enterprise Administrator > Global Blueprints**. Global blueprints are listed in the same manner as that described for local blueprints earlier in the chapter. Any global blueprint you create is available to any PGM for selection for one or more of his groups.

If you are an Enterprise Administrator and a PGM, you can create and manage both global and local blueprints. It does not matter whether you list a blueprint by selecting **Enterprise Administrator > Global Blueprints** or **Provisioning Group Manager > Blueprints**; you can edit any global blueprint, or any local blueprint created in one of your groups, and toggle it between global and local. When you make it global, you can select it for any of your groups; when you make it local, you must select one and only one of your groups to associate it with.

**Managing Provisioning Groups**

Enterprise Administrators create and manage provisioning groups, which often represent business or functional units or departments. Only provisioning group members can request machines, and provisioning groups cannot function without appropriately designated PGMs to create blueprints, approve requests, and manage machines. Careful planning and management of provisioning groups is essential to the successful functioning of a vCAC site.

**Viewing, Deleting and Editing Provisioning Groups**

To view and edit existing provisioning groups, select **Enterprise Administrator > Provisioning Groups** in the activity pane to display the Provisioning Groups page.

The Provisioning groups page shows the following information for each group by default:

- The name of the group
- One or more PGM email addresses or Active Directory accounts
- A description of the group
- The number of existing virtual machines provisioned on the group’s reservations
The percentage of the group’s total reserved virtual capacity that is currently allocated to virtual machines for machine quota (maximum number of machines that can be provisioned), memory and storage.

Total reserved virtual capacity is the sum of all of the group’s existing reservations on all virtualization compute resources, not just those in the enterprise groups you manage. (To see the group’s usage of its reservations on compute resources in your enterprise groups, use the View Reservations option described below.)

The final (Total) row aggregates the usage statistics for all provisioning groups, showing the total virtual machine quota, memory and storage allocated out of reserved capacity for all compute resources in the entire vCAC site.

You can sort and filter individual columns and change the included columns using the Columns control and create complex filters using the Filters control as described in "Elements of the vCAC Console", earlier in this chapter. Additional virtual columns available include:

- The total storage used by the group
- The storage used by the group as a percentage of reserved storage.

**Note:** The amount of storage allocated to a machine is the same as the amount used by it when standard storage technology is in use. However, when machines are provisioned using a space-efficient technology such as thin provisioning or NetApp FlexClone-enabled storage, a machine’s storage used can be less than its storage allocated because the machine uses storage only as needed. You can calculate the storage saved using space-efficient technology by comparing the amount of allocated storage shown in the Storage Allocated % column and the amount of used storage shown in the optional Storage Used column.

Physical columns available include:

- The total of all physical machines reserved for the group
- The percentage of total machines that are provisioned and under vCAC management
- The percentage of total reserved quota that is provisioned and under vCAC management

Cloud columns available include:

- The number of existing cloud machines provisioned on the group’s reservations by group members
- The percentage of the group’s total reserved cloud machine quota that is currently allocated to cloud machines. (Total reserved machine quota is the sum of all of the group’s existing reservations on all cloud endpoints.)

These additional columns are also totaled for all provisioning groups in the final row.

Changes you make in the list display persist from one view of the list to the next.

The Export drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, .xls or CSV) or Microsoft Office Word (RTF) file. You can also create a provisioning group by clicking the New Provisioning Group link at the right-hand end of the title bar.

The menu for each listed group provides several options. You can also select the Edit option by simply clicking the group name.
**Edit**: Edit the selected group’s settings.

**Group Information**: Displays detailed information about the selected provisioning group, including a list of the group’s reservation with status; a list of the global and local blueprints available to group members requesting machines, and a list of all machines provisioned from the group’s reservations.

**Delete**: Delete the selected group. You cannot delete a group that has one or more reservations or blueprints associated with it.

The first step in deleting an active provisioning group generally involves preventing further requests for machines from group members so you can delete the reservations, blueprints, and group when all existing machines have been destroyed or decommissioned. There are two ways to accomplish this:

- Disable all of the group’s blueprints by unselecting the Enabled check box for each blueprint as described in "Managing Provisioning Group Blueprints".
- Disable all of the group’s reservations as described in "Managing Reservations".

**View Reservations**: Display the Reservations page, filtered for the selected provisioning group, showing you a summary of that group’s virtual and cloud reservations on compute resources and endpoints in your enterprise group(s) as well as its physical reservations. The information is useful in letting you easily identify situations in which you may need to increase reservation capacity for the group.

The list of reservations displayed can be further filtered, for instance for a particular compute resource for virtual reservations.

**View Compute Resources**: Display the Compute Resources page to view Compute Resources belonging to an endpoint.

**Provisioning Group Settings**
When you edit a provisioning group, you can change all of its settings except the name. Provisioning group settings include:

- The name and description of the group
- One or more email addresses (including group aliases) or Active Directory accounts for the user(s) specified as PGM. Multiple entries must be separated by commas (with no spaces), for example
  
  JoeAdmin@VMware.com,VMware\TinaVP,WeiMgr@VMware.com

  These addresses are shown in the My Pending Requests lists of group members.

- The default machine prefix for blueprints created by the group’s managers. You can add a prefix or modify an existing one, if necessary, by clicking the Manage machine prefixes link to go to the Machine Prefixes page.

- The default active directory container for machines provisioned by group members (such as
  
  ou=test,ou=servers,dc=VMware,dc=local)

- Current manager, Support User, and user memberships. A group can have more than one manager, and a user can be manager of more than one group.

  You can enter users manually or use the drop-down list at the top of each entry box to select users to add. Note, however, that only users who currently own at least one machine listed on the Enterprise Machines page are included in the drop-down list.
Any changes you make to group membership are reflected in the console immediately after you save the new or modified provisioning group. For example, if you change a member’s role from manager to user, she immediately loses access to the Provisioning Group Manager activities (including managing blueprints, approving requests and so on) for that group, and this change is immediately reflected in her console if she is currently using vCAC.

**Note:** If the users you specify are not local users of the vCAC server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

You can add an Active Directory security group as a provisioning group member to give provisioning group membership to all members of the security group. Do not, however, add Active Directory distribution groups, as distribution groups cannot be authenticated against and thus cannot convey vCAC roles.

When a valid user entry can no longer be resolved by vCAC, for example because the user was removed from Active Directory, the entry is replaced by Account unknown (SID), where SID is the system identification number of the user account. This is done to allow for situations in which a user name temporarily becomes invalid. If the user account is restored, the Account unknown entry is converted back to the user name. If you know the account will not be restored, you can simply delete the Account unknown entry.

- Any custom properties to be applied to all machines created by members of this provisioning group. Typically, these would be different from those in build profiles and blueprints, having to do with resource management or line of business accounting.

**Note:** As noted in Custom Properties in Machine Provisioning, Blueprints and Build Profiles, custom property values in reservations override those in provisioning groups, and those in provisioning groups override those in blueprints and build profiles. Because properties from these sources may be applied to so many machines provisioned from so many blueprints, they should be used carefully, and restricted to purposes applicable to all the machines they will be applied to.

When entering custom properties, select the Encrypt check box to ensure that a secure property (such as a password) is never visible in plain text.

Click the Save button to save your changes to a property or the Cancel button to cancel them. Remember that the properties you add or modify are not saved until you save the reservation by clicking OK, but that you must click the Save button to save and close each property you open before pressing OK.

**Note:** When entering custom properties, always ensure that property values do not contain trailing spaces, as these may cause provisioning to fail.

By default, the organization in Cisco UCS Manager in which a provisioned Cisco UCS machine is placed is created for each provisioning group by vCAC. It is possible to override this setting by adding the Cisco.Organization.DN custom property to a provisioning group.
Creating a Provisioning Group

To create a provisioning group, click the **New Provisioning Group** link at the right-hand end of the Provisioning Groups title bar.

To begin by copying the settings of an existing provisioning group, use the **Copy from existing group** drop-down list to select from among all provisioning groups. You can then modify the settings and membership as needed and save the group under a new name.

Provisioning groups typically represent organizational units such as a department or line of business, and the group name and description should reflect this basis and provide useful information about the group. Your site may have required naming conventions.

Managing Approval Groups and Policies

As described in "Blueprint Settings", the approval policy assigned to a blueprint determines what approvals are required, if any, before a machine can be provisioned from it. By default, all vCAC sites have two options available: No Approval (approval is never required), and Default Approval (PGM approval required). If you want other vCAC users to review machine requests, you must place them in approval groups and then place those groups in additional approval policies. Those approval policies can then be selected by PGMs and Enterprise Administrators creating blueprints.

An approval group is a collection of users, *any one of whom* can approve a machine request. An approval policy contains one or more approval groups, *each of which* must approve the machine request in a specified sequence. This means that in practice, all members of the first approval group in the policy see the request; when one of them approves it, they no longer see it and all members of the next approval group see it; and so on. This is illustrated in the following figure, in which a machine request is approved by three users, each of whom is a member of one of the three approval groups making up the approval policy specified in the blueprint.
Email is always sent to each PGM and approval group email address when their turn in the approval sequence comes up. At the end of the approval process (when the machine request is ultimately approved or denied) email is sent to the requestor, summarizing the results.

If advanced approval support has been enabled by the vCAC administrator several additional features are available. These are described in the following sections.

To manage your site's approval groups and policies, select Enterprise Administrator > Approval Groups & Policies. The Approval Groups and Policies page displays all existing groups and all existing policies.

You can use the Edit or Delete options to edit or delete a group or policy, or the New links at the right-hand ends of the title bars to create a group or policy.

**Approval Group Settings**

Approval group settings include:

- A name and description

- One or more email addresses (including group aliases) or Active Directory accounts for the user(s) specified as approvers. Multiple entries must be separated by commas. These addresses are shown in the My Pending Requests lists of group members.
• One or more approvers, selected from the drop-down list or entered directly into the Approvers box. Note that only users who own at least one machine listed on the Enterprise Machines page are included in the drop-down list. User names are validated when you save your changes; if one or more of the user names is not valid, the group remains open for editing.

Any user who is included in at least one approval group sees the Approvals entry in the activity pane of the console and can use it to find out whether any machine approvals are pending.

**Note:** If the users you specify are not local users of the vCAC server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

You can add an Active Directory security group as an approver to give this role to all members of the security group. Do not, however, add Active Directory distribution groups, as distribution groups cannot be authenticated against and thus cannot convey vCAC roles.

When a valid user entry can no longer be resolved by vCAC, for example because the user was removed from Active Directory, the entry is replaced by Account unknown (SID), where SID is the system identification number of the user account. This is done to allow for situations in which a user name temporarily becomes invalid. If the user account is restored, the Account unknown entry is converted back to the user name. If you know the account will not be restored, you can simply delete the Account unknown entry.

• If advanced approval support is enabled, one or more delegates are temporarily or indefinitely designated for one or more members of the group. These delegates become approvers and receive and can act on all requests that come to the user for which they are designated, in effect becoming members of the approval group.

To designate a delegate, click the Add Delegate link and select a group member from the drop-down list or enter the member’s user name, then enter the user name of the delegate and click the Save button. (Be sure to use the domain format for user names, for example VMware\Joe.Admin.) For existing delegations, click the edit icon next to the specified group member to modify delegates and the delete icon to remove them.

**Note:** Unless a delegate you designate is added to the email address or alias specified for the approval group, she will not receive automatic emails about approval requests.

• If advanced approval support is enabled, a custom properties grid is displayed in which you can enter custom properties, the values of which must be supplied by the group member approving a request. You cannot specify property values; if a value was provided by the blueprint or requesting user, it appears as the default for the approver. Typically this is used to let the approver confirm or modify a value provided by the requesting user.

**Note:** Because the value of the Hostname property must be unique for each machine, you should not add hostname to an approval group unless you are certain that Prompt User is selected for hostname in the blueprints from which machines to be approved will be provisioned. Selecting Prompt User for the Hostname property restricts all requests from the blueprint to a single machine, which means the value the approver supplies for hostname will be applied to one machine only and not multiple machines, which would cause an error.
Be sure to carefully consider whether to select **Encrypt** for any property you add. If you do not select **Encrypt**, the property will not be encrypted in the provisioned machine, even if **Encrypt** is selected in the blueprint.

Property values supplied by an approver override values specified in the applicable reservation, provisioning group, blueprint and build profile. However, they are not preserved during reprovisioning.

**Approval Policy Settings**

Approval policy settings always include:

- Name and description
- Approval groups included in the policy, and their sequence
- Whether PGM approval is required in addition to the listed approval groups (PGM always comes first in the approval sequence)

**Note:** When **Group manager approval required** is selected, and a PGM is also included in an included approval group, that individual may have to approve twice, once as PGM and once as approver.

Use the **Add**, **Remove**, **Up** and **Down** buttons to select the approval groups you want and set them in the desired sequence.

When advanced approval support is enabled, two additional entries are available in the **Group** box listing available approval groups, and can be added to the policy sequence:

- **[Machine Provisioning]**—This entry indicates the point in the approval process at which the machine is actually provisioned. Groups above the entry approve before provisioning, those below it approve after, allowing an approver to directly verify something about the provisioned machine before giving approval for it to be used. This entry can be used only once in a policy.

In general, as described in "Blueprint Settings", when an approval policy is selected in a blueprint and at least one approval threshold is set, approval is required only when the requesting user meets or exceeds an approval threshold. When one or more approval groups appear after **[Machine provisioned]**, however, approval by these groups is always required, even when the requesting user did not exceed any approval threshold in the initial request. For example, suppose approval policy **Policy12** includes:

```plaintext
ApprovalGroupB
[Machine provisioned]
ApprovalGroupJ
```

If **Policy12** is selected in a blueprint with at least one approval threshold:

- When the requesting user meets or exceeds an approval threshold, approval by **ApprovalGroupB** is required before machine provisioning and by **ApprovalGroupJ** after provisioning.
- When the requesting user does not meet or exceed an approval threshold, approval from **ApprovalGroupJ** is required after machine provisioning.
Note: If an approval group in the policy prompts approvers for the values of properties applied to the machine during provisioning, such as compute resource name, the group must appear above [Machine Provisioning] in the policy.

• <<Owner>>—This entry indicates the point(s) at which the approval workflow returns to the requester, who can decide whether to continue with the request or cancel it. Because the requester can examine the custom properties of the machine at that point in the workflow, this is useful when one or more approval groups includes one or more custom property values to be supplied by approvers. For instance, if an administrator assigns an additional cost to the machine, to be charged to the requester’s provisioning group, when approving a request, the requester can see this value in the machine’s properties and may decide to cancel the request so as not to incur the additional cost. This entry can be used more than once in a policy.

Once you create an approval policy, it is available to be selected in the Approval Policy drop-down list in any global or local blueprint in your site.

Managing Virtualization Compute Resources

In managing the enterprise group’s virtualization compute resources, the Enterprise Administrator is responsible for monitoring and maintaining both the compute resources themselves and provisioning group virtual reservations on the compute resources. Virtual reservations are covered in the following section.

vCAC Proxy Agents

vCAC communicates with a compute resource and the virtualization platform managing it through a proxy agent. vCAC can use the compute resource to provision machines only if this agent is active and reachable by vCAC.

Proxy agents initially and then regularly collect information about each compute resource for vCAC. Each vSphere agent is associated with an endpoint representing a vCenter Server instance; the agent collects data from all discovered ESX Server compute resources within that instance. XenServer and Hyper-V agents collect data from all compute resources associated with them by a vCAC administrator.

The Compute Resources page provides information about the proxy agent managing each compute resource and, in the case of ESX Server compute resources, the endpoint configured for the vSphere agent managing the compute resource.

Host Clusters and Xen Pools in vCAC

A vCAC proxy agent can discover and manage a single ESX Server or an ESX Server cluster, a single XenServer or a Xen pool, aggregating cluster or pool-wide resources so that the cluster or pool is treated as a single provisioning compute resource. Within vCAC there is no difference between standalone compute resources and compute resource clusters or Xen pools, and they are handled in the same fashion. For example, a reservation on a compute resource cluster or Xen pool spans all nodes within it and thus the resources needed to provision a machine from the reservation may come from any node in a dynamic process that is transparent to vCAC users.

Note: When selecting the node in a cluster on which to provision a requested machine, vCAC considers three factors: whether the node is in maintenance mode, its overall status (green, yellow or red) and the amount of free memory it has available.
Amazon Web Service Regions

Each Amazon Web Service account is represented by a cloud endpoint. When you create an Amazon EC2 endpoint in vCAC, regions are collected as compute resources.

After the vCAC Administrator selects compute resources for an enterprise group, inventory and state data collection occur automatically.

Inventory data collection, which occurs automatically once a day, collects data about what is on a compute resource, such as:

- Elastic IP Addresses
- Elastic load balancers
- Elastic block storage volumes

State data collection occurs automatically every 15 minutes by default. It gathers information about the state of managed instances, which are instances vCAC creates. Examples of state data include:

- Windows passwords
- State of machines in load balancers
- Elastic IP Addresses

Note: Data is never collected for compute resources that do not belong to an enterprise group.

An enterprise administrator can manually initiate inventory and state data collection on compute resources, as well as disable or change the frequency of the inventory and state data collection.

Compute Resource Membership in Enterprise Groups

vCAC cannot collect data from a compute resource and reservations cannot be made or machines provisioned on it until it has been added to at least one enterprise group.

A compute resource can belong to more than one enterprise group, including groups managed by different Enterprise Administrators.

There are two ways in which a compute resource can be added to or removed from an enterprise group:

- By a vCAC administrator using vCAC Administrator > Enterprise Groups.
- By a vCAC administrator who is also an Enterprise Administrator using the Infrastructure Organizer.

vCAC Resource Hierarchy

When displaying information about resource usage, including virtual resource usage on virtualization compute resources, vCAC uses five terms:

- Physical (virtual only)—The actual memory or storage capacity of a virtualization compute resource.
- Reserved—The specified machine quota (all types), memory (virtual and physical), or storage (virtual only) of a reservation. For example, if a compute resource’s physical storage is 600 GB
and there are three reservations on it of 100 GB each, the compute resource’s \textit{reserved storage} is 300 GB and the \textit{storage reserved} % is 50%.

- \textbf{Allocated}—The amount of a resource assigned to provisioned machines. For example, if a cloud reservation’s machine quota is 30 and there are 10 machines currently provisioned from it, it is \textit{33\% allocated}.

\begin{quote}
\textbf{Note:} Only virtual machines that are powered on are included in allocated memory and machine quota statistics; all virtual machines are included in storage statistics. Only cloud machines that are turned on are counted in quota statistics.
\end{quote}

- \textbf{Used (virtual storage only)}—The amount of storage in use by vCAC-provisioned virtual machines. When standard storage is employed, allocated and used are the same, because the storage allocated to a machine is committed to that machine and cannot be used for another. However, when machines are provisioned using a space-efficient technology such as thin provisioning or NetApp FlexClone-enabled storage, storage used is less than storage allocated because each machine uses storage only as needed up to its full allocation. When machines are provisioned using such technology, used may be 0 (zero), as when a newly provisioned machine has not been used at all by its owner.

- \textbf{Free (virtual storage only)}—All unused physical capacity on a storage path. Note that some of the space that is in use may be used by programs other than vCAC.

vCAC collects data from each compute resource and cloud and physical endpoint at set intervals. Information about the amount of used and free storage on each storage path enabled in a reservation is collected even more frequently, and is used to calculate the used storage total for each reservation and compute resource. Used/free space data is included in regular data collections and is also obtained from each enabled storage path following creation or deletion of any vCAC-provisioned machine on that storage path.

**Compute Resource Locations**

The \textit{Display location on request} check box on the Blueprint Information tab of a blueprint can be used to give a requesting user the option of selecting a particular datacenter location at which to provision the machine. When the check box is selected, the request confirmation page includes a drop-down list containing locations; in the case of virtual blueprints, this includes all locations which at least one compute resource is associated. If the requester chooses a location, the machine can be provisioned only from reservations on compute resources that have been associated with that location, and if no such reservation has sufficient capacity available, provisioning fails. If the requester does not select a location, any compute resource can be used.

To enable this feature for virtual blueprints, you must

- Add data center locations to the vCAC location file.
- Associate compute resources with locations. Each compute resource can be associated with one location, which can be changed whenever it is edited as described in Compute Resources, below.

\begin{quote}
\textbf{Note:} Once a compute resource is associated with a location, that association remains even if the location is removed from the location file. That is, if you add London to the file, associate 10 compute resources with that location, and then
remove London from the file, the compute resources are still associated with the location London and **London** is still included in the location drop-down list on the Confirm Machine Request page. Only editing the compute resource and removing the location setting disassociates an individual compute resource; only disassociating a location from all compute resources removes it from the location drop-down list on the Confirm Machine Request page.

---

**Viewing, Removing and Editing Compute Resources**

To view and edit managed compute resources, select **Enterprise Administrator > Compute Resources** in the activity pane. The Compute Resources page displays a list of compute resources in your enterprise group(s) showing (by default) the status of each compute resource’s proxy agent and whether regular data collection is enabled, as well as how many reservations and virtual machines exist on the compute resource.

An icon indicates whether the entry is for a compute resource or compute resource cluster. Click the **View more information** button (.) to display detailed information about the compute resource, including hypervisor in use and physical capacity. A green light indicates that the proxy agent is active and responding to vCAC; a red light indicates that vCAC cannot reach the proxy agent.

To perform operations on a compute resource, point to the compute resource name and select an option from the menu.

Additional default columns include all machines allocated from all reservations on the compute resource as a percentage of those reservations' total machine quota, total reserved memory and storage as a percentage of the compute resource's physical capacity, and the endpoint configured for the agent managing each compute resource, if applicable. The **Columns** control lets you select many more fields for display, including several relating to each resource (machine quota, memory and storage).

You can also sort and filter each column individually, as described in "Elements of the vCAC Console". Changes you make in the list display persist from one view of the list to the next.

The **Filters** control includes a number of built-in filters to identify compute resources that are overallocated (allocation of a resource to machines exceeds the total reserved), overreserved (total reservation of a resource exceeds the physical capacity of the compute resource), and underreserved (total reservation of a resource represents a small fraction of physical capacity), as well as those that are memory, storage, or machine quota-bound (one resource is used to capacity while the others still have much capacity available.)

Note that if a compute resource is overallocated—that is, the percentage is over 100%— the percentage bar is a different color and includes a warning icon. Only machines that are turned on are included in allocated memory and machine quota statistics. Allocated storage statistics include all machines, off or on.

The **Export** drop-down list lets you export the information in the list to an Adobe Acrobat Reader, Microsoft Office Excel (.xlsx, xls or CSV) or Microsoft Office Word (RTF) file.

The hover menu for each listed compute resource provides several options. You can also click the compute resource name to select the **Edit** option.

**Edit:** Edit the selected compute resource’s settings.

**View Reservations, New Reservation:** Display a list of all reservations on the compute resource, or add a reservation.
**View Compute Resources**: Display the Compute Resources page to view Compute Resources belonging to an endpoint.

**View Proxy Agent**: Display information about the proxy agent through which vCAC communicates with the compute resource.

**View Machines**: Display the Enterprise Machines page with the machine list filtered to include only those provisioned on the selected compute resource.

**Data Collection**: Configure data collection frequency or initiate collection of data from the compute resource. Data collection typically takes place once every 24 hours for all compute resources, but at times you may want to update vCAC’s information about the compute resource immediately. By default, EC2 inventory data collection is every 24 hours and State data collection is every 15 minutes.

**Compute Resource Settings**

An Enterprise Administrator can view compute resource’s settings to manage existing compute resources, view or add reservations, and force rediscovery. Settings on the page include:

- The name and description of the compute resource
- Whether data collection is on or off
- Status of the agent managing the compute resource
- Endpoint name
- Platform type
- Reservations
- Total number of machines on a compute resource
- % of quota allocated
- % reserved memory available
- % reserved storage
- Machine quota
- The cost profiles the compute resources and storage paths associated with it. Along with the blueprint’s daily cost setting, these cost profiles determine the daily cost of each virtual machine provisioned on the compute resource. The daily cost is displayed to users and included in chargeback reports.

  Each optional compute resource cost profile includes a daily compute resource cost charged per GB of memory; a daily cost per GB of storage, and a daily cost per CPU. Each optional storage cost profile contains a daily storage cost that overrides the storage cost in the compute resource cost profile, if any. If a compute resource has no compute resource cost profile, no memory or CPU cost is charged, and only storage paths with a storage profile have a storage cost associated with them.

  To select a cost profile for the compute resource, use the Cost Profile drop-down list. To select a cost profile for an individual storage path, click the edit icon for that storage path, choose a storage profile, then save your changes. Storage paths with no storage profile display Unassigned and Default.
Managing Data Collection

vCAC regularly collects data from all compute resources that belong to enterprise groups. Data collection updates information about a compute resource or endpoint and provides details about the machines provisioned on it. In the case of compute resources, this includes unmanaged virtual machines (provisioned outside of vCAC).

vCAC has the following types of data collection:

- **Inventory** data collection on a compute resource updates the vCAC record of the virtual or cloud machines whose resource usage is tied to that compute resource.
- **State** data collection on a compute resource updates the vCAC record of the power state of each machine discovered through inventory data collection.
- **Performance** data collection (vSphere compute resources only) updates the vCAC record of the average CPU, storage, memory, and network usage for each virtual machine discovered through inventory data collection.
- **WMI data collection** (Windows compute resources only) updates the vCAC record of the management data for each Windows machine. A WMI agent must be installed (typically on the Manager Service host) and enabled to collect data from Windows machines that includes, for example, the Active Directory status of a machine’s vCAC owner.
- **vCNS inventory data collection** (vSphere compute resources only) updates the vCAC record of the vCNS-related network and security data, particularly as it relates to security groups and load balancing, for each machine following inventory data collection.

The types of data collection available in the vCAC console at any particular time depend on the type of host and endpoint currently in use. For example, vCNS inventory data collection is available only when an endpoint for a vCNS Manager instance exists.

An enterprise administrator can enable, disable, and set the frequency of data collection.

To manage data collection:

1. Point to the compute resources on the Compute Resources page (Enterprise Administrators) and click **Data Collection**.
   
The Data Collection page displays the following information:
   
   - The time of the last data collection from the compute resource
   - Whether the last data collection succeeded or failed
   - Whether data collection is currently running

2. For each type of data collection, you can configure its frequency or initiate immediate data collection.
   
   - Specify a value for **Frequency** to change it from its default frequency.
   - Click **Request Now** to initiate data collection.

Although data collection can be set to run at regular intervals, you may want to work with the most recent data by initiating a data collection.

The time required for data collection to complete depends on several factors, including the capacity of the compute resource and the number of machines on the compute resource, the number of compute resources in an enterprise group, current system and network load, among other variables.
When data collection is complete for a compute resource, the **Status** is updated with the result which can be success or failure and the **Last Completed** field is updated with the date and time.

By default, vCAC limits concurrent data collection activities to two per agent and queues requests that are over this limit. This allows data collection activities to complete quickly while not affecting overall performance. It is possible to raise the limit to take advantage of concurrent data collection but this should be weighed against any degradation in overall performance.

If you do increase the configured vCAC per-agent limit, you may want to increase one or more of these execution timeout intervals. For more information about configuring timeout intervals, see "Adjusting Concurrency Limits and Timeout Intervals," on page 227.

**Managing Reservations**

Each provisioning group must have at least one reservation—virtual, cloud, physical—in order for its members to provision machines of that type. Enterprise Administrators are responsible for providing the provisioning groups they create with reservations as needed.

Compute resources, endpoints, physical machines and enterprise groups are independent of provisioning groups, but each reservation is for one provisioning group only. Each provisioning group can have as many reservations as desired.

A virtual reservation is a description of the share of a compute resource or compute resource cluster’s resources—memory, CPU and storage—reserved for use by a particular provisioning group in provisioning virtual machines. A virtual reservation for any provisioning group within a vCAC site can be made on any compute resource or compute resource cluster known to vCAC (because it is managed by a proxy agent) and belonging to an enterprise group.

A cloud reservation makes the capacity of the cloud service account represented by a cloud endpoint available to one provisioning group for use in provisioning cloud machines. A cloud reservation for any provisioning group within the vCAC site can be made on any cloud endpoint that belongs to an enterprise group.

A physical reservation is a set of physical machines reserved for and available to a particular provisioning group for provisioning. Each machine must be unprovisioned when it is added to the reservation; a provisioned machine must remain in the reservation until it is decommissioned. Any physical machine represented by a physical endpoint is available to any Enterprise Administrator to include in a physical reservation, but each machine can belong to only one reservation.

**Note:** The Enterprise Administrator > Reservations page does not display an endpoint for physical reservations.

The following sections discuss topics applicable to all or some types of reservations.

**Using Space Efficient-Storage in Virtual Provisioning**

When a virtual machine is provisioned on standard storage, the storage allocated to the machine is fully committed to it while it exists (including when it is powered off) and cannot be used for any other purpose. This typically involves at least some inefficiency, as few virtual machines actually use all of the storage allocated to them, just as few physical machines operate with a 100% full disk.

Space-efficient storage technology eliminates this inefficiency by using only the storage actually required for the machine’s operation, which is a fraction of the storage allocated to it. vCAC supports virtual provisioning on two types of space-efficient technology, thin provisioning (all provisioning methods) and NetApp FlexClone (provisioning by cloning only).
When standard storage is employed, vCAC usage statistics show allocated and used storage as the same. When a space-efficient technology is in use, however, storage used is always less than storage allocated. You can calculate the storage saved using space-efficient technology by comparing the amount of storage allocated to storage used on a number of pages. For example, on the Provisioning Groups page and Reservations page you can compare the amount of allocated storage shown in the Storage Allocated % column and the amount of used storage shown in the optional Storage Used column; on the compute resources page you can compare the Storage Allocated and Storage Used columns.

For example, suppose a provisioning group FinOps had two reservations, one of them on storage using space-efficient technology. Those on the space-efficient reservation were allocated a total of 100 GB of storage but are using only 27, those on the other reservation were allocated (and are therefore using) 80 GB. The relevant columns on the Reservations and Provisioning Groups pages would have the following values:

Table 7 Example of Space-Efficient Technology Usage Statistics

<table>
<thead>
<tr>
<th>Page</th>
<th>Entry</th>
<th>Allocated</th>
<th>Used</th>
<th>Storage Saved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservations</td>
<td>space-efficient reservation</td>
<td>100</td>
<td>27</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>standard reservation</td>
<td>80</td>
<td>80</td>
<td>0</td>
</tr>
<tr>
<td>Provisioning Groups</td>
<td>(provisioning group name)</td>
<td>180</td>
<td>107</td>
<td>73</td>
</tr>
</tbody>
</table>

Reports in the Capacity Usage group also provide information about storage (and cost) savings from using space-efficient storage.

Using NetApp FlexClone-Enabled Storage in Virtual Provisioning

To provision by cloning using NetApp FlexClone on FlexClone-enabled storage devices, you must identify these devices within one or more virtual reservations. You can then use one or more reservation policies to ensure that machines provisioned from particular blueprints are provisioned on FlexClone-enabled storage.

Note: Only provisioning by cloning can make use of NetApp FlexClone space-efficient technology. Used with other virtual provisioning methods, FlexClone-enabled storage behaves like standard storage.

The steps required to create reservations on FlexClone-enabled reservations are as follows:

- A vCAC administrator uses the vCAC Administrator > Customization activity to enable FlexClone provisioning
- A vCAC administrator creates one or more NetApp ONTAP endpoints for FlexClone-enabled storage devices
- In creating or editing the reservation, you select Enable FlexClone and then select a FlexClone endpoint for each storage path you select in the reservation

Using Thin Provisioning in Virtual Provisioning

However, whether it can be specified for individual virtual machines, blueprints, or virtual reservations using the custom property VirtualMachine.Admin.ThinProvision depends on the virtualization platform, type of storage in use, and storage configuration within the platform. Thin provisioning can be selected
using the custom property on Hyper-V server compute resources and on ESX Server compute resources using local or iSCSI storage.

Note that NFS storage attached to ESX Server compute resources always uses thin provisioning, as does storage configured for thin provisioning that is attached to XenServer compute resources. This is shown in the following table.

**Table 8  Using Thin Provisioning in Virtual Machine Provisioning**

<table>
<thead>
<tr>
<th>Virtualization compute resource</th>
<th>Storage Type</th>
<th>Storage Configuration</th>
<th>Thin provisioning is used ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESX Server</td>
<td>NFS</td>
<td>---</td>
<td>always</td>
</tr>
<tr>
<td></td>
<td>local, iSCSI</td>
<td>---</td>
<td>when VirtualMachine.Admin.Thin Provision=True</td>
</tr>
<tr>
<td>Hyper-V Server</td>
<td>---</td>
<td>thin provisioning</td>
<td>always</td>
</tr>
<tr>
<td>XenServer</td>
<td>---</td>
<td>standard provisioning</td>
<td>never</td>
</tr>
</tbody>
</table>

If VirtualMachine/Admin/ThinProvision is not specified when provisioning on Hyper-V server compute resources and on ESX Server compute resources using local or iSCSI storage, the type of provisioning used depends on the default specified in the virtualization platform.

**Managing Reservation Capacity**

Managing the provisioning capacity of each provisioning group’s reservations so that machine requests never fail due to lack of capacity is an important task of Enterprise Administrators.

**Managing Virtual Reservation Capacity and Overreservation**

vCAC uses five terms when displaying information about virtual resource usage:

- **physical** — Actual memory or storage capacity of a virtualization compute resource.
- **reserved** — Specified machine quota, memory, or storage of a vCAC reservation, or of the total of vCAC reservations on a compute resource.
- **allocated** — Amount of a resource assigned to provisioned machines.
- **used** — Amount of storage actually in use by provisioned machines.
- **free** — all unused physical capacity on a storage path.

When a virtual reservation’s specified machine quota, memory, or storage is entirely allocated, no more machines can be provisioned from it. Because allocated memory and storage are not always the same as used memory and storage, however, this allocation limit may result in using less than the available physical capacity of a compute resource. For this reason, there are two situations in which it is appropriate for Enterprise Administrators to overreserve a compute resource—that is, to create virtual reservations on the compute resource that total more than its physical capacity for memory, storage or both.

- Since memory usage by virtual machines varies from moment to moment depending on whether and how they are used, the average and peak usage for a group of machines may be
significantly less than the memory allocated (which was specified in the blueprint with peak rather than continuous requirements in mind).

For example, if a reservation has 8 GB of memory and there are 4 powered-on machines with 2 GB of memory each provisioned on it, the reservation's memory is fully allocated and no more machines can be provisioned. But if the peak total memory usage of these machines never exceeds 4 GB, 4 GB of compute resource memory is never in use but at the same time unavailable for provisioning more machines. If there are four such reservations on a compute resource with 32 GB of physical memory, no more machines can be provisioned on the compute resource but 16 of its 32 GB of memory are not in use.

In this case, the Enterprise Administrator might assign 16 GB of memory to each reservation for a total of 64 GB; the compute resource would then be overreserved, with the Memory Reserved (%) column on the compute resources page showing 200%, but actual memory usage would be within the physical capacity of the compute resource.

• As noted in the previous section, for virtual reservations on standard storage allocated and used storage statistics are the same, but when machines are provisioned using a space-efficient technology, a reservation's storage used can be significantly less than its storage allocated. When this is the case, the difference can be calculated by comparing the allocated and used storage figures shown in the Storage Allocated % and Storage Used columns on the Reservations page and the Storage Allocated and Storage Used columns on the compute resource page.

If some or all of a compute resource’s storage is space-efficient, storage used is likely to consistently be significantly less than storage allocated, which results in the allocation limit preventing the use of the unused storage. For example, a compute resource with 300 GB of physical storage might typically show 250 GB allocated but only 125 GB used. In such a case, the Enterprise Administrator might increase the storage reserved on the compute resource to 500 to make more available for allocation, overreserving it at 167% (low enough to avoid using 100% of the physical storage).

Managing Cloud Reservation Capacity

Because of the potential expense of cloud machines, you should consider carefully before creating a cloud reservation with an unlimited machine quota.

Managing Physical Reservation Capacity

Assessing allocation of physical reservations is a relatively straightforward matter. There are three numbers to be compared:

• Total number of machines in the reservation
• Machine quota of the reservation, which is a limit on the number of machines that can be managed at one time
• Number of machines that are actually provisioned, or allocated

Note: Unlike virtual machines, powered-off physical machines are included in all allocation statistics.

The machine quota of a physical reservation does not have to be different from the total number of machines, but you may want to make the former less than the latter simply to hold some number of machines in reserve. (If you do not specify a quota, the effective machine quota will always be the num-
ber of machines in the reservation.) The Reservations page compares allocation to quota for each listed reservation.

You can also review the amount of a provisioning group’s total reserved physical quota that is currently allocated on the Provisioning Groups page.

**Reservation Alerts**

Reservation alerts enable an enterprise administrator to alert users when thresholds on reservations are reached so the user can track capacity usage. Thresholds can be set as a percentage of the total compute resources available. When a threshold is exceeded, an email is sent to a designated person or to a set of people. The enterprise administrator can adjust the frequency at which alerts are sent as well as receive copies of all email alerts. Alerts can be created for the following:

- Physical resources of a reservation including memory, CPU, and storage
- Total number of machines allocated against the reservation

**Note:** If the reminder is blank, you will receive the alert only once. Otherwise, you will receive an email at the frequency you have established.

Reservations are checked daily by running a scheduled workflow. The workflow collects any alerts for all existing reservations. If there is at least one alert set up, the workflow collects data on the following:

- Current capacities (adding the capacities of each machines to get the vCPUs used)
- Allocated capacities
- Limits for each capacity

For each defined alert, the workflow compares the allocated amount against the prescribed limit. All capacities that are over the prescribed limit are summarized in an email that is sent (asynchronously) to the specified set of recipients.

**Reducing Reservation Usage by Attrition**

You may at times want to reduce the number of machines on a particular reservation over the long term while keeping the reservation and the existing machines on it active. You can do this by reducing the reserved memory or storage of a virtual reservation or the machine quota of a virtual, cloud or physical reservation below the amount currently allocated. This allows management of existing machines to continue without change while preventing provisioning of new machines until allocation falls below the new reserved amount.

For example, suppose a provisioning group has a physical reservation containing 20 provisioned machines expiring over the next 90 days, and you want to reduce it by attrition (as the existing machines expire and are decommissioned) to no more than 15 machines. Simply set the machine quota to 15. No further machines can be provisioned, regardless of how many unprovisioned machines are included in the reservation, until the number of provisioned machines falls to 14 or below.

**Note:** Because virtual machines that are powered off are not included in allocated memory and machine quota totals, reducing the memory or machine quota of a virtual reservation below the amount allocated prevents powered-off machines from being powered on, as well as preventing provisioning of new machines.
Reservation Priority

All types of reservations and the storage paths enabled in virtual reservations can be assigned priorities, with 0 (zero) representing the highest priority. These priorities are part of the basis on which reservations and storage paths are selected for use in provisioning, as described in "Reservation and Storage Logic in Provisioning", later in this chapter.

Virtual Reservation Storage Paths

A virtual reservation can include one or more of the storage paths available on the compute resource. The amount of storage reserved is specified separately for each storage path.

Be sure that all storage paths included in any virtual reservation on a compute resource cluster are defined on and accessible to all compute resources in the cluster. Storage paths local to a single compute resource are available when creating a reservation on a cluster. If you enable a local storage path, however, provisioning will fail when the proxy agent selects a different compute resource in the cluster.

Virtual Reservation Network Paths

When a virtual machine is provisioned, its network device is attached to a network specified in the reservation. A reservation can include one or more of the networks available on the compute resource. When more than one network is selected in a reservation, distribution of machines among them is round robin.

The use of the VirtualMachine.NetworkN.* set of custom properties, however, makes it possible to create a blueprint that:

- Always attaches the virtual machine to a specific network even when the reservation it is provisioned from includes several
- Creates a machine with several network interfaces, each attached to a different network

In each case, the network(s) specified in the blueprint must be among those included in the reservation used for provisioning; this can be ensured using reservation policies.

You can also specify a network profile for each network path selected in a virtual reservation; any machine provisioned by cloning or kickstart/autoYasT provisioning and attached to a network path with a network profile selected is provisioned using static IP address assignment. The network profile specified in a machine’s source blueprint using the VirtualMachine.NetworkN.ProfileName property, however, overrides the network profile specified for the network to which it is attached.

Note: VMware recommends selecting a network profile for all or none of the network paths selected in a virtual reservation.

You can use reservation policies to group reservations with network profiles specified and select these network profiles in blueprints for virtual provisioning by cloning with static IP assignment.

Static IPs are automatically reclaimed every 20 minutes in vCAC, but the machine must have been in the Destroyed state for at least 30 minutes before being reclaimed. Because of this, static IPs can generally take anywhere between 30 and 49 minutes to be reclaimed.
Reservation and Storage Logic in Provisioning

When a machine is requested, vCAC must select one of the provisioning group’s reservations of the appropriate type (assuming it has more than one) from which to provision the machine. The logic by which vCAC selects a reservation depends on a number of factors, including:

- The reservation policy specified in the blueprint, if any
- For virtual and cloud machines, whether the reservation’s location matches the location selected by the requesting user
- The priorities of the available reservations
- Whether the reservation has provisioning capacity available and, if so, for virtual and physical machines the allocated percentage of each reservation’s machine quota (limit on the number of machines that can be provisioned from it)
- For virtual machines, whether at least one storage path in the reservation has sufficient unused capacity to provision the machine

**Note:** A reservation policy can include reservations of different types, but only reservations matching the blueprint type are considered for provisioning.

Reservation logic varies depending on whether a virtual, cloud or physical machine is being provisioned.

Virtual Reservation and Storage Path Selection in Provisioning

When a virtual machine is requested, vCAC must select both a virtual reservation and one of the storage paths enabled in that reservation (if more than one is enabled) to use for the machine’s storage requirements. The logic by which the reservation and storage path are selected can be very simple or relatively complex, depending on the number of eligible reservations and how many storage paths they contain.

In selecting a virtual reservation for provisioning, vCAC considers the following factors:

- The reservation policy specified in the blueprint, if any
- The location specified by the requesting user, if any
- The relative priorities of the reservations.
- The percentage of each reservation’s machine quota that has been allocated. (Allocated quota includes only machines that are powered on.)
- Whether the reservation has sufficient reserved but unallocated quota, memory and storage to provision the machine.
- Whether at least one of the reservation’s enabled storage paths has sufficient free physical capacity to provision the machine.

In selecting a storage path from among those enabled in the selected reservation, vCAC considers whether it has both sufficient unallocated reserved storage and sufficient free physical capacity to provision the machine.

**Note:** vCAC updates information about the amount of physical storage in use on each known storage path as frequently as is practical. However, it is always possible...
for the amount of free space on a storage path to decrease significantly between the last update and a provisioning operation. In particular, a data deduplication or dynamic disk storage technology involving highly dynamic storage usage by individual machines can reduce the accuracy of even very recent overall usage information.

**Virtual Reservation Selection Logic**

When a provisioning group has more than one virtual reservation, whether on a single compute resource or on multiple compute resources, the reservation from which to provision a requested machine is selected according to the following logic. (Remember that allocated machine quota includes only machines that are powered on; if a reservation has a quota of 50, and 40 machines have been provisioned but only 20 of them are powered on, the reservation’s quota is 40% allocated, not 80%.)

1. A reservation is initially selected:
   - If a reservation policy is specified in the blueprint from which the machine is requested, a location is selected by the user, or both, and
   - the provisioning group has a single reservation meeting those criteria—that is, it is included in the policy, on a compute resource associated with the selected location, or both—that reservation is selected.
   - the provisioning group has multiple reservations meeting the criteria, the reservation with the highest priority (0 being the highest) is selected. Where reservation priorities are the same, the reservation with the lowest percentage of its machine quota allocated is selected.
   - the provisioning group has no reservation meeting the criteria, provisioning fails.

   If no reservation policy is specified or location selected, the reservation with the highest priority among the group’s reservations is selected. Where reservation priorities are the same, the reservation with the lowest percentage of its machine quota allocated is selected.

2. If the initially selected reservation has sufficient unallocated quota, memory and storage to provision the machine, its enabled storage paths are evaluated for sufficient free capacity. If it does not, the next reservation is selected according to the logic in step 1. If no eligible reservation has sufficient unallocated resources, provisioning fails.

3. When a reservation with sufficient unallocated resources is selected, vCAC determines the greatest free capacity among its enabled storage paths. If this is enough to provision the machine, the reservation is selected. If it is not, the next reservation is selected according to the logic in step 1 and evaluated for unallocated capacity as in step 2.

4. If no eligible reservation has sufficient unallocated resources and at least one storage path with enough free capacity, provisioning fails.

**Storage Path Selection Logic**

Once a virtual reservation is selected, the storage path on which to provision the machine is selected according to this logic:

1. The storage paths are ordered by priority; where priorities are the same, ordering is random.
2. Each storage path is evaluated, in order, for unallocated storage capacity. If this is sufficient to provision the machine, the storage path is selected. If not, the next storage path in order is evaluated. If no storage path has sufficient unallocated capacity, provisioning fails.
3. If unallocated capacity on the selected storage path is sufficient to provision the machine, the storage path is selected. If not, the next storage path in order is evaluated. If no storage path has sufficient unallocated capacity, provisioning fails.

4. When a storage path with sufficient unallocated storage capacity is selected, it is evaluated for free capacity. If this is enough to provision the machine, the storage path is selected. If not, the next storage path in order is evaluated for unallocated capacity as in step 2 and then for free capacity.

5. If no storage path has sufficient unallocated capacity and enough free capacity, provisioning fails.

**Note:** Because unallocated reserved virtual capacity is evaluated before free physical capacity in selection of both virtual reservations and storage paths, it is possible for provisioning to fail even when there is at least one eligible reservation containing an enabled storage path with sufficient free capacity to provision the machine.

As previously noted, it is always possible for the amount of free space on a storage path to decrease significantly between vCAC’s last update and a provisioning operation, particularly if a data deduplication or dynamic disk storage technology involving highly dynamic storage usage by individual machines is in use, the storage path is in regular use outside vCAC, or both. A decrease in free capacity since the last vCAC update can cause provisioning to fail even after the reservation containing the storage path is selected.

**Reservation Logic in Cloud Provisioning**

The following two factors always determine the reservation selected to provision a cloud machine:

- Each cloud blueprint specifies an Amazon Machine Image (AMI) and each AMI is specific to a particular region within an Amazon Web Services (AWS) account.

- The requesting user must select a location (Amazon availability zone) from those in the region corresponding to the AMI.

The region of the AMI specified in the blueprint and the user’s location selection therefore specify the region and location of the reservation to be selected.

Based on this requirement, when a provisioning group has more than one cloud reservation, whether on a single endpoint or on multiple endpoints, the reservation from which to provision a requested machine is selected according to the following logic.

1. A reservation is initially selected as follows:

   If a reservation policy is specified in the blueprint from which the machine is requested, and

   - the provisioning group has a single reservation included in the specified reservation policy that matches the required region and location, that reservation is selected.

   - the provisioning group has multiple reservations in the reservation policy that match the region and location, the reservation with the highest priority (0 being the highest) is selected; where priorities are the same, ordering is random.

   - the provisioning group has no reservation in the reservation policy that matches the region and location, provisioning fails.
If no reservation policy is specified, the reservation with the highest priority among those matching the required region and location is selected. Where reservation priorities are the same, ordering is random.

2. If the initially selected reservation has an unlimited machine quota, or the machine quota is specified but not fully allocated, the reservation is used for provisioning; if the machine quota is set and is fully allocated, the next reservation is selected according to the logic in step 1.

3. If no eligible reservation has unallocated machine quota, provisioning fails.

Because all private AMIs are account specific, the above logic creates an additional failure scenario when available cloud endpoints represent more than one AWS account. When the reservation selected for provisioning has the required region and location, but is not on the endpoint representing the account containing the private AMI specified in the blueprint, provisioning fails. (Public AMIs are typically available to all accounts.) For example, consider the following:

- Endpoint X and endpoint Y represent two different AWS accounts, each of which includes the Asia Pacific (Tokyo) region, which contains availability zones ap-northeast-1a and ap-northeast-1b.
- There are reservations with region Asia Pacific (Tokyo) and location ap-northeast-1a on both endpoint X and endpoint Y.
- The private AMI win2008r2sp1-sqlsrvr2008-iss-appset2 is registered in Asia Pacific (Tokyo) in the account represented by endpoint X.
- A user requests a machine from a cloud blueprint specifying AMI win2008r2sp1-sqlsrvr2008-iss-appset2 and selects location ap-northeast-1a.
- The first reservation to be considered is on endpoint Y, region Asia Pacific (Tokyo), location ap-northeast-1a.

Because the region and location match the provisioning request, the reservation is selected; because the account represented by endpoint Y does not contain AMI win2008r2sp1-sqlsrvr2008-iss-appset2, provisioning fails.

There are two ways to avoid this problem:

- Register your private AMIs in only one regions in each AWS account and in a different region in each account, then create reservations on each corresponding endpoint only in the corresponding region.

In the above example, for instance, endpoint X could contain private AMIs only in region Asia Pacific (Tokyo), and endpoint Y only in region Asia Pacific (Singapore); reservations on endpoint X would therefore be made only with region Asia Pacific (Tokyo), and those on endpoint Y only with region Asia Pacific (Singapore).

Thus provisioning requests would select only reservations on the endpoint containing the intended AMI. In the example, all provisioning requests from blueprints specifying AMIs from endpoint X would require reservations with region Asia Pacific (Tokyo), and all reservations with Asia Pacific (Tokyo) would be on endpoint X.

- Use reservation policies to restrict provisioning from particular blueprints to particular sets of reservations. In the above example, the simplest form of this would be to include all reservations on endpoint X in reservation policy X and all of those on endpoint Y in reservation policy Y; when
selecting an AMI from the account represented by endpoint X, the blueprint creator would also select reservation policy X.

**Reservation Logic in Physical Provisioning**

When a physical machine is requested, vCAC must select one of the provisioning group’s physical reservations from which to provision the machine. If the selected reservation contains more than one unprovisioned machine matching the blueprint specification, vCAC must also choose the machine to provision. The logic by which the reservation and machine are selected can be very simple or more complex, depending on the number of eligible reservations, the use of reservation policies, and so on.

In selecting a physical reservation for provisioning, vCAC considers these factors, in order:

- The reservation policy specified in the blueprint, if any
- The relative priorities of the reservations
- Where priorities are the same, the percentage of each reservation’s machine quota that has been allocated

In selecting an unprovisioned machine from among those in the selected reservation, vCAC considers whether the machine matches the CPU and memory specifications in the blueprint, including the resource matching settings.

When a provisioning group has more than one physical reservation, the reservation from which to provision a requested physical machine is selected according to this logic:

1. A reservation is initially selected from among all those belonging to the provisioning group:
   - If a reservation policy is specified in the blueprint from which the machine is requested, and the provisioning group has:
     - A single reservation included in the specified policy, that reservation is selected.
     - Multiple reservations included in the policy, the reservation with the highest priority (0 being the highest) is selected. Where reservation priorities are the same, the reservation with the lowest percentage of its machine quota allocated is selected. If no reservation has any unallocated quota, provisioning fails.
     - No reservation included in the policy, provisioning fails.
   - If no reservation policy is specified, the reservation with the highest priority among the group’s reservations is selected. Where reservation priorities are the same, the reservation with the lowest percentage of its machine quota allocated is selected. If no reservation has any unallocated quota, provisioning fails.

2. Once a reservation is selected, vCAC considers unprovisioned machines in the reservation in an unordered sequence.
   - The first machine is evaluated against the blueprint specifications—for example, at least 2 CPUs and exactly 2 GB of memory, or exactly 4 CPUs and 4 GB. If it matches the specifications, it is selected for provisioning. If it does not, the next machine in sequence is considered, and so on.
   - If no machine in the reservation matches the CPU and memory specifications, the next reservation is selected according to the logic described above.

3. If no reservation contains a machine matching the specifications, provisioning fails.
Physical Reservations and Hardware Type

Although a physical reservation is not restricted to a particular hardware type, the best practice is typically to create reservations with only one type of physical machine and use reservation policies to restrict provisioning from blueprints of a specific type to reservations containing only machines of that type. This allows you to ensure that your HP iLO blueprints are correct for HP iLO provisioning, and so on. For example, when you use a custom property in a blueprint to specify the location of a boot disk for WIM-based, kickstart/autoYaST or SCCM-based provisioning, the value is a web URL for HP iLO machines but an NFS or CIFS path for Dell iDRAC machines.

**Using Reservation Policies to Match Cisco UCS Service Profile Templates and Boot Policies**

Reservation policies are particularly useful in ensuring successful provisioning of Cisco UCS machines. When creating a Cisco UCS blueprint, as described in "Managing Provisioning Group Blueprints", you must select a Cisco UCS Manager service profile template (and optionally a boot policy) on the Build Information tab. If the specified service profile template is not found in the Cisco UCS Manager instance managing the machine selected for provisioning, provisioning fails.

Because a blueprint is not associated with any particular reservation, and templates and boot policies are selected from among all those discovered on all Cisco UCS endpoints, there is a possibility that the selected template or boot policy or both will not be available in the UCS Manager instance represented by the endpoint on which the reservation selected for provisioning was made.

The best way to avoid these circumstances is to use reservation policies to restrict provisioning from certain Cisco UCS blueprints to the corresponding UCS Manager endpoints.

For example, suppose service profile templates A is available on UCS Manager endpoints C1 and C2 but not on C3 and C4. If a Cisco UCS machine from a reservation on endpoints C3 or C4 is provisioned from a blueprint calling for template A, provisioning fails. To avoid this, create a reservation policy called **ServiceProfileA** containing only reservations on endpoints C1 and C2. Any blueprint selecting service profile A on the Build Information tab should also select this reservation policy on the Blueprint information tab, meaning that machines can be provisioned from those blueprints only on reservations on endpoints C1 and C2, on which service profiles A is available.

The Service profile template drop-down list on the blueprint Build Information tab shows the endpoint on which each template is available (a template may be available on more than one endpoint). This information can help you identify the appropriate reservation(s) to be placed in a reservation policy for each Cisco UCS blueprint.

**Determining a Machine’s Organization in Cisco UCS Manager**

When a Cisco UCS physical machine is provisioned, it must be placed in an organization within the Cisco UCS Manager instance managing it. There are two ways to accomplish this in vCAC.

By default, provisioned Cisco UCS machines are placed in an organization corresponding to the provisioning group of the blueprint used for provisioning. The organization for a particular provisioning group within a particular UCS manager instance is created the first time a reservation for that provisioning group containing at least one machine is made on the endpoint representing that instance. The generated organization is of the form `org-root/org-VMware/org-provisioning_group_guid`, where `provisioning_group_guid` is the first 16 characters of the group’s GUID, for example `org-root/org-VMware/org-3d8528feda964a82`. There is one organization per provisioning group per instance; for example, if a vCAC site has five provisioning groups provisioning Cisco UCS machines from reservations on three endpoints representing three UCS Manager instances, 15 organizations will be created, and all provisioned Cisco UCS machines will be sorted into these organizations.
You can specify a different organization for a provisioning group by adding the Cisco.Organization.DN custom property to the group. This property specifies the distinguished name of the Cisco UCS Manager organization to place machines in. The specified organization must exist within the UCS manager on which machines are provisioned by that group, however, or provisioning fails. You can ensure that this does not happen by making all reservations for that provisioning group on UCS manager endpoints representing instances in which the specified organization exists.

When provisioning fails because the specified organization does not exist within UCS Manager, the reservation used is disabled. To correct this, ensure that the organization exists within UCS manager, enable the reservation, and then edit it and save it.

Viewing, Deleting and Editing Reservations

Enterprise Administrators can display the Reservations page to view and manage reservations in one of several ways. Under Enterprise Administrator in the activity pane, you can

- select Reservations to display all virtual and cloud reservations on all compute resources and endpoints in the enterprise group(s) you manage, as well as all physical reservations
- select Provisioning Groups, then choose View Reservations from the hover menu for a listed provisioning group to display that group’s reservations of all types
- select Compute Resources, then choose View Reservations from the hover menu for a listed compute resource to display all virtual reservations on that compute resource

If you are also a vCAC administrator you can also select Endpoints, then choose View Compute Resources from the hover menu for a listed cloud endpoint to display all cloud reservations on that endpoint.

Whichever method you use, the Reservations page by default shows each reservation’s name, type, provisioning group and priority, and includes several columns indicating provisioning capacity usage, including total machines on the reservation, percentage of total machines that is allocated (turned on for virtual and cloud reservations, managed for physical reservations) and percentage of reserved capacity allocated for machine quota (all types) as well as memory and storage (virtual only).

Note: Only machines that are turned on are counted included in virtual reservation allocated quota and memory statistics. Allocated storage statistics include all virtual machines, off or on.

Reservation Settings

Reservation settings vary between the different types of reservations; these differences are noted where applicable. Settings are described below.

Common Reservation Settings

- **Compute Resource/Endpoint**—The compute resource a virtual reservation is on or the endpoint a cloud reservation is on. (There is no equivalent for physical reservations.)
- **Name**—A descriptive name for the reservation.
- **Provisioning group**—The provisioning group the reservation is for.
Note: Neither the compute resource or endpoint a reservation is on nor the provisioning group it is for can be changed after it is created.

- **Reservation Policy**—Reservation policy in which to place the reservation. A reservation policy is a collection of reservations that can be selected in a blueprint to restrict all machine provisioning from that blueprint to those reservations. A reservation need not belong to a reservation policy, but can belong to only one.

Reservation policies are often used to group like resources to create defined service levels or make a specific type of resource (such as NetApp FlexClone-enabled storage) easily available for a particular purpose. They can also be used to restrict provisioning of cloud machines to reservations on endpoints representing the AWS account containing the AMI specified in the blueprint or provisioning of Cisco UCS physical machines from a particular blueprint to reservations on endpoints on which the selected service profile template and boot policy are available.

- **Machine Quota**—The maximum number of machines that can be provisioned from the reservation. Leave this field empty to specify no limit. (Only virtual and cloud machines that are turned on are counted in virtual reservation allocated machine quota statistics.)

- **Priority**—The priority of the reservation, for use in determining which reservation to use when two or more are available to a provisioning group. Lower-numbered reservations are used first.

- **Custom properties** (bottom of page)—Any custom properties to be used in provisioning machines on the reservation. Typically, these would be different from those in build profiles and blueprints, having to do with resource management.

Note: As noted in Custom Properties in Machine Provisioning, Blueprints and Build Profiles, custom property values in reservations override those in provisioning groups, and those in provisioning groups override those in blueprints and build profiles. Because properties from these sources may be applied to so many machines provisioned from so many blueprints, they should be used carefully, and restricted to purposes applicable to all the machines they will be applied to.

When entering custom properties, select the **Encrypt** check box to ensure that a secure property (such as a password) is never visible in plain text.

Click the **Save** button to save your changes to a property or the **Cancel** button to cancel them. Remember that the properties you add or modify are not saved until you save the reservation by clicking **OK**, but that you **must** click the **Save** button to save and close each property you open before pressing **OK**.

Note: When entering custom properties, always ensure that property values do not contain trailing spaces, as these may cause provisioning to fail.

**Virtual Reservation Resource Settings**

Virtual reservations require a number of resource settings to be functional.

- **Enable FlexClone**—Whether the storage paths selected in a virtual reservation represent NetApp FlexClone-enabled storage devices.

  If this check box is selected, each storage path selected for the reservation must be associated with a NetApp ONTAP endpoint. If there is not at least one such storage path available on the
selected compute resource, you cannot save the reservation with the Enable FlexClone check box selected.

**Note:** The Enable FlexClone check box does not appear unless a vCAC administrator has enabled FlexClone provisioning and is only supported with Virtual Center compute resources.

- **Memory**—Use the Memory section of the Edit (or New) Reservation - Virtual page to specify how much of the virtualization compute resource's memory is reserved by this reservation. The section also shows you the current total physical, allocated and reserved memory of the compute resource. This lets you specify an amount of memory for the current reservation within the context of the compute resource's overall usage. If physical and reserved memory on the compute resource are currently the same, for example, there is no more unreserved memory available; adding a reservation or adding memory to an existing reservation will cause the compute resource to become overreserved. On the other hand, if reserved and allocated are the same but physical is larger, more machines can be provisioned on the compute resource if more memory is reserved. (Only machines that are turned on are counted included in allocated memory statistics.)

- **Storage**—Use the Storage section of the Edit (or New) Reservation - Virtual page to enable storage paths and to specify how much storage on each is reserved by this reservation. For each storage path available on the selected compute resource, this section shows you
  - The current physical, free and reserved storage on the entire storage path. The Reserved figure is for all vCAC reservations, not just the one you are currently editing. Remember that a storage path can be deliberately overreserved as discussed earlier in this section.
  - The amount of storage reserved by the reservation you are editing and the storage currently allocated from it to virtual machines. (Remember that the amount actually used by those machines will be less if space-efficient storage is in use.)

These statistics let you select among the available storage paths and specify an amount of storage for the current reservation within the context of each storage path’s overall usage to avoiding overreservation of storage paths. You must select at least one storage path.

A storage cost is also displayed for each storage path. This cost is specified on the Cost Profile tab for the compute resource the reservation is on, either in the cost profile assigned to the compute resource or in the storage cost profile assigned to the individual storage path. If no cost profile of either type is assigned, the storage cost is 0.

If Enable FlexClone is selected (above), you must select a NetApp ONTAP endpoint with which to associate each storage path you select for the reservation. If no such endpoint is available, you cannot save the reservation with Enable FlexClone selected.

When selecting multiple storage paths, you can assign a priority to each, which determines the order in which vCAC evaluates them for provisioning once the reservation has been selected. If you do not specify priorities or specify equal priorities, ordering is random.

You can also disable each storage path in an existing reservation to prevent new machines from being provisioned on it. This is usually done prior to decommissioning a storage device; once existing machines provisioned on the path are disposed of, the storage can be removed from the compute resource.
**Note:** Be sure that all storage paths included in any virtual reservation on a compute resource cluster are defined on and accessible to all compute resources in the cluster. Storage paths local to a single compute resource are available when creating a reservation on a cluster. If you enable a local storage path, provisioning will fail when the proxy agent selects a different compute resource in the cluster.

For virtual reservations on Hyper-V compute resources, you must select `default` as the storage path. This is the only currently supported storage path.

- **Network**—The **Network** section of the Edit (or New) Reservation - Virtual page lets you select the network paths to which machines using the reservation will be added from among those available on the compute resource. You must select at least one. If you select more than one, machines are distributed among them in round-robin fashion.

  For each network, you can select from among existing network profiles to be assigned to virtual machines provisioned from the reservation. A network profile is used for static IP address assignment when provisioning virtual machines by cloning or kickstart/autoYaST provisioning, it has no effect on virtual machines provisioned by other methods. The **New Network Profile** link takes you directly to the New Network Profile page so you can create a network profile before completing the virtual reservation.

  The network profile specified in a machine’s source blueprint using the `VirtualMachine.NetworkN.ProfileName` property overrides the network profile specified for the network to which it is attached.

  For this option to be available, a vCAC Administrator must have enabled static IP use for your site.

**Note:** VMware recommends selecting a network profile for all or none of the network paths selected in a virtual reservation.

  You can use reservation policies to group reservations with network profiles specified and select these network profiles in blueprints for virtual provisioning by cloning with static IP assignment.

  An IP address within the specified ranges that has been allocated to a machine is not automatically made available when the machine is destroyed; it must be returned to use manually by an Enterprise Administrator. For this reason, none of the addresses specified in the network profile may be available. When this is the case and a network path for which the network profile is specified is selected from the reservation selected for provisioning, provisioning fails.

- **Resource pool**—The virtualization platform resource pool to which the virtual reservation belongs. Resource pools are a method of prioritizing resource usage. For example, one line of business may have a more pressing need for machines than another, and therefore be willing to pay more for rapid provisioning; in this case the two lines would draw from different resource pools. Available resource pools are determined through data collection.

**Note:** The resource pool setting of a reservation can be overridden by the use of the `Infrastructure.ResourcePool.Name` custom property in a profile or blueprint. If the resource pool of a machine changes in the virtualization platform after it is
provisioned, this property is updated when vCAC synchronizes with the virtualization platform through data collection.

Cloud Reservation Resource Settings

A reservation on a cloud region automatically makes all the resources of the cloud service account available for provisioning cloud machines (unless you specify a machine quota for the reservation). However, you must choose several required settings and can choose another optional setting. Choices for each setting represent all elements discovered through data collection.

Physical Reservation Resource Settings

The only resources specified in a physical reservation are the machines themselves.

- Physical machines already included in the reservation are displayed with their hardware name, vendor, CPU count, memory, and asset tag of each.
- Unprovisioned machines in the list have a delete icon next to them; click this to remove the machine from the reservation. The icon does not appear for managed machines, which cannot be removed from the reservation.
- To add a machine to the reservation, click the Add Machine link. The Enterprise Machines page is displayed as a popup, filtered for unreserved machines (status of Unmanaged). Select one or more and click OK to add those machines to the reservation.
- You can create an empty reservation.

Note: Although a physical reservation is not restricted to a particular hardware type, the best practice is typically to create reservations with only one type of physical machine and use reservation policies to restrict provisioning from blueprints of a specific type to reservations containing only machines of that type. This is particularly useful with Cisco UCS machines, because it allows you to restrict a Cisco UCS blueprint to reservations on endpoints representing Cisco UCS Manager instances containing the service profile template and boot policy specified in the blueprint.

The first time you add a Cisco UCS machine managed by a particular instance of Cisco UCS Manager to a reservation for a particular provisioning group, an organization corresponding to that provisioning is created within that instance and all Cisco UCS machines subsequently provisioned by that group are placed in that organization.

Reservation Alert Settings

To establish thresholds and send email alerts (virtual only):

1. Click Enterprise Administrator > Reservations.
2. Create a new reservation or edit an existing reservation.
3. Click the Alerts tab.
4. Select Enable alerts to turn on the thresholds alert option.
5. Use the sliders to set the thresholds for each resource, including:
To establish machine quota thresholds and send email alerts (cloud, physical):

1. Click **Enterprise Administrator > Reservations**.
2. Create a new reservation or edit an existing reservation.
3. Click the **Alerts** tab.
4. Select **Enable alerts** to turn on the thresholds alert option.
5. Use the sliders to set the machine quota thresholds.
6. Enter the email addresses of recipients of the alert emails.
   Length of emails is limited to 256 characters.
7. (Optional) Click the check box to Send email to Group Manager.
8. Enter the reminder frequency (in days) or leave the field blank to not send email reminders after sending the initial alert email.

**Adding a Reservation**

To add a reservation, move the pointer over the **New Reservation** link at the right-hand end of the Reservations title bar and select **Virtual, Physical**, or **Cloud**.

To begin by copying the settings of an existing reservation, use the **Copy from existing reservation** drop-down list to select from among all reservations. You can then modify the settings as needed and save the reservation under a new name. Bear in mind that this copies the provisioning group and compute resource/endpoint settings along with others; once you have created the reservation these cannot be changed, so if you want to change them do it right away, before saving the reservation.

All reservations settings but reservation policy, quota, resource pool (virtual only), physical machines (physical only) and custom properties are required. Descriptive reservation names are helpful in allowing you and other Enterprise Administrators to manage virtual reservation usage site wide.

**Moving Virtual Machines to a New Storage Path**

When a virtual machine is moved from one storage path to another on the same compute resource, compute resource cluster or Xen pool—for example, when you are migrating storage in preparation for decommissioning an array—this information must be updated within vCAC. There are two ways to do this, depending on whether the virtual machines are to:

- Remain on the same virtual reservation in the same provisioning group within vCAC
• Be moved to a new reservation on the compute resource, belonging to either their original provision-
ing group or a different provisioning group

**Moving Machines Within the Same Virtual Reservation**

When the old storage path and the new storage path are both selected in the virtual reservation on which the moved virtual machines are provisioned, vCAC data collection detects the movement of machines from one to the other and updates the vCAC database accordingly. To move machines between storage paths in the same reservation, do the following:

1. Edit each virtual reservation and:
   - Disable the old storage path if all machines are to be moved and it is going to be decommissioned.
   - Select the new storage path if it is not already selected, making sure an appropriate amount of storage is reserved on it.

2. Move the machine(s) to the new storage path outside of vCAC.

3. Wait for the next data collection to complete, or initiate data collection on the compute resource using the Data Collection option.

**Moving Machines to a New Virtual Reservation and Provisioning Group**

To move virtual machines to a new storage path in a new virtual reservation, possibly in a new provisioning group, use the following procedure. You must be a PGM of both the original provisioning group and the target provisioning group, even if they are the same, to use the Change Reservation option.

1. Add a virtual reservation on the compute resource on which the machines are provisioned, in which the new storage path is selected with an appropriate amount of storage reserved on it. The reservation can be in any provisioning group (but remember that you must be PGM of that group).

2. Edit the virtual reservation containing machines to be moved and disable the old storage path if all machines are to be moved and it is going to be decommissioned

3. Move the machine(s) to the new storage path outside of vCAC.

4. Select Enterprise Administrator > Enterprise Virtual Machines to display the enterprise virtual machines list. For each machine that was moved externally, use Change Reservation to move the machine to the new reservation and storage path within it. (Remember, you must be PGM of the provisioning group the old reservation belongs to.) The vCAC database now contains the correct information about each machine’s storage path.

5. If you add a virtual reservation for every provisioning group containing machines you have relocated, you can move each machine within its original provisioning group. In this case it is generally best to select the same blueprint the moved machine is currently associated with.

6. If you move the machine to a virtual reservation in a new provisioning group, you must select a blueprint in the new provisioning group to associate the machine with. You may want to create appropriate virtual blueprints within the provisioning group before you use Change Reservation.

If the machine’s owner is not a member of the new provisioning group, you must also do one of the following:
• Use the **Edit** option (above) to change the machine’s owner to someone in the new provisioning group

• Edit the new provisioning group to add the machine’s existing owner to the new provisioning group.

If you do not do one or the other, the machine’s owner will not have any access to the machine.

**Note:** If the network on which the moved virtual machine was provisioned is not the only network selected in the new reservation, a mismatch between the machine’s actual network and the network associated with it in the vCAC database may result. However, this has no practical effect.

If a machine is moved to a new compute resource outside of vCAC, the compute resource change is updated in vCAC but the storage path and network must be updated manually. In such a case, use the procedure immediately above, but create the new virtual reservation on the new compute resource. To change the reservation of a machine that was moved to a new compute resource, you must have Enterprise Administrator access to both the original compute resource and the new compute resource.

### Decommissioning a Storage Path

After you have moved all existing machines off a storage path in preparation for removing it from service, be sure to disable the storage path in all virtual reservations on that compute resource, compute resource cluster or Xen pool using the **Disable** check box. To do this you can list all reservations on a compute resource using the **View Reservations** option on the compute resources page, then edit each listed reservation.

vCAC data collection detects the removal of a storage path from a compute resource and automatically removes it from the console. The storage path is removed from existing virtual reservations and cannot be selected in new reservations on the compute resource.

### Temporary Storage Path Outages

As noted above, vCAC data collection detects the absence of a storage path on a compute resource, for whatever reason, and automatically removes it from the console. If the storage path is subsequently restored, however, data collection detects this and automatically restores the storage path to the console and to all existing virtual reservations in which it was previously selected, with all reservation specifications as they were before the storage path was removed.

Virtual machines provisioned on the storage path are listed as missing in the **Is Missing** column on the Enterprise Virtual Machines page and in reports while it is unavailable.

### Managing Reservation Policies

A reservation policy is a collection of reservations of one type (virtual, cloud or physical) that can be selected in a blueprint to restrict all machine provisioning from that blueprint to the reservations in the policy. A reservation need not belong to a reservation policy, but can belong to only one.

Reservation policies are often used to group like resources to create defined service levels or make a specific type of resource easily available for a particular purpose—for example, NetApp FlexClone-enabled storage or high CPU count physical machines.

Reservation policies can also be used to restrict provisioning of cloud machines to reservations on endpoints representing the AWS account containing the AMI specified in the blueprint, or provisioning of
Cisco UCS physical machines from a particular blueprint to reservations on endpoints on which the selected service profile template and boot policy are available.

Reservation policies are site-wide elements; any user creating or editing a blueprint can select from among all existing reservation policies. As explained in “Reservation and Storage Logic in Provisioning”, however, if the provisioning group from which a blueprint is selected to request a machine has no appropriate reservations included in the reservation policy specified in the blueprint, provisioning will fail.

Suppose, for example, you create a reservation policy **XenPools** containing all reservations on compute resources representing Xen pool as well as a global blueprint **Xen Developer Workstation** with the **XenPools** policy selected. If the manager of provisioning group **FinanceOps** selects **Xen Developer Workstation** as a blueprint for her group, but **FinanceOps** has no reservations on Xen pool compute resources and thus no reservations in the **XenPools** policy, users in **FinanceOps** can select **Xen Developer Workstation** when requesting machines but no machines can be provisioned from it until a reservation for **FinanceOps** is placed in **XenPools**.

**Note:** You can mix reservations of different types in a reservation policy, but only reservations matching the blueprint type are considered for provisioning.

Enterprise Administrators are responsible for managing reservation policies as necessary. You place a reservation in a reservation policy while adding or editing the reservation, not the policy. Reservations can be moved among policies as needed.

To manage reservation policies, select **Enterprise Administrator > Reservation Policies** in the activity pane. The table that appears shows all existing policies with their descriptions. When modifying a policy, or adding one using the **New Reservation Policy** link at the right-hand end of the title bar, click the **Save** button to save your changes or the **Cancel** button to cancel them. You must click the **Save** button to save an open policy before leaving the page.

**Note:** You can review the reservations that belong to each reservation policy by selecting **Enterprise Administrator > Reservations** and adding the optional **Reservation Policy** column to the Reservations list, then sorting or filtering that column.

### Managing Network Profiles

In general vCAC uses DHCP to assign IP addresses to the machines it provisions, regardless of which provisioning method is used. When provisioning virtual machines by cloning or using kickstart/autoYaST provisioning, however, you can assign static IP addresses from a predetermined range.

To enable static IP assignment, you can create one or more network profiles containing the ranges of IP addresses that can be used. Each IP address within the specified ranges that has been allocated to a machine is automatically reclaimed for reassignment when the machine is destroyed.

To manage network profiles, select **Enterprise Administrator > Network Profiles** in the activity pane. For this option to be available, a vCAC administrator must have enabled static IP use for your site.

### Viewing, Deleting, Editing and Creating Network Profiles

The Network Profiles page lists the existing profiles. You can use the **Edit** and **Delete** options to edit or delete a profile, and the **New Network Profile** link at the right-hand end of the title bar to create a network profile.
**Note:** To avoid duplicate IP assignments, which cause provisioning to fail, do not delete a network profile that is tracking allocated IP addresses.

Attempting to create a network profile containing IP addresses imported from CSV files causes an error.

Network profile settings include a name and description, the subnet mask to apply (required), and a number of optional network settings, as well as one or more IP address ranges.

### Adding and Deleting IP Address Ranges

The **Defined Ranges** grid shows the IP address ranges currently specified for the profile. You can use the **Delete** option to remove one. To add a range to a network profile, click the **Add IPv4 Static Range** link in the right-hand end of the title bar, and on the New Network Range page enter a name and description for the range and the starting and ending IP addresses. Ranges are inclusive. If you want to specify only one IP address, enter it for both starting and ending address. Click **OK** to return to editing or creating the network profile.

### Monitoring IP Address Assignment and Reclamation

The **Defined IP Addresses** grid at the bottom of the page shows the current status of all of the IP addresses within the ranges specified in the **Defined Ranges** grid that have been allocated to a machine at least once. The **Status** of such an address can be one of the following:

- **Allocated**—Currently assigned to the active virtual machine whose name appears in the **compute resourcename** column.
- **Expired**—Currently assigned to the expired machine whose name appears in the **Machine** column.
- **Unallocated**—Previously assigned to the machine whose name appears in the **compute resourcename** column, now available.
- **Destroyed**—Assigned to the machine whose name appears in the **compute resourcename** column, which has been destroyed. Also includes those assigned to requested machines that were never successfully provisioned. Each address in this category is reclaimed and converted to **Unallocated** about 30 minutes after the machine was destroyed.

To manually change an IP address from **Destroyed** to **Unallocated**, select **Reclaim** from the menu.

### Uploading IP Addresses and Status from a CSV File

The **Upload CSV** box lets you browse for and upload a CSV file containing information about IP addresses. This lets you add a pool of nonsequential IP addresses to the network profile for allocation.

Each record of the CSV file is of the format `IP_address,hostname,status`, where a value for **hostname** is required for an allocated address and the default value for status is **unallocated**. For example, the record

```
192.168.15.99,,
```

indicates that the address 192.168.15.99 has not yet been allocated to any compute resource, while the record

```
192.168.15.87,XPdevWS1423,allocated
```
indicates that the address 192.168.15.87 is currently allocated to machine XPdevWS1423.
The IP addresses in the CSV file must be on the same subnet as the Gateway specified for the network profile, if any.
You cannot import any IP addresses that are already defined in an existing network profile.
To remove an IP address you added using a CSV file from the Defined IP Addresses list, select the Delete option from the menu. This option is not available for IP addresses from the ranges in the Defined Ranges grid.

Managing Machine Prefixes

Each blueprint has a machine prefix associated with it that is used to generate the names of the machines provisioned from that blueprint. These prefixes can be used to indicate the provisioning group or blueprint of a machine (or both) in its name. A prefix is a base name to be followed by a counter of a specified number of digits. For example, a prefix of g1dw (for group1 and developer workstation) with a counter of three digits produces machines named g1dw001, g1dw002, and so on. A prefix can also specify a number other than 1 to start the counter with.

Enterprise Administrators are responsible for managing machine prefixes as necessary. When you create a provisioning group you must assign one of the existing machine prefixes as its default, as noted in "Managing Provisioning Groups". This does not restrict PGMs when they are creating blueprints, however, as using the group's default prefix is optional. An Enterprise Administrator can change the default prefix of a provisioning group at any time.

To manage machine prefixes, select Enterprise Administrator > Machine Prefixes in the activity pane. The table that appears shows all existing prefixes with their counter lengths (Number of Digits) and the next counter number to be generated (Next Number). The latter is updated every time a machine is built using the prefix. For instance, if the prefix JJCServer shows a counter length of four digits and a next number of 27, the next name generated will be JJCServer0027. You can change the next number at any time to reset the counter, or to skip certain numbers (especially when lengthening the counter), or for any reason.

When modifying a prefix, or adding one using the New machine prefix link at the right-hand end of the title bar, click the Save button to save your changes or the Cancel button to cancel them. You must click the Save button to save a prefix before leaving the page.

Note: Be sure to use enough digits to prevent a machine prefix from rolling back to the starting number and generating names that are still in use. For example, if thousands of machines with names generated from a single prefix will exist concurrently, you should specify four or five digits for the prefix.

To conform to standard host name limitations, machine prefixes must contain only the ASCII letters a through z (case-insensitive), the digits 0 through 9 and the hyphen (-). They must not begin with a hyphen. No other symbols, punctuation characters, or blank spaces can be used.

To conform to the Windows limit of 15 characters in host names, machine prefixes should not be longer than 15 characters, including the digits. Longer host names are truncated when a machine is provisioned, and updated at the next data collection from the virtualization compute resource or physical endpoint.

vCAC does not support multiple virtual machines with the same name within a single vCAC instance. This can occur if vCAC provisions a machine using the
name of an existing unmanaged virtual machine, so it is important to choose prefixes that do not overlap with existing naming practices outside of vCAC. You can also configure vCAC to validate the host names it generates against DNS, Active Directory (for Windows machines) or both.

Managing Cost Profiles

To enable calculation of a machine’s cost for display to machine owners, requesters and administrators and for chargeback reporting, you can associate each virtualization compute resource and each physical machine with a cost profile. For finer definition of storage cost for virtual machines, you can also associate each known storage path on a compute resource with a storage cost profile.

Enterprise Administrators can assign or change a compute resource’s or physical machine’s cost profile using the Edit option on the compute resources or Enterprise Physical Machines pages.

Each cost profile specifies these costs:

• compute resource cost—A daily cost per GB of memory capacity specified in the virtual blueprint or installed in the physical machine
• CPU cost—A daily cost per CPU specified in the virtual blueprint or installed in the physical machine
• storage cost—A daily cost per GB of storage capacity as specified in the virtual blueprint (not used for physical machines, as vCAC does not discover or track the storage attached to physical machines).

These daily costs are added to that specified in the blueprint, if any to be displayed and charged back to machine owners and provisioning groups. (The daily blueprint cost can be used to represent such factors as storage for physical machines or a more costly feature of a virtual machine blueprint, for example specific software it is deployed on machines provisioned from it.)

A storage cost profile contains only a daily cost per GB of storage. If you assign a storage cost profile to a storage path, this storage cost overrides the storage cost in the cost profile assigned to the compute resource, if any.

**Note:** Cost profiles cannot be applied to cloud machines. For a cloud machine, the only cost factor is the daily cost in the blueprint from which it was provisioned.

Elsewhere in the vCAC Console memory is specified in MB, but it is specified in GB in compute resource cost settings and chargeback reports to avoid the necessity for very small cost settings.

Calculating Virtual Machine Cost

A virtual machine’s daily cost can be calculated as follows:

\[
\text{daily cost} = (\text{allocated\_memory\_GB} \times \text{compute\_resource\_cost}) + (\text{allocated\_number\_CPUs} \times \text{CPU\_cost}) + (\text{allocated\_storage\_GB} \times \text{storage\_cost}) + \text{blueprint\_cost}
\]

where each cost may be zero, if no cost profile or blueprint cost is assigned, and where storage\_cost may be determined by the cost profile assigned to the compute resource on which the machine is provisioned or the storage cost profile assigned to the storage path used.
If cost profiles are not assigned to a virtualization compute resource or its storage paths, and no cost is specified in the blueprint, daily costs default to $0.00.

The Reservations by Group report is calculated for each reservation rather than for each machine, using the cost profile assigned to the compute resource a reservation is on but without reference to blueprint cost. In the above example, a reservation on the compute resource specifying 12 GB of memory and 200 GB of storage would be charged at a daily rate of 20.6 ($0.60 for memory and $20 for disk).

Calculating Cloud Machine Cost

The daily cost setting in the blueprint is the only cost factor applied to cloud machines. Make sure this figure accurately reflects cloud service charges. Note that blueprints with more than one instance type available for selection by the user allow provisioning of instances charged at different rates from the same blueprint, larger instances being more expensive than smaller ones. When there is more than one instance type available, you may want to ensure that the daily cost settings reflects charges for the largest instance.

Calculating Physical Machine Cost

A provisioned physical machine’s daily cost can be calculated as follows:

\[
(machine\_memory\_GB \times compute\_resource\_cost) + (allocated\_number\_CPUs \times CPU\_cost) + blueprint\_cost
\]

If a cost profile is not assigned to a physical machine, the daily cost defaults to $0.00.

Because the cost profile’s storage cost is not included in the calculation for physical machines, you may need a separate policy handling physical provisioning cost. For example, you can

- Create physical-only cost profiles in which the compute resource cost represents the total cost of the machine.
- Apply cost profiles to virtualization compute resources only and use the daily blueprint cost only to represent provisioned machine cost.
- Use a combination of reservation policy and daily blueprint cost to reflect storage expense for virtual machines. To do this, you might:
  - Place machines attached to relatively expensive storage, or to large storage pools, in reservations associated with the high cost storage reservation policy, all those attached to inexpensive or limited storage in reservations associated with the low cost storage policy and so on, with whatever number of levels are appropriate.
  - When creating physical blueprints specifying the high cost storage policy, set a high daily blueprint cost; when creating blueprints specifying low cost storage, set a low daily cost; and so on.

Viewing, Creating, Editing and Deleting Cost Profiles

To create and manage cost profiles, select Enterprise Administrator > Cost Profiles in the activity pane. The page is divided into lists of Cost Profiles and Storage Cost Profiles. Existing profiles, if any, are displayed. Click the edit icon to edit an existing profile or the delete icon to delete an existing profile.

Each profile has a name (which must be unique across the vCAC site), a description, and either three costs (cost profiles) or one cost (storage profiles).
A cost profile can display a cost value with up to four decimal places as in the value .0001, though the actual number of decimal places displayed on a machine depends on its locale settings. The Blueprints page displays cost values with up to three decimal places and reports display them with up to two decimal places.

When modifying a profile, or adding one using the **New Cost Profile** link at the right-hand end of the title bar, click the **Save** button to save your changes or the **Cancel** button to cancel them. You must click the **Save** button to save a profile before leaving the page.

**Managing EBS Volumes (Amazon EC2)**

You can destroy unattached Elastic Block Storage (EBS) volumes that belong to a compute resource (region) in your enterprise group. If you are also a provisioning group manager, you can change the owner of an EBS volume.

To delete an unattached EBS volume as an Enterprise Administrator:

1. Click **Enterprise Administrator > EBS Volume Management**.
2. Locate the volume you want to delete and click the **Delete** button.
3. Click **OK** to confirm.

To change the owner of an EBS volume:

1. Click **Enterprise Administrator > EBS Volume Management**.
2. Locate the volume you want to modify and click the **Edit** button.
3. The **Edit EBS Volume** window opens and provides the following information:
   - Name
   - Description
   - Device Size (GB)
   - Owner
4. In the **Owner** field, type or select a name from the list.
5. Click the **Save** button.

**Discovery: Organizing Virtual Infrastructure**

The **Discovery** activity group is available to all Enterprise Administrators; to use the **Infrastructure Organizer** activity, however, you must have at least one additional role.

- If you are a vCAC administrator and an Enterprise Administrator you can use **Discovery > Infrastructure Organizer** to organize known virtualization compute resources into enterprise groups.
- If you are a vCAC administrator and a PGM you can use the Infrastructure Organizer to import unmanaged virtual machines on known compute resources into vCAC, modifying or creating virtual reservations as needed.
- If you have all three roles you can use the organizer for both tasks.
The Infrastructure Organizer is particularly useful when incorporating existing infrastructure into a newly installed vCAC site, but can be used at any time to manage enterprise group membership and import unmanaged virtual machines.

**vCAC Administrator: Configuration, Security, and Customization**

The responsibilities of the vCAC administrator include:

- Setting up virtual, cloud and physical provisioning and managing instance types
- Designating other vCAC users as vCAC administrators and Access Administrators
- Customizing the vCAC Console
- Monitoring user rights, vCAC logs including Audit Viewer log and Workflow history, Distributed Execution Manager status, and license information

A vCAC administrator is often an Enterprise Administrator as well. vCAC administrators should be familiar with the tools for managing domains and users in the operating environment in which vCAC is installed.

**Setting Up Virtual, Cloud and Physical Provisioning**

To set up virtual, cloud and physical provisioning in vCAC, the vCAC administrator must add virtualization compute resources, cloud service accounts, physical machines and NetApp FlexClone-enabled storage devices to vCAC by:

- Configuring Hyper-V and XenServer proxy agents for the compute resources they are to manage
- Adding endpoints for vCenter Server (with vCNS Manager, if enabled), KVM, and SCVMM instances, physical machine interfaces, cloud service accounts and NetApp FlexClone-enabled storage devices, including the credentials needed to manage them, and installing a vSphere proxy agent for each vSphere endpoint
- For Amazon EC2, administrators must add Amazon regions to enterprise groups so that they can be managed as compute resources and used for reservations.
- For vCloud Director, administrators must add organization VDCs to enterprise groups to manage them as compute resources and use them for reservations

Once all endpoints have been added and agents configured, the vCAC administrator organizes known ESX Server, Hyper-V and XenServer virtualization compute resources and the cloud endpoints into enterprise groups.

Data collection from cloud, physical and NetApp endpoints begins as soon as the endpoints are created. Cloud endpoints must be added to enterprise groups before reservations can be made on them. All physical machines discovered by data collection are available for reservation to all Enterprise Administrators, without regard to enterprise groups.

Data collection from each virtualization compute resource begins only when the compute resource is added to an enterprise group. When initial data collection from a compute resource is complete, reservations can be made on it.
Configuring Agents for Hyper-V and XenServer Virtualization Compute Resources

Once a vCAC proxy agent is managing a virtualization compute resource and the compute resource is added to an enterprise group, vCAC can collect data about that compute resource, including its characteristics, the physical memory and storage it provides and the amount of these resources that are in use, and any unmanaged virtual machines (not provisioned within vCAC) that exist on the compute resource. The way in which proxy agent management is established, however, depends on the type of compute resource involved.

The vSphere agents managing vCenter Server instances are associated during installation with a generic endpoint containing the information needed to interact with a vCenter Server instance. To discover the compute resources within a vCenter Server instance so they can be added to enterprise groups, you need to create an endpoint and then install and configure a vSphere agent for that endpoint.

Hyper-V and Xen proxy agents, however, are installed with only the credentials used to gain access to the compute resources they will manage and not the names of the compute resource themselves. For this reason, each proxy agent must be configured for the Hyper-V and XenServer compute resources it will manage. Whenever you want to make a Hyper-V or XenServer compute resource known to vCAC so it can be added to an enterprise group, you must configure one of your installed and running Hyper-V or Xen proxy agents for that compute resource, or install a new agent and then configure it for the compute resource.

To associate compute resources with proxy agents, select vCAC Administrator > Agent Configuration in the activity pane. On the page that appears, select the appropriate proxy agent, enter the fully qualified DNS name of the Hyper-V or XenServer server and optionally enter a description for the compute resource. Click OK to configure the agent for the compute resource.

**Caution:** Do not enter the name of a Xen pool on this page. The pool will be incorrectly identified to vCAC and therefore unusable, and it will be impossible to disassociate the agent from the pool name so the pool can be correctly associated.

A Xen proxy agent can manage both individual XenServers and Xen pools. To associate a Xen pool with the appropriate proxy agent, enter the name of pool master. Data collection recognizes the specified compute resource as the master of a pool and associates the pool with the compute resource object.

**Note:** Within the Xen pool, all nodes must be identified by their fully qualified DNS names. vCAC cannot communicate with or manage any node not identified by its fully qualified DNS name within the Xen pool.

Once an agent is configured for a Hyper-V compute resource or XenServer compute resource, it must be added to an enterprise group using vCAC Administrator > Enterprise Groups or the Infrastructure Organizer. Once this has been done, data collection from the compute resource begins automatically. If the credentials with which the agent you selected was installed do not provide administrator-level access to the compute resource, however, data collection fails and the compute resource is not discovered.

**Note:** If vCAC cannot successfully collect data from the compute resource you configured, the compute resource can still be added to an enterprise group so it can be displayed in the compute resources list using Enterprise Administrator > compute resources. There you can use the Delete option to remove the compute resource, as long as you have made no reservations on it. (The option appears in the menu only for compute resources from which there has been no
Managing Credentials and Endpoints

As vCAC administrator, you are responsible for managing the endpoints needed to collect data from and manage some provisioning elements. Specifically:

- To add the ESX Server compute resources in a vCenter Server instance to vCAC, you must add an endpoint containing the address of the instance and the credentials required to manage it and then install a vSphere agent configured for that endpoint.

- To add vCNS security groups and load balancing to vCAC, you must add the address of the vCNS Manager instance and the credentials required to manage it to the endpoint of its vCenter Server instance.

- To add a vCloud Director compute resource, you must add the address of the vCloud Director instance (and optionally, an organization to provide access only to relevant organization VDCs) and the credentials required to manage it to the vApp (vCloud Director) endpoint. See the vCloud Automation Center Multi-Machine Guide for documentation on the vCloud Director integration.

- To add a KVM (RHEV) compute resource, you must add the address of the KVM (RHEV) instance and the credentials required to manage it to the KVM (RHEV) endpoint. See the vCloud Automation Center KVM (RHEV) Integration Guide for documentation on the KVM (RHEV) integration.

- To add an AWS account to vCAC, you must add an endpoint containing the credentials required to sign in to the account.

- To add a physical machine to vCAC, you must add a physical endpoint containing the address of the machine’s management interface.—HP iLO, Dell iDRAC or Cisco UCS Manager—and the credentials required to manage it.

- To enable vCAC to provision using NetApp FlexClone on a storage device on which this technology is enabled, you must add an endpoint containing the compute resourcename or IP address of the device.

Note: As noted in the previous section, Hyper-V and Xen proxy agents are configured for the compute resources they manage manually.

When creating an endpoint, you must add the credentials to be associated with it. These credentials are used to gain administrator-level access to the vCenter Server instance, vCNS Manager instance, cloud account, management interface or storage device specified in the endpoint.

Managing Credentials

vCAC access to virtualization compute resources, vCNS security groups and load balancing, cloud accounts, physical machines and certain storage devices requires use of the appropriate user name/password pairs. Credentials for Hyper-V and XenServer proxy agents are configured in the agent at installation, but those for vSphere agents, cloud accounts, physical machine interfaces and storage devices are stored in vCAC in the endpoints representing them. Because the same credentials may be used for multiple endpoints, credentials are managed separately from endpoints and then associated
with endpoints as the latter are created and edited. Once credentials have been entered they can be used for multiple endpoints as appropriate.

To manage credentials, select vCAC Administrator > Credentials in the activity pane. The table that appears shows all existing credentials with their names, descriptions, user names, and hidden passwords.

When modifying credentials, or adding credentials using the New Credentials link at the right-hand end of the title bar, click the Save button to save your changes or the Cancel button to cancel them. You must click the Save button to save any new or modified credentials before leaving the page. If the two password entries do not match, you cannot save.

The credentials to be added for each type of endpoint are as follows:

- **vSphere (and vCNS)**—The credentials required by the vSphere agent to access the vCenter Server instance and those required to access the vCNS Manager instance (optional) that are specified in the endpoint. The vCenter Server account must have permission to modify custom attributes; the vCNS Manager account must have vCNS enterprise administrator privileges. In some cases, the use of an administrator-level account for this purpose may conflict with established policy or practice. The vCloud Automation Center Installation Guide contains a table showing the detailed permissions the vSphere agent account must have to enable the agent to manage a vCenter Server instance for vCAC.

  **Note:** When creating the endpoint representing the vCenter Server instance to be managed by a vSphere agent, you can choose to have the agent use the credentials the agent service is running under to interact with vCenter Server.

- **Cloud**—The credentials required for access to the AWS account. Use the Access Key ID and Secret Access Key for the account as the user name and password. To obtain the Access key ID and Secret Access Key:
  a. Log into the AWS account on aws.amazon.com,
  b. Click the Account link at the top to display the Your Account page, then click the Security Credentials link to display the Security Credentials page.
  c. Scroll down to the Access Credentials section. The Access Keys tab displays the access keys for the account. Copy and paste the Access Key ID into the Username field in vCAC, then click the Show link in the Secret Access Key column to display the Secret Access Key and copy and paste the contents into the Password field.

  **Note:** Do not enter the account sign-in credentials, an X.509 certificate or a key pair.

- **Cisco UCS, Dell iDRAC, HP iLO, NetApp ONTAP**—The credentials required for access to the management interface specified as the address in the endpoint.

You can also create and manage credentials while creating or editing an endpoint, as described below.

**Managing Endpoints**

As previously noted, endpoints contain information about vCenter Server, vCNS Manager, and SCVMM instances, AWS accounts, physical machine interfaces or NetApp FlexClone-enabled storage devices.

- After you create an endpoint for a vCenter Server instance (and optionally, an affiliated vCNS Manager instance), you must install a vSphere agent to manage the instance, providing the end-
point name during installation. Note that if the information in the endpoint is not valid, the agent configured for it will generate frequent errors until the agent service is stopped. Once the agent has initially discovered the ESX Server compute resources in the vCenter Server instance, they can be added to enterprise groups to be fully discovered and made available for reservation and provisioning.

**Note:** To have a vSphere agent use the credentials the agent service is running under to interact with the vCenter Server instance, select the predefined credentials Integrated.

If you later want to change the endpoint a vSphere agent is configured for, you can do so using the `DynamicOps.Vrm.VRMencrypt.exe` utility.

- After you create a cloud endpoint for an AWS account or an HP iLO, Dell iDRAC or Cisco UCS physical endpoint, vCAC collects data from the endpoint. Once data collection is complete, cloud service accounts (once the endpoints are added to enterprise groups) and physical machines represented by the specified interfaces are available for reservation and provisioning.

- Once you have created endpoints for NetApp FlexClone-enabled storage devices (and have enabled FlexClone for the vCAC site, as described in "Customizing the vCAC Console", later in this chapter) an Enterprise Administrator can associate those endpoints with the storage paths in a virtual reservation, creating a FlexClone-enabled reservation. You can then create a blue-print specifying a reservation policy containing only such reservations to provision virtual machines using this space-efficient technology.

**Note:** To see which ESX Server virtualization compute resources are being managed by the vSphere agent using a particular generic endpoint, select Enterprise Administrator > Compute Resources to list all known virtualization compute resources and filter the Endpoint column for the endpoint involved.

Data collection from virtualization compute resource detects unmanaged (provisioned outside vCAC) virtual machines on those compute resources, but data collection from cloud endpoints does not collect any information about cloud machines in the account that were not provisioned by vCAC.

**Viewing, Editing and Deleting Endpoints**

To view and edit existing endpoints, select **vCAC Administrator > Endpoints** in the activity pane. The table that appears shows all existing generic endpoints with their names, descriptions, interface types, addresses and credentials.

You can sort and filter individual columns. Changes you make in the list display persist from one view of the list to the next.

To perform operations on an endpoint, move the pointer over the name and select an option from the menu, or click the name to select **Edit**. The first three options are available to vCAC administrators; the remaining options are available only if you are also an Enterprise Administrator.

**Edit:** Update all settings except discovered physical machines.
Note: If you edit the endpoint for a vCNS Manager instance, unselect the Specify vCNS Manager check box, and save the change, vCAC removes all discovered vCNS data from the vCAC database.

Delete: Remove an endpoint. When the credentials specified for an endpoint you are deleting are not in use in any other endpoint, you have the option to delete the credentials as well.

You cannot delete an endpoint that represents managed physical machines.

- A vSphere or SCVMM endpoint cannot be deleted if there are any discovered hosts associated with it.
- A cloud endpoint cannot be deleted if there are any cloud machines provisioned on it.
- A NetApp endpoint cannot be deleted if a discovered storage device is associated with it.

Deleting an Amazon endpoint can take time (up to an hour or more). Verify that the endpoint has been deleted by checking Workflow History.

View Reservations/New Reservation (virtual and cloud only, must be Enterprise Administrator): Display the Reservations page, filtered for the selected endpoint, or display the New Reservation - Virtual/Cloud page with that endpoint selected.

View Compute Resources: Display the Compute Resources page to view Compute Resources belonging to an endpoint.

View Machines (must be Enterprise Administrator): Display the enterprise machines list, filtered for the selected endpoint.

Note: To view the compute resources represented by a vSphere endpoint or EC2 regions that have been added to an enterprise group, go to the Enterprise Machines page or the Compute Resource page and filter the Endpoint column for the endpoint you want.

Adding an Endpoint

To add an endpoint, move the pointer over the New Endpoint link at the right-hand end of the title bar and select the type of endpoint you want. The New Endpoint page appears. All types of endpoints have an Endpoint tab; physical endpoints also have a Details tab. Settings on the Endpoint tab include:

- **Name**—A descriptive name for the endpoint.
- **Description**—Detailed description of what the endpoint represents.
- **Address**—The URL of the instance (https://vSphereA/sdk for a vSphere instance, for example) or the hardware management interface of the physical machine or storage device. This can be a compute resourcename with optional port, web URL, or IP address. (The web address for AWS accounts is fixed, so entry is not required.)

Note: The address of a Cisco UCS Manager instance must be specified as an IP address in URL format, for example http://111.222.333.444.

- **Credentials**—The credentials required to gain access to the vCenter Server instance, AWS account or management interface. Click the button to display existing credentials.
To have the vSphere agent that will be configured for the endpoint use the credentials the agent service is running under to interact with the vCenter Server instance, select the predefined credentials **Integrated**.

- **Specify vCNS Manager**— Select this check box to specify the vCNS Manager instance for the current vSphere (vCenter) endpoint. vCAC displays the following options when the check box is selected:
  - **Address** (vCNS only)—The URL of the vCNS Manager instance.
  - **Credentials** (vCNS only)—The vCNS Enterprise Administrator credentials required to gain access to the instance. Click the button to display existing credentials.

- **Custom properties**—Any custom properties to be used in provisioning machines on the endpoint. Typically, these would be different from those in build profiles and blueprints. Custom properties specified in endpoints are used during provisioning only and are not added to the properties of the provisioned machine.

When entering custom properties, select the **Encrypt** check box to ensure that a secure property (such as a password) is never visible in plain text. Click the **Save** button to save your changes to a property or the **Cancel** button to cancel them. Remember that the properties you add or modify are not saved until you save the endpoint by clicking **OK**, but that you must click the **Save** button to save and close each property you open before pressing **OK**.

**Note:** When entering custom properties, always ensure that property values do not contain leading or trailing spaces, as these may cause provisioning to fail.

User-defined settings on the Detail tab for physical endpoints are optional and include:

- **Data center**—The hardware’s datacenter location.
- **Row and Rack**—The hardware’s physical location within the specified data center.
- **Physical machines** (existing endpoints only)—The physical machines discovered on the endpoint by data collection, including hardware name, vendor, CPU and memory specifications and asset tag. This information is read-only and cannot be changed.

**Importing Endpoints from CSV Files**

You can add multiple endpoints of multiple types all at once by loading a CSV file containing the required information. To do so, select the **Import Endpoints** link at the right-hand end of the title bar and browse for the CSV file. This feature is not available with vCNS endpoints.

The CSV file must contain a header row determining the order of the fields, which are case sensitive. Fields include:

- **InterfaceType**
  Possible values include **DellIdrac**, **HPIlo**, **CiscoUCS**, **vSphere**, **KVM**, **NetAppOnTapp**, **SCVMM** and **AmazonEC2**.
- **Address** (not required for Amazon EC2 endpoints)
- **Credentials**
- **Name**
After you have added multiple endpoints from a file you can update settings for any of the endpoints by editing them individually.

Managing Enterprise Groups

As described in "Approver: Approving Machine Requests", enterprise groups and their administrators are critical to the successful functioning of a vCAC site. By creating enterprise groups and placing virtualization compute resources and cloud endpoints in them, the vCAC administrator enables Enterprise Administrators to create the virtual and cloud reservations needed by provisioning groups.

Viewing, Editing, Creating and Deleting Enterprise Groups

To view and edit existing enterprise groups, select vCAC Administrator > Enterprise Groups in the activity pane. The grid on Enterprise Groups page displays complete information about each enterprise group.

To edit an enterprise group, use the Edit option; to create an enterprise group, use the New Enterprise Group link at the right-hand end of the title bar. The Edit/New Enterprise Group page lets you enter the name of a new group, enter or change the description, and change the compute resource membership, cloud endpoint membership, or list of Enterprise Administrators who can make reservations on the compute resources and endpoints.

You can enter users directly into the Enterprise Administrators box or use the drop-down list, but note that only users who own at least one machine provisioned within the vCAC site are included in the drop-down list. User names are validated when you save your changes; if one or more of the user names is not valid, the group remains open for editing.

You do not need to add virtualization compute resources, cloud endpoints, or Enterprise Administrators to an enterprise group when you create it; you can add them at any time.

Note: If the users you specify are not local users of the vCAC server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

You can add an Active Directory security group as an Enterprise Administrator to give this role to all members of the security group. Do not, however, add Active Directory distribution groups, as distribution groups cannot be authenticated against and thus cannot convey vCAC roles.

When a valid user entry can no longer be resolved by vCAC, for example because the user was removed from Active Directory, the entry is replaced by Account unknown (SID), where SID is the system identification number of the user account. This is done to allow for situations in which a user name temporarily becomes invalid. If the user account is restored, the Account unknown entry is converted back to the user name. If you know the account will not be restored, you can simply delete the Account unknown entry.
Remember that XenServer and Hyper-V compute resources cannot be discovered until they have been associated with the appropriate proxy agents and placed in an enterprise group.

You can also use the Infrastructure Organizer to edit the virtualization compute resources belonging to one or more enterprise groups. The advantage of this method is that it lets you see the current enterprise group membership of all compute resources as you are making changes.

Use the **Delete** option to delete an enterprise group.

---

**Caution:** Deleting an enterprise group does not delete the compute resources and endpoints that belong to it or the reservations on them, but does remove management access to these elements by the designated Enterprise Administrator. Do not delete an enterprise group or remove a compute resource or endpoint from an enterprise group unless you are sure such access to reservations on the compute resource or endpoint is no longer needed, or the compute resources or endpoints belong to other groups through which access can be maintained.

---

**Note:** The number of compute resources and endpoints that can be placed in a single enterprise group is limited. Because the limit depends on the lengths of the names assigned to all the compute resources and endpoints in the group, it is difficult to calculate for a given group. Generally speaking, an enterprise group can contain at least 300 compute resources or endpoints, possibly several times this number if the names of the compute resources are relatively short.

---

**Designating Administrators**

To designate access administrators and vCAC administrator, select **vCAC Administrator > Administrators** in the activity pane to display the Administrators page.

Any changes you make are reflected immediately. For example, if you remove a user from the vCAC administrator role, she immediately loses access to vCAC administrator activities, and this change is immediately reflected in her console if she is currently using vCAC.

**Designating Access Administrators**

Although Enterprise Administrators can modify provisioning group membership, they may not be in a position to add users or remove group members when this is required. vCAC administrators are responsible for designating enough Access Administrators to ensure that someone with the authority to modify provisioning group membership is always available to respond to PGM requests for such changes.

To add or remove Access Administrators, click **Access Control Administrator** on the Administrators page.

**Designating vCAC Administrators**

One vCAC administrator may not be enough for your vCAC site. A vCAC administrator can add others as desired. To add or remove vCAC administrators, click **vCAC Administrator** on the Administrators page. Remember that a vCAC administrator can make herself an Enterprise Administrator at will, and then a PGM; by adding a user to the vCAC administrator list you are giving that user access to all elements in the vCAC site including compute resources, reservations, provisioning groups, profiles, and blueprints.
Caution: If you remove yourself from the vCAC administrator list you may lose your vCAC administrator rights and be unable to restore them without the help of another vCAC administrator.

Never remove all vCAC administrator assignments; you will lose administrative access to the vCAC Console.

Note: If the users you specify are not local users of the vCAC server, you must enter the user names in domain format, for example ENGINEERING\jsmith.

You can enter users directly into the boxes or use the drop-down lists, but note that only users who own at least one machine provisioned within the vCAC site are included in the drop-down lists. User names are validated when you save your changes; if one or more of the user names is not valid, the page remains open for editing.

You can add an Active Directory security group as an access or vCAC administrator to give the role to all members of the security group. Do not, however, add Active Directory distribution groups, as distribution groups cannot be authenticated against and thus cannot convey vCAC roles.

When a valid user entry can no longer be resolved by vCAC, for example because the user was removed from Active Directory, the entry is replaced by Account unknown (SID), where SID is the system identification number of the user account. This is done to allow for situations in which a user name temporarily becomes invalid. If the user account is restored, the Account unknown entry is converted back to the user name. If you know the account will not be restored, you can simply delete the Account unknown entry.

Viewing User Rights

As vCAC administrator you can review all of a specific user’s rights within vCAC. To do so, select vCAC Administrator > User Rights in the activity pane, then select a user name from the search drop down (which includes the user names of current and previous machine owners) or type in a user name and click Search.

Note: If the user you specify is not a local user of the vCAC server, you must enter the user name in domain format, for example ENGINEERING\jsmith.

The page that appears shows number of machines the user owns, the user’s provisioning group memberships with role, the blueprints the user has access to, and the user’s global administrator rights if any. If you are also an Enterprise Administrator, you can click the name of a provisioning group to edit the group; if an access admin, you can click a provisioning group to modify its membership. You can click a local blueprint name to edit the blueprint if you are a manager of its group, or a global blueprint name if you are an Enterprise Administrator.

Customizing the vCAC Console

As vCAC administrator you can customize several aspects of the vCAC Console, including

- The application name and logo
• Whether static IP service is enabled
• Whether virtual machine Snapshot Manager is enabled
• Whether provisioning on NetApp FlexClone-enabled storage is enabled
• Whether advanced approval support is enabled
• The number of items per page in element lists
• The announcements that appear on the start page and the no authorization page
• The self-service portal for provisioning group members in the User role only, including which page displays first and the appearance of the My Machines and Request Machine pages.

To change any of these settings select **vCAC Administrator > Customization** in the activity pane.

### Customizing the Application Name and Logo

You can change the application name at the top of the console, the logo that appears to its left, or both on the Console Settings tab. Enter the application name you want to display and browse for an image file to use as the logo.

Once you have substituted your own image file for the default logo, it is displayed on the Console Setting tab. Press the **Remove** button to return to the default image.

### Enabling Static IP Service

Static IP service enables Enterprise Administrators to create network profiles containing IP address ranges. Enterprise Administrators and PGMs can then specify those profiles in provisioning by cloning blueprints to assign static IP addresses to cloned machines.

To enable static IP service, check the box on the Console Settings tab.

### Enabling FlexClone Provisioning

Enabling FlexClone provisioning makes it possible to identify and use FlexClone-enabled NetApp storage devices for use in virtual provision, as described in "Managing Reservations". Unless you enable FlexClone provisioning, Enterprise Administrators cannot identify virtual reservations as FlexClone-enabled and associate the storage paths in them with NetApp ONTAP endpoints.

To enable FlexClone provisioning, check the box on the Console Settings tab.

### Enabling Advanced Approval Support

Enabling advanced approval support adds three features to the approval workflow:

- Approval from each approval group in a policy can be required either before or after the requested machine is actually provisioned
- Each approver can be required to provide the value for one or more specified custom properties, or given the option of providing values
- The requesting user can be given one or more opportunities within the approval workflow to continue with or cancel the machine request after examining the custom property values provided by approvers, as above.
Customizing List Paging

To set the number of items per page in all element lists within vCAC—machines, compute resources, blueprints, reservations and so on—use the Items per page counter on the Console Settings tab. The default is 25.

Customizing vCAC Announcements

To customize one of four vCAC announcements that appear on the start page, select the Announcements tab. The drop-down list lets you select the Welcome, Support Information, and No Access Available announcement to customize.

- Welcome and Support Information appear on the announcements page, which by default is the start page displayed when the console is opened. The announcements page is also displayed whenever a user clicks the Announcements link in the upper right.

- The No Access Available announcement is displayed when a user who has no assigned role within vCAC accesses the console.

You can choose either design or HTML view when editing announcements. Note that these announcements use the variables %app_name% and %username% for the application name specified on the Console Settings tab and the user name of the current user, respectively.

Customizing the Basic User Interface

Select the UI Customization tab to customize the pages and page sections that basic users see. You can change the settings described below.

Default Landing Page: Select the start page that first displays when a basic user loads the vCAC Console.

Dashboard Page: Include or remove the Dashboard activity pane entry and page for basic users.

My Machines Grid: Customize the My Machines page for basic users using the following controls:

- Show: Include or remove the My Machines list
- Allow columns: Allow the user to change the columns displayed in the list using the Columns control.
- Allow filters: Include or remove the Filters control on the My Machines page.
- Allow export: Include or remove the Export control on the My Machines page.
- Default columns: Change the columns that are included in the My Machines list by default.

My Pending Requests Grid: Include or remove the My Pending Requests list and enable or disable export of this list.

My Reclamation Requests Grid: Include or remove the My Reclamation Requests list and enable or disable column changes in this list and export of this list.

My Expiring Machines Grid: Include or remove the Expiring Machines list and enable or disable export of this list.

Recent Events Grid: Include or remove the Recent Events log and enable or disable export of this list.

Request Machine Screen: Change the columns that are included by default in the list of blueprints on the Request Machine page for basic users.
Reset to Defaults: Remove all customizations and return to the basic user interface as installed.

Note: Customizations of the basic user interface are lost when a vCAC instance is upgraded to a new version.

Using the Log Viewer and the Audit Log Viewer

To review all messages from all vCAC logs since the vCAC instance was installed:

- Select vCAC Administrator > Log Viewer.

You can use the boxes to filter the list by typing in the beginning of a message ID, severity, category, timestamp, or message text.

vCAC Administrators can also view an Audit Log that provides details about the activities performed on and status of virtual machines. By default the Audit Log Viewer provides details including Time, Action, Source, Entity, Entity Instance, and Message.

Other information can be displayed by adding Column headers to the table, as described in Table 9.

To add columns:

- Select the Columns drop-down list and click to display the

Table 9 Additional Audit Log Viewer Details

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log ID</td>
<td>Display a unique ID for the log.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the date and time when the action occurred in the format MM/DD/YYYY 12-hour clock.</td>
</tr>
<tr>
<td>Action</td>
<td>Describes the action. For example, Amazon Instance Destroyed or Snapshot Created, Snapshot Applied.</td>
</tr>
<tr>
<td>Source</td>
<td>Identifies the component that performed the action. For example, an action taken by the DEM Worker displays DEM Worker.</td>
</tr>
<tr>
<td>Entity Instance ID</td>
<td>Displays a unique ID for the entity instance.</td>
</tr>
<tr>
<td>Entity Instance</td>
<td>Identifies the instance that the action was performed on.</td>
</tr>
<tr>
<td>Username</td>
<td>Display the user name of the user who performed or requested the activity.</td>
</tr>
<tr>
<td>Message</td>
<td>Describes the details of the action taken. For example, Amazon Instance (name) Destroyed.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays properties associated with the activity.</td>
</tr>
</tbody>
</table>

To review all messages from all vCAC logs since the vCAC instance was installed:

- Select vCAC > vCAC Administrator > Log Viewer.

To view an audit of actions performed on managed machines:
Select **vCAC > vCAC Administrator > Audit Log Viewer**.

**Viewing Distributed Execution Status**

As noted in the *vCloud Automation Center Installation Guide*, the Distributed Execution Manager (DEM) is a primary component of vCAC. Each DEM executes the business logic of custom models, interacting with the VMware database and with external databases and systems as required. A vCAC site may include multiple DEMs.

Like vCAC proxy agents, the DEM runs as a service, typically but not necessarily on the vCAC server. Without a running DEM Worker and DEM Orchestrator, vCAC cannot operate. When this is the case, the console displays a banner indicating the problem.

To review the status of the DEMs available within your vCAC site:

- Select **vCAC Administrator > Distributed Execution Status**.

  The Distributed Execution Status page shows the name and status of each DEM, the compute resource it is on, and the number of workflow instances currently executing on it. If a DEM is down, this information will help you locate and start it.

For more information about the workflow instances executing on a DEM, select **More Details** from the menu. This information is useful when analyzing workflow traffic across the available DEMs. Use the **View Instance Details** link in the upper right to see details for all DEMs as the same time.

**Workflow Execution History**

The execution of all workflows is now recorded and a Workflow History page has been added to the vCAC Console. The Workflow History page enables the vCAC Administrator to view all the workflows that have been executed. The information that it displays for each executed workflow includes:

- The DEM that executed it
- The created time, claimed time (when the DEM Worker picked up the workflow), and completed time
- Whether it was scheduled and any applicable schedule
- Whether the execution was successful (with a link to view the related error information if it failed)

The Workflow History page enables the administrator to perform such tasks as:

- Checking the outcome of all executed workflows
- Checking when scheduled workflows were run
- Monitoring each DEM to see which workflows they have executed
- Calculating how long it took for a workflow to execute

**Viewing Distributed Execution Status and Workflow History**

The Distributed Execution Status and Workflow History pages display information about the status of DEMs and the workflows that they execute. Together they provide a complete picture of workflow execution.
Viewing the Status of Distributed Execution Managers

The Distributed Execution Status page displays information about each Distributed Execution Manager, including its name, status, and the number of workflow instances it is currently executing.

To view the status of Distributed Execution Managers:

1. Log on to the vCAC Console as a vCAC Administrator.
2. On the vCAC Administrator menu, click Distributed Execution Status.

The Distributed Execution Status page displays a list of all registered Distributed Execution Managers and their status: Online or Offline. The status Online (Active) on a DEM Orchestrator indicates that it is the Orchestrator instance that is currently orchestrating workflow execution. It also displays the following information:

- For each DEM instance, the name of the host on which it is running, so that you can locate and restart a DEM that is offline
- For each DEM Worker, the number of workflow instances it is currently executing and the skills that are associated with that instance. Skills restrict which DEM Workers can execute which workflows
- A list of all schedules installed in the Model Manager, including their most recent and next scheduled runs.

Viewing Current Workflow Execution Status

You can view the number of workflows currently being executed on the Distributed Execution Status page. You can also select the name of a DEM Worker to view the list of workflows currently being executed by that DEM, or view the list of all workflows currently being executed by all DEMs.

A workflow may have a status Executing or Pending. An executing workflow is currently being executed by a DEM Worker. A pending workflow has not yet been picked up by a DEM Worker and may be in one of the following states:

- Waiting to be preprocessed by the DEM Orchestrator
- Preprocessed and is ready to be picked up by a DEM Worker
- Delayed to allow for a similar workflow to complete

To view the status of currently running workflows:

1. Log on to the vCAC Console as a vCAC Administrator.
2. On the vCAC Administrator menu, click Distributed Execution Status.
3. Do one of the following:
   - To view the status of all currently running workflows, click View Workflows.
   - To view the status of workflows being executed by a specific DEM Worker instance, click the name of the DEM Worker.
   - To return to the list of all currently running workflows, point to (unnamed) Filter and click Clear.

After a workflow has finished executing, its details, status, and the result of its execution appear on the Workflow History page.
**Viewing Workflow History**

The Workflow History page displays a list of every workflow that has been run by a Distributed Execution Manager.

The Workflow History list includes only workflows that have completed. You can view information about currently running workflows on the Workflows page, accessible via the Distributed Execution Status page.

Actions performed by vCAC Agents are not included on the Workflow History page.

To view information about completed workflows:

1. Log on to the vCAC Console as a vCAC Administrator.
2. On the vCAC Administrator menu, click **Workflow History**.

   The Workflow History page displays the following information:
   - A list of all completed workflows and their status: **Succeeded**, **Failed**, or **Stopped**.
   - A workflow may be stopped if the DEM Worker that was executing it stops or loses its connection to the Model Manager. Stopped workflows are re-executed when a DEM Worker becomes available to pick up the workflow.
   - In the case of failed workflows, the **Result Details** field displays a brief exception message.
   - The **Multiple Attempts?** field indicates when a workflow was stopped and required multiple attempts to complete successfully.

3. To view detailed information about a workflow instance, click the name of the workflow.
   - In the case of a workflow that has been stopped and restarted, the Workflow Execution Details page displays a row for each attempt to run this workflow.
   - In the case of a failed workflow, the Workflow Execution Details page provides a link to the associated log entry.

**Managing Licenses**

A License can be either a perpetual license or a 60-day evaluation license. From the vCAC Console you can view, add, and remove license keys. From the VMware License Portal you can combine and divide the capacity of license keys and purchase additional licenses.

If you mix a vCloud Suite license and a vCloud Automation Center Server license, used units are counted for vCloud Suite and not for vCloud Automation Center Server.

A license for vCloud Automation Center Development Kit is not available in evaluation mode.

Please contact VMware Customer Support for all license-related queries.

vCAC can be licensed for:

- vCloud Suite
- vCloud Automation Center (Server)
- vCloud Automation Center (Desktop)
• vCloud Automation Center Development Kit

Any type of machine—virtual, cloud or physical—can be a workstation or a server. The type of machine is determined by the Blueprint type setting on the Build Information tab of the blueprint it was provisioned from.

**Viewing License Keys**

From the vCAC Console, you can view information about your license keys, such as:

- License key
- Expiration date
- Product name the license is for
- License unit
- Licensed units
- Units used
  - vCloud Automation Center (Desktop) (Unit = Desktop)
  - vCloud Automation Center (Server) (Unit = Servers)
  - vCloud Suite (Unit = unlimited Servers)
  - vCloud Automation Center Development Kit (Unit = Instance)
- Average license usage

To view the license information for your vCAC site:

1. Start the vCAC Console as a user in the vCAC Administrator role.
2. Select **vCAC Administrator > License Info**.
3. To run a license report:
   - In **License Report**, click **Select Month** and select the month you want to display.
   - The average number of servers and desktop licenses per endpoint appears.

The average is calculated to the current day and the last time data collection ran. License information for the past 12 months is available to view.

**Adding a License Key**

From the vCAC Console, you can add a license key.

To add a license key:

1. Start the vCAC Console as a user in the vCAC Administrator role.
2. Select **vCAC Administrator > License Info**.
3. Click **Add License**.
   - The **Add License** dialog appears.
4. In **License key**, type a valid license key.
5. Click **OK**.

### Deleting a License Key

From the vCAC Console, you can delete a license key. You cannot delete a license key that is in use by a machine that currently uses the blueprint type.

To delete a license key:

1. Start the vCAC Console as a user in the vCAC administrator role.
2. Select **vCAC Administrator > License Info**.
3. Click the Delete icon.
4. Click **Yes**.

### License Warnings

A banner message appears for vCAC Administrators, Enterprise Administrators and PGMs when:

- Your site is in violation of its license
- Your license has expired
  
  If a license expires, you can create a blueprint; however, it cannot be provisioned and the blueprint name is disabled on the Request Machine page.
- Your evaluation license is due to expire

### About the License Portal

Use the license portal to get upgraded license keys, combine the capacity of multiple license keys, divide the capacity of a single license key, view the change history of your license keys, and find lost license keys.

VMware provides evaluation license keys for every type of license key. The evaluation period is 60 days and begins when the key is created.

VMware recommends that you write down the license key and put it in a secure, easily accessible location.

### Getting Upgraded License Keys

If you are upgrading from DCAC 4.5 or vCAC 5.1, use the license portal to retrieve the new license keys. After you retrieve the license keys, you can...

### Combining the Capacity of License Keys

If your vCAC site contains multiple license keys, each with a small amount of capacity, you might want to combine them into one large-capacity license key. Combining license keys is useful when the total available capacity across license keys is large enough to accommodate an asset, but no single license key is large enough to accommodate the asset.

After you use the license portal to combine license keys, you must add the new license key to vCAC and remove the old license keys.
Dividing the Capacity of License Keys
If you have a large-capacity license key, you might want to divide the capacity to create multiple smaller-capacity license keys. Dividing license keys is useful for managing license keys in different vCAC license inventories or assigning different license keys to groups in your organization.

Viewing the Change History of License Keys
The license portal tracks the complete history of license key upgrades, downgrades, combinations, and divisions for your organization.

Finding Lost License Keys
If a license key is misplaced, you can search for it in the license portal by:
- Date range
- License key
- Order number
- Transaction type

Managing Instance Types
A set of predefined Amazon instance types is provided with vCAC. These instance types are available for blueprint creators to select in a blueprint, making them available in turn to users requesting machines from that blueprint. The instance type selected by the requesting user is applied to the Amazon Machine Image (AMI) specified in the blueprint to provision a cloud machine.

You can manage the instance types available at your vCAC site using the vCAC Administrator > Instance Types activity. This displays a list of instance types. Use the edit icon to change the instance type settings, including name, API name, type name, IO performance name, number of CPUs, memory in GB, storage in GB, and compute units. Use the delete icon to delete an instance type.

To create an instance type, use the New Instance Type link at the right-hand end of the title bar.

Click the Save button or the Cancel button to save or discard your changes. If you navigate away from the page before saving your changes, your changes are lost.

Note: Consult Amazon EC2 documentation, for example http://aws.amazon.com/ec2/instance-types, for information about instance types.

Due to a limitation in Amazon EC2, the platform name column in the AMI list does not provide platform information for non-Windows AMIs.

Using vCAC Reports
If you are a Support User, PGM, Enterprise Administrator, or vCAC administrator, you can go to the vCAC reports web site by clicking Reports in the activity pane.

The available report groups are shown in the activity pane and can be expanded or collapsed as needed.
Most reports have a Filters area that lets you use relevant filter criteria—such as type of machine, date range, provisioning group, and so on—to narrow down the report and focus on a particular issue or area.

The report tool bar always lets you

- Print the report or the current page of the report
- Go the first, previous, next, or last page of the report, or to a selected page
- Export the report in one of a number of formats and save it to disk or display it in a new window.

Executive Summary

These reports provide an overview of provisioning and resources for the entire vCAC site, by machine type.—virtual, physical and cloud.

The Environment Totals section provides counts for all of the elements and resources involved in provisioning the selected type of machine. The virtual and physical summaries divide some elements into two groups, discovered and managed; the latter is a subset of the former.

- Discovered
  - All virtualization compute resources from which proxy agents are collecting data, whether in enterprise groups or not, or all virtual machines discovered on all such compute resources, whether provisioned by vCAC or provisioned outside of vCAC and not under vCAC management
  - All physical machines discovered on all endpoints, whether unprovisioned or provisioned by or imported into vCAC. Unprovisioned machines include both unmanaged and reserved unprovisioned machines, as described in "Managing Enterprise Machines".

  Note: vCAC does not collect data on cloud machines it did not provision, so there is no such thing as a Discovered cloud machine

- Managed
  - Only those compute resources that belong to enterprise groups and are therefore under vCAC management, or only those virtual machines managed by vCAC because they were either provisioned by vCAC or imported into vCAC using the Infrastructure Organizer.
  - Only those physical machines provisioned by or imported into vCAC.
  - Cloud machines provisioned by vCAC.

On the virtual summary, a section provides totals for physical, reserved, allocated and used virtualization resources. As noted in "vCAC Resource Hierarchy", these terms indicate the following:

- Physical—The actual memory or storage capacity of a virtualization compute resource (in the virtual summary, of all compute resources).
- Reserved—The specified memory or storage of a reservation (in the virtual summary, of all reservations).
- Allocated—The amount of a resource assigned to provisioned machines.
Note: Only virtual machines that are powered on are included in allocated memory statistics; all virtual machines are included in allocated storage statistics.

- **Used** (storage only)—The amount of storage in use by vCAC-provisioned virtual machines. When standard storage is employed, allocated and used are the same, but when machines are provisioned using a space-efficient technology such as thin provisioning or NetApp FlexClone-enabled storage, storage used is less than storage allocated because each machine uses storage only as needed up to its full allocation.

Each executive summary also provides the same charts as the Enterprise Administrator section of the corresponding dashboard, but for all machines of the selected type site-wide.

**Capacity Usage Reports**

The capacity usage reports provide breakdowns of machine quota, memory and storage usage by provisioning group, virtualization compute resource, machine owner, and blueprint. Only provisioning groups with reservations of the selected type are displayed.

**Capacity Usage by Group**: This report shows resources reserved, allocated and used by all provisioning groups or a selected group, and must be filtered for machine type.

Two charts show the allocated and unallocated portions of total reserved memory (virtual and physical) and storage (virtual only) for all provisioning groups or the selected group. A table shows the following for each displayed provisioning group:

**Table 10  Capacity Usage by Group Table**

<table>
<thead>
<tr>
<th>Resource Type</th>
<th>Machines</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
</table>
| virtual       | **Total**—Total machines provisioned from group’s reservations  
**Allocated**—Total machines provisioned on group’s reservations  
**Allocated %**—Percentage of total machine quota allocated to provisioned machines  
**Note**: Virtual and cloud machines that are turned off appear in **Total** but not in **Allocated** and **Allocated %** | **Reserved**—Total memory reserved by group’s reservations  
**Allocated**—Total memory allocated to machines provisioned on group’s reservations  
**Allocated %**—Percentage of total reserved memory allocated to provisioned machines | **Reserved**—Total storage reserved by group’s reservations  
**Allocated**—Total storage allocated to machines provisioned on group’s reservations  
**Allocated %**—Percentage of total reserved storage allocated to provisioned machines  
**Used**—Total storage used by provisioned machines; less than **Allocated** only when space-efficient storage is in use |
| physical       | does not apply | does not apply | does not apply |
| cloud          | does not apply | does not apply | does not apply |

**Capacity Usage by compute resource**: This report shows total virtual resources reserved, allocated and used for all compute resources or a selected compute resource.
Two charts show the allocated and unallocated portions of total reserved memory and storage for all compute resources or the selected compute resource. A table shows the following for each displayed compute resource:

**Table 11  Capacity Usage by compute resource Table**

<table>
<thead>
<tr>
<th>Machines</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sockets—Number of CPU sockets in the compute resource</td>
<td>Reserved—Total memory reserved by all reservations on the compute resource</td>
<td>Physical—Total physical storage available on the compute resource</td>
</tr>
<tr>
<td>Total—Total machines provisioned on the compute resource</td>
<td>Reserved %—Percentage of total physical memory reserved by all reservations</td>
<td>Reserved—Total storage reserved by all reservations on the compute resource</td>
</tr>
<tr>
<td>Allocated—Same as Total</td>
<td>Allocated—Total memory allocated to all machines provisioned on the compute resource</td>
<td>Reserved %—Percentage of total physical storage reserved by all reservations</td>
</tr>
<tr>
<td></td>
<td>Allocated %—Percentage of total reserved memory allocated to machines</td>
<td>Allocated—Total storage allocated to machines provisioned on the compute resource</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Allocated %—Percentage of total reserved storage allocated to machines provisioned on the compute resource</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Used—Total storage used by machines provisioned on the compute resource; less than Allocated only when space-efficient storage is in use</td>
</tr>
</tbody>
</table>

**Capacity Usage by Owner:** This report shows resources allocated to machines owned by all machine owners or a selected owner, and must be filtered by machine type. Only owners of machines of the selected type are displayed.

A table shows the following for each displayed owner:

**Table 12  Capacity Usage by Owner Table**

<table>
<thead>
<tr>
<th>Machine Type</th>
<th>Data Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual</td>
<td>Machines Total—Total provisioned machines owned</td>
</tr>
<tr>
<td></td>
<td>Machines Allocated—Total machines owned and powered on</td>
</tr>
<tr>
<td></td>
<td>Memory Allocated (GB)—Total memory allocated to machines owned and powered on</td>
</tr>
<tr>
<td></td>
<td>Storage Allocated (TB)—Total storage allocated to all machines owned</td>
</tr>
<tr>
<td></td>
<td>Storage Used (TB)—Total storage used to all machines owned; less than Storage</td>
</tr>
<tr>
<td></td>
<td>Allocated only when space-efficient storage is in use</td>
</tr>
<tr>
<td>physical</td>
<td>Machines Total—Total provisioned machines owned</td>
</tr>
<tr>
<td></td>
<td>Machines Allocated—Same as Machines Total</td>
</tr>
<tr>
<td></td>
<td>Memory Allocated (GB)—Total memory allocated to machines owned</td>
</tr>
</tbody>
</table>
Capacity Usage by Blueprint: This report shows resources allocated to machines provisioned from all blueprints or a selected blueprint, and can be filtered for blueprint type.

A table shows the type and provisioning group (or possibly groups if global) of each displayed blueprint along with the following information:

**Table 13  Capacity Usage by Blueprint Table**

<table>
<thead>
<tr>
<th>Blueprint Type</th>
<th>Data Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual</td>
<td><strong>Machines Total</strong>—Total machines provisioned from the blueprint</td>
</tr>
<tr>
<td></td>
<td><strong>Machines Allocated</strong>—Total provisioned machines that are powered on</td>
</tr>
<tr>
<td></td>
<td><strong>Memory Allocated (GB)</strong>—Total memory allocated to provisioned machines that are powered on</td>
</tr>
<tr>
<td></td>
<td><strong>Storage Allocated (TB)</strong>—Total storage allocated to provisioned machines</td>
</tr>
<tr>
<td></td>
<td><strong>Storage Used (TB)</strong>—Total storage used by provisioned machines owned; less than</td>
</tr>
<tr>
<td></td>
<td><strong>Storage Allocated</strong> only when space-efficient storage is in use</td>
</tr>
<tr>
<td>physical</td>
<td><strong>Machines Total</strong>—Total machines provisioned from the blueprint</td>
</tr>
<tr>
<td></td>
<td><strong>Machines Allocated</strong>—Same as <strong>Machines Total</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Memory Allocated (GB)</strong>—Total memory allocated to provisioned machines</td>
</tr>
<tr>
<td>cloud</td>
<td><strong>Machines Total</strong>—Total machines provisioned from the blueprint</td>
</tr>
<tr>
<td></td>
<td><strong>Machines Allocated</strong>—Total provisioned machines that are powered on</td>
</tr>
</tbody>
</table>

**Audit Log Reports**

The audit reports display all machine audit log entries during a specified time period, filterable by:

- Provisioning group or owner of machine, machine name matching pattern or a combination of the three
- Compute resource on which virtual machine was provisioned, machine owner, or a combination of the two
- Blueprint from which machine was provisioned, machine owner, or a combination of the two

Entry Status is Info, Warning or Error.

**Chargeback Reports**

As discussed in "Managing Cost Profiles", earlier in this chapter, cost profiles containing daily memory, CPU and storage costs can be associated with virtualization compute resources and physical machines. A storage cost profile can also be assigned to each storage path on a compute resource, overriding the storage cost in the cost profile assigned to the compute resource if any. A daily cost can also be specified in each blueprint. Cost profiles and daily blueprint cost are optional; all of the settings in a cost profile can be zero.
Cost profiles are assigned to compute resources and physical machines by Enterprise Administrators. Blueprint costs are specified by Enterprise Administrators for global blueprints and PGMs for local blueprints.

Taken together, these costs enable the generation of daily costs per machine, and chargeback reports totalling these costs for each machine and for all machines on each reservation over a specified period. The formula is as follows:

**Table 14  Chargeback Calculation by Machine Type**

<table>
<thead>
<tr>
<th>Machine Type</th>
<th>Daily cost is the sum of...</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Cost times GB of memory allocated</td>
</tr>
<tr>
<td></td>
<td>CPU Cost times number of CPU equivalents allocated</td>
</tr>
<tr>
<td></td>
<td>Storage Cost times GB of storage allocated, if no storage cost profile associated with storage path on which machine is provisioned</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage cost profile</td>
<td>Storage Cost times GB of storage allocated from storage path with which cost profile is associated; if zero, calculated storage cost is zero regardless of storage cost in compute resource cost profile</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Blueprint</td>
<td>Cost (daily) setting on Build Information tab</td>
</tr>
<tr>
<td>physical</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Cost times GB of installed memory</td>
</tr>
<tr>
<td></td>
<td>CPU Cost times number of CPUs installed</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine cost profile</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Blueprint</td>
<td>Cost (daily) setting on Build Information tab</td>
</tr>
<tr>
<td>cloud</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Blueprint</td>
<td>Cost (daily) setting on Build Information tab</td>
</tr>
</tbody>
</table>

**Chargeback by Group by Allocated Resources:** This report shows the cost for all provisioning groups or a selected provisioning group of all machines or all machines of a selected type owned by members of the group, over a specified period of time. For example, you can see the cost of machines of all types owned by a particular group during a particular week, or the cost of physical machines owned by all provisioning groups over a year. Costs are shown for individual machines and totaled for all machines owned by a provisioning group.

The table displayed shows the type, owner and blueprint of each machine along with resources allocated and component costs appropriate to the machine type. For virtual machines, allocated CPUs, memory and storage are shown along with costs for each; for physical machines, installed CPUs and memory are shown, with associated costs. Daily blueprint cost is shown for all machine types. For each provisioning group, only total cost of all machines is shown.

**Chargeback by Owner by Allocated Resources:** This report shows the cost for all machines owners or a selected owner of all machines or all machines of a selected type owned, over a specified period of time. For example, you can see the cost of machines of all types owned by a particular owner during a particular week, or the cost of physical machines owned by all owners over a year. Costs are shown for individual machines and totaled for all machines owned by a user.

The table displayed shows the type, provisioning group and blueprint of each machine along with resources allocated and component costs appropriate to the machine type. For virtual machines, allocated CPUs, memory and storage are shown along with costs for each; for physical machines, installed...
CPUs and memory are shown, with associated costs. Daily blueprint cost is shown for all machine types. For each owner, only total cost of all machines is shown.

**Chargeback by Group by Reservation:** This report shows the cost for all provisioning groups or a selected provisioning group of all machines or all machines of a selected type provisioned on each of its reservations, over a specified period of time. For example, you can see the cost of machines of all types provisioned on each reservation for a particular group during a particular week, or the cost of physical machines provisioned on each physical reservation for all provisioning groups over a year. Costs are shown for individual reservations and totaled for all of a provisioning group’s reservations.

The table displayed shows the type of each reservation along with resources allocated and component costs appropriate to the reservation type. For virtual reservations, allocated CPUs, memory and storage are shown along with costs for each; for physical reservations, total installed CPUs and memory of provisioned machines are shown, with associated costs. Daily blueprint cost is shown for all machine types. For each provisioning group, only total cost of all reservations is shown.

---

**Note:** You must choose the next day as the End Date to see virtual machines that were created on the current day.

### Reclamation Reports

The reclamation reports provide information on all machines or machines of a particular type that have been reclaimed (destroyed or decommissioned) during a particular period. This includes machines destroyed/decommissioned after lease expiration or manual expiration or machines manually destroyed/decommissioned, as well as virtual machines destroyed by a reclamation workflow initiated by an Enterprise Administrator.

The **Reclaimed Resources Dashboard** report totals reclaimed machines, or machines of a selected type, during the last 7, 30, 90, and 365 days.

The **Reclamation Savings by Group** report shows the number of machines (or machines of a selected type) reclaimed and cost savings realized by reclamation since the specified start date by provisioning group. Two charts indicate number of machines reclaimed and total cost savings by provisioning group. The table displayed provides the following information for each provisioning group:

- **Machines Total**—Total machines owned by the provisioning group since the specified start date, including machines reclaimed
- **Machines Reclaimed**—Total machines reclaimed from the provisioning group since the specified start date
- **Machines Reclaimed %**—Percentage of total machines represented by reclaimed machines
- **CPUs Reclaimed** (virtual and physical only)—Number of CPUs allocated to machines reclaimed since the specified start date
- **Memory Reclaimed** (virtual and physical only)—GBs of memory allocated to machines reclaimed since the specified start date
- **Storage Reclaimed** (virtual only)—GBs of storage allocated to machines reclaimed since the specified start date
- **Savings in Period**—Difference between what would have been the cost of total machines owned by the provisioning group since the specified start date if reclaimed machines had not been reclaimed, and the actual cost including machine reclamation
The **Reclamation Savings by Owner** report shows the following information for each owner of one or more machines (or machines of a selected type) reclaimed since the specified start date:

- **Machines Total**—Total machines owned by the provisioning group since the specified start date, including machines reclaimed
- **Machines Reclaimed**—Total machines reclaimed from the provisioning group since the specified start date
- **Machines Reclaimed %**—Percentage of total machines represented by reclaimed machines
- **CPUs Reclaimed** (virtual and physical only)—Number of CPUs allocated to machines reclaimed since the specified start date
- **Memory Reclaimed** (virtual and physical only)—GBs of memory allocated to machines reclaimed since the specified start date
- **Storage Reclaimed** (virtual only)—GBs of storage allocated to machines reclaimed since the specified start date
- **Savings in Period**—Difference between what would have been the cost of total machines owned by the provisioning group since the specified start date if reclaimed machines had not been reclaimed, and the actual cost including machine reclamation

---

**Using the vCAC Self-Service Portal Website**

This information describes key details about using the vCAC Self-Service Portal Website.

**Accessing the vCAC Self-Service Portal**

Access to the vCAC Self-Service Portal Website is based on the Windows credentials for each user.

To open the vCAC Self-Service Portal Website:

1. Scripting and cookies must be enabled in your browser. Active scripting must be enabled in Internet Explorer, which can be done by enabling this feature alone or by disabling Enhanced Security Configuration.
2. To access the vCAC Self-Service Portal Website remotely, open a browser and type:

   ```
   https://localhost/vCACSelfService
   ```

   where localhost is the FQDN of the host machine where the vCAC Self-Service Portal Website was installed in your URL.
3. If you are denied access, or if you are logged in under an unexpected name, contact your vCAC administrator.

**Connecting by Using SSH for Linux Machines**

To enable the use of the Connect Using SSH option for a Linux machine:

1. On the vCAC manager service host, navigate to `C:\Program Files (86)\DynamicOps\Self-Service Portal\` and open the `Web.config` file for editing.
2. At the end of the `<appSettings>` section, before `</appSettings>`, insert:
<add key="ShowConnectUsingSsh" value="true" />

3. Reset IIS and restart the Manager Service.

4. Add the custom property Machine.SSH=true to a blueprint or the blueprint’s incorporated build profile.

For any powered on machine provisioned from the blueprint, the Connect Using SSH right-click option appears. However, when you select it the browser attempts to load the URL ssh://machine_name, which requires an SSH URL handler to be installed on the system on which you clicked the link and it needs to be enabled on the guest operating system.

Preferences

You can select to exclude information that appears when more details for a machine are requested.

To exclude details:

1. In the upper-right of the screen, click the Preferences icon (person silhouette) and select General Settings.

2. In Machine details, click to select the details you want to exclude.

Selecting Multiple Machines

To select multiple machines:

- Press CTRL and click the machines you want to select.

Blueprint Icons

Optional display icons are available on the Blueprint Information tab in the vCAC Console for use by the vCAC Administrator. The display icons are intended to identify what the machine is, for example, Windows Server 2008 R2, Red Hat Linux web server, Database machine, or load balancer. You can use the icons provided or upload your own. The icon must be either a .png (preferred) or .gif and it must be 32x32 pixels.

You can use the combination of the icons and the name of the blueprint to differentiate machine types and functions.

These icons appear only when users request a machine or when they are managing their own machines by using the vCAC Self-Service Portal Website and not when they select Self-Service from the vCAC Console.

When you create or edit a local or global blueprint in the vCAC console, you have the option to include an icon that appears in the vCAC Self-Service Portal Website. You can use the icon and the name of the blueprint to help users make the correct machine selections in the vCAC Self-Service Portal Website. Standard icons are provided or you can add your own.

To add your own icons:

1. From the vCAC console, go to vCAC Administrator > Customization > Icons and select the icon.

2. Click Browse and locate the icon file. The icon must be either a .png (preferred) or .gif and it must be 32x32 pixels.

3. Click OK.
To add an icon to a blueprint:

1. From the vCAC console, go to Provisioning Group Manager > New Blueprint.
2. On the Blueprint Information tab, click the displayed icon and select an icon.
3. Click OK.

**Multi-Machine Services Support**

You can use the vCAC Self-Service Portal Website to request and manage multi-machine services. Multi-machine services appear as one machine in the Dashboard. The vCloud Automation Center Multi-Machine Guide provides more detail on Multi-Machine Services.

When you request additional components for a multi-service machine, each subsequent machine will be the same size as the machine that was originally requested. If you require component machines of a different size than the original, you need to use the vCAC Console or re-create the multi-machine service with the desired configuration in the vCAC Self-Service Portal Website.

**vCloud Director**

You can use the vCAC Self-Service Portal Website to request and manage machines in vCloud Director.

**Security**

Security for the vCAC Self-Service Portal Website in the same as it is for the vCAC console.
Chapter 5 Customizing vCAC

This chapter provides information about methods you can use to customize your vCAC site and integrate it with external entities and systems using custom properties, vCAC plugins, and vCAC workflows.

Comparing Virtualization Platforms

The virtualization platforms (and component hypervisors) supported by vCAC—VMware ESX servers within vCenter Server datacenters, XenServers, and Hyper-V servers—place varying limits on machine specifications and provisioning compute resource capacity. Elements you create and maintain in vCAC (such as blueprints, build profiles and reservations) may be influenced by the characteristics of the virtualization platform you are working with.

Customizing Resource-Intensive Concurrency Limits

To help you better manage your vCAC site and the resources on which it depends, vCAC places limits on the number of concurrent instances of two particularly resource-intensive operations, machine provisioning and data collection. In some cases one or both of the default limits can be adjusted.

Customizing Concurrent Machine Provisioning

Depending on the needs of machine owners at your site, the vCAC server may sometimes receive multiple concurrent requests for machine provisioning. This can happen when

• a single user submits a request for multiple machines
• many users request machines at the same time
• one or more group managers approve multiple pending machine requests in close succession.

The time required for vCAC to provision a machine generally increases with larger numbers of concurrent requests. The increase in provisioning time depends on three important factors, as follows:

• The effect on performance of concurrent resource-intensive vCAC workflow activities, including the SetupOS activity (for machines created within the virtualization platform, as in WIM-based provisioning) and the Clone activity (for machines cloned within the virtualization platform).

• The configured vCAC limit on the number of resource-intensive (typically lengthy) provisioning activities that can be executed concurrently. By default this is two. Concurrent activities beyond the configured limit are queued.

• Any limit within the virtualization platform or cloud service account on the number of vCAC work items (resource-intensive or not) that can be executed concurrently. For example, the default limit in vCenter Server is four, with work items beyond this limit being queued.

By default, vCAC limits concurrent virtual provisioning activities to two per proxy agent because this ensures that the virtualization platform managed by a particular agent will never receive enough resource-intensive work items to prevent execution of other items. Plan to carefully test the effects of changing the limit before making any changes. Determining the best limit for your site may require that...
you investigate work item execution within the virtualization platform as well as workflow activity execu-
tion within vCAC.

If you do increase the configured vCAC per-agent limit, you may have to make additional configuration
adjustments in vCAC, as follows:

• The default *execution* timeout intervals for the SetupOS and Clone workflow activities are two
  hours for each. If the time required to execute one of these activities exceeds this limit, the
  activity is cancelled and provisioning fails. Therefore, if you have increased the limit to the point
  at which this sometimes occurs, you will want to increase one or both of these execution timeout
  intervals.

• The default *delivery* timeout intervals for the SetupOS and Clone workflow activities are 20
  hours for each. Once one of these activities is initiated, if the machine resulting from the activity
  has not been provisioned within 20 hours, the activity is cancelled and provisioning fails. There-
  fore, if you have increased the limit to the point at which this sometimes occurs, you will want to
  increase one or both of these delivery timeout intervals.

### Customizing Concurrent Data Collections

vCAC regularly collects data from known virtualization compute resources through its proxy agents and
from cloud service accounts and physical machines through the endpoints that represent them. Depend-
ing on the number of virtualization compute resources, agents, and endpoints in your site, concurrent
data collection operations may occur frequently.

Data Collection running time depends on the number of objects on endpoints including virtual
machines, datastores, templates, and compute resources, for example. Depending on many factors, a
single data collection can require a significant amount of time. As with machine provisioning, concur-
rency increases the time required to complete data collection.

By default, vCAC limits concurrent data collection activities to two per agent, with those over the limit
being queued. This ensures that, once begun, each data collection completes relatively quickly and that
concurrent data collection activities are unlikely to affect performance.

Depending on the resources and circumstances at your site, however, it may be possible to raise the
configured limit while maintaining fast enough performance to take advantage of concurrency in data
collection. While raising the limit may increase the time required for a single data collection, this may be
outweighed by the ability to collect more information from more compute resources and machines at
one time.

If you do increase the configured vCAC per-agent limit, you may have to adjust the default execution
timeout intervals for the different types of data collection that use an agent—inventory, performance,
state, and WMI. If the time required to execute one of these activities exceeds the configured timeout
intervals, the activity is cancelled and restarted. Therefore, if you have increased the limit to the point at
which this sometimes or frequently occurs, you may want to increase one or more of these execution
timeout intervals.

### Customizing the Cloud Timeout Interval

The default timeout interval for cloud service machine provisioning is 30 minutes. Once provisioning has
been initialized, if the machinse resulting from the activity has not been provisioned within 30 minutes,
the activity is cancelled and provisioning fails.
Adjusting Concurrency Limits and Timeout Intervals

To reconfigure the vCAC per-agent limits on concurrent provisioning or data collection activities or the default timeout intervals discussed above, follow these steps:

1. Log into the vCAC server using credentials with administrator access.
2. Edit the file `ManagerService.exe.config` in the vCAC server install directory (typically `%SystemDrive%\Program Files x86\VMware\vCAC\Server`).
3. Locate the `workflowTimeoutConfigurationSection`. Within this,
   a. To reconfigure the concurrent provisioning limit, change the following parameter:
      `MaxOutstandingResourceIntensiveWorkItems="2"`
   b. To reconfigure one of the virtual provisioning execution timeout intervals, change one of these parameters:
      `CloneExecutionTimeout="02:00:00"`
      `SetupOSExecutionTimeout="02:00:00"`
   c. To reconfigure one of the virtual provisioning delivery timeout intervals, change one of these parameters:
      `CloneTimeout="20:00:00"`
      `SetupOSTimeout="20:00:00"`
   d. To reconfigure the cloud provisioning initialization timeout interval, change this parameter:
      `CloudInitializeProvisioning="00:30:00"`
   e. To reconfigure the concurrent data collection limit, change the following parameter:
      `MaxOutstandingDataCollectionWorkItems="2"`
   f. To reconfigure one of the data collection execution timeout intervals, change one of these parameters:
      `InventoryTimeout="02:00:00"`
      `PerformanceTimeout="02:00:00"`
      `StateTimeout="01:00:00"`
4. Save the file, then select `Start > Administrative Tools > Services` and stop and restart the vCloud Automation Center service.

**Note:** If vCAC is running in High Availability mode, any changes made to the `ManagerService.exe.config` file after installation must be made on both the primary and failover vCAC servers.

Customizing Automatic Emails

vCAC sends automatic emails to machine owners informing them of certain events involving their machines. You can customize several aspects of these emails, including:

- Information about the SMTP server and other configuration used to send emails.
- The product name that appears in the subject of automatic emails.
The base URL of the portal web site in links to vCAC Console pages in automatic emails.

Whether to use the fully qualified domain name instead of the short host name when machine names appear in automatic emails.

The list of events that trigger automatic emails. For example, by default the owner does not receive an email message when a machine is powered off or on, but you can change the configuration so that these events do trigger emails.

The text and format of the automatic email triggered by specific events. For example, you can customize the content of the email that is sent when a machine is powered off. Most emails including the ones commonly sent during provisioning are customizable, but emails for reconfigure and capacity alerts cannot be customized.

### Configuring the SMTP Server and From Address

Basic information used for sending emails such as the SMTP server and the address in the “From” field of automatic emails is configured during installation and maintained in global properties.

vCAC supports both anonymous connections to the SMTP server and connections using basic authentication, as well as communication over SSL or without SSL.

The following properties can be edited on the **vCAC Administrator > Global Properties** page under **Group: Email**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SSL</td>
<td>If true, vCAC communicates with the SMTP server using SSL.</td>
</tr>
<tr>
<td>SMTP Server</td>
<td>The host name or IP address of the outgoing SMTP server.</td>
</tr>
<tr>
<td>SMTP Port</td>
<td>The SMTP port on the server specified in the SMTP Server property. The default is 25.</td>
</tr>
<tr>
<td>From Address</td>
<td>The address with which to populate the “From” field of the email.</td>
</tr>
<tr>
<td>User Name</td>
<td>The user name with which to authenticate with the SMTP server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user with which to authenticate with the SMTP server.</td>
</tr>
</tbody>
</table>

**Note:** After editing global properties in the vCAC Console, you must restart the vCloud Automation Center service for your changes to take effect.

### Table 15  Email configuration properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SSL</td>
<td>If true, vCAC communicates with the SMTP server using SSL.</td>
</tr>
<tr>
<td>SMTP Server</td>
<td>The host name or IP address of the outgoing SMTP server.</td>
</tr>
<tr>
<td>SMTP Port</td>
<td>The SMTP port on the server specified in the SMTP Server property. The default is 25.</td>
</tr>
<tr>
<td>From Address</td>
<td>The address with which to populate the “From” field of the email.</td>
</tr>
<tr>
<td>User Name</td>
<td>The user name with which to authenticate with the SMTP server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user with which to authenticate with the SMTP server.</td>
</tr>
</tbody>
</table>

### Customizing the Product Name in Automatic Email Subjects

By default, each automatic email message sent by vCAC contains “vCAC” in its subject line.

To change the product name prefix in automatic emails:

1. Log into the vCAC Console as a vCAC Administrator.
2. Click **vCAC Administrator > Global Properties**.
3. Update the value of the **Product Name** property under **Group: Installation**.
   a. Click the **Edit** button next to the name of the property.
b. Specify a product name to include in automatic email subject lines.

c. Click the **Save** button.

4. Restart the vCloud Automation Center service.

### Customizing the Base URL of Console Links in Automatic Emails

Some automatic emails contain a link that the recipient can follow to open the vCAC Console to the page appropriate to the contents of the email. For example, when a user receives a reclamation request, the automatic email generated includes a link to the user’s My Machines page with the My Reclamation Requests list expanded.

The initial value of the URL is based on the vCAC Website Hostname specified during the Model Manager installation.

To customize the base URL for links in automatic emails:

1. Log into the vCAC Console as a vCAC Administrator.

2. Click **vCAC Administrator > Global Properties**.

3. Update the value of the **Website URI** property under **Group: Installation**.

   a. Click the **Edit** button next to the name of the property.

   b. Specify the root URL for the vCAC Console, for example:

   ```text
   http://vcac-web.example.com/vCAC/
   ```

   c. Click the **Save** button.

4. Restart the vCloud Automation Center service.

### Including the Machine’s FQDN in Automatic Emails

When the machine name is included in an automatic email template, the name is formed by appending the value of the custom property `VirtualMachine.Admin.NameCompletion` to `//VirtualMachineEx/Name` as described above. This means that if `VirtualMachine.Admin.NameCompletion` does not exist or has no value, the machine name shown will be the short host name only. To include the fully qualified domain name, set the value of `VirtualMachine.Admin.NameCompletion` to the domain name.

For example, if the host name of the machine (specified at request time) is `my-machine` and the value of `VirtualMachine.Admin.NameCompletion` is `example.com`, then vCAC generates the fully qualified domain name as `my-machine.example.com`.

### Customizing Automatic Email Events

To choose which machine events trigger emails to the machine’s owner or group managers, use the following procedure:

1. Log into the vCAC server using credentials with administrator access.

2. Edit the file `ManagerService.exe.config` in `%SystemDrive%\Program Files\x86\VMware\vCAC\Server` (or the vCAC server install directory, if different).

3. Locate the `workflowEmailByStateSection` section to customize machine owner emails and the `workflowManagerEmailByStateSection` to customize group manager emails.

4. In each section, set `true` and `false` values for the events listed below.
Remember however that for some events you must create a group manager template if you want to configure automatic email to group managers. Also, six of the events listed below apply to owners only, not to managers.

Two events do not involve templates:

- **If IncludeRdpLinkAttachment** is set to **true**, the default, emails regarding a provisioned, running machine include an .rdp file to enable the user to make a Remote Desktop Protocol connection to the machine in question. Turning this off is useful if users at your site do not use RDP to connect to machines, for instance if all access to machines is through XenDesktop.

- **DaysNotificationBeforeExpire** sets the number of days (default is 7) before a machine’s expiration that an expiration notification email is sent if **LeaseExpired** is set to **true**.

**Table 16 Automatic Email Events**

<table>
<thead>
<tr>
<th>workflowEmailByStateSection/ workflowManagerEmailByStateSection</th>
<th>if true, user/group manager receives email when:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ApprovalRequired=&quot;true&quot;</td>
<td>request is made from locked machine blueprint</td>
</tr>
<tr>
<td>RequestApproved=&quot;true&quot;</td>
<td>request from locked machine blueprint is approved by group manager and/or approvers</td>
</tr>
<tr>
<td>RequestRejected=&quot;true&quot;</td>
<td>request from locked machine blueprint is rejected by group manager or approver</td>
</tr>
<tr>
<td>MachineRequested=&quot;false&quot;</td>
<td>vCAC receives request and starts building machine</td>
</tr>
<tr>
<td>PowerOn=&quot;false&quot;</td>
<td>machine is powered on using the On button in the Status column</td>
</tr>
<tr>
<td>PowerOff=&quot;false&quot;</td>
<td>machine is powered off using the <strong>Power Off</strong> option</td>
</tr>
<tr>
<td>Shutdown=&quot;false&quot;</td>
<td>machine's guest OS is shut down using the Shut Down (square) button in the Status column [by owner only]</td>
</tr>
<tr>
<td>Suspend=&quot;false&quot;</td>
<td>machine is suspended using <strong>Suspend</strong> option [owner only]</td>
</tr>
<tr>
<td>Reboot=&quot;false&quot;</td>
<td>machine is rebooted using <strong>Reboot</strong> option [owner only]</td>
</tr>
<tr>
<td>Reset=&quot;false&quot;</td>
<td>machine is reset using <strong>Power Cycle</strong> option [owner only]</td>
</tr>
<tr>
<td>MachineActivated=&quot;true&quot;</td>
<td>machine build is complete and machine is activated</td>
</tr>
<tr>
<td>FailedToProvision=&quot;true&quot;</td>
<td>provisioning of requested machine failed</td>
</tr>
<tr>
<td>MachineRegisterRequest=&quot;false&quot;</td>
<td>external machine is imported with user as owner</td>
</tr>
<tr>
<td>VdiRegister=&quot;false&quot;</td>
<td>machine is registered with VDI server</td>
</tr>
<tr>
<td>VdiUnregister=&quot;false&quot;</td>
<td>machine is unregistered from VDI server</td>
</tr>
<tr>
<td>EpiRegister=&quot;false&quot;</td>
<td>machine is registered with EPI server</td>
</tr>
<tr>
<td>EpiUnregister=&quot;false&quot;</td>
<td>machine is unregistered from EPI server</td>
</tr>
<tr>
<td>MachineReprovisionRequest=&quot;false&quot;</td>
<td>machine is reprovisioned</td>
</tr>
<tr>
<td>MachineDisposed=&quot;true&quot;</td>
<td>machine is destroyed</td>
</tr>
</tbody>
</table>
5. Save and close the file.

6. Select **Start > Administrative Tools > Services** and restart the vCloud Automation Center service.

**Note:** To include the fully qualified domain name of the newly-provisioned machine in the **MachineActivated** email to the owner (above), include the property `Virtual-Machine.Admin.NameCompletion=domain_name` in the machine blueprint or incorporated build profile.

If vCAC is running in high availability mode, any changes made to the **ManagerService.exe.config** file after installation must be made on both the primary and failover vCAC servers.

To avoid excessive email, a group manager receives email about a lease extension request only if there are no such requests outstanding. Once there is at least one request in her list, she will not receive any more email about lease extension requests until she has dealt with all requests in the list.

<table>
<thead>
<tr>
<th>workflowEmailByStateSection/workflowManagerEmailByStateSection</th>
<th>if true, user/group manager receives email when:</th>
</tr>
</thead>
<tbody>
<tr>
<td>LeaseModified=&quot;true&quot;</td>
<td>machine lease is changed</td>
</tr>
<tr>
<td>LeaseAboutToExpire=&quot;true&quot;</td>
<td>machine will expire in the number of days specified in DaysNotificationBeforeExpire</td>
</tr>
<tr>
<td>LeaseExpired=&quot;true&quot;</td>
<td>machine (running or powered off) expires</td>
</tr>
<tr>
<td>LeaseExpiredPowerOff=&quot;true&quot;</td>
<td>running machine expires and is powered off</td>
</tr>
<tr>
<td>ArchivePeriodExpired=&quot;true&quot;</td>
<td>archive period expires and machine is destroyed</td>
</tr>
<tr>
<td>MachineOwnerChanged=&quot;true&quot;</td>
<td>machine’s owner is changed by admin using Edit option</td>
</tr>
<tr>
<td>LeaseApproved=&quot;true&quot;</td>
<td>lease change request is approved [owner only]</td>
</tr>
<tr>
<td>LeaseRejected=&quot;true&quot;</td>
<td>lease change request is rejected [owner only]</td>
</tr>
<tr>
<td>Reclamation=&quot;true&quot;</td>
<td>enterprise admin initiates reclamation workflow for machine, sending request to user</td>
</tr>
<tr>
<td>ReclamationReminder=&quot;true&quot;</td>
<td>enterprise admin sends reminder about machine in reclamation workflow</td>
</tr>
<tr>
<td>ReclamationExpiredLeaseModified=&quot;true&quot;</td>
<td>expiration of response period changes expiration date of machine to new lease period specified by the Enterprise Administrator</td>
</tr>
<tr>
<td>IncludeRdpLinkAttachment=&quot;true&quot;</td>
<td>whether emails contain RDP link to subject machine; this setting in the owner section applies to both owner and manager email</td>
</tr>
<tr>
<td>DaysNotificationBeforeExpire=&quot;7&quot;</td>
<td>number of days before machine expiration to send LeaseAboutToExpire email; this is set separately for owners and managers</td>
</tr>
</tbody>
</table>
Customizing and Creating Automatic Email Templates

Templates for automatic emails are contained in the directory `\Templates` under the vCAC server install directory (typically `%SystemDrive%\Program Files x86\VMware\vCAC\Server`). Machine owner email templates in this directory include one for each of the events listed above.

Modifying Existing Templates

To customize the text and format of the automatic email for an event, follow these steps:

1. Log into the vCAC server using credentials with administrator access.
2. Change to the directory `\Templates` under the vCAC install directory.
3. Edit the XSLT template for the event.

In order for an event to trigger automatic email, the event must be configured and a corresponding template must exist. Because group manager email templates include only the ten events listed below, you can configure automatic email for these events only by following the procedure described Customizing Automatic Email Events, optionally customizing the template using the procedure above:

- `ManagerFailedToProvision.xslt`
- `ManagerLeaseAboutToExpire.xslt`
- `ManagerLeaseExpired.xslt`
- `ManagerLeaseModified.xslt`
- `ManagerMachineActivated.xslt`
- `ManagerMachineDisposed.xslt`
- `ManagerMachineOwnerChanged.xslt`
- `ManagerMachineRequested.xslt`
- `ManagerRequestApproved.xslt`
- `ManagerRequestRejected.xslt`

To configure one of the other events for automatic group manager email, you must both configure the event in the `ManagerService.exe.config` file, then use this procedure: to create a template:

1. Log into the vCAC server using credentials with administrator access.
2. Change to the directory `\Templates` under `%SystemDrive%\Program Files x86\VMware\vCAC\Server` (or the vCAC server install directory, if different).
3. Make a copy of the machine owner template for the event, prepending `Manager` to the file name. For example, to configure group manager email when a machine owner uses the `Reprovision` option, copy the template file `MachineReprovisionRequest.xslt` to `ManagerMachineReprovisionRequest.xslt`.
4. Edit the new template and modify the contents to make them appropriate for group manager email.

Email Template Objects

This section describes some useful objects you can include in automatic email templates. Be sure to review the provided email templates for examples of how to use these objects, as well as additional objects not discussed here.

WebsiteURI

Returns the base URL of the vCAC Console, for example `http://vcac-web.example.com/DCAC/`. To use this object to provide a link to a particular page in the console, you might use lines like the following:

```xml
<xsl:attribute name="href">
Please click
<a>
ManagerFailedToProvision.xslt ManagerLeaseAboutToExpire.xslt ManagerLeaseExpired.xslt
ManagerLeaseModified.xslt ManagerMachineActivated.xslt ManagerMachineDisposed.xslt
ManagerMachineOwnerChanged.xslt ManagerMachineRequested.xslt ManagerRequestApproved.xslt
ManagerRequestRejected.xslt
```
VirtualMachineEx

Returns a specific item of information about the machine associated with the event triggering the email. The information is determined by the attribute provided with the object. For example, to include the expiration date of the machine in an email, you would use the following:

\[ <\text{xsl:value-of select="/WebsiteURI"/Leases/LEASESTATUS.aspx} > \text{here}</a> \text{for more detail.} \]

\[ <\text{xsl:value-of select="/VirtualMachineEx/Expires"/> \]

Table 17  Selected Attributes of VirtualMachineEx Email Object

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of machine as generated by vCAC</td>
</tr>
<tr>
<td>Description</td>
<td>Machine's description</td>
</tr>
<tr>
<td>DnsName</td>
<td>Machine’s DNS name</td>
</tr>
<tr>
<td>TemplateName</td>
<td>Name of blueprint from which machine was provisioned</td>
</tr>
<tr>
<td>StoragePath</td>
<td>If a virtual machine, name of storage path on which machine was provisioned</td>
</tr>
<tr>
<td>State/Name</td>
<td>Status of machine</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner of machine</td>
</tr>
<tr>
<td>Expires</td>
<td>Date on which machine expires</td>
</tr>
<tr>
<td>ExpireDays</td>
<td>Number of days until machine expires</td>
</tr>
<tr>
<td>CreationTime</td>
<td>Date and time at which machine was provisioned</td>
</tr>
<tr>
<td>HostName</td>
<td>If a virtual machine, name of host on which machine was provisioned</td>
</tr>
<tr>
<td>GroupName</td>
<td>Name of provisioning group within which machine was provisioned</td>
</tr>
<tr>
<td>ReservationName</td>
<td>Name of reservation on which machine was provisioned</td>
</tr>
<tr>
<td>Group/AdministratorEmail</td>
<td>Group manager email address for provisioning group within which machine was provisioned</td>
</tr>
</tbody>
</table>

In addition, the special attribute Properties lets you search the custom properties associated with the machine for a specific property and return the value if found. For example, to include the value of Image.WIM.Name, which specifies the name of the WIM image from which a machine was provisioned, you would use lines like the following:

\[ <\text{xsl:for-each select="/VirtualMachineEx/Properties/NameValue">} \]
\[ <\text{xsl:if test="starts-with(Name, 'Image.WIM.Name')">} \]
\[ <\text{xsl:value-of select="/Value"/>} \]

If the machine does not have the Image.WIM.Name property, nothing is returned.
vCloud Automation Center

Operating Guide

VirtualMachineTemplateEx
Returns a specific item of information about the source blueprint of the machine associated with the
even triggering the email. The information is determined by the attribute provided with the object. For
example, to include the daily cost specified in the source blueprint you would use the following:
<xsl:value-of select="//VirtualMachineTemplateEx/Cost"/>

Table 18

Selected Attributes of VirtualMachineTemplateEx Email Object

Attribute

Returns

Name

Name of blueprint

Description

Blueprint’s description

MachinePrefix

Machine prefix specified in blueprint

LeaseDays

Number of lease days specified in blueprint

ExpireDays

If a virtual blueprint, number of archive days specified

Cost

Daily cost specified in blueprint

VirtualMachineTemplateEx also takes the special attribute Properties to let you search the custom
properties included in the blueprint for a specific property and return the value if found, as described
above for VirtualMachineEx above.
ReservationHelper
When a cost profile applies to the virtual or physical machine associated with the event triggering the
email, returns information about the daily cost of the machine, as specified by the attributes in the table
below.
Table 19

Selected Attributes of ReservationHelper Email Object

Attribute

Returns

DailyCostFormatted

Daily cost of machine

LeaseCostFormatted

Daily cost times the number of days in the machine’s lease.

Request
Returns information about the machine provisioning request triggering the automatic email. For example, to include the reason provided by the requesting user you would use the following:
<xsl:value-of select="//Request/Reason"/>

Table 20

Selected Attributes of Request Email Object

Attribute

Returns

Name

Name of machine to be approved

Description

Description of machine to be approved

User

Requesting user

RequestDate

Request date and time

VMware Documentation

234

Release 5.2


Request also takes the special attribute Properties to let you search the custom properties associated with the requested machine for a specific property and return the value if found, as described above for VirtualMachineEx above.

RequestWithAudit

Returns information about the reclamation request triggering the automatic email. For example, to include daily machine cost you would use the following:

```xml
<xsl:value-of select="//RequestWithAudit/Cost"/>
```

Table 21  Selected Attributes of RequestWithAudit Email Object

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of virtual machine for which request was made</td>
</tr>
<tr>
<td>User</td>
<td>Enterprise administrator initiating request</td>
</tr>
<tr>
<td>RequestDate</td>
<td>Request date and time</td>
</tr>
<tr>
<td>Reason</td>
<td>Reason for request provided by initiator</td>
</tr>
<tr>
<td>Cost</td>
<td>Daily cost of machine</td>
</tr>
<tr>
<td>GroupName</td>
<td>Name of provisioning group in which machine was provisioned</td>
</tr>
<tr>
<td>HostName</td>
<td>Name of host on which machine was provisioned</td>
</tr>
<tr>
<td>Approver</td>
<td>Owner of machine who must respond to request</td>
</tr>
<tr>
<td>VirtualMachineState/Name</td>
<td>Status of machine</td>
</tr>
</tbody>
</table>

Adding Data Center Locations

The Display location on request check box on the Blueprint Information tab can be used to give a requesting user the option of selecting a particular datacenter location at which to provision the virtual or cloud machine she is requesting. To enable this feature for virtual machines, you must

- add your data center locations to the vCAC location file
- associate virtualization compute resources with these locations

To add locations to the location file and make them available for association and selection, use this procedure:

1. Log into the system hosting the vCAC web components using credentials with administrator access.
2. Edit the file `WebSite\XmlData\DataCenterLocations.xml` in the vCAC install directory (typically `%SystemDrive%\Program Files x86\VMware\vCAC\Server`).
3. For each location, create a Data Name entry in the CustomDataType section, as shown:

   ```xml
   <CustomDataType>
   ```
4. Save the file, then select Start > Administrative Tools > Services and restart the vCloud Automation Center service.

**Note:** If vCAC is installed in web farm configuration, you must update the DataCenterLocations.xml file on every compute resource in the web cluster. Update the file on each web compute resource using the procedure above and then copy the file to all other compute resources where Reports, websites and portal websites were installed. See the vCloud Automation Center Installation Guide for information about vCAC in web farm configuration.

Once a compute resource is associated with a location, that association remains even if the location is removed from the location file. That is, if you add London to the file, associate 10 compute resources with that location, and then remove London from the file, the compute resources are still associated with the location London and London is still included in the location drop-down list on the Confirm Machine Request page. Only editing the compute resource and resetting its Location removes the association from an individual compute resource; only disassociating a location from all compute resources removes it from the location drop-down list on the Confirm Machine Request page.

**Using Custom Properties**

vCAC custom properties allow you to add attributes of the machines your vCAC site provisions, or to override their standard attributes, for a variety of purposes.

**Specifying Custom Properties**

Any blueprint created within vCAC can optionally include custom properties, and can optionally incorporate a build profile containing custom properties. The properties specified in an incorporated profile are retrieved whenever a machine is created from the blueprint. The latest changes to the profile are therefore always used to build machines from the blueprint.

Any property specified in a blueprint overrides the same property specified in the incorporated build profile; this enables a blueprint to use most of the properties in a profile while differing from the profile in some limited number. For example, a blueprint that incorporates a standard developer workstation profile might override the US English settings in the profile with UK English settings. On the other hand, if no appropriate profile is available all the needed properties can be specified in the blueprint itself. This arrangement ensures that the number and complexity of blueprints remain manageable.

Any custom property in both blueprints and profiles can be marked as **Prompt User**, which means that the user must supply a value for it when requesting a machine. This requires machine requestors to customize individual characteristics of each machine, or gives them the option of doing so when a default value is provided for the required property.

By default, the Confirm Machine Request page displays the literal name of **Prompt User** properties with a required text box and does not provide any validation other than that a value has been entered. The property dictionary feature enables you to define characteristics of properties that are used to tailor the behavior of the request user interface. For more information about the property dictionary, see “Using the Property Dictionary” on page 272.
Uses of Custom Properties

Like any system or network object, a machine is defined by a number of properties. Examples include the machine’s architecture and operating system and the size of its memory and disk. Machines also have properties that exist and are tracked only within vCAC, such as a machine’s description as entered and modified by the user.

A machine’s external properties are determined when the virtualization platform involved creates the machine or during the WinPE phase of the build process. To set these properties, vCAC must provide their values to the proxy agent (which passes them on to the virtualization platform) or the guest agent (which implements them in the WinPE phase).

Some of the properties specified by vCAC are determined by standard settings that must be specified for all machines. For instance, memory and disk size must be specified by all blueprints. Additional properties, however, can be specified on an ad hoc or custom basis in build profiles and blueprints and in reservations. These custom properties are used to add values or override existing or default values for

- the machine’s OS, for example SysPrep information
- the virtualization platform, such as the VMware disk mode of a machine created by vCenter Server
- a vCAC build setting, for instance the size of the disk
- integration with an external system, for example registering a machine with a XenDesktop DDC server.

When a property is added to a blueprint or profile, it can be marked as a required custom property, the value for which must be provided by the user (although a default can be specified). This means that any property can be customized by the requestor on a per-machine basis, regardless of its destination. This technique is especially useful, however, with settings for the machine itself and its guest OS. For example, you can use required properties to have the user specify information about multiple disks sharing the machine’s allocated storage, or users or groups to be added to a local group on the machine, or even the host name of the machine.

Values specified by vCAC’s reserved custom properties reach the above destinations through vCAC agents. However, all custom properties, including any you define for your vCAC site, are recorded by default

- in the vCAC database by the vCAC manager service
- in the files `%SystemDrive%\VRM\Build\Properties.ini` and `%SystemDrive%\VRM\Build\Properties.xml` on the machine itself by the guest agent before the machine is powered on for use

A machine’s custom properties can be examined and edited using the Edit option on the machine hover menu, but changes made to the properties there affect only the vCAC database, not the machine itself or the agents.

Caution: The enterprise administrator is allowed to edit a physical machine. Currently, the enterprise administrator can change two custom properties, `PhysicalMachine.Admin.InterfaceType` and `VirtualMachine.Admin.AgentID`. However, both properties should be read-only. Do not edit either one of these properties.
Recording your own properties on the machine makes it possible to use them programmatically when the machine starts up. For example, a ProjectCode property could be used to update a configuration management database, or a series of Install properties could be used to install software that you do not want to include in the WIM image used in the machine’s provisioning.

**Note:** Custom property names are typically case-insensitive; ProjectCode is equivalent to projectcode. (Property values, however, are typically case sensitive.) Do not enter identical properties; the one actually added to the database and the one recorded on the machine may not be the same.

### vCAC Reserved Custom Properties

This section describes the custom properties currently reserved by and in use in vCAC. The following table lists all reserved custom properties. You can use any of these properties to add a property to a machine or override its default or existing value. Properties are of one of four types.

- **internal**
  The specified value is maintained in the vCAC database only. For example, the email address of the group manager who approved a machine request is recorded in vCAC in the VirtualMachine.Admin.Approver property but has no impact on the machine itself or the virtualization platform.

- **read-only**
  The specified value is implemented on the machine and maintained in vCAC, and cannot be changed on the machine or within vCAC for the life of the machine. For example, VirtualMachine.Admin.UUID specifies the UUID of the machine, which cannot be changed.

- **external**
  The specified value is implemented on the machine and maintained in vCAC, but is not updated in vCAC when it changes on the machine. For example, if the property VirtualMachine.Admin.AddOwnerToAdmins is set to True, the owner of the machine is added to its local Administrators group. If the owner is later removed from this group, however, the property is not updated to False.

- **updated**
  The specified value is implemented on the machine and maintained in vCAC, and is updated in vCAC through data collection when it changes outside vCAC. For example, when the compute resource a machine is on is changed in the virtualization platform, the proxy agent updates vCAC with the new compute resource, and the value of the machine’s VirtualMachine.Admin.Hostname property is changed.

External and updated properties can be used for cloned machines only if marked with (cloning). Others have no effect on cloned machines because they set attributes that are determined by the template and customization specification used and cannot be changed by vCAC.

Any property can be changed in the vCAC database only using the **Edit** option on the machine menu, except the read-only properties VirtualMachine.Admin.AgentID, VirtualMachine.Admin.UUID and VirtualMachine.Admin.Name.
**Note:** When entering custom properties, always ensure that property values do not contain leading or trailing spaces, as these may cause provisioning to fail.

### Table 22 Custom Properties Reserved by vCAC

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Admin.Name</td>
<td>Name of the machine as generated by vCAC. May be useful in creating custom workflows or plugins. <em>Not modifiable by the user; value set in blueprint or build profile has no effect.</em> However, the Hostname property, below, can be used to override the vCAC-generated machine name.</td>
<td>read-only</td>
</tr>
<tr>
<td>VirtualMachine.Admin.UUID</td>
<td>UUID of the machine. Recorded once by the guest agent when the machine is created, then read-only. <em>Not modifiable by the user; value set in blueprint or build profile has no effect.</em></td>
<td>read-only</td>
</tr>
<tr>
<td>VirtualMachine.Admin.AgentID</td>
<td>UUID of the guest agent. Recorded once by the guest agent when the machine is created, then read-only. <em>Not modifiable by the user; value set in blueprint or build profile has no effect.</em></td>
<td>read-only</td>
</tr>
<tr>
<td>Amazon.ElasticLoadBalancer.Names</td>
<td>Assigns machines provisioned on a blueprint to the elastic load balancers that match the values you specify.</td>
<td></td>
</tr>
<tr>
<td>Amazon.Instance.Id</td>
<td>The Amazon instance ID of a cloud machine provisioned on an Amazon EC2 endpoint.</td>
<td>read-only</td>
</tr>
<tr>
<td>Hostname</td>
<td>Name of the machine, overriding the vCAC-generated machine name contained in the read-only property VirtualMachine.Admin.Name (above). If Hostname is not specified, the value of VirtualMachine.Admin.Name is the name of the machine. (cloning)</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Owner</td>
<td>User name of the machine’s owner.</td>
<td>internal</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Approver</td>
<td>User name of the group manager who approved the machine request.</td>
<td>internal</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Description</td>
<td>Description of the machine as entered or modified by its owner or an administrator.</td>
<td>internal</td>
</tr>
<tr>
<td>VirtualMachine.Admin.AdministratorEmail</td>
<td>Group manager email addresses/Active Directory accounts specified for the provisioning group containing the blueprint used to build the machine. Multiple entries must be separated by commas, for example <a href="mailto:JoeAdmin@VMware.com">JoeAdmin@VMware.com</a>,<a href="mailto:WeiMgr@VMware.com">WeiMgr@VMware.com</a></td>
<td>internal</td>
</tr>
<tr>
<td>VirtualMachine.Admin.ConnectionAddress</td>
<td>RDP connection address for machine in .rdp file downloaded when Connect Using RDP option is used or attached to automatic emails. Should not be used in a blueprint or build profile unless Prompt User is selected and no default value is supplied.</td>
<td>internal</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>VirtualMachine.Admin.NameCompletion</td>
<td>If VirtualMachine.Admin.Connection address does not exist, machine’s IP address is not static, and machine’s host name is not a fully qualified domain name, appended to machine’s host name to form connection address in .rdp file downloaded when <strong>Connect Using RDP</strong> option is used or attached to automatic emails. For example, can be set to domain name to form fully qualified domain name as connection address in .rdp files.</td>
<td>internal</td>
</tr>
<tr>
<td>VirtualMachine.Host.TpmEnabled</td>
<td>Limits virtual machine placement to hosts that have a Trust Protection Module (TPM) device installed and recognized by ESX and vSphere. The default value is False. A valid placement requires that all hosts in a cluster have TPMs installed. If no acceptable hosts/clusters are found, then the virtual machine cannot be provisioned until the property is removed, or trustable hardware is installed on an endpoint.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Rdp.SettingN</td>
<td>Specification for a setting to be used when opening an RDP (remote desktop protocol) link to the machine to create a Microsoft Terminal Services connection, where ( N ) is a unique number distinguishing this setting from other RDP settings.</td>
<td>internal</td>
</tr>
</tbody>
</table>
| VirtualMachine.Rdp.File                      | Name of .rdp file containing settings to be used when opening an RDP link to the machine. Can be used together with or as an alternative to VirtualMachine.Rdp.SettingN. The file must be located in  
  \( \text{vCAC\_installation\_dir\Website\Rdp} \)  
  where  
  \( \text{vCAC\_install\_dir} \)  
  \( \text{is the vCAC server install directory (typically,}   
  \%\text{SystemDrive}\%\text{Program Files x86\VMware\vCAC\Server}) \). You will need to create the Rdp directory. | internal |
<p>| VirtualMachine.Admin.Hostname                | Name of the compute resource on which the machine resides. (cloning)                                                                                                                                          | updated|
| VirtualMachine.Admin.ClusterName             | Name of the cluster containing the compute resource on which the machine resides. (cloning)                                                                                                                   | external|
| VirtualMachine.Admin.ForceHost               | If the compute resource specified by the reservation backing the blueprint is a cluster (that is, if VirtualMachine.Admin.Clustername has a value), the name of the individual compute resource within the cluster on which the machine must be provisioned. (VMware only) (cloning) | external|
| VirtualMachine.Admin.ConnectionAddress       | RDP connection address for machine in .rdp file downloaded when <strong>Connect Using RDP</strong> option is used or attached to automatic emails. Should not be used in a blueprint or build profile unless <strong>Prompt User</strong> is selected and no default value is supplied. | internal|</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Admin.ThinProvision</td>
<td>In virtual provisioning only, determines whether thin provisioning is used on Hyper-V server hosts and on ESX Server hosts using local or iSCSI storage. If <strong>True</strong>, thin provisioning is used; if <strong>False</strong>, standard provisioning is used; if not specified, virtualization platform default is used. Not used in physical provisioning.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Admin.ApplicationID</td>
<td>List of application IDs that can be assigned to a machine.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Admin.AddOwnerToAdmins</td>
<td>Boolean value indicating whether to add the machine's owner (VirtualMachine.Admin.Owner) to the local Administrators group on the machine. <strong>Note</strong>: This property is not supported for provisioning by cloning.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Admin.AllowLogin</td>
<td>Boolean value (default true) indicating whether to add the machine's owner (VirtualMachine.Admin.Owner) to the local Remote Desktop Users group.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Agent.CopyToDisk</td>
<td>Boolean value (default true) indicating whether to copy the vCAC guest agent executable to <code>%SystemDrive%\VM\Build\Bin</code> on the machine's disk.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Agent.Reboot</td>
<td>Boolean value (default true) indicating whether the vCAC guest agent (see VirtualMachine.Agent.CopyToDisk above) reboots the machine when it is executed following installation of the guest OS.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Agent.GuiRunOnce</td>
<td>Boolean value (default true) indicating whether to include execution of the vCAC guest agent (see VirtualMachine.Agent.CopyToDisk above) in the GuiRunOnce section of the SysPrep.inf file on the machine, so that the guest agent starts on first successful login, allowing post-installation processing by the agent during WIM-based provisioning. This behavior is mandatory for Windows Server 2008, Windows Vista and Windows 7; setting this property to false has no effect on virtual machines with these operating systems. Set to <strong>False</strong> for Linux kickstart/autoYaST provisioning so that the Linux agent can terminate the provisioning workflow.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.Admin.TotalDiskUsage</td>
<td>Total disk space used by the machine, including all disks as specified by all VirtualMachine.DiskN.Size properties (below) and the swap file as specified by VMware.Memory.Reservation (below).</td>
<td>updated</td>
</tr>
<tr>
<td>VirtualMachine.Memory.Size</td>
<td>Size of the machine's memory in MB. Default is the value specified by the <strong>Memory</strong> setting on the blueprint's Build Information tab.</td>
<td>updated</td>
</tr>
<tr>
<td>VirtualMachine.CPU.Count</td>
<td>Number of CPUs allocated to a machine. Default is the value specified by the <strong># CPUs</strong> setting on the blueprint's Build Information tab.</td>
<td>updated</td>
</tr>
<tr>
<td>VirtualMachine.Storage.Name</td>
<td>Storage path the machine is on. Default is the value specified in the reservation from which the machine was provisioned.</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>VirtualMachine.CDROM.Attach</td>
<td>Boolean value indicating whether a CDROM drive is attached to the machine. Default is True. Set to False when provisioning using Citrix Provisioning Server or with the basic workflow.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Size</td>
<td>Size of machine’s disk N. By default a machine has one disk referred to by VirtualMachine.Disk0.Size=size, where size is specified by the Storage setting on the Build Information tab of the blueprint from which the machine is provisioned. The value in the Storage field on the Build Information tab overwrites the value in the VirtualMachine.Disk0.Size property. More disks can be added if desired by specifying VirtualMachine.Disk1.Size, VirtualMachine.Disk2.Size and so on, and other associated properties as listed below. Note that VirtualMachine.Admin.TotalDiskUsage always represents the total of .DiskN.Size properties plus VMware.Memory.Reservation.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Active</td>
<td>Boolean indicating whether machine’s disk N is active. Default is true.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Letter</td>
<td>Letter of machine’s disk N, e.g. C:, E:, F:, etc. Default is C.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.FS</td>
<td>Filesystem of machine’s disk N. Default is NTFS, can be FAT or FAT32.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Label</td>
<td>Label of machine’s disk N. Windows limits the size of a disk label to 32 characters.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Percent</td>
<td>Percentage of specified disk to be formatted by guest agent for machine’s use. Remaining portion of disk will be unusable by machine.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.Storage</td>
<td>To specify the datastore on which to place machine disk N.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.StorageReservationPolicy</td>
<td>To specify a storage reservation policy to find storage for disk N.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.DiskN.StorageReservationPolicyMode</td>
<td>To allocate disk N on the best available storage reservation policy.</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.Name</td>
<td>Name of network to which network device N in a virtual machine is attached. By default a virtual machine has one network device referred to by VirtualMachine.Network0.Name=network_name, where the network name is specified in the reservation from which the machine is provisioned. Additional network devices can be added to machines by specifying VirtualMachine.Network1.Name and a MAC address as listed below, if desired.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.MacAddressType</td>
<td>Indicates whether the MAC address of network device N is auto-generated or user-defined. Default is generated. If static, must use VirtualMachine.NetworkN.MacAddress below to specify the MAC address. (cloning)</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.MacAddress</td>
<td>MAC address of network device N. If VirtualMachine.Network.N.MacAddressType, above, is set to static, specify the MAC address. (For virtual machines provisioned on ESX Server hosts, address must be within the range specified by VMware; see <a href="http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&amp;cmd=displayKC&amp;externalId=219">http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&amp;cmd=displayKC&amp;externalId=219</a> or a more recent source.) If VirtualMachine.Network.N.MacAddressType is set to generated, this property contains the generated address. (cloning)</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.PortID</td>
<td>When using a dvPort group with a vSphere distributed switch, this property is used to specify the Port ID to use for the provisioned virtual machine. In this example, the property, VirtualMachine.NetworkN.PortID uses N = 0,1,2,... to represent the numerical index of the network card. Replace N with the required number.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.ProfileName</td>
<td>Name of the network profile from which to obtain the range(s) of static IP addresses that can be assigned to network device N of a cloned machine, where N=0 for the first device, 1 for the second, and so on (provisioning by cloning and kickstart/autoYaST provisioning only)</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.Address</td>
<td>IP address of network device N in a machine cloned using static IP addresses.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.SubnetMask</td>
<td>Attributes of the network profile specified in VirtualMachine.NetworkN.ProfileName to enable static IP assignment in a provisioning by cloning blueprint.</td>
<td>external</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.Gateway</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.PrimaryDns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.SecondaryDns</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.PrimaryWins</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.SecondaryWins</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.DnsSuffix</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.DnsSearchSuffix</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VirtualMachine.VDI.Type</td>
<td>Type of Virtual Desktop Infrastructure; set to XenDesktop to register machine with XenDesktop.</td>
<td>internal</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Type of external provisioning infrastructure to provision machine from; set to <strong>CitrixProvisioning</strong> to provision from Citrix Provisioning Server or <strong>BMC</strong> to provision from BMC BladeLogic Configuration Manager.</td>
<td>internal</td>
</tr>
<tr>
<td>AD.Lookup.Department</td>
<td>Specifies the value that is used for the Cost Center in emails that are sent to approvers to notify them of pending approvals.</td>
<td>internal</td>
</tr>
<tr>
<td>BMC.Software.Install</td>
<td>Set to <strong>True</strong> to enable BladeLogic Configuration Manager integration.</td>
<td>internal</td>
</tr>
<tr>
<td>BMC.Software.BatchLocation</td>
<td>Location within BladeLogic Configuration Manager of software jobs to be deployed; must match the appropriate field in <strong>Website\Software.txt</strong>.</td>
<td>internal</td>
</tr>
<tr>
<td>BMC.Service.Profile</td>
<td>Name of the default authentication profile on the BladeLogic server.</td>
<td>internal</td>
</tr>
<tr>
<td>BMC.AddServer.Delay</td>
<td>Optionally, number of seconds to delay before adding the machine to BladeLogic; default is <strong>30</strong>.</td>
<td>internal</td>
</tr>
<tr>
<td>BMC.AddServer.Retry</td>
<td>Optionally, number of seconds to wait before retrying if the first attempt to add the machine to BladeLogic CM is unsuccessful; default is <strong>100</strong>.</td>
<td>internal</td>
</tr>
<tr>
<td>Cisco.Organization.DN</td>
<td>Provisioning groups only. The distinguished name of the Cisco UCS Manager organization in which Cisco UCS machines provisioned by the provisioning group are placed, for example <strong>org-root\org-Engineering</strong>. If the specified organization does not exist in the Cisco UCS Manager instance managing the machine, provisioning fails.</td>
<td>external</td>
</tr>
<tr>
<td>CloneFrom</td>
<td>Name of an existing machine or virtualization platform object to clone from, for example a template in vCenter Server. Default is the value specified by the <strong>Clone from</strong> setting on the blueprint’s Build Information tab. (VMware only.) (cloning)</td>
<td>internal</td>
</tr>
<tr>
<td>CloneSpec</td>
<td>Specification to be used for a cloned machine, for example a predefined SysPrep object in vCenter Server. Default is the value specified by the <strong>Customization spec</strong> setting on the blueprint’s Build Information tab. (VMware only) (cloning)</td>
<td>internal</td>
</tr>
<tr>
<td>Command.DiskPart.Options</td>
<td>When using WIM-based virtual provisioning on ESX Server hosts, set to <strong>Align=64</strong> to use VMware’s recommended alignment parameters when formatting and partitioning the machine’s disk. See <a href="http://www.vmware.com/pdf/esx3_partition_align.pdf">http://www.vmware.com/pdf/esx3_partition_align.pdf</a>. Not used in physical provisioning.</td>
<td>internal</td>
</tr>
<tr>
<td>Command.FormatDisk.Options</td>
<td>When using WIM-based virtual provisioning on ESX Server hosts, set to <strong>/A:32K</strong> to use VMware’s recommended alignment parameters when formatting and partitioning the machine’s disk. See the reference above. Not used in physical provisioning.</td>
<td>internal</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>EPI.Server.Name</td>
<td>Name of the external provisioning infrastructure server. If at least one general EPI agent of the appropriate type (see VirtualMachine.EPI.Type above) was installed without specifying a server, this value directs the request to the desired server. If only dedicated EPI agents for specific servers of the appropriate type were installed, this value must match exactly the server name configured for one of these agents. As described in the <em>vCloud Automation Center Installation Guide</em>, each Citrix Provisioning Server instance to be used in provisioning requires a dedicated EPI agent. When used in a blueprint for Citrix Provisioning Server integration, therefore, the value of this property must match the server name provided when an EPI agent of type <strong>CitrixProvisioning</strong> was installed.</td>
<td>internal</td>
</tr>
<tr>
<td>EPI.Server.Port</td>
<td>Port on which to contact Citrix Provisioning Server; omit to use default of 54321. (Citrix Provisioning Server only.)</td>
<td>internal</td>
</tr>
<tr>
<td>EPI.Server.VDiskName</td>
<td>Name of Citrix Provisioning vDisk to provision from. (Citrix Provisioning Server only.)</td>
<td>internal</td>
</tr>
<tr>
<td>EPI.Server.Store</td>
<td>Name of Citrix Provisioning store containing the vDisk specified in EPI.Server.VDiskName. (Citrix Provisioning Server only.)</td>
<td>internal</td>
</tr>
<tr>
<td>EPI.Server.Collection</td>
<td>Name of Citrix Provisioning collection to register machine under. (Citrix Provisioning Server only.)</td>
<td>internal</td>
</tr>
<tr>
<td>EPI.Server.Site</td>
<td>Name of Citrix Provisioning site containing collection and store specified by EPI.Server.Collection and EPI.Server.Store. (Citrix Provisioning Server only.)</td>
<td>internal</td>
</tr>
<tr>
<td>Hyperv.Network.Type</td>
<td>Network adapter type of the virtual machine (Hyper-V only). Possible values include:</td>
<td>external</td>
</tr>
<tr>
<td></td>
<td>· Synthetic (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· Legacy (not compatible with Windows XP or Windows Server 2003 64-bit guest operating systems)</td>
<td></td>
</tr>
<tr>
<td>Infrastructure.ResourcePool.Name</td>
<td>Resource pool to which the machine belongs, if any. Default is the value specified in the reservation from which the machine was provisioned. (cloning)</td>
<td>external</td>
</tr>
<tr>
<td>Infrastructure/Admin.DefaultDomain</td>
<td>Default domain on the machine.</td>
<td>external</td>
</tr>
<tr>
<td>Infrastructure/Admin.ADUser</td>
<td>User name used by the machine to query Active Directory users and groups when an anonymous bind cannot be used.</td>
<td>external</td>
</tr>
<tr>
<td>Infrastructure/Admin.ADPassword</td>
<td>Password for Infrastructure/Admin.ADUser</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the ISO image to boot from--WinPE ISO image (WIM-based provisioning), Linux boot image (kickstart/autoYaST provisioning), or boot image corresponding to the SCCM operating system deployment task sequence (SCCM-based provisioning). In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed. This property is required for WIM-based provisioning, Linux kickstart/autoYaST provisioning, and SCCM-based provisioning.</td>
<td>external</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the ISO image to boot from--WinPE ISO image (WIM-based provisioning), Linux boot image (kickstart/autoYaST provisioning), or boot image corresponding to the SCCM operating system deployment task sequence (SCCM-based provisioning). In virtual provisioning on vCenter Server, the path to the boot image, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOs/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash. In virtual provisioning on XenServer, the name of the boot image within the storage repository specified by Image.ISO.Location. In virtual provisioning on Hyper-V, the full local path to the boot image, including filename. In physical provisioning, the filename of the boot image. This property is required for WIM-based provisioning, Linux kickstart/autoYaST provisioning, and SCCM-based provisioning.</td>
<td>external</td>
</tr>
<tr>
<td>Image.ISO.UserName</td>
<td>Specify a user name to access the boot ISO in the following form: username@domain.</td>
<td></td>
</tr>
<tr>
<td>Image.ISO.Password</td>
<td>Specify the password for the user specified in Image.ISO.UserName.</td>
<td></td>
</tr>
<tr>
<td>Image.WIM.Path</td>
<td>UNC path to the WIM file from which an image is extracted during WIM-based provisioning, for example \server\share$.</td>
<td>external</td>
</tr>
<tr>
<td>Image.WIM.Name</td>
<td>Name of the WIM file located in Image.WIM.Path.</td>
<td>external</td>
</tr>
<tr>
<td>Image.WIM.Index</td>
<td>Index to be used to extract the desired image from the WIM file.</td>
<td>external</td>
</tr>
<tr>
<td>Image.Network.User</td>
<td>User name under which to map the WIM image path (Image.WIM.Path) to a network drive on the machine.</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Image.Network.Letter</td>
<td>Drive letter to which WIM image path is mapped on the machine (default is K).</td>
<td>external</td>
</tr>
<tr>
<td>Linux.ExternalScript.Name</td>
<td>The name of an optional customization script to be executed by the Linux agent after the operating system is installed on Linux machines cloned from templates on which the legacy Linux agent is installed.</td>
<td>internal</td>
</tr>
<tr>
<td>Linux.ExternalScript.LocationType</td>
<td>The location of the script named in Linux.ExternalScript.Name, either local or nfs.</td>
<td>internal</td>
</tr>
<tr>
<td>Linux.ExternalScript.Server</td>
<td>The name of the NFS server on which the script is located; use only if Linux.ExternalScript.LocationType is NFS.</td>
<td>internal</td>
</tr>
<tr>
<td>Linux.ExternalScript.Path</td>
<td>The local path to the script or the export path on the NFS server, not including the file name. The value must use forward slashes and begin with a forward slash.</td>
<td>internal</td>
</tr>
<tr>
<td>LoadSoftware</td>
<td>Set to True to make software jobs listed in Website\Software\Software.txt available for selection by the user requesting the machine when BladeLogic or HP Software Automation integration is in use.</td>
<td>internal</td>
</tr>
<tr>
<td>MaximumProvisionedMachines</td>
<td>Used to set the number of machines that can be provisioned across all users based on a given blueprint. Most blueprint types are unlimited by default. Linked clone blueprints have a default maximum of 20 machines.</td>
<td></td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Execute</td>
<td>Set to True to use the AD cleanup plugin with this blueprint. By default, each machine's account is disabled when it is destroyed.</td>
<td>external</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.UserName</td>
<td>User name of AD account with sufficient rights to delete, disable, rename or move AD accounts. Use the DOMAIN\Username format. This is required if the vCAC manager service does not have these rights in a domain, which may be the case if vCAC is provisioning machines in more than one domain.</td>
<td>external</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Password</td>
<td>Password for the account specified by Plugin.AdMachineCleanup.UserName. (Be sure to use the Encrypt check box for security.)</td>
<td>external</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Delete</td>
<td>Set to True to delete each machine's account when the machine is destroyed, instead of disabling it.</td>
<td>external</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.MoveToOu</td>
<td>Specify the OU to which each machine's account is to be moved when it is destroyed, in the format ou=OU, dc=dc ... .</td>
<td>external</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.RenamePrefix</td>
<td>Specify the prefix to be attached to the name of each machine's account when the machine is destroyed, thereby renaming it, for example destroyed_.</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Pxe.Setup.ScriptName</td>
<td>Name of a PowerShell script installed in the vCAC model manager, to be run on a physical machine being provisioned using PXE-based provisioning before it is booted from the PXE network boot program.</td>
<td>internal</td>
</tr>
<tr>
<td>Pxe.Clean.ScriptName</td>
<td>Name of a PowerShell script installed in the vCAC model manager, to be run on a physical machine after it is provisioned using PXE-based provisioning.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.Collection.Name</td>
<td>The name of the SCCM collection containing the operating system deployment task sequence.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.Server.Name</td>
<td>The fully qualified domain name of the SCCM server on which the collection resides.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.Server.SiteCode</td>
<td>The site code of the SCCM server.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.Server.UserName</td>
<td>A user name with administrator-level access to the SCCM server.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.Server.Password</td>
<td>The password for SCCM.Server.UserName.</td>
<td>internal</td>
</tr>
<tr>
<td>SCCM.CustomVariable.Name</td>
<td>The value of a custom variable named SCCM.CustomVariable.Name to be made available to the SCCM task sequence when the newly created virtual machine or selected physical machine is registered with the SCCM collection.</td>
<td>internal</td>
</tr>
<tr>
<td>Snapshot.Policy.Limit</td>
<td>Sets the limit of Snapshots (depth) that can be created for machines.</td>
<td>internal</td>
</tr>
<tr>
<td>Snapshot.Policy.AgeLimit</td>
<td>Sets the age limit (in days) for Snapshots that can be applied to machines.</td>
<td>internal</td>
</tr>
<tr>
<td>SysPrep.Section.Key</td>
<td>Optionally used to specify information to be added to the SysPrep answer file on the machine during WinPE stage of provisioning. Section represents the name of a section in the file; Key represents a key name within the section. Information that already exists in the answer file is overwritten. Only the Section.Key combinations below can be specified:GUIUnattended AdminPassword EncryptedAdminPassword TimeZone UserData ProductKey FullName ComputerName OrgName Identification DomainAdmin DomainAdminPassword JoinDomain JoinWorkgroup</td>
<td>internal</td>
</tr>
</tbody>
</table>
AddUser

Adds a user to a specific group on the provisioned machine.

XXX is the name of a Windows local group on the machine being provisioned, with spaces delimited by periods.

The value is the name of a domain or local user to add to the group.

For example, `Users.Power.Users.AddUser = DOMAIN\joe.admin` adds the user `DOMAIN\joe.admin` to the Power Users group on the machine after provisioning.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users.XXX.AddUser</td>
<td>Adds a user to a specific group on the provisioned machine.</td>
<td></td>
</tr>
<tr>
<td>VbScript.PreProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run before a machine is provisioned, including the filename and extension, for example <code>%SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendEmail.vbs</code>.</td>
<td>external</td>
</tr>
<tr>
<td>VbScript.PostProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run after a machine is provisioned, including the filename and extension, for example <code>%SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendEmail.vbs</code>.</td>
<td>external</td>
</tr>
<tr>
<td>VbScript.UnProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run when a machine is to be destroyed, including the filename and extension, for example <code>%SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendEmail.vbs</code>.</td>
<td>external</td>
</tr>
</tbody>
</table>
The vCNS security group or groups to which the virtual machine is assigned during provisioning. The value is a security group name or a list of names separated by commas. Names are case-sensitive so that "Sg1" and "SG1" are interpreted as different values. The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles. Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list security groups intended for general use, for the Sales force, and for Support:

- VCNS.SecurityGroup.Names

You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCNS.SecurityGroup.Names.[name]</td>
<td>The vCNS security group or groups to which the virtual machine is assigned during provisioning. The value is a security group name or a list of names separated by commas. Names are case-sensitive so that &quot;Sg1&quot; and &quot;SG1&quot; are interpreted as different values. The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles. Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list security groups intended for general use, for the Sales force, and for Support:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VCNS.SecurityGroup.Names</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VCNS.SecurityGroup.Names.Sales</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together.</td>
<td>external</td>
</tr>
</tbody>
</table>
## Property: VCNS.LoadBalancerEdgePool.Names.[name]

The vCNS load balancing pools to which the virtual machine is assigned during provisioning. Note that the virtual machine is assigned to all service ports of all specified pools.

The value is an edge/pool name or a list of edge/pool names separated by commas. Names are case-sensitive which means that “edge1/pool1” and “Edge1/pool1” are interpreted as different values.

The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles.

Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list load balancing pools set up for general use and machines with high, moderate, and low performance requirements:

- VCNS.LoadBalancerEdgePool.Names
- VCNS.LoadBalancerEdgePool.Names.Moderate
- VCNS.LoadBalancerEdgePool.Names.High
- VCNS.LoadBalancerEdgePool.Names.Low

You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together.

## Property: VDI.Server.Website

Server name of Citrix web interface site to use in connecting to the machine. If the value of VDI.Server.Name below is a XenDesktop farm, this property must have an appropriate value or the machine owner will not be able to connect to the machine using XenDesktop from within vCAC. If this property is not specified, VDI.Server.Name determines the DDC to connect to, and therefore must be the name of a server hosting a DDC.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCNS.LoadBalancerEdgePool.Names.[name]</td>
<td>The vCNS load balancing pools to which the virtual machine is assigned during provisioning. Note that the virtual machine is assigned to all service ports of all specified pools. The value is an edge/pool name or a list of edge/pool names separated by commas. Names are case-sensitive which means that “edge1/pool1” and “Edge1/pool1” are interpreted as different values. The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles. Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list load balancing pools set up for general use and machines with high, moderate, and low performance requirements: VCNS.LoadBalancerEdgePool.Names VCNS.LoadBalancerEdgePool.Names.Moderate VCNS.LoadBalancerEdgePool.Names.High VCNS.LoadBalancerEdgePool.Names.Low You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together.</td>
<td>external</td>
</tr>
<tr>
<td>VDI.Server.Website</td>
<td>Server name of Citrix web interface site to use in connecting to the machine. If the value of VDI.Server.Name below is a XenDesktop farm, this property must have an appropriate value or the machine owner will not be able to connect to the machine using XenDesktop from within vCAC. If this property is not specified, VDI.Server.Name determines the DDC to connect to, and therefore must be the name of a server hosting a DDC.</td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>VDI.Server.Name</td>
<td>Name of server hosting the DDC to register with and connect to or name of a XenDesktop farm containing DDCs to register with. If the value is a farm name, VDI.Server.Website must be the URL of an appropriate Citrix web interface site to use in connecting to the machine. If the value is a server name: • If at least one general XenDesktop VDI agent was installed without specifying a DDC server, this value directs the request to the desired server. • If only dedicated XenDesktop VDI agents for specific DDC servers were installed, this value <em>must match exactly</em> the server name configured for a dedicated agent.</td>
<td>external</td>
</tr>
<tr>
<td>VDI.Server.Group</td>
<td>For XenDesktop 5, name of XenDesktop group to add machines to and name of the catalog to which the group belongs, in the format group_name;catalog_name. For XenDesktop 4, name of XenDesktop group to add machines to. <strong>Note:</strong> vCAC does not support the use of XenDesktop groups of types other than Pre-Assigned in XenDesktop 4.</td>
<td>external</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Interval</td>
<td>Optional interval value in TimeSpan format for VDI Machine Active Directory registration check, default 00:00:15 (15 sec).</td>
<td>external</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Timeout</td>
<td>Optional timeout value in TimeSpan format for VDI Machine Active Directory registration check, default 00:30:00 (30 min.).</td>
<td>external</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Delay</td>
<td>Optional value in TimeSpan format determining delay between successfully adding machine to Active Directory and initiation of XenDesktop registration, default 00:00:05 (5 sec.).</td>
<td>external</td>
</tr>
<tr>
<td>VMware.Network.Type</td>
<td>Network adapter type of the virtual machine (VMware only). Possible values include: • <strong>Flexible</strong> (default if no valid value provided) • <strong>VirtualPcNet32</strong> (not compatible with vSphere) • <strong>E1000</strong> (or <strong>VirtualE1000</strong>) • <strong>VMXNET</strong> (or <strong>VirtualVMXNET</strong>) • <strong>VMXNET2</strong> • <strong>VMXNET3</strong></td>
<td>external</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Type</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>VMware.SCSI.Type</td>
<td>SCSI type of the machine (VMware only). Use one of the following case-sensitive values:</td>
<td>external</td>
</tr>
<tr>
<td></td>
<td>• busLogic -- Use BusLogic emulation for the virtual disk.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IsiLogic -- Use LSI Logic emulation for the virtual disk.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IsiLogicSas -- Use LSI Logic SAS 1068 emulation for the virtual disk.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• pvscsi -- Use para-virtualization emulation for the virtual disk.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• none -- SCSI controller does not exist for this machine.</td>
<td></td>
</tr>
<tr>
<td>VMware.Memory.Reservation</td>
<td>Size of machine’s swap file (for use when heavily constrained). (VMware only)</td>
<td>external</td>
</tr>
<tr>
<td>VMware.VirtualCenter.Folder</td>
<td>Name of the inventory folder within the vCenter Server datacenter in which the machine is created; default is VRM. Can be a path with multiple folders, for example production\email servers. The proxy agent creates the folder in vCenter Server if it does not exist. (vSphere, VMware only) (cloning)</td>
<td>external</td>
</tr>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>For virtual provisioning only, the vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. This OS version must match the OS version to be installed on the provisioned machine. See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) (cloning) When this property has a non-Windows value, the Connect Using RDP option is disabled. The property can be used for this purpose in any virtual, cloud, or physical blueprint.</td>
<td>external</td>
</tr>
</tbody>
</table>
For cloud and virtual provisioning only. Specifies whether provisioning must use a compute resource associated with a particular location, or if any location is suitable. To enable this feature, you must

- Add data center locations to the vCAC location file.
- Associate compute resources with locations. Each compute resource can be associated with one location, which can be changed whenever the compute resource is edited.

Set to **Exact** to provision a requested machine on a compute resource associated with the location specified on the blueprint. If a compute resource with sufficient capacity and associated with that location is not available, then provisioning will fail.

Set to **NonExact** to provision a requested machine on a compute resource with sufficient capacity and associated with the location specified on the blueprint, or if such a compute resource is not available, then on the next available compute resource with sufficient capacity without regard to location. This option is the default.

Optionally specify a software job to be applied to all machines provisioned from the blueprint when BladeLogic or HP Software Automation is in use.

If a BladeLogic software job, set the value to `job_type=job_path`, where `job_type` is the numerical representing the BladeLogic job type:

- 1 — AuditJob
- 2 — BatchJob
- 3 — ComplianceJob
- 4 — DeployJob
- 5 — FileDeployJob
- 6 — NSHScriptJob
- 7 — PatchAnalysisJob
- 8 — SnapshotJob

and `job_path` is the job’s location within BladeLogic, for example `4=/Utility/putty`.

If an HP Software Automation job, set the value to the name of the policy in the HP SA instance that will be installing the software.

NNNN is a number from 1000 to 1999.

Set to **False** when provisioning Windows 7 virtual machines on a XenServer host or Xen pool; default is **True**. Not used in physical provisioning.
Custom Properties for Specific Purposes

The following tables show custom properties used for specific purposes, as described in the sections that follow the tables. (These properties are also included in the preceding table but are grouped here by purpose.)

Table 23  Custom Properties for Provisioning by Cloning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. This OS version must match the OS version to be installed on the provisioned machine. See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the Connect Using RDP option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Thin Provision</td>
<td>Determines whether thin provisioning is used on Hyper-V server hosts and on ESX Server hosts using local or iSCSI storage. If <strong>True</strong>, thin provisioning is used; if <strong>False</strong>, standard provisioning is used; if not specified, virtualization platform default is used.</td>
</tr>
<tr>
<td>VirtualMachine.NetworkN.ProfileName</td>
<td>The name of the network profile from which to obtain the range(s) of static IP addresses that can be assigned to network device $N$ of a cloned machine, where $N=0$ for the first device, 1 for the second, and so on (provisioning by cloning and kickstart/autoYaST provisioning only)</td>
</tr>
<tr>
<td>Linux.ExternalScript.Name</td>
<td>The name of an optional customization script to be executed by the Linux agent after the operating system is installed on Linux machines cloned from templates on which the legacy Linux agent is installed.</td>
</tr>
<tr>
<td>Linux.ExternalScript.LocationType</td>
<td>The location of the script named in Linux.ExternalScript.Name, either <strong>local</strong> or <strong>nfs</strong>.</td>
</tr>
<tr>
<td>Linux.ExternalScript.Server</td>
<td>The name of the NFS server on which the script is located; use only if Linux.ExternalScript.LocationType is <strong>NFS</strong>.</td>
</tr>
<tr>
<td>Linux.ExternalScript.Path</td>
<td>The local path to the script or the export path on the NFS server, not including the file name. The value must use forward slashes and begin with a forward slash.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| VCNS.SecuirtyGroup.Names.[name] | The vCNS security group or groups to which the virtual machine is assigned during provisioning.  
The value is a security group name or a list of names separated by commas. Names are case-sensitive so that “Sg1” and “SG1” are interpreted as different values.  
The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles.  
Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list security groups intended for general use, for the Sales force, and for Support:  
VCNS.SecurityGroup.Names  
VCNS.SecurityGroup.Names.Sales  
You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together. |
| VCNS.LoadBalancerEdgePool.Names.[name] | The vCNS load balancing pools to which the virtual machine is assigned during provisioning. Note that the virtual machine is assigned to all service ports of all specified pools.  
The value is an edge/pool name or a list of edge/pool names separated by commas. Names are case-sensitive which means that “edge1/pool1” and “Edge1/pool1” are interpreted as different values.  
The property can be used anywhere custom properties are used such as reservations, blueprints, and build profiles.  
Appending an optional name to the end of the property name allows you to create multiple versions of a custom property. For example, the following properties could list load balancing pools set up for general use and machines with high, moderate, and low performance requirements:  
VCNS.LoadBalancerEdgePool.Names  
VCNS.LoadBalancerEdgePool.Names.Moderate  
VCNS.LoadBalancerEdgePool.Names.High  
VCNS.LoadBalancerEdgePool.Names.Low  
You could use these properties separately or together, in any combination, because vCAC recognizes them as being the same custom property and combines their values if submitted together. |
Table 25  Custom Properties for WIM-Based Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. This OS version must match the OS version to be installed on the provisioned machine. See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the WinPE ISO image to boot from. In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed. This property is required for WIM-based provisioning.</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the WinPE ISO image to boot from. In virtual provisioning on vCenter Server, the path to the image, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOs/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash. In virtual provisioning on XenServer, the name of the image within the storage repository specified by Image.ISO.Location. In virtual provisioning on Hyper-V, the full local path to the image, including filename. In physical provisioning, the filename of the image. This property is required for WIM-based provisioning.</td>
</tr>
<tr>
<td>Image.WIM.Path</td>
<td>The UNC path to the WIM file.</td>
</tr>
<tr>
<td>Image.WIM.Name</td>
<td>The name of the WIM file.</td>
</tr>
<tr>
<td>Image.WIM.Index</td>
<td>The index to be used to extract the desired image from the WIM file.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image.Network.User</td>
<td>The user name under which to map the WIM image path (Image.WIM.Path) to a network drive on the machine, typically a domain account with access to the network share.</td>
</tr>
<tr>
<td>Image.Network.Letter</td>
<td>The drive letter to which WIM image path is mapped on the machine (default is K).</td>
</tr>
<tr>
<td>VirtualMachine/Admin.ThinProvision</td>
<td>In virtual provisioning only, determines whether thin provisioning is used on Hyper-V server hosts and on ESX Server hosts using local or iSCSI storage. If True, thin provisioning is used; if False, standard provisioning is used; if not specified, virtualization platform default is used. Not used in physical provisioning.</td>
</tr>
<tr>
<td>Sysprep/Section.Key</td>
<td>Optionally used to specify information to be added to the Sysprep answer file on the machine during WinPE stage of provisioning. Section represents the name of a section in the file; Key represents a key name within the section. Information that already exists in the answer file is overwritten. Only the Section.Key combinations below can be specified:</td>
</tr>
<tr>
<td>GuiUnattended</td>
<td>AdminPassword</td>
</tr>
<tr>
<td></td>
<td>EncryptedAdminPassword</td>
</tr>
<tr>
<td></td>
<td>TimeZone</td>
</tr>
<tr>
<td>UserData</td>
<td>ProductKey</td>
</tr>
<tr>
<td></td>
<td>FullName</td>
</tr>
<tr>
<td></td>
<td>ComputerName</td>
</tr>
<tr>
<td></td>
<td>OrgName</td>
</tr>
<tr>
<td>Identification</td>
<td>DomainAdmin</td>
</tr>
<tr>
<td></td>
<td>DomainAdminPassword</td>
</tr>
<tr>
<td></td>
<td>JoinDomain</td>
</tr>
<tr>
<td></td>
<td>JoinWorkgroup</td>
</tr>
</tbody>
</table>
## Custom Properties for Linux Kickstart/AutoYaST Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. This OS version must match the OS version to be installed on the provisioned machine. See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.Admin.ThinProvision</td>
<td>In virtual provisioning only, determines whether thin provisioning is used on Hyper-V server hosts and on ESX Server hosts using local or iSCSI storage. If <strong>True</strong>, thin provisioning is used; if <strong>False</strong>, standard provisioning is used; if not specified, virtualization platform default is used. Not used in physical provisioning.</td>
</tr>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the Linux boot image to boot from. In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed. This property is required for kickstart/autoYaST provisioning.</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the Linux boot image to boot from. In virtual provisioning on vCenter Server, the path to the image, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOS/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash. In virtual provisioning on XenServer, the name of the image within the storage repository specified by Image.ISO.Location. In virtual provisioning on Hyper-V, the full local path to the image, including filename. In physical provisioning, the filename of the image. This property is required for kickstart/autoYaST provisioning.</td>
</tr>
<tr>
<td>VirtualMachine.AgentGuiRunOnce</td>
<td>Set to <strong>False</strong> so that the Linux agent can terminate the provisioning workflow.</td>
</tr>
</tbody>
</table>
### Table 27  Custom Properties for SCCM-Based Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image.ISO.Location</td>
<td>The location of the SCCM boot image to boot from. In virtual provisioning, the value depends on the virtualization platform. For vCenter Server this is the name of a datastore within the instance that will be accessible to the provisioning compute resource, for XenServer the name of a storage repository. In physical provisioning, the HTTP URL of the web-accessible location (HP iLO) or NFS or CIFS location (Dell iDRAC) in which the image has been placed. This property is required for SCCM-based provisioning.</td>
</tr>
<tr>
<td>Image.ISO.Name</td>
<td>The name of the SCCM boot image to boot from. In virtual provisioning on vCenter Server, the path to the image, including the name, within the datastore specified by Image.ISO.Location, for example /MyISOs/Microsoft/MSDN/win2003.iso. The value must use forward slashes and begin with a forward slash. In virtual provisioning on XenServer, the name of the image within the storage repository specified by Image.ISO.Location. In virtual provisioning on Hyper-V, the full local path to the image, including filename. In physical provisioning, the filename of the image. This property is required for SCCM-based provisioning.</td>
</tr>
<tr>
<td>SCCM.Collection.Name</td>
<td>The name of the SCCM collection containing the operating system deployment task sequence</td>
</tr>
<tr>
<td>SCCM.Server.Name</td>
<td>The fully qualified domain name of the SCCM server on which the collection resides</td>
</tr>
<tr>
<td>SCCM.Server.SiteCode</td>
<td>The site code of the SCCM server</td>
</tr>
<tr>
<td>SCCM.Server.UserName</td>
<td>A user name with administrator-level access to the SCCM server</td>
</tr>
<tr>
<td>SCCM.Server.Password</td>
<td>The password for SCCM.Server.UserName</td>
</tr>
<tr>
<td>SCCM.CustomVariable.Name</td>
<td>The value of a custom variable named SCCM.CustomVariable.Name to be made available to the SCCM task sequence when the newly created virtual machine or selected physical machine is registered with the SCCM collection.</td>
</tr>
<tr>
<td>VMware.Network.Type</td>
<td>Set to E1000 when provisioning Windows 7 32-bit virtual machines on ESX Server hosts to ensure that machines are created with the correct network adapter. Not used in physical provisioning.</td>
</tr>
</tbody>
</table>
### Table 28 Custom Properties for PXE-Based Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties appropriate to the provisioning method initiated by the PXE network boot program (WIM-based, kickstart/autoYaST, SCCM-based), not including Image.ISO.Name and Image.ISO.Location, which should not be used</td>
<td>see previous tables</td>
</tr>
<tr>
<td>Pxe.Setup.ScriptName</td>
<td>The name of a PowerShell script installed in the vCAC model manager, to be run on the selected physical machine before it is booted using the PXE network boot program.</td>
</tr>
<tr>
<td>Pxe.Clean.ScriptName</td>
<td>The name of a PowerShell script installed in the vCAC model manager, to be run on the selected physical machine after it is provisioned.</td>
</tr>
</tbody>
</table>

### Table 29 Custom Properties for Virtual Desktop (XenDesktop) Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.VDI.Type</td>
<td>Type of Virtual Desktop Infrastructure; set to XenDesktop.</td>
</tr>
<tr>
<td>VDI.Server.Website</td>
<td>Server name of Citrix web interface site to use in connecting to the machine. If the value of VDI.Server.Name below is a XenDesktop farm, this property must have an appropriate value or the machine owner will not be able to connect to the machine using XenDesktop from within vCAC. If this property is not specified, VDI.Server.Name determines the DDC to connect to, and therefore must be the name of a server hosting a DDC.</td>
</tr>
</tbody>
</table>
| VDI.Server.Name           | Name of server hosting the DDC to register with and connect to or name of a XenDesktop farm containing DDCs to register with.  
                           | If the value is a farm name, VDI.Server.Website must be the URL of an appropriate Citrix web interface site to use in connecting to the machine.  
                           | If the value is a server name:  
                           | If at least one general XenDesktop VDI agent was installed without specifying a DDC server, this value directs the request to the desired server.  
                           | If only dedicated XenDesktop VDI agents for specific DDC servers were installed, this value must match exactly the server name configured for a dedicated agent. |
Table 30  Custom Properties for Citrix Provisioning Server Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDI.Server.Group</td>
<td>For XenDesktop 5, name of XenDesktop group to add machines to and name of the catalog to which the group belongs, in the format <code>group_name;catalog_name</code>. For XenDesktop 4, name of XenDesktop group to add machines to. <strong>Note:</strong> vCAC does not support the use of XenDesktop groups of types other than Pre-Assigned in XenDesktop 4.</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Interval</td>
<td>Optional interval value in TimeSpan format for VDI Machine Active Directory registration check, default <strong>00:00:15</strong> (15 sec).</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Timeout</td>
<td>Optional timeout value in TimeSpan format for VDI Machine Active Directory registration check, default <strong>00:30:00</strong> (30 min.).</td>
</tr>
<tr>
<td>VDI.ActiveDirectory.Delay</td>
<td>Optional value in TimeSpan format determining delay between successfully adding machine to Active Directory and initiation of XenDesktop registration, default <strong>00:00:05</strong> (5 sec).</td>
</tr>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version to be installed on the provisioned machine.</em> See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvmsdk.apiref.doc_50%2Fcom.vmware.wssdk.operators.doc_50%2FVdc.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvmsdk.apiref.doc_50%2Fcom.vmware.wssdk.operators.doc_50%2FVdc.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>Infrastructure.Admin.MachineObjectOU</td>
<td>Specifies the OU of the machine, which must be the same as that of the Citrix Provisioning Server. Use Citix’s format; for example, for OU=Xen-Farm,OU=QA use the value Xen-Farm, QA with no extra commas or spaces. When machines are placed in the required OU by the provisioning group OU setting, this property is not required.</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Type of external provisioning infrastructure; set to <strong>CitrixProvisioning</strong> for Citrix Provisioning Server integration.</td>
</tr>
<tr>
<td>VirtualMachine.CDROM.Attach</td>
<td>Set to <strong>False</strong> to provision the machine without a CD-ROM device.</td>
</tr>
</tbody>
</table>
### Table 31  Custom Properties for BMC BladeLogic Configuration Manager Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPI.Server.Name</td>
<td>Name of Citrix Provisioning Server to provision from. As described in the <em>vCloud Automation Center Installation Guide</em>, each Citrix Provisioning Server instance to be used in provisioning requires a dedicated EPI agent. The value of this property must therefore match the server name provided when an EPI agent of type <strong>CitrixProvisioning</strong> was installed.</td>
</tr>
<tr>
<td>EPI.Server.Port</td>
<td>Port on which to contact Citrix Provisioning Server; omit to use default of <strong>54321</strong>.</td>
</tr>
<tr>
<td>EPI.Server.VDiskName</td>
<td>Name of Citrix Provisioning vDisk to provision from.</td>
</tr>
<tr>
<td>EPI.Server.Store</td>
<td>Name of Citrix Provisioning store containing the vDisk specified in EPI.Server.VDiskName.</td>
</tr>
<tr>
<td>EPI.Server.Collection</td>
<td>Name of Citrix Provisioning collection to register machine under.</td>
</tr>
</tbody>
</table>

#### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version to be installed on the provisioned machine</em>. See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvm%2FvmGuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvm%2FvmGuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Type of external provisioning infrastructure; set to <strong>BMC</strong> for BladeLogic integration.</td>
</tr>
<tr>
<td>EPI.Server.Name</td>
<td>Name of server hosting BladeLogic. If at least one general BMC EPI agent was installed without specifying a BladeLogic CM host, this value directs the request to the desired server. If only dedicated BMC EPI agents for specific BladeLogic CM hosts were installed, this value <strong>must match exactly</strong> the server name configured for one of these agents.</td>
</tr>
<tr>
<td>BMC.Service.Profile</td>
<td>Name of the default authentication profile on the BladeLogic server.</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BMC.AddServer.Delay</td>
<td>Optionally, number of seconds to delay before adding the machine to BladeLogic; default is 30.</td>
</tr>
<tr>
<td>BMC.AddServer.Retry</td>
<td>Optionally, number of seconds to wait before retrying if the first attempt to add the machine to BladeLogic CM is unsuccessful; default is 100.</td>
</tr>
<tr>
<td>BMC.Software.Install</td>
<td>Set to True to enable BladeLogic integration.</td>
</tr>
<tr>
<td>BMC.Software.BatchLocation</td>
<td>Location within BladeLogic of software jobs to be deployed; must match the appropriate field in Website\Software.txt if this file exists or in value of VRM.Software.IdNNNN properties if these are used.</td>
</tr>
<tr>
<td>LoadSoftware</td>
<td>Optionally set to True to make the software jobs listed in Website\Software.txt available for selection by the user requesting the machine when BladeLogic or HP Software Automation integration is in use.</td>
</tr>
<tr>
<td>VRM.Software.IdNNNN</td>
<td>Optionally specify a software job to be applied to all machines provisioned from the blueprint; set the value to job_type=job_path, where job_type is the number representing the BladeLogic job type: 1 — AuditJob 2 — BatchJob 3 — ComplianceJob 4 — DeployJob 5 — FileDeployJob 6 — NSHScriptJob 7 — PatchAnalysisJob 8 — SnapshotJob and job_path is the job's location within BladeLogic, for example 4=/Utility/putty. NNNN is a number from 1000 to 1999.</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version to be installed on the provisioned machine.</em> See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the Connect Using RDP option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Type of external provisioning infrastructure; set to <strong>Opsware</strong> for HP SA integration.</td>
</tr>
<tr>
<td>EPI.Server.Name</td>
<td>Name of server hosting HP SA. If at least one general Opsware EPI agent was installed without specifying an HP SA server, this value directs the request to the desired server. If only dedicated Opsware EPI agents for specific HP SA server were installed, this value <em>must match exactly</em> the server name configured for one of these agents.</td>
</tr>
<tr>
<td>Opsware.Software.Install</td>
<td>Set to <strong>True</strong> to enable software installation by HP SA.</td>
</tr>
<tr>
<td>LoadSoftware</td>
<td>Optionally set to <strong>True</strong> to make the HP SA policies listed in Website\Software.txt available for selection by the user requesting the machine.</td>
</tr>
<tr>
<td>Opsware.Server.Name</td>
<td>Fully qualified name of the HP SA server.</td>
</tr>
<tr>
<td>Opsware.Server.Username</td>
<td>User name provided when password file in agent directory was created; must have administrative access to the HP SA instance (for example, <em>opswareadmin</em>).</td>
</tr>
<tr>
<td>Opsware.BootImage.Name</td>
<td>Boot Image name as defined in HP SA (for example, <em>winpe32</em> for the 32-bit WinPE image); not required when provisioning by cloning.</td>
</tr>
<tr>
<td>Opsware.Customer.Name</td>
<td>Customer Name value as defined in HP SA (for example, <em>AcmeCorp</em>).</td>
</tr>
<tr>
<td>Opsware.Facility.Name</td>
<td>Facility Name value as defined in HP SA (for example, <em>Columbus</em>).</td>
</tr>
<tr>
<td>Opsware.Machine.Password</td>
<td>Default local administrator password for OS sequence WIM image (Opsware.OSSequence.Name) as defined in HP SA (for example, <em>P@ssword1</em>).</td>
</tr>
</tbody>
</table>

**Table 32  Custom Properties for HP Server Automation (Opsware SAS) Integration**
### Custom Properties for Basic Workflow Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opsware.OSSequence.Name</td>
<td>OS Sequence Name as defined in HP SA (for example, <strong>Windows 2003 WIM</strong>).</td>
</tr>
<tr>
<td>Opsware.Realm.Name</td>
<td>Realm Name value as defined in HP SA (for example, <strong>Production</strong>).</td>
</tr>
<tr>
<td>Opsware.Register.Timeout</td>
<td>Time (in seconds) to wait for creation of a provisioning job to complete.</td>
</tr>
<tr>
<td>Opsware.WOL.Enabled</td>
<td>Set to <strong>False</strong> for virtual provisioning.</td>
</tr>
<tr>
<td>Opsware.WOL.Delay</td>
<td>Time (in seconds) to wait before executing Wake-On-LAN. Not required (ignored) when Opsware.WOL.Enabled is set to <strong>False</strong>.</td>
</tr>
<tr>
<td>Opsware.ProvFail.Notify</td>
<td>Email address for HP SA to notify in the event of provisioning failure (optional).</td>
</tr>
<tr>
<td>Opsware.ProvFail.Owner</td>
<td>HP SA user to assign ownership to in the event of provisioning failure (for example, <strong>opswareadmin</strong>) (optional).</td>
</tr>
<tr>
<td>Opsware.ProvSuccess.Notify</td>
<td>Email address for HP SA to notify in the event of provisioning success (optional)</td>
</tr>
<tr>
<td>Opsware.ProvSuccess.Owner</td>
<td>HP SA user to assign ownership to in the event of provisioning success (for example, <strong>opswareadmin</strong>) (optional).</td>
</tr>
<tr>
<td>VRM.Software.IdNNNN</td>
<td>Optionally specify an HP SA policy to be applied to all machines provisioned from the blueprint. <strong>NNNN</strong> is a number from 1000 to 1999.</td>
</tr>
<tr>
<td>VirtualMachine.CDROM.Attach</td>
<td>Set to <strong>False</strong> to provision the virtual machine without a CD-ROM device (virtual provisioning only).</td>
</tr>
<tr>
<td>Linux.ExternalScript.Name</td>
<td>The name of the customization script that installs the HP SA agent on a Linux virtual machine following cloning. (Linux only)</td>
</tr>
<tr>
<td>Linux.ExternalScript.LocationType</td>
<td>Set to <strong>local</strong> to indicate that the script named in Linux.ExternalScript.Name is on the cloned machine. (Linux only)</td>
</tr>
<tr>
<td>Linux.ExternalScript.Path</td>
<td>The local path to the script named in Linux.ExternalScript.Name. The value must use forward slashes and begin with a forward slash. (Linux only)</td>
</tr>
</tbody>
</table>

**Table 33** Custom Properties for Basic Workflow Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.CDROM.Attach</td>
<td>Set to <strong>False</strong> to provision the machine without a CD-ROM device.</td>
</tr>
</tbody>
</table>
Table 34  Custom Properties for Calling Visual Basic Scripts During Provisioning

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version to be installed on the provisioned machine.</em> See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.Admin.Thin Provision</td>
<td>Determines whether thin provisioning is used on ESX Server hosts using local or iSCSI storage. If <strong>True</strong>, thin provisioning is used; if <strong>False</strong>, standard provisioning is used; if not specified, virtualization platform default is used.</td>
</tr>
</tbody>
</table>

**Table 34  Custom Properties for Calling Visual Basic Scripts During Provisioning**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VbScript.PreProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run before a machine is provisioned, including the filename and extension, for example %SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendE-mail.vbs.</td>
</tr>
<tr>
<td>VbScript.PostProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run after a machine is provisioned, including the filename and extension, for example %SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendE-mail.vbs.</td>
</tr>
<tr>
<td>VbScript.UnProvisioning.Name</td>
<td>The complete pathname (on the system on which the VBScript EPI agent is installed) of the Visual Basic script to be run when a machine is destroyed, including the filename and extension, for example %SystemDrive%\Program Files (x86)\VMware\vCAC Agents\EPI_Agent\Scripts\SendE-mail.vbs.</td>
</tr>
</tbody>
</table>
## Table 35 Custom Properties for Customizing RDP Connections

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Rdp.SettingN</td>
<td>Specification for a setting to be used when opening an RDP (remote desktop protocol) link to the machine to create a Microsoft Terminal Services connection, where ( N ) is a unique number distinguishing this setting from other RDP settings.</td>
</tr>
<tr>
<td>VirtualMachine.Rdp.File</td>
<td>Name of .rdp file containing settings to be used when opening an RDP link to the machine. Can be used together with or as an alternative to VirtualMachine.Rdp.SettingN. The file must be located in vCAC_installation_dir\Website\Rdp where vCAC_installation_dir is the vCAC server install directory (typically, %SystemDrive%\Program Files x86\VMware\vCAC\Server). You will need to create the Rdp directory.</td>
</tr>
<tr>
<td>VirtualMachine.Admin.ConnectionAddress</td>
<td>RDP connection address for machine to be used in .rdp file downloaded when Connect Using RDP option is used or attached to automatic emails. Should not be used in a blueprint or build profile unless Prompt User is selected and no default value is supplied.</td>
</tr>
<tr>
<td>VirtualMachine.Admin.NameCompletion</td>
<td>If VirtualMachine.Admin.Connection address does not exist, machine’s IP address is not static, and machine’s host name is not a fully qualified domain name, appended to machine’s host name to form connection address for machine in .rdp file downloaded when Connect Using RDP option is used or attached to automatic emails. For example, can be set to domain name to form fully qualified domain name as connection address in .rdp files.</td>
</tr>
</tbody>
</table>

## Table 36 Custom Properties for Customizing Active Directory Cleanup

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin.AdMachineCleanup.Execute</td>
<td>Set to True to use the AD cleanup plugin with this blueprint. By default, each machine’s account is disabled when it is destroyed.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.UserName</td>
<td>User name of AD account with sufficient rights to delete, disable, rename or move AD accounts. Use the DOMAIN\username format. This is required if the vCAC manager service does not have these rights in a domain, which may be the case if vCAC is provisioning machines in more than one domain.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Password</td>
<td>Password for the account specified by Plugin.AdMachineCleanup.UserName. (Be sure to use the Encrypt check box for security.)</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Delete</td>
<td>Set to True to delete each machine’s account when the machine is destroyed, instead of disabling it.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.MoveToOu</td>
<td>Specify the OU to which each machine’s account is to be moved when it is destroyed, in the format ou=OU, dc=dc ... .</td>
</tr>
</tbody>
</table>
Note: The ADMachineCleanupPlugin is capable of managing machine records in multiple domains using either the Sysprep.Identification.JoinDomain custom property or the Plugin.AdMachineCleanup.Domain custom property with the Sysprep property taking precedence, if both are provided.

Table 37 Custom Property for Adding FQDN to Machine-Activated Emails

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin.AdMachineCleanup.RenamePrefix</td>
<td>Specify the prefix to be attached to the name of each machine’s account when the machine is destroyed, thereby renaming it, for example destroyed_.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Domain</td>
<td>Name of the AD domain containing the machine account to be destroyed.</td>
</tr>
<tr>
<td>Sysprep.Identification.JoinDomain</td>
<td>Name of the AD domain containing the machine account to be destroyed. Takes precedence over any value specified in the property Plugin.AdMachineCleanup.Domain.</td>
</tr>
</tbody>
</table>

Customizing Machine Connections Using Custom Properties

The Connect Using RDP option on a machine’s menu lets the user download an .rdp file that can be opened to create a Remote Desktop Protocol link and open a Microsoft Terminal Services connection to a Windows machine. As noted in Customizing Automatic Emails, if the includeRdpLinkAttachment event is set to true (the default), emails regarding a provisioned, running machine (such as the machine activated email have a similar .rdp file attached. By using custom properties, you can do the following:

- Use the machine’s fully qualified domain name (FDQN) or IP address (if static) as the connection address in the .rdp file, rather than its short host name.
- Disable the Connect Using RDP option for non-Windows machines.
- Customize RDP connections to machines provisioned from that blueprint. You can also specify an .rdp template file from which to obtain connection settings.

Note: The Connect Using RDP option does not appear when the machine is registered with a XenDesktop DDC server and the Connect to Virtual Desktop option is available.

Including the FQDN or IP Address in the RDP File

The connection address included in the .rdp file downloaded using Connect Using RDP or attached to automatic emails is determined according to the following rules:

- If the property VirtualMachine.Admin.ConnectAddress exists, the value of this property is used as the address. Because individual values must be supplied for individual machines, this property should be used in blueprints or build profiles only with Prompt User selected and no default
value, requiring the requesting user or an approver to provide the address. It can also be added to an individual machine by a Provisioning Group Manager (PGM) or Enterprise Administrator using the **Edit** option, or by a PGM when provisioning the machine.

- If `VirtualMachine.Admin.ConnectAddress` does not exist and the machine has a static IP address, the IP address is used as the address.

- If `VirtualMachine.Admin.ConnectAddress` does not exist and the machine’s IP address is not static, the machine’s host name is evaluated to determine if it is already an FQDN (for example, whether it contains a dot). If it is not, the value of the `VirtualMachine.Admin.NameCompletion` property is appended to the host name to create the machine’s address.

- If neither `VirtualMachine.Admin.ConnectAddress` or `VirtualMachine.Admin.NameCompletion` exists and the machine’s IP address is not static, the machine’s host name is used as the address.

**Disabling the Connect Using RDP Option**

To remove the **Connect Using RDP** option from the menu for machines provisioned from a blueprint, add the property `VMware.vCenter Server.OperatingSystem` to the blueprint or build profile with a value indicating a non-Windows machine, for example `rhel5Guest` for Red Hat Enterprise Linux 5. This property is required for provisioning virtual machines on ESX Server hosts but can be used in any blueprint to disable the **Connect Using RDP** option for any virtual, cloud or physical machine. See VMware documentation at http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html and http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html or other current locations for possible values.

**Specifying RDP Settings**

Use the `VirtualMachine.Rdp.Setting\N` custom property to specify specific RDP settings. \(N\) is a unique number used to distinguish one RDP setting from another.) For example, to specify a Connect To Console RDP session, add the first of the following properties to a blueprint or build profile:. To specify multiple monitor spanning (Version 6.0, see http://support.microsoft.com/kb/925876), add the second property.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>VirtualMachine.Rdp.Setting1</code></td>
<td>connect to console:i:1</td>
</tr>
<tr>
<td><code>VirtualMachine.Rdp.Setting2</code></td>
<td>span monitors:i:1</td>
</tr>
</tbody>
</table>

You can also customize settings by specifying an `.rdp` file from which to obtain the settings. The file must be located in \%CAC_installation_dir\Website\Rdp where \%CAC_installation_dir\ is the vCAC server install directory (typically \%SystemDrive%\Program Files x86\VMware\vCAC\Server). For example, a custom file might have the path name \%Program Files (x86)\DynamicOps\DCAC Server\Website\Rdp\my_custom_file.rdp.

A file called `Default.rdp` that you can use as a template in creating custom `.rdp` files exists in the \%CAC_installation_dir\Website\Rdp directory (not to be confused with the \%CAC_installation_dir\Website\Rdp directory). When using `Default.rdp` as a template, copy the file and rename the copy as your new custom `.rdp` file. You will need Notepad or a similar text editor to view and edit the files.

To create and use a custom `.rdp` file specifying console access, you might do the following:
1. Set your current directory to the `vCAC_installation_dir\Rdp` directory; for example, `C:\Program Files (x86)\DynamicOps\DCAC Server\Rdp`.

2. Copy `Default.rdp` and rename the copy to `Console.rdp` in the same directory.

3. Add the `connect to console:i:1` setting to `Console.rdp` and copy the file to the `vCAC_installation_dir\Website\Rdp` directory.

4. Add the following property to the blueprint or build profile:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Rdp.File</td>
<td>Console.rdp</td>
</tr>
</tbody>
</table>

**Note:** You cannot apply RDP settings by adding the VirtualMachine.Rdp properties to the machine itself; they must exist in the blueprint from which the machine is built or its incorporated build profile.

### Assigning vCNS Security Groups and Load Balancing Pools Using Custom Properties

The vCNS custom properties assign vCNS security groups and load balancing pools to vSphere vCenter Server machines during provisioning. You can use the custom properties in reservations, blueprints, build profiles, and anywhere else custom properties are used. See Table 24, “Custom Properties for Provisioning with vCNS Manager,” for a description of

- `VCNS.SecurityGroup.Names.[name]`
- `VCNS.LoadBalancerEdgePool.Names.[name]`

Before you can use these properties, you must have the following in vCAC:

- vCNS Manager credentials
- vCNS endpoint
- vCNS data collection enabled

See Managing Credentials and Endpoints and Managing Data Collection for information on providing and enabling the vCNS credentials, endpoint, and data collection.

### Deleting an Assigned Virtual Machine

If you assign a vCNS security group to a virtual machine in vCAC and then delete the machine, the vCNS Manager automatically removes the machine from the vCNS security group.

If you assign a vCNS load balancing pool to a virtual machine in vCAC and then delete the machine, vCAC removes the deleted machine from the vCNS load balancing pool during the next vCNS inventory data collection.

### Customizing Active Directory Cleanup Using Custom Properties

Each machine provisioned by vCAC is added to an Active Directory (AD) organizational unit (OU) when it is created. By default this is the OU specified for the provisioning group in which the machine is provisioned, but another can be specified using the custom property `Infrastructure.Admin.MachineObjectOU`. 
The AD Cleanup plugin allows you to determine the disposition of a machine’s Active Directory account when the machine is destroyed. Using the plugin and associated custom properties you can specify that the accounts of all machines provisioned from a particular blueprint be

- deleted
- disabled
- renamed
- moved to another OU

To apply the AD Cleanup plugin to machines, create a blueprint in which at least the first three of the following custom properties are included, either in an incorporated build profile or directly on the blueprint’s Build Information tab. The first three required properties alone specify that the AD account of each machine provisioned from the blueprint is to be disabled when the machine is destroyed. Use one of the last three optional properties to specify another policy for AD accounts when machines provisioned from the blueprint are destroyed.

**Table 38  Custom Properties for AD Cleanup Plugin**

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin.AdMachineCleanup.Execute</td>
<td>Set to <strong>True</strong> to use the AD cleanup plugin with this blueprint. By default, each machine’s account is disabled when it is destroyed.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.UserName</td>
<td>User name of AD account with sufficient rights to delete, disable, rename or move AD accounts. Use the <strong>DOMAIN\username</strong> format. This is required if the vCAC manager service does not have these rights in a domain, which may be the case if vCAC is provisioning machines in more than one domain.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Password</td>
<td>Password for the account specified by Plugin.AdMachineCleanup.UserName. (Be sure to use the <strong>Encrypt</strong> check box for security.)</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.Delete</td>
<td>Set to <strong>True</strong> to delete each machine’s account when the machine is destroyed, instead of disabling it.</td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.MoveToOu</td>
<td>Specify the OU to which each machine’s account is to be moved when it is destroyed, in the format <strong>ou=OU, dc=dc ...</strong></td>
</tr>
<tr>
<td>Plugin.AdMachineCleanup.RenamePrefix</td>
<td>Specify the prefix to be attached to the name of each machine’s account when the machine is destroyed, thereby renaming it, for example <strong>destroyed_</strong></td>
</tr>
</tbody>
</table>

**Using the Property Dictionary**

The property dictionary feature enables an enterprise administrator to provide a more robust user interface for custom properties that a machine owner enters at request time.
Properties are used throughout the product to provide settings for many features. When users request new machines they are prompted for any required properties. Enterprise administrators or provisioning group managers designate which properties are required by selecting the **Prompt User** option on the blueprint or build profile. By default, the Confirm Machine Request page displays the literal name of the property as a required text box and does not provide any validation other than that a value has been entered.

The property dictionary allows you define characteristics of properties that are used to tailor the behavior of the request user interface, for example:

- Associate a property name with a particular user control, such as a check box, calendar control, or drop-down list
- Specify constraints such as minimum and maximum values or validation against a regular expression
- Provide descriptive display names for properties or specify text (for a tooltip or text label) with additional information
- Designate a property as optional rather than required
- Group sets of property controls together and specify the order in which they appear by using control layouts

You can create property definitions for reserved custom properties that are used by core vCAC features as well as any new custom properties that you define. For a list of reserved custom properties, see “vCAC Reserved Custom Properties” on page 238.

New custom properties are typically used by custom workflows that specify the logic to execute based on the value of that property. You can define these custom workflows using either vCAC Designer or the vCAC Development Kit. For more information about working with custom workflows, see the vCloud Automation Center Extensibility Guide.

### Creating Property Definitions

A property definition associates a property by name to attributes which define its behavior.

The high-level process for using property definitions is as follows:

1. Create a new property definition and select the control type to use for editing the property. The name of the property in the property dictionary is the same name that you add to a blueprint or build profile.
2. Specify any relevant property attributes for the new property. Attributes contain additional information such as minimum and maximum values, or help text to display with the property. Attribute types can vary depending on the control type.
3. To enable the interface for editing the property, add the property to a blueprint or build profile and select **Prompt User**.

The following sections describe how to accomplish each of these steps. For a detailed example of creating and using a property definition, see “Property Definition Example: Network Drop-Down List” on page 282.
User Controls for Property Definitions

Each property definition is associated with a particular control type that determines the user interface for editing that property.

The property dictionary provides the following types of user controls for custom properties:

<table>
<thead>
<tr>
<th>Control Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckBox</td>
<td>Check box for specifying true or false values.</td>
</tr>
<tr>
<td>DateTimeEdit</td>
<td>A calendar and time control that enables users to specify a date and time.</td>
</tr>
<tr>
<td>DropDown</td>
<td>Drop-down-style combo box. A user can enter arbitrary text in addition to selecting from the list.</td>
</tr>
<tr>
<td>DropDownList</td>
<td>Drop-down list–style combo box. A user must select a value from the list.</td>
</tr>
<tr>
<td>Integer</td>
<td>Numeric spin box. A user can enter an integer between the minimum and maximum values or step up and down by a defined interval.</td>
</tr>
<tr>
<td>Label</td>
<td>Displays a read-only text label.</td>
</tr>
<tr>
<td>Link</td>
<td>Displays a link with the property display name as the link text and the property value as the URL.</td>
</tr>
<tr>
<td>Notes</td>
<td>Multi-line text box.</td>
</tr>
<tr>
<td>Password</td>
<td>Text box that masks the current value.</td>
</tr>
<tr>
<td>TextBox</td>
<td>Single-line text box.</td>
</tr>
</tbody>
</table>

Some control types may have additional configuration, for example, a drop-down property has a set of values from which a user can select and an integer property can have minimum and maximum values.

Defining a Basic Property

This procedure describes how to create a property definition with no attributes. Most control types do not require any attributes to be configured.

To define a basic property:

1. Click Enterprise Administrator > Property Dictionary.
2. Click Add Property Definition.
3. In the Name box, specify the property name. This name must be an exact match (case- and white space–sensitive) to the name that you specify in the blueprint or build profile.
4. In the Display Name box, specify a descriptive name for the property. This text appears as the field label on the Confirm Machine Request page.
5. Optionally, specify a Description. This text describes the behavior to the property dictionary administrator and is not displayed to end users.
6. From the Control Type list, select the user control that you want to associate with this property.
7. Select Required if the machine owner must specify a value for this property.
8. Click the Save button.

Defining a Date-Time Property

A Date-Time property displays as a calendar and time control that enables a user to specify a date and time value.
To define a date-time property:

1. Click **Enterprise Administrator > Property Dictionary**.
2. Click **Add Property Definition**.
3. In the **Name** box, specify the property name. This name must be an exact match (case- and white space–sensitive) to the name that you specify in the blueprint or build profile.
4. In the **Display Name** box, specify a descriptive name for the property. This text appears as the field label on the Confirm Machine Request page.
5. Optionally, specify a **Description**. This text describes the behavior to the property dictionary administrator and is not displayed to end users.
6. From the **Control Type** list, select **DateTimeEdit**.
7. Select **Required** if the machine owner must specify a value for this property.
8. Click the **Save** button.
9. Optionally, specify a minimum (earliest) value for the property.
   a. Under **Property Attributes**, click **Edit**.
   b. Click **Add Property Attribute**.
   c. From the **Type** list, select **MinValue**.
   d. Specify a **Name** (the attribute name is not displayed to the end user).
   e. In the **Value** box, specify a date in **YYYY-MM-DD** or **MM/DD/YYYY** format or a date followed by a time in **HH:MM** format (24-hour clock or followed by **AM** or **PM**).
   f. Click the **Save** button.
   g. Click **OK**.

### Defining an Integer Property

An integer property displays as a spin box that enables a user to specify an integer value.

To define an integer property:

1. Click **Enterprise Administrator > Property Dictionary**.
2. Click **Add Property Definition**.
3. In the **Name** box, specify the property name. This name must be an exact match (case- and white space–sensitive) to the name that you specify in the blueprint or build profile.
4. In the **Display Name** box, specify a descriptive name for the property. This text appears as the field label on the Confirm Machine Request page.
5. Optionally, specify a **Description**. This text describes the behavior to the property dictionary administrator and is not displayed to end users.
6. From the Control Type list, select **Integer**.
7. Select **Required** if the machine owner must specify a value for this property.
8. Click the **Save** button.
9. Optionally, specify the minimum, maximum, and interval values for the property.
a. Under **Property Attributes**, click **Edit**.
b. Click **Add Property Attribute**.
c. From the **Type** list, select **MinValue**.
d. Specify a **Name** (the attribute name is not displayed to the end user).
e. In the **Value** box, specify an integer for the minimum value of the property.
f. Click the **Save** button.
g. Repeat steps b-f for the **MaxValue** and **Interval**.
   The interval is the increment by which the property value is increased or decreased when a user clicks the up or down arrows.
h. Click **OK**.

**Defining a Drop-Down Property**

A drop-down property enables a user to select from a list of string values. You can optionally enable the user to enter arbitrary values.

To define a drop-down property:

1. Click **Enterprise Administrator > Property Dictionary**.
2. Click **Add Property Definition**.
3. In the **Name** box, specify the property name. This name must be an exact match (case- and white space–sensitive) to the name that you specify in the blueprint or build profile.
4. In the **Display Name** box, specify a descriptive name for the property. This text appears as the field label on the Confirm Machine Request page.
5. Optionally, specify a **Description**. This text describes the behavior to the property dictionary administrator and is not displayed to end users.
6. From the Control Type list, select **DropDown** for a control that enables the user to enter arbitrary values or **DropDownList** for a control that limits the user to selecting from the values in the list.
7. Select **Required** if the machine owner must specify a value for this property.
   h. Click the **Save** button.
9. Specify the values for the drop-down list.
   a. Under **Property Attributes**, click **Edit**.
   b. Click **Add Property Attribute**.
   c. From the **Type** list, select **ValueList**.
   d. Specify a **Name** (the attribute name is not displayed to the end user).
   e. In the **Value** box, specify a comma-separated list of values that the user can select from. Enclose any values that contain commas in quotation marks (").
Configuring Common Property Attributes
This section describes aspects of a property definition can apply to multiple property types.

Specifying Tooltip Text for a Property
You can specify help text that displays as a tooltip for any property type except for a link property.
To specify help text for a property:
1. Under Property Attributes, click Edit.
2. Click Add Property Attribute.
3. From the Type list, select HelpText.
4. Specify a Name (the attribute name is not displayed to the end user).
5. In the Value box, specify the text that you want to display as a tooltip when the user pauses over the property field.
6. Click the Save button.
7. Click OK.

Specifying Display Order for a Property
You can specify an order index for a property that determines the order in which it appears on the Confirm Machine Request page.
All properties that have a specified display order display before properties with no display order.
Another way to designate the order in which properties are displayed is to create a control layout. For more information, see “About Control Layouts” on page 280.
To specify the display order:
1. Under Property Attributes, click Edit.
2. Click Add Property Attribute.
3. From the Type list, select OrderIndex.
4. Specify a Name (the attribute name is not displayed to the end user).
5. In the Value box, specify an alphanumeric value that represents the order in which a property should display. Index values do not have to be sequential.

Note: Index values are sorted alphabetically. For example, if you use numerical indexes from 1-12, they are sorted in the following order: 1, 10, 11, 12, 2, 3 …
6. Click the Save button.
7. Click OK.

Configuring Regular Expression Validation
You can specify a regular expression against which to validate text input in a text box, drop-down, notes, or password field.
Note: Regular expression validation only applies if a value is supplied; it does not make the property required. If you create a password field with a regular expression attribute that enforces a length of 6-8 characters and do not make the property required, vCAC does not attempt to validate a blank password. However, if the user enters a password that is only 4 characters long, then it would fail validation.

To specify a regular expression to use to validate a property:

1. Under **Property Attributes**, click **Edit**.
2. Click **Add Property Attribute**.
3. From the **Type** list, select **RegEx**.
4. Specify a **Name** (the attribute name is not displayed to the end user).
5. In the **Value** box, specify the regular expression to use to validate the property value.
6. Click the **Save** button.
7. Click **OK**.

### Defining Relationships between Properties

You can define a relationship between a drop-down property and another property such that the value of one property determines the possible values of the drop-down property.

In a property relationship, one property is the **parent** (the one whose value determines the behavior of the child property control) and the other is the **child** (the drop-down property whose values are populated based on the value of the parent). When the value of the parent property changes, the child property is refreshed with a list of possible values depending on the value of the parent.

Instead of specifying a ValueList for the child property, you specify the mapping between the values of the parent property and the possible values of the child property in an XML string called a **value expression**.

The high-level process for creating relationships is as follows:

1. Create two property definitions, the parent and child.
2. Add a **Relationship** attribute to the child property whose value is the name of the parent property.
3. Create a value expression that describes which values to display in the child drop-down list for each value of the parent property.
4. Add the value expression as an attribute of the child property.
5. Add both properties to a blueprint or build profile.

For a detailed example of defining relationships between properties, see “Property Relationship Example” on page 283.

### Creating a Value Expression

A value expression is an XML string that maps the values of the parent property and the child property in a property relationship.

To create a value expression:
   ```xml
   <?xml version="1.0" encoding="utf-8" standalone="yes"?>
   ```
2. Create the root element, **ArrayOfPropertyValue**.
   ```xml
   <ArrayOfPropertyValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   </ArrayOfPropertyValue>
   ```
3. Insert a **PropertyValue** element.
   ```xml
   <ArrayOfPropertyValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
       <PropertyValue>
           <FilterName>Custom.Property.Parent</FilterName>
           <FilterValue>Colors</FilterValue>
           <Value>Blue</Value>
       </PropertyValue>
   </ArrayOfPropertyValue>
   ```
   
4. Insert the following child elements into the **PropertyValue** element:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FilterName</td>
<td>The name of the parent property</td>
</tr>
<tr>
<td>FilterValue</td>
<td>The value of the parent property that enables a specific value for the child property</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the child property to enable when the parent property has a value of FilterValue</td>
</tr>
</tbody>
</table>

5. Repeat steps 3-4 for each property mapping you want to define for the parent property and the child property.

6. Format the XML as one continuous string with no line breaks.
   The following is an example of a value expression (prior to formatting it as a single line):
   ```xml
   <?xml version="1.0" encoding="utf-8" standalone="yes"?>
   <ArrayOfPropertyValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
       <PropertyValue>
           <FilterName>Custom.Property.Parent</FilterName>
           <FilterValue>Colors</FilterValue>
           <Value>Blue</Value>
       </PropertyValue>
       <PropertyValue>
           <FilterName>Custom.Property.Parent</FilterName>
           <FilterValue>Colors</FilterValue>
           <Value>Red</Value>
       </PropertyValue>
       <PropertyValue>
           <FilterName>Custom.Property.Parent</FilterName>
           <FilterValue>Colors</FilterValue>
           <Value>Blue</Value>
       </PropertyValue>
   </ArrayOfPropertyValue>
   ```
Displaying a Property on the Confirm Machine Request Page

After you have defined a property in the property dictionary, you must add the property to a blueprint or build profile to expose it to the user at request time.

**Note:** The following procedure assumes that you are adding the property directly to a blueprint or global blueprint, but the property can also be defined in a build profile that you reference in a blueprint.

To add a property from the property dictionary to a blueprint:

1. Create a new blueprint or edit an existing blueprint.
2. On the **Properties** tab, click **New Property**.
3. In the **Name** box, specify the name of the property definition. This must be an exact match (case- and white space–sensitive) to the **Name** you specified in the Property Dictionary.
4. Optionally, specify a **Value**.
   - For most property types, the value you specify in the blueprint is a default value that can be overridden by the user at request time.
   - For a label property, the value is the text of the label that displays.
   - For a link property, the value is the target URL of the link. (The property display name serves as the link text.)
5. Select **Prompt User**.
   Although the label and link properties are read only, you must still select **Prompt User** in order to for them to appear on the **Confirm Machine Request** page.
6. Click the **Save** button.
7. Click **OK**.

**About Control Layouts**

Control layouts enable you to define a group of properties that go together and specify the order in which they are displayed on the Confirm Machine Request page.
You can specify exactly one control layout for a blueprint and it should include all the property definitions with custom controls that you want to use with that blueprint. You can use the same layout on multiple blueprints.

If there are additional custom properties that are specified as **Prompt User** on the same blueprint as a control layout, the properties in the layout appear first, followed by the individual properties. These individual properties display using the default behavior for custom properties (that is, with the property name as the display name, and a plain text field for entering the value) even if you have defined a property in the property dictionary with the same name.

The high-level process for creating a control layout is as follows:

1. Create the property definitions that you want to include in a layout.
2. Create a new control layout.
3. Add the properties to the layout and specify the order in which they should be displayed.
4. Add the control layout and the properties that it contains to a blueprint.

For a detailed example of creating and using control layouts, see "Control Layout Example" on page 286.

### Creating a Control Layout

A control layout acts as a named container to which you can add properties and specify the order in which their user controls should appear.

Before creating a control layout, you should first create all the property definitions that you want to include in the layout.

To create a control layout:

1. Click **Enterprise Administrator > Property Dictionary**.
2. Click **Add Property Layout**.
3. In the **Name** box, specify a name for the layout.
4. Optionally, specify a **Description**. This text describes the behavior to the property dictionary administrator and is not displayed to end users.
5. Click the **Save** button.
6. Under **Property Instances**, click **Edit**.
7. In the **Order** box, specify an alphanumeric value that represents the order in which a property should display. Order values do not have to be sequential.

**Note:** Order values are sorted alphabetically. For example, if you use numerical values from 1-12, they are sorted in the following order: 1, 10, 11, 12, 2, 3 …

8. From the **Property Definition** drop-down, select one of the properties you have previously defined.
9. Click the **Save** button.
10. Repeat steps 6-9 as needed to add additional properties to the layout.
11. Click **OK**.
Displaying a Control Layout on the Confirm Machine Request Page

To enable a control layout, you add it to a blueprint along with the properties that it contains.

You specify a control layout on a blueprint using a reserved custom property named `VirtualMachine.Request.Layout`.

If you use a control layout in a blueprint, any custom properties that you add to the blueprint that are not part of the control layout have the default behavior on the Confirm Machine Request page. For example, suppose you define a property named `CustomProperty.NotInLayout` with a display name and custom user control. If you add the property to a blueprint that has a control layout that does not include this property, the property appears on the Confirm Machine Request page with the label `CustomProperty.NotInLayout` and a basic text field for input rather than the display name and user control specified in the property dictionary.

**Note:** The following procedure assumes that you are adding the properties directly to a blueprint or global blueprint, but the properties can also be defined in a build profile that you reference in a blueprint.

To add a control layout to a blueprint:

1. Create a new blueprint or edit an existing blueprint.
2. On the **Properties** tab, click **New Property**.
3. In the **Name** box, type `VirtualMachine.Request.Layout`.
4. In the **Value** box, specify the name of the control layout.
5. Leave the **Prompt User** check box unselected.
6. Click the **Save** button.
7. For each of the properties contained in the layout, add a custom property to the blueprint, ensuring that you select **Prompt User**.
8. Click **OK**.

Examples of Using the Property Dictionary

The following sections include detailed examples of using the property dictionary and control layouts.

**Note:** The following examples assume that you are adding the properties directly to a blueprint or global blueprint, but the properties can also be defined in a build profile that you reference in a blueprint.

Property Definition Example: Network Drop-Down List

Typically, when you request a machine on a reservation with more than one available network, the network is automatically assigned by vCAC during provisioning. The following example shows how you can add a drop-down list that enables users to select from a list of specific values for the network, giving the users more control over the resulting machine.

To create a blueprint with network selection:

1. Log on as an Enterprise Administrator.
2. Click **Enterprise Administrator > Property Dictionary**.
3. Create the property definition.
   a. Click Add Property Definition.
   b. In the Name box, specify VirtualMachine.Network0.Name. (0 is the number zero.)
   c. In the Display Name box, specify Select Network.
   d. Optionally, specify a Description.
   e. From the Control Type drop-down list, choose DropDownList.
   f. Select the Required check box to make this property required at request time.
   g. Click the Save button.

4. Specify the set of networks to display in the drop-down list by creating a property attribute.
   a. Under Property Attributes, click Edit.
   b. Click Add Property Attribute.
   c. From the Type drop-down list, select ValueList.
   d. In the Name box, specify Values.
   e. In the Value box, enter a comma-separated list of networks a user can choose from, for example: Development Network,QA Network 1,QA Network 2,Production Network,Failover Network.

   **Note:** You should use values that correspond to the networks that are available on your reservation.

   f. Click the Save button.
   g. Click OK.

5. Add the VirtualMachine.Network0.Name custom property to a blueprint (or global blueprint).
   a. Create a new blueprint or edit an existing blueprint.
   b. On the Properties tab, click New Property.
   c. In the Name box, specify the name of the property definition you just created: VirtualMachine.Network0.Name. This must be an exact match (case- and white space–sensitive).
   d. Leave the Value blank, or specify one of the possible values in the drop-down list to use as the default value.
   e. Select Prompt User.
   f. Click the Save button.
   g. Click OK.

When a user requests a machine using this blueprint, the “Select Network” drop-down list now appears on the Confirm Machine Request page, with the values specified in the property attributes. The user can select a network from this list for the machine that they are requesting.

**Property Relationship Example**

Building on the previous example, this example shows how to define a relationship so that the value of a new property (the parent) determines the values of the networks drop-down list (the child).
We introduce a property, `VirtualMachine.Network.Environment`, that is used to filter the available network options based on the environment for the machine. The user must first select the environment before selecting from the list of networks that are applicable to the selected environment.

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Development</td>
<td>Development Network</td>
</tr>
<tr>
<td>QA</td>
<td>QA Network 1</td>
</tr>
<tr>
<td></td>
<td>QA Network 2</td>
</tr>
<tr>
<td>Production</td>
<td>Production Network</td>
</tr>
<tr>
<td></td>
<td>Failover Network</td>
</tr>
</tbody>
</table>

The `VirtualMachine.Network.Environment` property has no effect in vCAC other than to act as a filter for the networks that a user can select on the Confirm Machine Request page.

To enable a user to select a network for a machine based on its environment:

1. Log on as an Enterprise Administrator.
2. Click **Enterprise Administrator > Property Dictionary**.
3. Create the parent property.
   a. Click **Add Property Definition**.
   c. In the **Display Name** box, specify **Environment**.
   d. Optionally, specify a **Description**.
   e. From the **Control Type** drop-down list, choose **DropDownList**.
   f. Select the **Required** check box to make this property required at request time.
   g. Click the **Save** button.
4. Define the values for the parent property.
   a. Under **Property Attributes**, click **Edit**.
   b. Click **Add Property Attribute**.
   c. From the **Type** drop-down list, select **ValueList**.
   d. In the **Name** box, specify **Values**.
   e. In the **Value** box, specify **Development,QA,Production**.
   f. Click the **Save** button.
   g. Click **OK**.
5. Create the child property if you have not already created it in the previous example.
   a. Click **Add Property Definition**.
   b. In the **Name** box, specify `VirtualMachine.Network0.Name`.
   c. In the **Display Name** box, specify **Select Network**.
   d. Optionally, specify a **Description**.
6. Define the relationship between the child and the parent properties.
   b. Click Add Property Attribute.
   c. From the Type drop-down list, select Relationship.
   d. In the Name box, specify Parent.
   f. Click the Save button.
   g. Click OK.

7. Create the following value expression that specifies the values of the child property based on the values of the parent property:

```xml
<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<ArrayOfPropertyValue xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <PropertyValue>
    <FilterName>VirtualMachine.Network.Environment</FilterName>
    <FilterValue>Development</FilterValue>
    <Value>Development Network</Value>
  </PropertyValue>
  <PropertyValue>
    <FilterName>VirtualMachine.Network.Environment</FilterName>
    <FilterValue>QA</FilterValue>
    <Value>QA Network 1</Value>
  </PropertyValue>
  <PropertyValue>
    <FilterName>VirtualMachine.Network.Environment</FilterName>
    <FilterValue>QA</FilterValue>
    <Value>QA Network 2</Value>
  </PropertyValue>
  <PropertyValue>
    <FilterName>VirtualMachine.Network.Environment</FilterName>
    <FilterValue>Production</FilterValue>
    <Value>Production Network</Value>
  </PropertyValue>
</ArrayOfPropertyValue>
```
8. Add the value expression to the child property.
   a. In a text editor or similar tool, format the value expression so that it is a single string with no
      line breaks.
   c. Click Add Property Attribute.
   d. From the Type drop-down list, select ValueExpression.
   e. In the Name box, type expression.
   f. Copy the value expression from the text editor and paste it into the Value box.
   g. Click the Save button.
   h. Click OK.

9. Add both properties to a blueprint.
   a. Create a new blueprint or edit an existing blueprint.
   b. Click the Properties tab.
   c. Click New Property.
   d. In the Name box, type `VirtualMachine.Network0.Environment`. This must be an exact
      match (case- and white space–sensitive).
   e. Leave the Value blank.
   f. Select Prompt User.
   g. Click the Save button.
   h. Repeat steps c-g for `VirtualMachine.Network0.Name`.
   i. Click OK.

When a user requests a machine using this blueprint, the “Environment” and “Select Network” drop-
down lists now appear on the Confirm Machine Request page and are initially empty. The user can
select an environment, which then narrows the list of network they can select from for the machine that
they are requesting.

**Control Layout Example**

In this example, we demonstrate how to create and use a control layout.

To use a control layout on a blueprint:
1. Click **Enterprise Administrator > Property Dictionary**.

2. Create the properties to use in the layout.
   a. Click **Add Property Definition**.
   b. In the **Name** box, type **ControlLayout.Network.Title**.
   c. In the **Display Name** box, type **Title**.
   d. From the **Control Type** list, select **Label**.
   e. Click the **Save** button.
   f. If you have not created the **VirtualMachine.Network.Environment** and **VirtualMachine.Network0.Name** properties from a previous example, create two simple text box properties in their place:

<table>
<thead>
<tr>
<th>Name</th>
<th>Display Name</th>
<th>Control Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VirtualMachine.Network.Environment</td>
<td>Environment</td>
<td>TextBox</td>
</tr>
<tr>
<td>VirtualMachine.Network0.Name</td>
<td>Network</td>
<td>TextBox</td>
</tr>
</tbody>
</table>

3. Create a control layout.
   a. Click **Enterprise Administrator > Property Dictionary**.
   b. Click **Add Property Layout**.
   c. In the **Name** box, type **NetworkLayout**.
   d. Click the **Save** button.

4. Add the properties you just created to the layout.
   a. Under **Property Instances**, click **Edit**.
   b. In the **Order** box, type **1**.
   c. From the **Property Definition** drop-down, select **ControlLayout.Network.Title**.
   d. Click the **Save** button.
   e. Repeat steps b-d with the following values:

<table>
<thead>
<tr>
<th>Order</th>
<th>Property Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>VirtualMachine.Network.Environment</td>
</tr>
<tr>
<td>3</td>
<td>VirtualMachine.Network0.Name</td>
</tr>
</tbody>
</table>
   f. Click **OK**.

5. Add the layout to a blueprint.
   a. Create a new blueprint or edit an existing blueprint.
   b. On the **Properties** tab, click **New Property**.
   c. In the **Name** box, type **VirtualMachine.Request.Layout**.
   d. In the **Value** box, type **NetworkLayout**.
   e. Leave the **Prompt User** check box unselected.
   f. Click the **Save** button.
6. Add the properties contained in the layout to the blueprint.
   a. Click **New Property**.
   b. Add the three properties as follows:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Prompt User</th>
</tr>
</thead>
<tbody>
<tr>
<td>ControlLayout.Networks.Title</td>
<td>Select an environment and network:</td>
<td>Yes</td>
</tr>
<tr>
<td>VirtualMachine.Network0.Name</td>
<td>[leave empty]</td>
<td>Yes</td>
</tr>
</tbody>
</table>

   c. Click **OK**.

   When a user requests a machine using this blueprint, the Confirm Machine Request page looks like the following:

   ![Request Information](image)

   If there are any other custom properties that are specified as Prompt User on this blueprint, they would appear between **Select Network** and **Reason for request**.
Appendix A Reconfigure Machine

This appendix describes the reconfigure machine feature. Reconfiguring machines is only available for virtual machines provisioned using VMware vSphere.

About Reconfiguring Machines

The reconfigure machine feature enables machine owners to modify the compute resources of a virtual machine.

A machine owner can make any of the following changes to a provisioned machine:

- Increase or decrease Memory
- Increase or decrease the number of CPUs
- Modify Storage by adding, removing, or increasing the size of volumes (SCSI disks only)
- Modify Networks by adding, removing, or updating network adapters

Changes to each of these parameters are subject to limits defined in the blueprint that was used to provision the machine. Reconfigure requests can also be made subject to approval, as with provisioning requests.

By default, the reconfiguration executes immediately after any necessary approvals, but a machine owner can optionally schedule a reconfiguration for a specific time or opt to trigger the reconfiguration manually after it is approved.

The virtual machine must be powered off when the reconfiguration occurs. To enable vCAC to shut down virtual machines cleanly before reconfiguration, VMware Tools must be installed on the guest operating system of the machine being reconfigured.

Reconfiguration Life Cycle

To reconfigure a machine, it must have been provisioned from a blueprint that allows reconfiguration. For details about enabling the reconfigure machine feature for a blueprint, see “Enabling Reconfigure Machine on Blueprints ” on page 291.

A machine owner can request a reconfiguration when the machine is in either the On or Off state. vCAC checks whether approval is required based on the approval policy and approval thresholds specified in the blueprint.

Once the request is approved, the reconfiguration is ready to be executed. The three options for when to execute the reconfiguration are:

- Immediately — The reconfiguration is automatically queued for execution after all required approvals have been given.
- Scheduled — The machine owner specifies a date and time to execute the reconfiguration. Execution can be rescheduled if the request is not approved until after the scheduled time.
- Queue for Owner — The reconfiguration must be triggered manually by the machine owner after all approvals have been given.
Before proceeding with the reconfiguration, vCAC validates that any additional resources that were requested are available on the current reservation. If the reconfiguration request decreases the amount of resources used by the machine, these resources are not deallocated and made available to other requests until after the reconfiguration completes successfully.

**Note:** Machines can be reconfigured using a reservation that has been disabled. Therefore, it is important to monitor resources that are part of disabled reservations.

If the virtual machine is powered on when the reconfiguration begins, it is shut down or powered off before reconfiguring and then powered back on at the end of the reconfiguration. If the virtual machine is powered off when reconfiguration begins, it remains powered off at the end of the reconfiguration process.

If the reconfiguration fails, any additional resources (such as storage) that were allocated in anticipation of the reconfiguration are deallocated and made available to other machine requests. The machine owner has the option to retry the reconfiguration (without any additional approval process) or to cancel the reconfiguration.

Email notifications are sent, as with a new provisioning request, at each stage of the approval process and upon completion of the reconfiguration, whether it was successful or not.

**About Reconfiguration Status**

The status of the machine is updated with a reconfiguration status that reflects the current stage of the reconfiguration life cycle as it goes through approval and execution. The reconfiguration status appears in parentheses after the machine status. For example, when a reconfigure request has been submitted and requires approval, the machine may have the status **On (Reconfigure.WaitingForApproval)**.

The following diagram shows the reconfiguration statuses and their place within the overall reconfiguration life cycle.
Configuring the Reconfigure Machine Feature

This section assumes that you are familiar with creating blueprints and the basic provisioning and approval process. They describe how the process differs when using the reconfigure machine feature.

**Enabling Reconfigure Machine on Blueprints**

You can enable the reconfigure machine feature on virtual blueprints that use vSphere for provisioning.
To enable reconfigure for a specific blueprint:

1. Select a blueprint:
   - New – Choose New Blueprint > Virtual > vSphere (vCenter).
   - Existing – Point to a blueprint with a Platform type of vSphere (vCenter) and click Edit.
2. On the Blueprint Information tab, specify blueprint details as you would for any blueprint.
3. In the Machine Resources section of the Build Information tab:
   a. Specify the Minimum value for # CPUs and Memory (MB).
   b. Optionally, specify a minimum and maximum number of days and an approval threshold for the machine lease. Leave the fields blank for no expiration date.
   c. Add at least one volume to the blueprint.
      • Click Add Volume.
      • Specify a minimum value for Capacity (GB).
      • Optionally, specify other values such as Drive Letter, Label, or Storage Reservation Policy.
      • Click the Save button to save the new volume.
      • Optionally, specify custom properties for this volume by clicking Edit under Custom Properties.
   For more information about configuring storage volumes, see “Using Multiple Datastores for Machine Volumes” on page 299.
   d. To offer the machine owner a choice within a range of values for CPUs, memory, or storage, specify a Maximum value for the appropriate resource. This maximum applies to both the initial machine request and any reconfigure request.
   e. If you have specified an approval policy on the Blueprint Information tab and a maximum value for a machine resource, you can optionally specify an approval threshold in the Approval At column. When the machine owner selects a value at or above the threshold, or if there is a maximum value but no threshold for a particular resource, approval is required before the machine is provisioned or reconfigured.
   f. Specify the maximum number of volumes. Leave the field blank to accept the default maximum of 15 volumes. Specify a value of 0 to disable the addition of volumes.
   g. Specify the maximum number of network adapters. Leave the field blank for no limit. Specify a value of 0 to disable the addition of network adapters.
4. On the Properties tab, specify custom properties as you would for any blueprint.
5. On the Security tab, specify the blueprint access and enable machine operations as you would for any blueprint.
6. In the Reconfigure section:
a. Specify whether to **Allow reconfigure** for machines provisioned from this blueprint.

b. To enable users requesting a reconfigure to specify when to execute the reconfiguration (immediately, at a scheduled time, or on owner approval), select **Enable execution selector**. If this option is disabled, the reconfiguration is always executed immediately after any necessary approvals.

c. To enable users requesting a reconfigure to specify whether vCAC should attempt to shut down a machine before reconfiguring it, select **Enable force shutdown**. If this option is disabled on the blueprint, force shutdown is always selected when a user requests a reconfigure.

Recall that the machine must be powered off for reconfiguration. If the machine is powered on when the reconfiguration begins, the force shutdown option enables vCAC to perform a graceful shutdown of the guest operating system before powering off the machine so that the reconfiguration can proceed. Shutting down a virtual machine requires VMware Tools to be installed on the guest OS.

### About Approving Reconfigure Requests

Machine reconfiguration requests use the same approval policy as for machine provisioning requests. Reconfigure requests are listed in a separate section on the Machine Requests page from provisioning requests. You can view a summary of the changes that are being requested for the machine by clicking the **View more information** button next to the machine name. You must either approve or reject the entire reconfigure request; you cannot approve a change in one resource (such as CPU) and reject another aspect (such as storage) if both resources were modified in the same request.

Advanced approval, including the option to delegate approvals, is not supported for reconfiguration. If a machine is provisioned from a blueprint that uses an advanced approval policy, then the reconfigure approval ignores any <<Owner>> steps and any steps after the [MachineProvisioning] step.

By default, vCAC determines whether a reconfigure request requires approval according to the same rules as for provisioning requests. That is, if a blueprint has an approval policy, and any machine resource has both a minimum and maximum value, then approval is required if the user requesting the reconfigure selects a value for that resource at or above the approval threshold or if no approval threshold is specified in the blueprint.

You can require approval for all reconfigure requests (regardless of whether the approval thresholds are met) by setting the **Require approval for all requests** property to **true** on the **vCAC Administrator > Global Properties** page. This applies only to blueprints that have an approval policy (including Default Approval).

### About Automatic Approval of Reconfigure Requests

Reconfigure requests may be automatically approved under certain circumstances, even if the approval thresholds are reached.

There are two cases where a reconfigure request is automatically approved:

- In the case of default (or group manager) approval, if the user requesting the reconfigure is a manager of the provisioning group
- Within a custom approval policy, if the requester is the only approver in the approval group

The above rules for automatic approval apply to a single step within an approval workflow. For example, suppose that a blueprint has a custom approval policy with several steps beginning with provisioning...
group manager approval followed by approval from Finance and IT. Amy is a provisioning group man-
ger as well as one of the approvers in the Finance approval group. When she requests a reconfigura-
tion for one of her machines (or any machine in her provisioning group), the following occurs:

1. The first step is automatically approved, so Amy does not have to approve her own request as
   provisioning group manager.

2. At the second step, because Amy is not the only approver in the Finance group, the request is
   sent to all the approvers in the group. Amy may approve her own request or another approver in
   the group may approve it.

3. At the final step, the request must be approved by someone in the IT group.

Automatic approval is enabled by default and applies to reconfigure requests only. You can disable auto-
matic approval by setting the Allow automatic approvals property to false on the vCAC Administra-
tor > Global Properties page.

**About Notification Emails for Reconfigure**

Notification emails are sent for the following events related to reconfiguring machines:

- When a reconfigure request requires approval
- When a reconfigure request is approved or rejected
- When a reconfiguration is queued for the owner to execute it
- When the reconfigure completes, with information about whether it was successful or not

The configuration for reconfiguration emails (including SMTP server information and the email address
from which the emails are sent) are specified through the same global properties as other vCAC emails.
For more information, see “Customizing Automatic Emails” on page 227. The text of reconfiguration
emails cannot be customized.

**Reconfiguring a Machine**

You can request reconfiguration of a machine by editing the machine when its status is either On or Off.
The aspects of the machine that you can reconfigure (CPU, Memory, Storage, Network) are defined in
the blueprint that you used to provision the machine. Some of the options described below may not be
available for a particular machine depending on its blueprint.

To request a reconfiguration:

1. Log in to vCAC.
2. Do one of the following:
   a. As a machine owner, click Self-Service > My Machines.
   b. As a provisioning group manager, click Provisioning Group Manager > Group Machines.
   c. As an enterprise administrator, click Enterprise Administrator > Enterprise Machines.

The machine you want to reconfigure should have the status On or Off with no active reconfig-
ure status.

3. Point to the name of the machine and click Edit.
4. On the **Machine Info** tab, you can adjust the number of CPUs and amount of Memory on the machine. The ranges are the same as when you requested the new machine from this blueprint, and are subject to the same approval thresholds.

5. On the **Storage** tab, you can add volumes, remove volumes, or increase the size of existing volumes.

   **Note:** Reconfigure is not supported for IDE disks.

   - To add a new volume, click **Add Volume**, specify the **Capacity** in GB, and click the **Save** button. Optionally, you can also specify a **Storage Reservation Policy** for the new volume or specify custom properties for the volume.
   - To remove a volume, click the **Delete** button next to the disk. You cannot remove volume 0.
   - To increase the size of an existing volume, click the **Edit** button next to the volume, specify a new value for **Capacity**, and click the **Save** button. You cannot reduce the size of existing volumes.

   Volume size is limited by the total amount of storage specified in the blueprint. For example, if the blueprint has a maximum storage capacity of 30GB, and you provision a machine with 10GB of initial storage, you have 20GB remaining to allocate to existing volumes or additional volumes.

6. On the **Network** tab, you can add network adapters, remove network adapters, or edit existing adapters.

   - To add a new network adapter, click **Add Network Adapter**, select the network under **Name**, and click the **Save** button. All networks enabled on the machine’s reservation are available. Each adapter on the machine must be connected to a unique network.
   - To remove a network adapter, click the **Delete** button next to the network adapter. You cannot remove the first network adapter.
   - To edit an existing network adapter, click the **Edit** button next to the network adapter, select a new network under **Name**, and click the **Save** button.

7. On the **Execution** tab, specify additional information about the reconfigure request.

   a. From the **Execute request** dropdown list, select an option for when to execute the reconfiguration:

      - If you select **Immediately**, the reconfiguration begins as soon as possible after it is approved.
      - If you select **Scheduled**, you can specify a date and time to execute the reconfiguration.

   **Note:** The scheduled time is the local time where the vCAC web server is located. If you are not in the same time zone as the server, you should manually calculate the server time when scheduling a reconfiguration.

      - If you select **Queue for Owner**, the reconfiguration is put on hold after any necessary approvals until you execute it. For more information, see “Executing an Approved Reconfiguration” on page 296.

      If the **Execute request** option is not available, the reconfiguration is executed immediately.
b. If you want vCAC to attempt to shut down the machine safely before reconfiguring, select **Shut down machine before reconfigure**. If the shutdown operation fails for any reason, the reconfiguration is canceled. If the machine is powered off before requesting the reconfiguration, you can clear the selection for this option. If you do not select this option and the machine is powered on when the reconfiguration begins, vCAC performs a hard power-off (the equivalent of pulling the plug) before reconfiguring the machine.

If the virtual machine is powered on when the reconfiguration begins, it is shut down or powered off before reconfiguring and then powered back on at the end of the reconfiguration. If the virtual machine is powered off when reconfiguration begins, it remains powered off at the end of the reconfiguration process.

c. Optionally, specify a reason for the reconfiguration. This information is passed along with the request to approvers.

8. Click **OK** to submit the reconfigure request.

An entry appears in the Recent Events pane for the machine owner and the requester (if different), including a brief summary of the reconfigure request, and the request is sent for approval if necessary.

**Executing an Approved Reconfiguration**

If you select **Queue for Owner** when specifying when a reconfigure request should be executed, the request is held after it goes through any required approvals until you trigger it manually.

When the request is approved, you receive an email notifying you that the reconfiguration is waiting for your final approval to proceed.

To execute an approved reconfiguration:

1. Click the link in the notification email or log in to vCAC and click **My Machines**.

   The machine that is being reconfigured should have the status **On** or **Off** with a reconfigure status of **Reconfigure.QueuedForOwner**.

2. Expand the **My Pending Requests** section.

   The **My Pending Requests** grid appears below **My Machines** and **My Multi-Machine Services**. Expand it by clicking on the arrows at the right end of the header.

3. Locate the machine that you want to reconfigure.

4. Click **Approve**.

The reconfiguration proceeds. Refresh the My Machines page to view the status of the reconfiguration.

**Retrying a Reconfiguration**

If a reconfiguration fails, you receive a notification email and you have the option to retry the reconfiguration without seeking approval.

To retry a reconfiguration:

1. Click the link in the notification email or log in to vCAC and click **My Machines**.

   The machine should have the status **On** or **Off** with one of the reconfigure status **Reconfigure.WaitingForRetry**.

2. In the **Recent Events** section, locate the message that describes the error that prevented the reconfiguration from completing successfully.
4. Resolve the error or work with an administrator to resolve it.
5. Point to the name of the machine and click **Execute Reconfigure**.
6. Specify a date and time to execute the reconfiguration or select **Now** to execute it immediately.
7. Click **OK**.

**Rescheduling a Reconfiguration**

You can reschedule a reconfiguration (which includes the option to execute it immediately) if the reconfiguration has not already occurred.

Additionally, if a reconfigure request is not approved until after the time when it was scheduled to execute, you can specify a new time or execute it immediately. You receive a notification email when a reconfiguration request is approved. The approval email does not indicate whether the reconfiguration is scheduled or whether the scheduled time has already passed, so you should check the status of your request after it is approved to see if you need to take any action.

To reschedule a reconfiguration:

1. Click the link in the notification email or log in to vCAC and click **My Machines**.
2. The machine should have the status **On** or **Off** with one of the following reconfigure statuses:
   - **Reconfigure.Pending**
   - **Reconfigure.WaitingForApproval**
   - **Reconfigure.Scheduled**
   - **Reconfigure.WaitingForExecution** (indicates that approval occurred after the scheduled time)
3. Point to the name of the machine and click **Execute Reconfigure**.
4. Specify a date and time to execute the reconfiguration or select **Now** to execute it immediately.
5. Click **OK**.

**Canceling a Reconfiguration**

You can cancel a reconfiguration if it is waiting for approval or if it has been approved and is waiting for execution.

To cancel a reconfiguration:

1. Log in to vCAC and click **My Machines**.
2. The machine should have the status **On** or **Off** with one of the following reconfigure statuses:
   - **Reconfigure.WaitingForApproval**
   - **Reconfigure.QueueedForOwner**
   - **Reconfigure.Scheduled**
   - **Reconfigure.WaitingForExecution**
   - **Reconfigure.WaitingForRetry**
3. Point to the name of the machine and click **Cancel Reconfigure**.
4. Click **OK**.

**Troubleshooting Reconfigure Machine**

This section describes issues you may encounter when using the reconfigure machine feature.

**Data Collection**

vCAC may display temporarily incorrect information about virtual machines immediately after reconfiguring.

This can occur when reconfiguration and data collection are running concurrently. For example:

- A virtual machine is powered on and is automatically shut down in preparation for reconfiguration. While the machine is powered off, state data collection runs and records the power state of the machine as **Off**. The reconfiguration process completes and the machine is powered on, but it still appears as **Off** in the vCAC Console.

- A virtual machine is reconfigured while inventory data collection is being performed. Depending on the point within the data collection process at which the machine is reconfigured, the machine may display the old value for the reconfigured resource (detected by the agent before the reconfiguration occurred) after the reconfiguration is complete.

Another case is when a virtual machine that is managed by vCAC is reconfigured directly in vSphere rather than through vCAC and the information in vCAC no longer reflects the current specifications of the machine.

In these and similar situations, the machine is updated with the correct information the next time data collection runs. Both state and inventory data collection are scheduled to run at regular intervals. Alternatively, as an enterprise administrator, you can run data collection on the affected compute resource from the **Enterprise Administrator > Compute Resources** page to refresh the information in vCAC.

**Destroying Machines**

If a machine has an active reconfigure status, the Destroy operation is not available in the machine menu.

If you want to destroy a machine that has an active reconfigure status, you must first cancel the reconfiguration. This includes the case where a machine goes missing or it expires while a reconfigure is not yet complete. See “Canceling a Reconfiguration ” on page 297.
Appendix B Using Multiple Datastores for Machine Volumes

The multi-storage feature enables you to assign the volumes of a virtual machine to different datastores for the vSphere, SCVMM, and KVM platform types.

Having the ability to assign the volumes of a virtual machine to different datastores allows you to control and use storage space more effectively. For example, you might deploy the operating system volume to a slower, less expensive datastore and the database volume to a faster datastore.

You can assign a single datastore or a storage reservation policy representing multiple datastores to a volume. When you assign a single datastore to a volume, vCAC uses that datastore at provisioning time, if possible. When you assign a storage reservation policy to a volume, vCAC uses one of its datastores at provisioning time, if possible. A storage reservation policy is essentially a tag applied to one or more datastores. It allows you to group datastores that have similar characteristics, such as speed or price. A datastore can be assigned to only one storage reservation policy at a time, but a storage reservation policy can have many different datastores.

The enterprise administrator creates a storage reservation policy and assigns it to one or more datastores. The enterprise administrator or provisioning group manager then assigns the storage reservation policy to a volume in a virtual blueprint. When a user requests a virtual machine that uses the blueprint, vCAC uses the storage reservation policy specified in the blueprint to select a datastore for the machine’s volume.

You have the following options when adding or editing a volume in a virtual blueprint:

- **Assign a single datastore to the volume.** This one-to-one relationship allows vCAC to assign a storage volume only the specified datastore at provisioning time. If the datastore is not available or lacks sufficient space, provisioning fails. See “Assigning Datastores to Volumes” on page 302.

- **Assign a storage reservation policy to the volume.** This allows vCAC to select one of the datastores associated with the storage reservation policy at provisioning time. If the policy’s datastores are unavailable or lack sufficient space, provisioning fails. For information about how to override this restriction, see “Allowing Alternative Datastores at Provisioning Time” on page 301.

- **Not assign a datastore or a storage reservation policy to a volume.** This allows vCAC to select from all available datastores at provisioning time. Provisioning fails if a datastore with sufficient space is not available.

vCAC also uses a datastore’s priority (as assigned by its reservation) to select a datastore from among eligible datastores at provisioning time.

You should generally avoid specifying a storage path and a storage reservation policy for the same volume, though there may be times when this is desirable. If this situation does arise, the storage path takes precedence over the storage reservation policy.

Creating a Storage Reservation Policy

The enterprise administrator can create, update, delete, and assign a storage reservation policy.

To create a storage reservation policy:

1. Log on as an Enterprise Administrator.
2. Select **Reservation Policies**.

3. Click **New Storage Reservation Policy** in the **Storage Reservation Policies** title bar.
   
   In the **Name** field, enter a name for the storage reservation policy. For example, a tiered strategy might have policies named Tier 1, Tier 2, and Tier 3.

4. In the **Description** field, you can type additional information.

5. Click the **Save** button.

Your current storage reservation policies appear at the bottom of the page. After creating a storage reservation policy, you can assign it to a compute resource.

### Assigning Storage Reservation Policies to a Compute Resource

A storage reservation policy must be assigned to one or more datastores before you can use it with a volume. Assigning a storage reservation policy to multiple datastores creates an exclusive group of datastores for use with a blueprint.

The enterprise administrator assigns storage reservation policies to datastores on the Compute Resources page.

To assign a storage reservation policy to a datastore:

1. Log on as an Enterprise Administrator.

2. Select **Compute Resources**.

3. Point to an existing compute resource and click **Edit**.

4. Go to the **Configuration** tab.

5. In the **Storage Path** column, click the **Edit** button next to the datastore you want to assign to a storage reservation policy.

6. In the **Storage Reservation Policy** column, select the storage reservation policy to assign to the datastore.

7. To assign storage reservation policies to additional datastores, repeat steps 5 and 6.

8. Click the **Save** button.

9. Click **OK**.

You can see which datastores are associated with a storage reservation policy by clicking **Compute Resources** and then going to the **Configuration** tab.

### Using Disk Properties with Volumes

Disk properties allow you to specify a volume’s storage capacity, labeling, and other properties. For create, clone, and Flexclone blueprints, you must use the **Volumes** grid to specify these properties. For a linked clone blueprint, you must use the **Properties** tab. Disk properties can only be specified on the **Volumes** grid in virtual blueprints for the vSphere, SCVMM, and KVM platforms.

The disk properties described in this section allow you to assign datastores to volumes, assign storage reservation policies to volumes, and to let vCAC use alternative datastores for volumes at provisioning time.
Using Disk Properties on the Volumes Grid

To create a disk property for a volume in the Volumes grid:

1. Log on as an Enterprise Administrator or Provisioning Group Manager.
2. Select Blueprints.
3. Select a blueprint:
   - New – Choose New Blueprint > Virtual.
   - Existing – Point to a create, clone, or Flexclone blueprint for a virtual machine and click Edit.
4. Go to the Build Information tab. If creating a blueprint, select either Hyper-V (SCVMM) or vSphere (vCenter) as the Platform type and then, in the Volumes grid, click Add Volume.
5. In the Custom Properties column of the Volumes grid, click Edit for the targeted volume. The Custom Properties popup appears.
6. Click New Property.
7. In the Name and Value fields, enter the disk property name (use the last part only; omit Virtual-Machine.DiskN.) and value.
8. Click the Save button.
9. Repeat steps 6 through 8 for to create more properties.
10. Click the x at the top of the popup to close it.
11. Click OK.

Using Disk Properties on the Properties Tab

To create a disk property for a volume on the Properties tab:

1. Log on as an Enterprise Administrator or Provisioning Group Manager.
2. Select Blueprints.
3. Point to a blueprint for a virtual machine and click Edit.
4. Go to the Properties tab.
5. Click New Property.
6. In the Name and Value fields, enter the full disk property name and value.
7. (Optional) Select the Prompt User check box. When you select this option, machine owners can see the property and change the value during a machine request. When you unselect the option, they cannot see or change the property during a machine request.
8. Click the Save button.
9. Click OK.

Allowing Alternative Datastores at Provisioning Time

VirtualMachine.DiskN.StorageReservationPolicyMode (with values Exact and NonExact) determines whether vCAC can use datastores not associated with a volume’s storage reservation policy. This disk property can be used with create, clone, Flexclone, and linked clone blueprints. NonExact allows
vCAC to use other datastores when no space is found in the datastores associated with the storage reservation policy. **Exact** requires vCAC to use only the datastores associated with the storage reservation policy, and if none of the datastores has sufficient space for the volume, then provisioning fails. **Exact** is the default value.

With create, clone, and Flexclone blueprints, you must use the **Volumes grid** to enter the disk property. With linked clone blueprints, you must use the **Properties tab**. When using the property in the **Volumes grid**, you specify only the last part of the property name and not the full property name. When using the disk property on the **Properties tab**, you must specify the full property name.

### Assigning Datastores to Volumes

**VirtualMachine.DiskN.Storage** assigns the specified datastore to volume 0 and can be used with create, clone, Flexclone, and linked clone blueprints. This property is equivalent to the **Storage Path** field in the **Volumes grid**. Enter the datastore name as it appears in the **Storage Path** column on the **Configuration tab** of **Compute Resources**.

**Note:** When you assign a datastore to a volume, do not specify a storage reservation policy for the same volume. If a volume does have a storage path and a storage reservation policy, the storage path takes precedence during provisioning.

With create, clone, and Flexclone blueprints, you must use the **Volumes grid** to enter the disk property. With linked clone blueprints, you must use the **Properties tab**.

### Assigning Storage Reservation Policies to Volumes (Linked Clone Only)

**VirtualMachine.DiskN.StorageReservationPolicy** assigns the specified storage reservation policy to volume 0 and can be used only with linked clone blueprints. This property is equivalent to the **Storage Reservation Policy** field in the **Volumes grid**.

**Note:** If you use **VirtualMachine.Disk0.StorageReservationPolicy** or **VirtualMachine.Disk0.Storage**, the virtual machine is provisioned on the same storage as Volume 0. To change this, use the property **VirtualMachine.Storage.Name**. For
Using Storage Reservation Policies in a Blueprint

Storage reservation policies can be assigned to virtual machine volumes at several points during the provisioning process. An enterprise administrator or provisioning group manager can assign storage reservation policies when editing or creating virtual blueprints. A machine owner can assign a storage reservation policy when requesting a virtual machine, if the current blueprint allows it. This section focuses on using storage reservation policies in blueprints.

The Volumes grid assists you in assigning storage reservation policies in create, clone, and Flexclone blueprints. With linked clone blueprints, you use custom properties to assign storage reservation policies. This section explains how to use both methods.

**Note:** Create, Clone, Flexclone, and Linked Clone are the Action field values found on the Build Information tab of the Edit Blueprint – Virtual page.

When using clones, the volumes of the cloned template appear in the Machine Resources section on the Build Information tab. You cannot remove them, change their capacity, or specify a drive letter/mount path or label for them. However, you can specify a storage path or assign a storage reservation policy to the volumes.

You can use a build profile to specify the same disk property values for multiple blueprints. Simply specify the full names and values of the disk properties in the build profile and apply the build profile to the blueprints. If a blueprint and the build profile have the same disk property but different values, the blueprint takes precedence over the build profile.

**Using Create, Clone, or Flexclone Blueprints**

To assign a storage reservation policy to a volume using a create, clone, or Flexclone blueprint:

1. Log on as an Enterprise Administrator or Provisioning Group Manager.
2. Select Blueprints.
3. Select a blueprint:
   - New – Choose New Blueprint > Virtual > vSphere (vCenter), New Blueprint > Virtual > Hyper-V (SCVMM), or New Blueprint > Virtual > KVM (RHEV).
   - Existing – Point to a create, clone, or Flexclone blueprint for a virtual machine and click Edit.
4. Click the Build Information tab.
5. In the Volumes grid, click Add Volume or click the Edit button next to an existing volume.
6. In the volume’s Storage Reservation Policy list, select a storage reservation policy. If adding a volume, you must specify a value for Capacity (GB).
7. Click the Save button.
8. To assign storage reservation policies to other volumes, repeat steps 5, 6, and 7.
9. (Optional) Select the Allow user to see and change storage reservation policies check box. Selecting this box allows the user to see and change the storage reservation policy in the volume.
volume information on the Storage tab of the Confirm Machine Request page, and when adding a volume on the Storage tab of the Edit Machine – Virtual page.

10. (Optional) Enter a maximum value for Storage (GB) in the Machine Resources section. Doing so allows the user to increase the size of the volumes in the blueprint and/or add volumes. If you selected the check box in the previous step, the user can also select a storage reservation policy when adding volumes.

11. Click OK to save the configuration.

The Custom Properties column in the Volumes grid does not accept values for the Size, Letter, Label, and Storage Reservation Policy disk properties (disk properties have Disk in their full names; for example, VirtualMachine.DiskN.Size). To enter a value for one of these disk properties, use its corresponding field in the Volumes grid. For example, to specify the Label disk property value for a volume, enter the value in the Label field when you add or edit the volume. Note that the Size disk property corresponds to the Capacity (GB) field, the Letter disk property to the Drive Letter/Mount Path field, and the Storage Reservation Policy property to the field of the same name.

Using Linked Clone Blueprints

To assign a storage reservation policy to a volume using a linked clone blueprint:

1. Log on as an Enterprise Administrator or Provisioning Group Manager.
2. Select Blueprints.
3. Select a blueprint:
   - New – Choose New Blueprint > Virtual > vSphere (vCenter), New Blueprint > Virtual > Hyper-V (SCVMM), or New Blueprint > Virtual > KVM (RHEV).
   - Existing – Point to a linked clone blueprint for a virtual machine and click Edit.
4. On the Build Information tab, select vSphere (vCenter) as the Platform type and Linked Clone as the Action; then select a vSphere machine and snapshot in Clone from.
5. Click the Properties tab.
7. In the Name field, type VirtualMachine.DiskN.StorageReservationPolicy where N is the index (starting at 0) of the volume you want to assign to a storage reservation policy.
8. In the Value field, type the name of the storage reservation policy to assign to the volume.
9. (Optional) Select the Prompt User check box. When you select this option, users can see the property and change the storage reservation policy value during a machine request. When you unselect the option, users cannot see or change the property during a machine request.
10. Click the Save button.
11. Select New Property again.
12. In the Name field, type VirtualMachine.DiskN.Size where N is the index you used in step 5.
13. In the Value field, type the amount of storage capacity (in gigabytes) to assign to the volume.
14. Click the Save button.
15. Click OK.
Requesting a Machine with Storage Reservation Policies

When requesting a machine, you can add, update, and remove storage reservation policies, if the blueprint allows it. If you are using a create, clone, or Flexclone blueprint to provision the machine and you have access to the storage reservation policies, then the Confirm Machine Request page displays the Storage tab and on it the Volumes grid where you can work with the policies. If you are using a linked clone blueprint and you have access to the storage reservation policies, then the Confirm Machine Request page does not display the Storage tab. Instead, it displays the storage reservation policies as editable property values.

To add, update, or remove storage reservation policies:

1. Click Self-Service > Request Machine.
2. If you are a member of multiple provisioning groups, select a group.
3. Click on a virtual blueprint.
4. On the Confirm Machine Request page:
   - (Storage tab with Volumes grid is present)
     a. Go to the Storage tab.
     b. In the Volumes grid, click Add Volume to create a volume or click the Edit button next to an existing volume.
     c. In the Storage Reservation Policy field, select a storage reservation policy, or select blank to remove the current one.
     d. Click the Save button.
   - (Storage tab is not present, but editable storage reservation policy names are present)
     a. Click on the storage reservation policy name you want to change.
     b. Edit the name and click OK.

Note: Leaving the field blank without a name deletes the property. This is not recommended.

Editing a Machine with Storage Reservation Policies

When you edit a provisioned machine (see “Reconfiguring a Machine” on page 294), you can add a storage reservation policy when you add a volume.

To add a storage reservation policy to a provisioned machine:

1. Click Self-Service > My Machines.
2. Point to an existing virtual machine and click Edit. The machine’s status must be On or Off.
3. Go to the Storage tab.
4. In the Volumes grid, Click Add Volume.
Note: If Add Volume is not present on the tab, then the blueprint used to provision the machine does not allow editing of storage on a provisioned machine and you are unable to add a storage reservation policy.

5. In the Storage Reservation Policy field, select a storage reservation policy.
6. Click the Save button.

Viewing the Machine’s Storage

By using multiple datastores, you can have the configuration file on a different datastore than volume 0 and other volumes. Two vCAC Console columns allow you to keep track of all datastores.

To view the locations of the configuration file, the machine’s datastores, and the volume/datastore assignments:

1. Based on your privileges, navigate to your machines:
   - Enterprise Administrator – Choose Enterprise Machines.
   - Provisioning Group Manager – Choose Group Machines.
   - Machine Owner – Choose My Machines.
2. Expand the drop-down list of Columns.
3. Select the following columns:
   - Storage Path – Displays the location of the configuration file.
   - Disk Storage Path Summary – Displays the datastores assigned to the machine.
4. Point to a virtual machine and click Edit.
5. Click the Storage tab.

The Volumes grid displays the volumes and their assigned datastores.
Appendix C Implementation Examples

The following instructions for integrating vCAC with BMC BladeLogic Configuration Manager and with HP Software Server Automation (formerly Opsware SAS) are provided as implementation examples of external system integration with vCAC.

**BMC BladeLogic**

By integrating BMC BladeLogic with vCAC, you can enable deployment of BladeLogic software jobs on machines provisioned by vCAC. These jobs can be either selected by the requesting user on a per-machine basis or applied to all machines provisioned from a particular blueprint.

To integrate BMC BladeLogic Configuration Manager with vCAC you must:

- Ensure that BMC BladeLogic Operations Manager 7.6.0.115 is installed on the same host as your EPI/BMC Agent
- Install at least one vCAC external provisioning integration (EPI) agent to manage interaction with BMC BladeLogic. The agent can be installed anywhere but must be able to communicate with both vCAC and BladeLogic Configuration Manager.
- If you want to make BladeLogic software jobs available to machine requestors in vCAC, add a file listing those jobs to vCAC
- Create a BladeLogic-ready template for cloning.
- Create a blueprint for BladeLogic integration, including custom properties for any BladeLogic software jobs to be deployed on machines provisioned from the blueprint.

**EPI Agent for BladeLogic Requirements**

If you are installing an EPI agent to interact with BMC BladeLogic Configuration Manager:

- Before installing an EPI/BMC Agent, BMC BladeLogic Operations Manager 7.6.0.115 must be installed on the same host as your EPI Agent. If the EPI agent is installed before BMC Operations Manager, then the agent service must be restarted after BMC Operations Manager is installed.
- The agent must be installed on a Windows Server 2008 SP2 (32 or 64-bit) or Windows Server 2008 R2 system with .NET 4.0 installed.
- The credentials under which the agent will run must have administrative access to all BladeLogic hosts with which the agent will interact.
- Microsoft PowerShell must be installed on the installation host prior to agent installation: The version required depends on the installation host’s operating system and may have been installed with that operating system. Visit [http://support.microsoft.com](http://support.microsoft.com) for more information.
- MS PowerShe[ll Execution Policy must be set to “RemoteSigned” or “Unrestricted”.]
Following installation of MS PowerShell, its Execution Policy is set to “Restricted”. This prevents any PowerShell scripts from running. To allow local PowerShell scripts to be run, you must set the PowerShell Execution Policy to “RemoteSigned” or “Unrestricted” using following steps.

1. As an Administrator, open the PowerShell command prompt using Start > All Programs > Windows PowerShell version > Windows PowerShell.

2. For “RemoteSigned”, enter the following command:
   ```bash
   Set-ExecutionPolicy RemoteSigned
   ```

3. For “Unrestricted”, enter the following command:
   ```bash
   Set-ExecutionPolicy Unrestricted
   ```

4. Verify that the command does not produce any errors.

5. Exit the PowerShell command prompt by entering `exit`.

For more information on PowerShell Execution Policy please type one of the following commands at PowerShell command prompt:

   ```bash
   help about_signing
   help Set-ExecutionPolicy
   ```

## Installing an EPI Agent for BladeLogic

To install a vCAC EPI agent for BladeLogic integration, follow these steps:

1. Place the agent installation file `DCAC-Agent-Setup.exe` on the installation host.

2. Select Start, right-click Command Prompt and select Run as administrator. In the command window you opened, change to the directory containing the installation file and execute `DCAC-Agent-Setup.exe` to launch the install wizard.

3. Click Next on the title panel to begin, read and accept the EULA, then continue.

   **Note:** If the vCAC agent installer detects existing vCAC agents installed on the host, it provides you with the option to upgrade those agents to the current version of vCAC. See the vCloud Automation Center Installation Guide for procedures for upgrading vCAC and vCAC agents.

4. On the Agent Name panel, provide a unique name for the agent and enter the host name of the vCAC server (this can be localhost if you are installing the agent on the vCAC server). If you select Use HTTPS as transport protocol further down the panel, you must enter the fully qualified name of the vCAC server.

   If vCAC was installed to use HTTPS as the transport protocol (see the vCloud Automation Center Installation Guide), select Use HTTPS as transport protocol, do the following:

   - In the vCloud Automation Center Hostname:Port box, specify the host name and port of the vCAC Server.
   - In the Model Manager Web Service Hostname:Port box, specify the host name and port of the Model Manager server.

5. On the Agent Selection panel, select EPI PowerShell Agent.
6. On the Agent Configuration panel, select **BMC** from the **EPI Type** dropdown. At the **EPI Server** prompt, you can enter the name of a BladeLogic Configuration Manager host or leave the field blank to let the agent interact with multiple hosts.

The BladeLogic host with which the agent interacts when provisioning a machine using BladeLogic depends on the value of a required custom property in the blueprint, **EPI.Server.Name** (discussed later in these instructions). Therefore,

- If you install a dedicated EPI agent by specifying a BladeLogic host name during installation, only machines whose **EPI.Server.Name** property *exactly matches the host name configured for the agent* can be provisioned by that host.

- If you install a general EPI agent by not specifying a BladeLogic host name during installation, a machine can be provisioned by any host specified in the blueprint’s **EPI.Server.Name** property (assuming the agent can contact that server).

7. On the Service Configuration panel, indicate that you want to register but not start the agent service as part of installation.

On the same panel, enter the credentials to be used by the agent service in **DOMAIN\username** format. This user must have administrative access to the machine the agent is being installed on as well as administrative access to all BladeLogic hosts with which the agent will interact.

8. On the final panel, press the **Install** button to complete the installation.

See the *vCloud Automation Center Installation Guide* for complete information about installing vCAC agents.

**Integrating BMC BladeLogic**

If a system from which BMC BladeLogic Configuration Manager deploys software is available on the network and you have installed an EPI agent to interact with it, software can be deployed from it directly to newly provisioned machines, with the requesting user selecting which software to deploy or the blueprint specifying the jobs to be deployed on all machines provisioned from it.

The following steps are required to integrate BladeLogic CM:

1. On the vCAC EPI/BMC Agent host, select **Start > Administrative Tools > Services** and then stop the vCloud Automation Center EPI/BMC Agent service.

2. On the EPI agent installation host (which may be the same as the manager service host), change to the EPI agent installation directory, typically `%SystemDrive%\Program Files (x86)\DynamicOps\DCAC Agents\agentname`.

3. Edit every file in the **Scripts\nsh** folder in the EPI agent directory except **shutdownMachine.nsh** and substitute the appropriate information in all occurrences of the following lines:

   ```
   blcli_setoption authType
   blcli_setoption userName
   blcli_setoption password
   blcli_setoption appserverHost
   blcli_setoption roleName
   ```

   where **authType** is **SRP** (this may not need to be changed), **userName/password** are the user-name and password used to access BladeLogic CM, **appserverHost** is the host name of the system hosting the Application Sever, and **roleName** is the access role assigned to **userName**.
4. Edit the file `Scripts\Functions\BmcFunctions.ps1`. In the line that reads
   
   \$wolApp = 'C:\Program Files (x86)\DynamicOps\vCAC\Agents\bladelogic\Scripts\WolCmd.exe'
   
   replace `bladelogic` with the name of the EPI agent directory so that the path to the scripts directory is correct.

5. Edit the agent configuration file, `VRMAgent.exe.config`, in the EPI agent directory. In the line
   
   
   replace `CitrixProvisioningUnregister.ps1` with `DecomMachine.ps1` so that it reads
   
   
6. If you intend to provision by cloning with static IP address assignment, you can enable BladeLogic registration of provisioned machines by IP address rather than machine name. To do this, edit the files `InstallSoftware.ps1` and `DecomMachine.ps1` in the `Scripts` folder in the EPI agent directory and change the line `$byip=$false` to `$byip=$true`.

   **Note:** If you enable registration by IP address by making the above change, you must provision with static IP address assignment, or BladeLogic integration will fail.

7. Start the EPI/BMC agent service (vCloud Automation Center Agent – `agentname` service) using `Start > Administrative Tools > Services`.

8. Place all the BladeLogic jobs you want available to be selected by machine requestors or specified by blueprint creators under a single location within BladeLogic CM, for example `/Utility`.

9. If you want to make software jobs available to the requesting user for selection on a per-machine basis, create a file called `Software.txt` to the `Website` directory under the vCAC server install directory (typically `%SystemDrive%\Program Files x86\DynamicOps\vCAC Server`). Each line of `Software.txt` must be in the following format:

   `job_name=job_type=job_path Job`

   where `job_name` is the name of the software job to be presented to the machine requestor, `job_type` is the numeral representing the BladeLogic job type, and `job_path` is the job's location within BladeLogic. Job types include the following:

### Table 1  BladeLogic Job Types

<table>
<thead>
<tr>
<th>Job Type Number</th>
<th>Job Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AuditJob</td>
</tr>
<tr>
<td>2</td>
<td>BatchJob</td>
</tr>
<tr>
<td>3</td>
<td>ComplianceJob</td>
</tr>
<tr>
<td>4</td>
<td>DeployJob</td>
</tr>
<tr>
<td>5</td>
<td>FileDeployJob</td>
</tr>
<tr>
<td>6</td>
<td>NSHScriptJob</td>
</tr>
<tr>
<td>7</td>
<td>PatchAnalysisJob</td>
</tr>
</tbody>
</table>
For example, to give the requestor her choice of two software deployment jobs and two file deploy jobs, you might create a `Software.txt` file like this:

```
Notepad++=4=/Utility/Notepad++ Job
Putty=4=/Utility/Putty Job
Red Hat Shell Scripts=5=/Utility/RHELScripts Job
Knowledge Base Library=5=/Utility/KBLibDec11 Job
```

10. Prepare a reference machine and convert it to a template for cloning.

When preparing the reference machine for these purposes you must

- Install a BladeLogic agent pointing to the server on which BladeLogic BMC is running
- Run the following command:
  ```
  Echo * rw,user=Administrator > %SystemDrive%\WINDOWS\rsc\exports
  ```

**Adding BMC BladeLogic Integration to a Blueprint**

To create a blueprint that enables deployment of BMC BladeLogic Configuration Manager software jobs on machines provisioned from it, create a blueprint for provisioning by cloning, then add the custom properties below. These are required unless otherwise noted.

As noted, software jobs can be either made available to individual machine requestors on a per-machine basis or specified in a blueprint to be applied to all machines provisioned from that blueprint.

- To make all the jobs listed in the `Software.txt` file you created in the previous procedure available to the machine requestor to select, include the property `LoadSoftware` with the value `True`.
- To specify a software job to be applied to all machines provisioned from the blueprint, include the custom property `VRM.Software.IdNNNN`, where `NNNN` is a number from 1000 to 1999, and set the value to
  ```
  job_type=job_path
  ```

  where `job_type` is the numeral representing the BladeLogic job type and `job_path` is the job's location within BladeLogic as described in the previous procedure, for example `4=/Utility/Putty`.

Remember that if you use provisioning by cloning with static IP address assignment, you can enable BladeLogic registration of machines by IP address rather than machine name.
**Note:** The custom properties can also be placed in a build profile which is then incorporated in the blueprint, and are included in a property set provided with vCAC. Custom Properties Required for BladeLogic Configuration Manager Integration

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
</table>
When this property has a non-Windows value, for example **rhel5Guest** for Red Hat Enterprise Linux 5, the Connect Using RDP option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint. |
| VirtualMachine.EPI.Type                            | Type of external provisioning infrastructure; set to **BMC** for BladeLogic integration.                                                                                                                                                                                                                                               |
| EPI.Server.Name                                    | Name of server hosting BladeLogic.  
If at least one general BMC EPI agent was installed without specifying a BladeLogic CM host, this value directs the request to the desired server.  
If only dedicated BMC EPI agents for specific BladeLogic CM hosts were installed, this value must match exactly the server name configured for one of these agents.                                                                                           |
| BMC.Service.Profile                                 | Name of the default authentication profile on the BladeLogic server.                                                                                                                                                                                                                                                                   |
| BMC.AddServer.Delay                                | Optionally, number of seconds to delay before adding the machine to BladeLogic; default is **30**.                                                                                                                                                                                                                                     |
| BMC.AddServer.Retry                                | Optionally, number of seconds to wait before retrying if the first attempt to add the machine to BladeLogic CM is unsuccessful; default is **100**.                                                                                                                                                                                                 |
| BMC.Software.Install                               | Set to **True** to enable BladeLogic integration.                                                                                                                                                                                                                                                                                    |
| BMC.Software.BatchLocation                         | Location within BladeLogic of software jobs to be deployed; must match the appropriate field in **Website\Software.txt** if this file exist or in value of VRM.Software.IdNNNN properties if these are used.                                                                                                                                                       |
| LoadSoftware                                       | Optionally set to **True** to make the software jobs listed in **Website\Software.txt** available for selection by the user requesting the machine.                                                                                                           |
By integrating HP Server Automation (SA) (formerly Opsware SAS) with vCAC, you can

- Provision virtual machines by using HP SA boot images. When you use this provisioning method you can optionally let the requesting user select among HP SA policies to install software on the requested machine, or specify HP SA policies in the blueprint to be applied to every machine provisioned from it.

- Provision virtual machines using provisioning by cloning with an HP SA-ready template. You can use this provisioning method to let each requesting user select among HP SA policies to install software on the requested machine or to specify HP SA policies in the blueprint to be applied to every machine provisioned from it, even though it is not created from an HP SA boot image.

To integrate HP SA with vCAC you must:

- Prepare at least one host for vCAC external provisioning integration (EPI) agent installation by installing the necessary PowerShell environment. The agent can be installed anywhere, including the vCAC server or the HP SA server, as long as the agent is able to communicate with both vCAC and HP SA.

- Install at least one to vCAC EPI agent to manage interaction with HP SA.

- In the agent directory
  - modify the agent configuration file
  - install the provided PowerShell scripts
  - create an HP SA password file

- If you want to enable software installation by HP SA on provisioned virtual machines
  - identify the HP SA policies you want to make available in vCAC

### Property | Definition
--- | ---
VRM.Software.IdNNNN | Optionally specify a software job to be applied to all machines provisioned from the blueprint; set the value to job_type=job_path, where job_type is the numeral representing the BladeLogic job type:
- 1 — AuditJob
- 2 — BatchJob
- 3 — ComplianceJob
- 4 — DeployJob
- 5 — FileDeployJob
- 6 — NSHScriptJob
- 7 — PatchAnalysisJob
- 8 — SnapshotJob
and job_path is the job’s location within BladeLogic, for example 4=/Utility/putty.
NNNN is a number from 1000 to 1999.

**HP Software Automation (Opsware SAS)**

By integrating HP Server Automation (SA) (formerly Opsware SAS) with vCAC, you can
• if you want to let individual machine requestors select from among the available HP SA policies, create a file listing those policies on the vCAC server

• If provisioning by creating from a boot image (rather than cloning virtual machines from a template), identify the HP SA boot image from which you want to provision virtual machines.

• If cloning from a template (rather than creating from a boot image), create an HP SA-ready template for cloning.

• Create a blueprint
  • for virtual provisioning from an HP SA boot image
  • for cloning from an HP SA-ready template

In either type of blueprint, you can optionally enable user selection of HP SA policies to be installed on the requested machine or specify the policies to be installed on every machine from the blueprint using custom properties

**EPI Agent for HP SA Requirements**

Ensure that these requirements are met on the host on which you will install the EPI agent for HP SA:

• The agent must be installed on a Windows Server 2008 SP2 (32 or 64-bit) or Windows Server 2008 R2 system with .NET 4.0 installed.

• The credentials under which the agent will run must have administrative access to all HP SA hosts with which the agent will interact.

• The following software must be installed on the installation host prior to agent installation:
  
  **Microsoft PowerShell:** The version required depends on the installation host’s operating system and may have been installed with that operating system. Visit [http://support.microsoft.com](http://support.microsoft.com) for more information.

  **Opsware PowerShell Snap-in** (included on the Opsware installation media). To install the snap-in, use these steps:

  1. Log into the installation host using credentials with administrator access.
  2. In the Start menu, right click Command Prompt and select Run as administrator.
  3. Change to the directory containing the PowerShell snap-in.
  4. Execute the command `msiexec /i OPSWpowershell-37.0.0.5-0.msi`
  5. Complete the installation, accepting all defaults.
  6. Open the PowerShell command prompt using Start > All Programs > Windows PowerShell 1.0 > Windows PowerShell.
  7. Enter the following PowerShell command:
  8. Add-PSSnapin ‘OpswareSasPs’
  9. Exit the PowerShell command prompt by entering exit.

• MS PowerShell Execution Policy the host must be set to “RemoteSigned” or “Unrestricted”.

Following installation of MS PowerShell, its Execution Policy is set to “Restricted”. This prevents any PowerShell scripts from running. To allow local PowerShell scripts to be run, you must set the PowerShell Execution Policy to “RemoteSigned” or “Unrestricted” using following steps.

1. Log into the installation host using credentials with administrator access.
2. Open the PowerShell command prompt using **Start > All Programs > Windows PowerShell**.
3. For “RemoteSigned”, enter the following command:
   ```powershell
   Set-ExecutionPolicy RemoteSigned
   ```
4. For “Unrestricted”, enter the following command:
   ```powershell
   Set-ExecutionPolicy Unrestricted
   ```
5. Verify that the command does not produce any errors.
6. Exit the PowerShell command prompt by entering **exit**.

For more information on PowerShell Execution Policy please type one of the following commands at PowerShell command prompt:

- **help about_signing**
- **help Set-ExecutionPolicy**

### Installing an EPI Agent for HP SA

To install a vCAC EPI agent for HP SA integration, follow these steps:

1. Before installing an EPI/Opsware Agent, Opsware PowerShell Snap-in must be installed on the same host as your EPI Agent. If the EPI agent is installed before the snap-in, then the agent service must be restarted after the snap-in is installed.
2. Place the file **DCAC-Agent-Setup.exe** on the installation host. This file can be downloaded from the VMware customer portal if necessary.
3. Select **Start**, right-click **Command Prompt** and select **Run as administrator**. In the command window you opened, change to the directory containing the installation file and execute **DCAC-Agent-Setup.exe** to launch the install wizard.
4. Click **Next** on the title panel to begin, read and accept the EULA, then continue.

**Note:** If the vCAC agent installer detects existing vCAC agents installed on the host, it provides you with the option to upgrade those agents to the current version of vCAC. See the **vCloud Automation Center Installation Guide** for procedures for upgrading vCAC and vCAC agents.

5. On the Agent Name panel, provide a unique name for the agent and enter the host name of the vCAC server (this can be **localhost** if you are installing the agent on the vCAC server). If you select **Use HTTPS as transport protocol** further down the panel, you must enter the fully qualified name of the vCAC server.

If vCAC was installed to use HTTPS as the transport protocol (see the **vCloud Automation Center Installation Guide**), select **Use HTTPS as transport protocol**, do the following:

- In the **vCloud Automation Center Hostname:Port** box, specify the host name and port of the vCAC Server.
• In the **Model Manager Web Service Hostname:Port** box, specify the host name and port of the Model Manager server.

6. On the Agent Selection panel, select **EPI PowerShell Agent**.

7. On the Agent Configuration panel, enter **Opsware** in the **EPI Type** field. At the **EPI Server** prompt, you can enter the name of an HP SA server or leave the field blank to let the agent interact with multiple hosts.

The HP SA server with which the agent interacts when provisioning a machine using HP SA depends on the value of a required custom property in the blueprint, **EPI.Server.Name** (discussed later in these instructions). Therefore,

• If you install a dedicated EPI agent by specifying an HP SA server name during installation, only machines whose **EPI.Server.Name** property *exactly matches the server name configured for the agent* can be provisioned by that server.

• If you install a general EPI agent by not specifying an HP SA server name during installation, a machine can be provisioned by any server specified in the blueprint's **EPI.Server.Name** property (assuming the agent can contact that server).

8. On the Service Configuration panel, indicate whether you want to register and start the agent service as part of installation. Both are required for the agent to function. If you want to delay starting the service for any reason, you can easily start it manually later. (Select **Start > Administrative Tools > Services** and then start the vCloud Automation Center Agent – *agentname* service.)

On the same panel, enter the credentials to be used by the agent service in **DOMAIN\username** format. This user must have administrative access to the machine the agent is being installed on as well as administrative access to all HP SA hosts with which the agent will interact.

9. On the final panel, press the **Install** button to complete the installation.

See the **vCloud Automation Center Installation Guide** for complete information about installing vCAC agents.

**Integrating HP SA**

The steps required to integrate HP SA with vCAC depend on which provisioning method you want to use and whether you want to enable software installation from HP SA.

**Enabling Provisioning by Creating from HP SA Boot Images**

If a system from which HP SA deploys images is available on the network and you have installed an EPI agent to interact with it, vCAC can provision machines using that instance of HP SA.

The following steps are required to integrate HP SA:

1. Log into the vCAC server using credentials with administrator access.

2. On the vCAC EPI/Opsware Agent host, select **Start > Administrative Tools > Services** and then stop the vCloud Automation Center EPI/Opsware Agent service.

3. Change to the agent directory of the EPI agent you installed in the previous section (typically %SystemDrive%\Program Files (x86)\DynamicOps\DCAC Agents\agentname).

4. Edit the file **VRMAgent.exe.config**. Locate this line
and change it to

```xml
<DynamicOps.Vrm.Agent.EpiPowerShell
  registerScript="CreateMachine.ps1"
  unregisterScript="DisposeVM.ps1"/>
```

5. Delete the **Scripts** folder in the EPI agent directory.

6. Obtain the **Scripts** folder containing the HP SA PowerShell scripts from VMware customer support and copy this folder to the agent directory.

7. In the **Scripts** folder, create an HP SA password file. The credentials you provide for this file must have administrator access to all instances of HP SA with which the agent will interact. To create the file, follow these steps:
   - Open the PowerShell command prompt using **Start > All Programs > Windows PowerShell**.
   - Change to the **Scripts** directory
   - Enter the following command:
     ```powershell
     .\CreatePasswordFile.ps1 username
     ```
     Enter the password for *username* when prompted.
   - Exit the PowerShell command prompt by entering **exit**.

8. On the vCAC EPI/Opsware Agent host, select **Start > Administrative Tools > Services** and then start or restart the vCloud Automation Center EPI/Opsware Agent service.

---

**Enabling Software Installation from HP SA**

If you want to enable software installation by HP SA on provisioned machines, identify the HP SA policies you want to make available in vCAC.

To allow the machine requestor to select from among these policies, follow these instructions:

1. Log into the vCAC server using credentials with administrator access.

2. Create a text file called **Software.txt** in the **Website** directory under the vCAC server install directory (typically `%SystemDrive%\Program Files x86\DynamicOps\DCAC Server`). Each line of **Software.txt** must be in the following format:

   ```text
   Software_policy_description=software_policy_name
   ```

   where **software_policy_description** is the label provided to requesting users making a selection and **software_policy_name** is the name of the policy in the HP SA instance that will be installing the software. For example, a **Software.txt** file might look like this:

   ```text
   HP SA Windows ISM Tool=Windows_ISMtool
   HP SA Linux ISM Tool=RedHatLinux_ISMtool
   ```

   In this case the requesting user would be able to choose **HP SA Windows ISM Tool**, **HP SA Linux ISM Tool**, or both.
Preparing an HP SA-Ready Template for Cloning

To add software installation by HP SA to provisioning by cloning, you must

- Add the HP SA agent installation package to the cloning template
- Add the customization required to invoke it after provisioning, so that the agent is installed on each cloned machine

To create the HP SA-ready template, prepare a reference machine and convert it to a template for cloning. Take the following additional steps when preparing the reference machine and customization specification to be used:

For Windows reference machines:

- Copy the HP SA agent installer to the C:\ directory of the reference machine.
- Add the following line to the Run Once section of the customization specification:
  
  `C:\opswareagentinstaller --opsw_gw_addr opswareipaddress:3001 -s --force_sw_reg --force_full_hw_reg`

  where `opswareagentinstaller` is the name of the HP SA agent installer executable, and `opswareipaddress` is the IP address of the server hosting the HP SA instance that will install the software. For example:

  `C:\ opsware-agent-37.0.0.2.61-win32-6.0.exe --opsw_gw_addr 10.20.100.52:3001 -s --force_sw_reg --force_full_hw_reg`

For Linux reference machines:

- Copy the HP SA agent installer to the reference machine.
- Create a script to run the installer and install the HP SA agent, then copy the script to the reference machine.
- Use the Linux.ExternalScript.* properties, described in the next section, to specify that the script be run after cloning.

  **Note:** Do not install the HP SA agent on the reference machine. The agent must be installed through the customization specification or postinstall script following cloning.

Creating Blueprints for HP SA Integration

To use HP SA integration, you can create a blueprint that enables

- provisioning of virtual machines from HP SA images, with optional software installation by HP SA
- provisioning of virtual machines by cloning from an HP SA-ready template, with software installation by HP SA

Creating a Blueprint for Creating from an HP SA Boot Image

Create a virtual blueprint and on the Build Information tab
• Select **Create** and the **ExternalProvisioningWorkflow** workflow.

• Add the custom properties specified below. These are required unless otherwise noted.

As noted, software jobs can be either made available to individual machine requestors on a per-machine basis or specified in a blueprint to be applied to all machines provisioned from that blueprint.

• To make all the policies listed in the **Software.txt** file described in Enabling Software Installation from HP SA available to the machine requestor to select, include the property **LoadSoftware** with the value **True**.

• To specify a policy to be applied to all machines provisioned from the blueprint, include the custom property **VRM.Software.IdNNNN**, where **NNNN** is a number from 1000 to 1999, and set the value to the name of the policy, for example **Windows_ISMtool**.

**Note:** The custom properties can also be placed in a build profile which is then incorporated in the blueprint, and are included in a property set provided with vCAC.

### Creating a Blueprint for Cloning from an HP SA-Ready Template

Create a blueprint for provisioning by cloning. On the Build Information tab, add the custom properties below.

**Note:** The custom properties can also be placed in a build profile which is then incorporated in the blueprint, and are included in a property set provided with vCAC.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware.VirtualCenter.OperatingSystem</td>
<td>The vCenter Server guest operating system version (VirtualMachineGuestOsIdentifier) with which vCenter Server is to create the machine. <em>This OS version must match the OS version to be installed on the provisioned machine.</em> See VMware documentation at <a href="http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://pubs.vmware.com/vsphere-50/index.jsp?topic=%2Fcom.vmware.wssdk.apiref.doc_50%2Fvim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> and <a href="http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html">http://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.vm.GuestOsDescriptor.GuestOsIdentifier.html</a> or other current locations for possible values. (required for VMware only) When this property has a non-Windows value, for example <strong>rhel5Guest</strong> for Red Hat Enterprise Linux 5, the <strong>Connect Using RDP</strong> option is disabled. The property can be used for this purpose in any virtual, cloud or physical blueprint.</td>
</tr>
<tr>
<td>VirtualMachine.EPI.Type</td>
<td>Type of external provisioning infrastructure; set to Opsware for HP SA integration.</td>
</tr>
<tr>
<td>Property</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| EPI.Server.Name              | Name of server hosting HP SA.  
• If at least one general Opsware EPI agent was installed without specifying a server, this value directs the request to the desired server.  
• If only dedicated Opsware EPI agents for specific HP SA server were installed, this value must match exactly the server name configured for one of these agents.                                                                                                                                         |
| Opsware.Software.Install    | Set to True to enable software installation by HP SA.                                                                                                                                                                                                                                                                                     |
| LoadSoftware                | Optionally set to True to make the HP SA policies listed in Website\Software.txt available for selection by the user requesting the machine.                                                                                                                                                                                                  |
| Opsware.Server.Name          | Fully qualified name of the HP SA server.                                                                                                                                                                                                                                                                                                  |
| Opsware.Server.Username      | Username provided when password file in agent directory was created; must have administrative access to the HP SA instance (for example, opswareadmin).                                                                                                                                                                                            |
| VRM.Software.IdNNNN         | Optionally specify an HP SA policy to be applied to all machines provisioned from the blueprint.  
NNNN is a number from 1000 to 1999.                                                                                                                                                                                                                                                                                                  |
| Linux.ExternalScript.Name   | The name of the customization script that installs the HP SA agent on a Linux virtual machine following cloning (see Preparing an HP SA-Ready Template for Cloning). (Linux only)                                                                                                                                                                           |
| Linux.ExternalScript.LocationType | Set to local to indicate that the script named in Linux.ExternalScript.Name is on the cloned machine. (Linux only)                                                                                                                                                                                                                       |
| Linux.ExternalScript.Path   | The local path to the script named in Linux.ExternalScript.Name. The value must use forward slashes and begin with a forward slash. (Linux only)                                                                                                                                                                                             |
## Appendix D Machine Lifecycle States

This table describes the workflows available in vCAC.

<table>
<thead>
<tr>
<th>Workflow Name</th>
<th>Workflow State</th>
<th>WorkItem</th>
<th>Agent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td>Requested</td>
<td></td>
<td></td>
<td>New machine requested; create or register.</td>
</tr>
<tr>
<td></td>
<td>AwaitingApproval</td>
<td></td>
<td></td>
<td>Approval process in progress. Machine build will complete with <strong>approved</strong> status or be disposed if it completes with <strong>rejected</strong> status.</td>
</tr>
<tr>
<td>RegisterMachine</td>
<td>RegisterVM</td>
<td>Proxy</td>
<td></td>
<td>Registering existing machine. Attributes (managed, owner, notes) created, set in Hypervisor.</td>
</tr>
<tr>
<td>BuildingMachine</td>
<td></td>
<td></td>
<td></td>
<td>Machine build is about to start. Provisioning workflow specified in Blueprint is being created.</td>
</tr>
<tr>
<td>MachineProvisioned</td>
<td>SetMachineOperations</td>
<td>DEM</td>
<td></td>
<td>Machine build completed with success and additional operations such as VDI registration or other custom configuration operations are being performed on machine before it is made available for user. Allowed machine operations defined in Blueprint Security tab are being configured on machine.</td>
</tr>
<tr>
<td>MachineActivated</td>
<td></td>
<td></td>
<td></td>
<td>Hypervisor guest OS tools (VMWare Tools) are being installed on machine by Hypervisor.</td>
</tr>
<tr>
<td>InstallTools</td>
<td>InstallTools</td>
<td>Proxy</td>
<td></td>
<td>Machine is On, Off, TurningOn, TurningOff, ShuttingDown, Suspending, Resetting, Rebooting.</td>
</tr>
<tr>
<td>Power States</td>
<td>Power States</td>
<td>Proxy</td>
<td></td>
<td>Machine has expired and was turned off. After archive period elapses, it will be automatically disposed. Machine cannot be used by user. Machine can only be reactivated or disposed.</td>
</tr>
<tr>
<td>DeactivateMachine</td>
<td></td>
<td></td>
<td></td>
<td>Hypervisor guest OS tools (VMWare Tools) are being installed on machine by Hypervisor.</td>
</tr>
<tr>
<td>UnprovisionMachine</td>
<td></td>
<td></td>
<td></td>
<td>Machine has been disposed and about to be removed from management. Master Workflow is about to terminate.</td>
</tr>
<tr>
<td>Disposing</td>
<td>DisposeVM</td>
<td>Proxy</td>
<td></td>
<td>Machine is being disposed by Hypervisor.</td>
</tr>
<tr>
<td>Finalized</td>
<td></td>
<td></td>
<td></td>
<td>Machine is being cloned by Virtual Center, SCVMM, or vCloud Director.</td>
</tr>
<tr>
<td>CloneMachine</td>
<td>CloneVM</td>
<td>Proxy</td>
<td></td>
<td>Machine is being customized by Virtual Center, SCVMM, or vCloud Director.</td>
</tr>
<tr>
<td>CustomizeMachine</td>
<td>CustomizeVM</td>
<td>Proxy</td>
<td></td>
<td>Machine is being powered on for the first time after clone process is completed.</td>
</tr>
<tr>
<td>InitialPowerOn</td>
<td>PowerOn</td>
<td>Proxy</td>
<td></td>
<td>Machine is being customized by Guest Agent (custom scripts being executed).</td>
</tr>
<tr>
<td>Workflow Name</td>
<td>Workflow State</td>
<td>WorkItem</td>
<td>Agent</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BuildFinished</td>
<td>BuildFinished</td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
<tr>
<td>WIMImageWorkflow</td>
<td>CreatingMachine</td>
<td>CreateVM</td>
<td>Proxy</td>
<td>Machine container is being created by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>AddingDisks</td>
<td>AddDisks</td>
<td>Proxy</td>
<td>Additional disks, if any, are being created and added to machine by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>InitialPowerOn</td>
<td>PowerOn</td>
<td>Proxy</td>
<td>Machine is being powered on for the first time.</td>
</tr>
<tr>
<td></td>
<td>SetupOS</td>
<td>SetupOS</td>
<td>Guest</td>
<td>Machine is booted from CDROM and OS WIM image is being copied to C:\ drive from configured location.</td>
</tr>
<tr>
<td></td>
<td>EjectingCD</td>
<td>EjectCD</td>
<td>Proxy</td>
<td>CDROM is being unmounted from machine.</td>
</tr>
<tr>
<td></td>
<td>InstallOS</td>
<td>InstallOS</td>
<td>Guest</td>
<td>Machine is being shut down, booted for the first time from hard disk, sysprepped and customized by Guest Agent (additional disks partitioned and formatted, Owner added to Administrator group).</td>
</tr>
<tr>
<td></td>
<td>BuildComplete</td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
<tr>
<td>BasicVMWorkflow</td>
<td>CreatingMachine</td>
<td>CreateVM</td>
<td>Proxy</td>
<td>Machine container is being created by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>AddingDisks</td>
<td>AddDisks</td>
<td>Proxy</td>
<td>Additional disks, if any, are being created and added to machine by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>BuildComplete</td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
<tr>
<td>ExternalProvisioningWorkflow</td>
<td>CreatingMachine</td>
<td>CreateVM</td>
<td>Proxy</td>
<td>Machine container is being created by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>AddingDisks</td>
<td>AddDisks</td>
<td>Proxy</td>
<td>Additional disks, if any, are being created and added to machine by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>EpiRegister</td>
<td>EpiRegister</td>
<td>EPI</td>
<td>Machine is being registered in External Provisioning Infrastructure (Citrix Provisioning, BladeLogic, etc.).</td>
</tr>
<tr>
<td></td>
<td>InitialPowerOn</td>
<td>PowerOn</td>
<td>Proxy</td>
<td>Machine is being powered on for the first time.</td>
</tr>
<tr>
<td></td>
<td>BuildComplete</td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
<tr>
<td>LinuxKickstartWorkflow</td>
<td>CreatingMachine</td>
<td>CreateVM</td>
<td>Proxy</td>
<td>Machine container is being created by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>AddingDisks</td>
<td>AddDisks</td>
<td>Proxy</td>
<td>Additional disks, if any, are being created and added to machine by hypervisor.</td>
</tr>
<tr>
<td></td>
<td>InitialPowerOn</td>
<td>PowerOn</td>
<td>Proxy</td>
<td>Machine is being powered on for the first time.</td>
</tr>
<tr>
<td>Workflow Name</td>
<td>Workflow State</td>
<td>WorkItem</td>
<td>Agent</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>InstallingOS</td>
<td>SetupOS</td>
<td>Guest</td>
<td></td>
<td>Machine is booted from CDROM and OS image is being created by kickstart process.</td>
</tr>
<tr>
<td>EjectingCD</td>
<td>EjectCD</td>
<td>Proxy</td>
<td></td>
<td>CDROM is being unmounted from machine.</td>
</tr>
<tr>
<td>CustomizeOS</td>
<td>CustomizeOS</td>
<td>Guest</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BuildComplete</td>
<td></td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
<tr>
<td>VirtualSccmProvisioningWorkflow</td>
<td>CreatingMachine</td>
<td>CreateVM</td>
<td>Proxy</td>
<td>Machine container is being created by hypervisor.</td>
</tr>
<tr>
<td>AddingDisks</td>
<td>AddDisks</td>
<td>Proxy</td>
<td></td>
<td>Additional disks, if any, are being created and added to machine by hypervisor.</td>
</tr>
<tr>
<td>SccmRegistration</td>
<td>SccmRegisterMachine</td>
<td>DEM</td>
<td></td>
<td>Machine is being registered in SCCM Provisioning Infrastructure.</td>
</tr>
<tr>
<td>InitialPowerOn</td>
<td>PowerOn</td>
<td>Proxy</td>
<td></td>
<td>Machine is being powered on for the first time.</td>
</tr>
<tr>
<td>InstallingOS</td>
<td>Complete</td>
<td>Guest</td>
<td></td>
<td>Machine is booted and is being provisioned by SCCM.</td>
</tr>
<tr>
<td>EjectingCD</td>
<td>EjectCD</td>
<td>Proxy</td>
<td></td>
<td>CDROM is being unmounted from machine.</td>
</tr>
<tr>
<td>EndedVirtualProvisioning</td>
<td></td>
<td></td>
<td></td>
<td>Machine build has been complete (success or failure). Provisioning workflow is about to terminate.</td>
</tr>
</tbody>
</table>